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Účel použití

Účel použití
PCR CFX Opus Dx pro práci v reálném časeTM a Software CFX Maestro Dx, bezpečnostní ediceTM je
určena k provádění PCR reakce s použitím flourescence k detekci a kvantifikaci sekvencí nukleových
kyselin. Systém a software jsou určeny k diagnostickému použití in vitro vyškolenými laboratorními
techniky. Systémy by se měly používat s diagnostickými testy nukleových kyselin třetích stran,
vyrobenými a označenými k diagnostickým účelům.

Použité symboly

Výrobce Číslo šarže

Spotřebujte do Pro diagnostické použití in vitro

Teplotní limit Katalogové číslo

Viz návod k použití Počet testů

Pro použití s Sériové číslo

Pouze na předpis Obsahuje latex
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Označení CE – předpis
(EU) 2017/746 IVDR

Překlady
Dokumenty k produktu mohou být k dispozici v jiných jazykových mutacích na elektronických médiích.
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Historie revizí

Historie revizí

Dokument Datum Popis změny

Software CFX Maestro Dx,
bezpečnostní edice
Uživatelská příručka, 2.0

(ID dokumentu
č. 10000135545)

Prosinec 2020 Verze A, první vydání

Software CFX Maestro Dx,
bezpečnostní edice
Uživatelská příručka, 2.3

(ID dokumentu
č. 10000135545)

Květen 2022 n Aktualizováno k zajištění podpory přístrojů CFX
Opus Deepwell Dx

n Byla aktualizována tabulka lexikonu symbolů

n Do úvodu přidejte poznámku o kybernetické
bezpečnosti
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Bezpečnost a shoda s předpisy
Systémy PCR pro práci v reálném čase CFX Opus 96 Dx, CFX Opus 384 Dx a CFX Opus Deepwell Dx
(v této příručce označované jako Systém CFX Opus Dx) se během provozu velmi rychle zahřívají
a ochlazují. Pro bezpečný provoz systému PCR v reálném čase Bio-Rad důrazně doporučuje dodržovat
bezpečnostní specifikace uvedené v této části a v této příručce.

Bezpečnostní výstražné štítky
Výstražné štítky umístěné na Systém CFX Opus Dx a v této příručce vás upozorňují na možné příčiny
zranění nebo škody. Tabulka 1 popisuje každý bezpečnostní výstražný štítek.

Ikona Význam

Provozování Systém CFX Opus Dx bez předchozího seznámení se s tímto
návodem k použití může znamenat riziko úrazu. Použití tohoto přístroje způsobem,
který není uveden v tomto návodu k použití nebo určen společností Bio-Rad může
mít za následek poškození nebo znehodnocení ochranných prvků přístroje.

Se Systém CFX Opus Dx jako takovým se nepojí žádná biologická ani radioaktivní
rizika. Tato rizika mohou nastat až ve chvíli, kdy jsou do systému vložena
prostřednictvím testovaných vzorků. Při manipulaci s biologicky nebezpečnými
nebo radioaktivními vzorky dodržujte doporučená bezpečnostní opatření
a směrnice specifické pro vaši laboratoř a místo. Tyto směrnice by měly obsahovat
způsoby čištění, monitorování a likvidace používaných nebezpečných materiálů.

Mimoto, jak je uvedeno výše, existuje malé riziko výbuchu nebo úniku kapalin nebo
par z nádob se vzorky. Při práci s nebezpečnými materiály je riziko úrazu uniklým
materiálem spojeno s rizikem, že by se samotný nebezpečný materiál mohl
rozptýlit v přístroji a kolem něj. Uživatelé by měli pro takové situace přijmout
příslušná preventivní opatření.

Tabulka 1. Obecné bezpečnostní výstrahy

Uživatelská příručka | 17



Bezpečnost a shoda s předpisy

Ikona Význam

Systém CFX Opus Dx při vysokých teplotách, které mohou způsobit závažné
popáleniny. Před otevřením víka a vyjmutím vzorků vždy nechte blok vzorku
vychladnout na pokojovou teplotu. I po ochlazení bloku vzorků mohou okolní
oblasti i topná deska ještě zůstat po nějakou dobu horké. V situacích, kdy není
dostatek času, aby mohl přístroj vychladnout, se doporučuje použít ochranné
prostředky, jako jsou termální rukavice nebo „chňapky“.

Za bezpečnost a výkon jakéhokoli systému zahrnujícího Systém CFX Opus Dx
odpovídá výhradně jeho montážní pracovník.

Systém CFX Opus Dx se může během běžného provozu natolik zahřát, že
způsobí, že se kapaliny ve vzorcích začnou vařit nebo odpařovat, což vede
k natlakování nádob se vzorky. Existuje riziko porušení nádob se vzorky;
důsledkemmůže být netěsnost/únik, rozstřik kapalin nebo explozivní prasknutí
a únik par nebo kapalin uvnitř přístroje a v jeho okolí.

Uživatelé by měli vždy pracovat s přístrojem se zavřeným víkem nebo mít během
provozu ochranné brýle, termální rukavice a další osobní ochranné prostředky, aby
nedošlo ke zranění. Při otevření přístroje, dokud jsou vzorky ještě horké, například
po přerušení běhu, hrozí únik, rozstříknutí nebo rozprášení kapaliny z tlakových
nádob. Před otevřením víka nechte vzorky vždy vychladnout.

Uživatelé by nikdy neměli spouštět reakci s víkem nebo fólií, které jsou otevřené,
uvolněné, propíchnuté nebo jinak poškozené, protože se tím zvýší
pravděpodobnost nebezpečného prasknutí či výbuchu.

Uživatelé by nikdy neměli provádět reakci s těkavými reagenciemi, které by mohly
zvýšit pravděpodobnost nebezpečného prasknutí nebo výbuchu.

Tabulka 1. Obecné bezpečnostní výstrahy, pokračování
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Bezpečnost a shoda s předpisy

Bezpečnost a shoda s předpisy

Soulad s bezpečností
Systém CFX Opus Dx byl testován a shledán v souladu se všemi příslušnými požadavky následujících
bezpečnostních a elektromagnetických norem:

n IEC 61010-1:2010 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení – Část
1: Všeobecné požadavky

n IEC 61010-2-010:2019 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení -
Část 2-010: Zvláštní požadavky na laboratorní zařízení pro ohřev materiálů

n IEC 61010-2-081:2019 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení –
Část 2-081: Zvláštní požadavky na automatická a poloautomatická zařízení pro analýzu a jiné účely

n IEC 61010-2-101:2018 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení –
Část 2-101: Zvláštní požadavky na zdravotnická zařízení pro diagnostiku in vitro (IVD)

n CAN/CSA-C22.2 č. 61010-1-12:2018 Bezpečnostní požadavky na elektrická měřicí, řídicí
a laboratorní zařízení, Část 1: Všeobecné požadavky

n CAN/CSA-C22.2 č. 61010-2-010:19 Bezpečnostní požadavky na elektrická měřicí, řídicí
a laboratorní zařízení, Část 2-010: Zvláštní požadavky na laboratorní zařízení pro ohřev materiálů

n CAN/CSA-C22.2 č. 61010-2-081:19 Bezpečnostní požadavky na elektrická měřicí, řídicí
a laboratorní zařízení, Část 2-081: Zvláštní požadavky na automatická a poloautomatická zařízení
pro analýzu a jiné účely

n CSA-C22.2 č. 61010-2-101:19 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní
zařízení, Část 2-101: Zvláštní požadavky na in vitro diagnostické (IVD) zdravotnické vybavení

n EN 61010-1:2010 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení, Část 1:
Všeobecné požadavky

n EN 61010-2-010:2014 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení –
Část 2-010: Zvláštní požadavky na laboratorní vybavení pro ohřev materiálů

n EN 61010-2-081:2015 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení –
Část 2-081: Zvláštní požadavky na automatické a poloautomatické laboratorní vybavení pro účely
analýzy a jiné účely
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n EN 61010-2-101:2017 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení –
Část 2-101: Zvláštní požadavky na in vitro diagnostické (IVD) zdravotnické vybavení

n UL 61010-1:2012 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení – Část 1:
Všeobecné požadavky

n UL 61010-2-010:2019 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení –
Část 2-010: Zvláštní požadavky na laboratorní vybavení pro ohřev materiálů

n UL 61010-2-081:2019 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení –
Část 2-081: Zvláštní požadavky na automatické a poloautomatické laboratorní vybavení pro účely
analýzy a jiné účely

n UL 61010-2-101:19 Bezpečnostní požadavky na elektrická měřicí, řídicí a laboratorní zařízení – Část
2-101: Zvláštní požadavky na in vitro diagnostické (IVD) zdravotnické vybavení

Elektromagnetická kompatibilita (EMC)
Systém CFX Opus Dx byl testován a shledán v souladu se všemi příslušnými požadavky následujících
norem o elektromagnetické kompatibilitě:

n IEC 61326-1:2012 Elektrická měřicí, řídicí a laboratorní zařízení - Požadavky na EMC - Část 1:
Obecné požadavky. Testováno jako zařízení třídy A

n IEC 61326-2-6:2012 Elektrická měřicí, řídicí a laboratorní zařízení - Požadavky na EMC – Část 2-6:
Konkrétní požadavky - Zdravotnická zařízení pro diagnostiku in vitro (IVD)

n EN 61326-1:2013 Elektrická měřicí, řídicí a laboratorní zařízení - Požadavky na EMC – Část 1:
Obecné požadavky. Testováno jako zařízení třídy A

n EN 61326-2-6:2013 Elektrická měřicí, řídicí a laboratorní zařízení - Požadavky na EMC – Část 2-6:
Konkrétní požadavky - Zdravotnická zařízení pro diagnostiku in vitro (IVD)

n FCC – část 15, hlava B, oddíly 15.107 a 15.109. Testováno jako digitální zařízení třídy A.

n CAN ICES-003v6:2019 Norma zařízení způsobujícího rušení, zařízení informačních technologií
(včetně digitálních přístrojů) – Limity a způsoby měření. Testováno na limity třídy A

Výstrahy a poznámky k elektromagnetické kompatibilitě
n Výstraha: Změny nebo úpravy tohoto přístroje, které výslovně neschválí Bio-Rad, mohou mít za

následek zrušení oprávnění uživatele k provozu takového zařízení.

n Poznámka: Přezkoušením tohoto zařízení bylo zjištěno, že splňuje limity pro digitální zařízení třídy A
v souladu s částí 15 předpisů FCC. Tyto limity jsou nastaveny tak, aby poskytovaly přiměřenou
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ochranu před škodlivým rušením při provozu zařízení v komerčním prostředí. Toto zařízení vytváří,
využívá a může vyzařovat vysokofrekvenční energii, a pokud není instalováno a používáno ve shodě
s návodem k použití, může způsobovat škodlivá rušení radiokomunikací. Provozování tohoto
zařízení v obytných prostorách pravděpodobně způsobí škodlivé rušení; v takovém případě musí
uživatel toto rušení na vlastní náklady odstranit.

n Poznámka týkající se shody s předpisy FCC: Ačkoliv se při testech zjistilo, že je tento přístroj
v souladu s částí 15, hlavy B předpisů FCC pro digitální zařízení třídy A, mějte na paměti, že tato
shoda není povinná, protože přístroj splňuje podmínky pro „vyňaté zařízení“ podle 47 CFR 15.103(c)
s ohledem na uvedené předpisy FCC platné v okamžiku výroby.

n Poznámka ohledně kabelů: Tento přístroj byl testován, zda vyhovuje elektromagnetické
kompatibilitě (EMC) za použití speciálně navržených kabelů USB, které jsou dodávány spolu s tímto
přístrojem. Tyto kabely, nebo jejich adekvátní náhrada schválená společností Bio-Rad, musí být
použity spolu s tímto přístrojem, aby bylo zajištěno trvalé dodržení emisních limitů EMC.
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Požadavky na prostředí
Systém CFX Opus DxSystémy CFX byly navrženy pro bezpečný provoz za podmínek prostředí
uvedených v následujících tabulce.

Parametr Specifikace

Prostředí Pouze pro použití v krytých prostorech

Provozní nadmořská výška Až 2 000 m n. m.

Teplota v místnosti 15–31 °C

Přepravní a skladovací teplota –20–60 °C**
–4–140 °F

Relativní vlhkost 20–80 % (bez kondenzace)***

Provozní napájení 100–240 V AC ± 10 %, 50/60 Hz, 850 Wmax.

Kolísání napětí hlavního zdroje napájení ±10%

Maximální spotřeba energie <850W

Pojistky 10 A, 250 V, 5 × 20 mm, rychlý typ (počet: 2)

Kategorie přepětí II

Stupeň znečištění 2

*Použití přístroje mimo tento teplotní rozsah může být v rozporu s výkonnostními specifikacemi. Teplota
v místnosti v rozmezí 5–40 °C je považována za bezpečnou.

**Aby byly splněny tyto požadavky na teplotu, přístroj skladujte a přepravujte v přepravním obalu.

***Použití přístroje při teplotě 4 ⁰C omezte na 18 hodin provozu za těchto podmínek. Prodlevy za teploty
4 ⁰C lze provádět až po dobu 72 hodin, pokud je vlhkost nižší než 60 % (bez kondenzace).

Tabulka 2. Požadavky na prostředí PCR CFX Opus Dx pro práci v reálném čase
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Rizika
Systém CFX Opus Dx je navržen tak, aby fungoval bezpečně a efektivně při použití způsobem
předepsaným výrobcem. Pokud je systém nebo jakákoli jeho přidružená součást používána způsobem,
který není specifikován výrobcem, může dojít k narušení vlastní ochrany poskytované přístrojem. Bio-Rad
nenese odpovědnost za úrazy ani škody způsobené použitím tohoto zařízení jakýmkoli blíže neurčeným
způsobem nebo úpravami přístroje, které nebyly provedeny prostřednictvím Bio-Rad či autorizovaného
zástupce. Systém CFX Opus Dx smí servisovat pouze vyškolení pracovníci společnosti Bio-Rad.

Biologická rizika
Systém CFX Opus Dx je laboratorní produkt . Pokud se však vyskytnou biologicky nebezpečné vzorky,
dodržujte následující pokyny a postupujte podle místních směrnic platných pro vaši laboratoř
a pracoviště.

Poznámka: Během normálního provozu tohoto přístroje se neuvolňují žádné biologicky nebezpečné
látky.

Všeobecná bezpečnostní opatření

n Vždy používejte laboratorní rukavice, plášť a bezpečnostní brýle s bočními kryty nebo ochranné
brýle.

n Nedotýkejte se rukama úst, nosu a očí.

n Všechny řezné rány a odřeniny zcela zakryjte ještě před zahájením práce s potenciálně infekčními
materiály.

n Po práci s potenciálně infekčními materiály si ještě před odchodem z laboratoře pečlivě umyjte ruce
mýdlem a vodou.

n Před zahájením práce na pracovním stole si sundejte náramkové hodinky a šperky.

n Uchovávejte všechny infekční nebo potenciálně infekční materiály v nerozbitných nepropustných
nádobách.

n Před opuštěním laboratoře si sundejte ochranný oděv.

n V rukavicích nepište, neberte telefony, nerozsvěcejte světla a nedotýkejte se předmětů, kterých se
ostatní lidé mohou dotýkat bez rukavic.

n Rukavice často měňte. Sejměte je okamžitě, pokud jsou viditelně kontaminovány.

n Nevystavujte látky, u kterých nelze provést řádnou dekontaminaci, potenciálně infekčním látkám.
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n Po dokončení práce s biologicky nebezpečnýmmateriálem dekontaminujte pracovní plochu
vhodným dezinfekčním prostředkem (např. v domácnosti používaným dezinfekčním přípravkem
naředěným v poměru 1:10).
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Povrchová dekontaminace

VÝSTRAHA! Před dekontaminací přístroj vždy vypněte a odpojte od elektrické sítě, aby
nedošlo k úrazu elektrickým proudem.

Následující oblasti lze čistit jakýmkoli baktericidním, virucidním nebo fungicidním dezinfekčním
prostředkem určeným pro nemocniční použití:

n vnější kryt a podvozek,

n vnitřní povrch bloku vzorků a jamek bloku vzorků,

n ovládací panel a displej.

Při přípravě a aplikaci dezinfekčního prostředku postupujte podle pokynů poskytnutých výrobcem
produktu. Po použití dezinfekčního prostředku několikrát opláchněte blok vzorků a jamky bloku vzorků
vodou. Po opláchnutí vodou důkladně blok vzorků a jamky bloku vzorků vysušte.

Důležité: Nepoužívejte abrazivní nebo korozivní čisticí prostředky ani silné alkalické roztoky. Tyto
prostředky mohou poškrábat povrchy a poškodit blok vzorků, což by vedlo ke ztrátě přesnosti teplotní
regulace.

Likvidace biologicky nebezpečného materiálu

Následující potenciálně kontaminované materiály likvidujte v souladu s místními a státními předpisy
platnými pro laboratoře:

n klinické vzorky;

n reagencie;

n použité reagenční nádobky nebo jiné spotřební materiály, které mohou být kontaminované.

Chemická rizika
Systém CFX Opus Dx neobsahuje žádné potenciálně nebezpečné chemické materiály.

Rizika spojená s výbušností nebo hořlavostí
Systém CFX Opus Dx nepředstavuje žádná neobvyklá nebezpečí z hlediska hořlavosti nebo výbuchu,
pokud je správně používán tak, jak je stanoveno společností Bio-Rad Laboratories.
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Rizika spojená s elektrickým proudem
Systém CFX Opus Dx nepředstavuje pro obsluhu žádná mimořádná rizika spojená s elektrickým
proudem, pokud se systém nainstaluje a obsluhuje správně bez provedení fyzické úpravy, a pokud se
připojí ke zdroji elektrického napájení o náležité specifikaci.

Doprava
Dříve, než Systém CFX Opus Dx budete přesouvat nebo přepravovat, je nutné provést postupy
dekontaminace. Systém vždy přesunujte nebo přepravujte v samostatných nádobách v dodaném
obalovémmateriálu od Bio-Rad, který ochrání systém před poškozením.

Informace o přepravě systému a vhodný obalový materiál si můžete vyžádat u místně příslušné prodejní
pobočky Bio-Rad.

Baterie
Systém CFX Opus Dx používá jednu 3V knoflíkovou lithium-kovovou baterii pro zachování nastavení
času v případě přerušení napájení střídavým proudem. Pokud po vypnutí jednotky nezůstane zachován
nastavený čas, může to znamenat, že jsou baterie vybité.

VÝSTRAHA! Nepokoušejte se baterie sami vyměnit. Nejsou určeny k servisním
zásahům uživatele. Místo toho se obraťte na technickou podporu Bio-Rad.

Platí pouze pro stát Kalifornie, USA

n Chloristanový materiál – Lithiové baterie obsahují chloristanový materiál, a proto může být zapotřebí
zvláštní zacházení. Viz www.dtsc.ca.gov/hazardouswaste/perchlorate.

Likvidace
Systém CFX Opus Dx obsahuje elektrické materiály; ty nesmí být zlikvidovány jako netříděný odpad
a musí být shromažďovány odděleně podle směrnice Evropské unie 2012/19/EU o odpadních
elektrických a elektronických zařízeních – směrnice OEEZ. Před likvidací se obraťte na místního
zástupce společnosti Bio-Rad a požádejte o pokyny pro vaši zemi.

Záruka
Systém CFX Opus Dx a jeho příslušenství pokrývá standardní záruka Bio-Rad. Podrobnosti o záruce
získáte v místní pobočce společnosti Bio-Rad.
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Kapitola 1 Úvod
Vysoce výkonné systémy amplifikace PCR společnosti Bio-Rad se vyznačují nejnovějšími
technologickými pokroky a poskytují vyšší přesnost a reprodukovatelnost při amplifikaci nukleových
kyselin pro genomické experimenty.

Software Bio-Rad Software CFX Maestro Dx, bezpečnostní edice je kompatibilní s následujícími přístroji
CFX a vyznačuje se optimalizovanými spouštěcími soubory pro analýzy využívající primery a sondy
PrimePCR společnosti Bio-Rad.

n CFX Systém PCR v reálném čase Opus 96 Dx (v této příručce označovaný jako CFX Opus 96 Dx),

n CFX Systém PCR v reálném čase Opus 384 Dx (v této příručce označovaný jako CFX Opus 384 Dx),

n Systém PCR v reálném čase Opus Deepwell Dx CFX (v této příručce označovaný jako CFX Opus
Deepwell Dx).
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Software CFX Maestro Dx, bezpečnostní edice (v této příručce označovaný jako CFX Maestro Dx SE)
vám pomůže interpretovat komplexní data a vytvářet podrobné studie pro genetickou analýzu. Pouhými
několika kliknutími můžete vytvářet studie a udělat si dokonalý obrázek o své studii genové exprese díky
nástrojům, jako jsou t-testy, jednofaktorová ANOVA, PrimePCR analýza kontrol a  Následně můžete své
výsledky připravit k zveřejnění a tisku díky snadno nastavitelným nástrojům softwaru CFX Maestro Dx SE
pro vizualizaci dat a anotaci.

Poznámka: Zobrazení některých obrazovek v systému CFX Maestro se může lišit od zobrazení
v této uživatelské příručce. Zobrazení v softwaru je správné a funkce jsou stejné.

Důležité: Kyberbezpečnost je ochrana prostředků v kybernetickém prostoru před útoky.
Kyberbezpečnost je schopnost společnosti Bio-Rad chránit vlastní zaměstnance, informace,
systémy a reputaci v kybernetickém prostoru. Kybernetický prostor je nepřetržitě fungující
a technologicky propojený svět tvořený lidmi, organizacemi, informacemi a technologiemi.

Rychlá reakce na kyberbezpečnostní problémy je důležitá! Pokud máte podezření, že je vaše zařízení
ohroženo kyberbezpečnostním problémem nebo že na vašem pracovišti došlo k narušení
kyberzabezpečení, neprodleně požádejte zástupce společnosti Bio-Rad o technickou podporu.
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Software CFX Maestro Dx, bezpečnostní edice, a jeho hlavní
funkční rysy

Pomocí CFX Maestro Dx SE můžete provádět následující:

n Analyzovat data pomocí sloupcových grafů, grafů „clustergram“ nebo rozptylových grafů, abyste
mohli rychle interpretovat a pochopit výsledky.

n Přizpůsobit reprezentaci dat a exportovat diagramy s vysokým rozlišením pro publikování
a reporting.

n Určit kvalitu RNA a řešit experimenty pomocí kontrol analýzy PrimePCR.

n Vybrat vhodný referenční gen a analyzovat jeho stabilitu pomocí nástroje pro výběr Reference Gene
(Referenční gen).

n Provádět statistickou analýzu zahrnující jednofaktorovou analýzu rozptylu ANOVA genové exprese.

Tyto funkce a způsob jejich použití vysvětluje tato uživatelská příručka.

Kde najít více informací
Po instalaci softwaru CFX Maestro Dx SE a nastavení příslušného přístroje PCR společnosti Bio-Rad
můžete tuto příručku i podrobná témata nápovědy pro software CFX Maestro Dx SE otevřít z nabídky
Help (Nápověda) v libovolném náhledu.

Tip: Pro otevření internetových stránek společnosti Bio-Rad klikněte na logo Bio-Rad v pravém
horním rohu libovolného okna CFX Maestro Dx SE. Tyto stránky obsahují odkazy na technické
poznámky, návody, videa, informace o výrobcích a technickou podporu. Na stránkách rovněž
najdete mnoho technických zdrojů týkajících se různých způsobů a aplikací souvisejících s PCR,
PCR v reálném čase a genovou expresí.
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Kapitola 2 Software CFX Maestro Dx,
bezpečnostní edice, a jeho instalace

Tato kapitola vysvětluje, jak nainstalovat Software CFX Maestro Dx, bezpečnostní edice. Informace
o nastavení PCR přístrojů pro práci v reálném čase podporovaných společností Bio-Rad naleznete v
příslušné příručce.

CFX Maestro Dx SE je software určený k analýze dat PCR v reálném čase pro systémy CFX Opus 96 Dx,
CFX Opus 384 Dx a CFX Opus Deepwell Dx. Tímto softwaremmůžete uvedené systémy rovněž ovládat
v režimu softwarového ovládání.

Systémy CFX Opus Dx jsou dodávány s kabelem USB v brašně na příslušenství. Systém CFX Opus Dx
připojte ke spuštěnému počítači s běžícím softwarem CFX Maestro Dx SE pomocí kabelu USB.

Uchovejte obal pro budoucí použití. Pokud vám nějaká položka chybí nebo je poškozena, obraťte se na
místní pobočku společnosti Bio-Rad.
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Požadavky na systém
Tabulka 3 uvádí minimální a doporučené systémové požadavky pro počítač se softwarem CFX Maestro
Dx SE.

Systém Minimální Doporučené

Operační systém Microsoft Windows 10 (pouze
64bitová verze), sestavení 1511
nebo novější, s nejnovějšími
aktualizacemi zabezpečení

Microsoft Windows 10 (pouze 64bitová verze),
sestavení 1511 nebo novější, s nejnovějšími
aktualizacemi zabezpečení

Poznámka:Windows 11 také podporuje Software CFX Maestro Dx, bezpečnostní edice.

Důležité: Bezpečné spuštění musí být na počítačích, na kterých běží CFX Maestro Dx SE,
deaktivováno. Počítače, na kterých běží CFX Maestro Dx SE, musí být nakonfigurovány tak, aby se,
pokud probíhá cyklus, nerestartovaly automaticky po aktualizaci systému nebo zabezpečení.
Požádejte o pomoc správce systému.

Porty 2 vysokorychlostní porty USB 2.0 2 vysokorychlostní porty USB 2.0

Místo na
pevném disku

128 GB 128 GB

Rychlost
procesoru

2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Rozlišení
obrazovky

1 024 × 768 s režimem true color 1 280 × 1 024 s režimem true color

Čtečka PDF Čtečka PDF Adobe nebo čtečka PDFWindows
z některé z podporovaných sad Microsoft Office:

n 2016

n 2019

Lokalizace Je podporován 64bitový operační
systém Microsoft Windows v
angličtině, čínštině a ruštině

Je podporován 64bitový operační systém
Microsoft Windows v angličtině, čínštině a
ruštině

Tabulka 3. Požadavky na počítač pro software CFX Maestro Dx SE

Poznámka: Pokud plánujete spustit software na stejném počítači jako CFX Maestro Dx SE, nastavte
rozlišení obrazovky na 1 280 × 1 024 s režimem true-color.
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Instalace softwaru CFX Maestro Dx SE
Důležité: Před instalací nebo upgradem softwaru musíte od počítače CFX Maestro Dx SE odpojit
všechny připojené přístroje. Při instalaci softwaru není nutné vypínat přístroj. Ujistěte se, že jste
uložili všechny běhy a že neprobíhají žádné experimenty.

Poznámka: Před zahájením instalace ověřte, zda je bezpečné spuštění deaktivováno. Zajistěte, aby
byl počítač nakonfigurován tak, aby se automaticky nerestartoval po aktualizaci systému nebo
zabezpečení, pokud probíhá běh. Požádejte o pomoc správce systému.

Jak instalovat software CFX Maestro Dx SE

1. V případě potřeby odpojte od počítače všechny připojené přístroje.

Najděte a odpojte USB kabel přístroje z počítače se softwarem CFX Maestro Dx SE. Systém CFX
Opus Dx může mít konec kabelu stále zapojený.

2. Přihlaste se k počítači se softwarem CFX Maestro Dx SE s oprávněním správce.

3. Zasuňte USB disk se softwarem CFX Maestro Dx SE do USB portu počítače.

4. V Průzkumníkovi Windows přejděte na USB jednotku se softwarem CFX Maestro Dx SE a otevřete ji.

USB jednotka obsahuje poznámky k vydání a následující složky:

n CFX,

n Drivers (Ovladače),

n Firmware,

n Quick Start (Rychlý start).

Spolu s dalšími soubory složka CFX obsahuje instalační program softwaru CFX Maestro Dx SE
(CFXMaestroDxSetup.exe).

5. Otevřete složku CFX a dvakrát klikněte na CFXMaestroDxSetup.exe a spusťte instalační program.

6. Postupujte podle pokynů pro instalaci na obrazovce.

Po dokončení se na ploše počítače zobrazí ikona Bio-Rad Software CFX Maestro Dx, bezpečnostní
edice.

Tip: Instalační program CFX Maestro automaticky nainstaluje uživatelskou příručku Software
CFX Maestro Dx, bezpečnostní edice. Chcete-li tyto příručky vyhledat, přejděte do nabídky Help
(Nápověda) a vyberte možnost Open User Guides (Otevřít uživatelské příručky).

7. Po dokončení instalace můžete USB disk bezpečně vyjmout.
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Detekce připojených přístrojů
Během instalace CFX Maestro Dx SE instalační program automaticky nainstaluje ovladače přístroje do
počítače s CFX Maestro Dx SE. CFX Maestro Dx SE detekuje připojené přístroje při spuštění softwaru.

Jak detekovat připojené přístroje

1. Pokud jste tak doposud neučinili, zapojte hranatý (samec) konec dodaného kabelu USB typu B do
portu USB typu B na zadní straně základny přístroje.

2. Druhý konec (port) zapojte do USB portu počítače se softwarem CFX Maestro Dx SE.

3. Pokud ještě není přístroj v provozu, zapněte jej stiskem vypínače napájení na zadní straně přístroje.

4. Spusťte software CFX Maestro Dx SE.

Software automaticky rozpozná připojený přístroj a zobrazí v podokně Detected Instruments (Detekované
přístroje) okna Home (Domů) jeho název.

Poznámka: Pokud se přístroj v podokně Detected Instruments (Detekované přístroje) neobjeví,
ujistěte se, že je USB kabel správně připojen. Pro přeinstalování ovladačů vyberte v okně Home
(Domů) softwaru CFX Maestro Dx SE položky Tools > Reinstall Instrument Drivers (Nástroje > Znovu
instalovat ovladače přístroje).
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Softwarové soubory
Tabulka 4 uvádí typy souborů softwaru CFX Maestro Dx SE.

Typ souboru Koncovka Podrobnosti

Protokol .prcl Obsahuje podrobnosti o nastavení protokolu pro provedení
běhu PCR.

Destička .pltd Obsahuje podrobnosti o nastavení destičky pro provedení
běhu PCR.

Data .pcrd Obsahuje výsledky experimentu a analýzy PCR.

PrimePCR .csv Obsahuje protokol a uspořádání destičky pro destičky
PrimePCR.

Genová studie .mgxd Obsahuje výsledky více cyklů PCR a analýzy genové
exprese.

Soubor předběžných
Stand-Alone dat

.zpcr Obsahuje hodnoty fluorescence z provozu stand-alone,
které jsou převedeny do datového souboru.

LIMS .plrn Obsahuje informace o nastavení destičky a protokolu,
které jsou nezbytné pro provedení LIMS kompatibilního
běhu.

JSON .json Soubor určený jen pro čtení generovaný pouze systémy
CFX Opus Dx. Tento soubor obsahuje data spouštěcího
souboru, která se zobrazí v podokně podrobností ve File
Browser (Prohlížeč souborů) po vybrání spouštěcího
souboru. Tento soubor je vygenerován po dokončení
pracovního běhu. Vyexportuje se spolu se souborem .zpcr
a uloží se společně s datovými soubory, pokud je Save
Location (Místem uložení) buď jednotka USB, nebo sdílená
síťová složka.

Tabulka 4. Typy souborů softwaru CFX Maestro Dx SE
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bezpečnostní edice, a správa uživatelských účtů

Software CFX Maestro Dx, bezpečnostní edice, vyžaduje od uživatelů přihlášení pomocí svého
uživatelského jména a hesla systémuWindows. Osobě, která nainstalovala CFX Maestro Dx SE, je
automaticky přiřazena role správce a může vytvářet a spravovat uživatelské účty a role. Všichni ostatní
uživatelé musí mít přiřazen uživatelský účet, aby se mohli přihlásit a používat software.

Důležité: Každý uživatel musí mít v systémuWindows účet a heslo na počítači CFX Maestro Dx SE,
a teprve poté můžete přiřadit uživatelský účet a roli. Uživatelé mohou být buď členy skupiny uživatelů
Windows, nebo správců systémuWindows. Členové skupiny uživatelů Windows mají přístup pouze
ke svým souborům a složkám CFX Maestro Dx SE. Členové skupiny správců systémuWindows mají
přístup k souborům a složkám všech uživatelů v počítači.

Tato kapitola vysvětluje, jak vytvořit uživatele systému Microsoft Windows, aby je bylo možné přidat do
CFX Maestro Dx SE. Tato část také vysvětluje, jak přidat uživatele CFX Maestro Dx SE a spravovat
uživatelské role a oprávnění.
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Software CFX Maestro Dx, bezpečnostní edice, a jeho
spouštění

Poznámka: Každý uživatel se musí přihlásit pomocí svého uživatelského jména a hesla systému
Windows.

Pro spuštění CFX Maestro Dx SE

1. Na ploše počítače CFX Maestro Dx SE poklepejte na ikonu CFX Maestro Dx SE zástupce pro
spuštění aplikace.

2. V dialogovém okně Login (Přihlášení) zadejte heslo systémuWindows a klikněte na OK.

V aplikaci CFX Maestro Dx SE se otevře okno Home (Domů). V záhlaví se zobrazuje uživatelské
jméno pro Windows přihlášeného uživatele a v pruhu nabídky se zobrazuje modrá nálepka
označující, že software vyhovuje předpisu 21 CFR, část 11, například:
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Software CFX Maestro Dx, bezpečnostní edice, a přidání
uživatelů systému Microsoft Windows do počítače

Všichni uživatelé se musí přihlásit na počítači, kde běží software CFX Maestro Dx SE, svým uživatelským
jménem a heslem systémuWindows. Kvůli přesnému sledování auditu nelze uživatelské účty systému
Windows přidat pomocí dialogového okna Start > Settings > Accounts (Start > Nastavení > Účty).
Uživatelské účty systémuWindows je nutné přidat prostřednictvím konzoly Computer Management
(Správa počítače).

Důležité: Pokud ve vlastnostech uživatele systémuWindows (včetně jména uživatele a celého
jména) provedete změny poté, co jste vytvořili přidruženého uživatele CFX Maestro Dx SE, ztratí
uživatel CFX Maestro Dx SE platnost. Než uživatele systémuWindows uložíte a vytvoříte
přidruženého uživatele CFX Maestro Dx SE, zkontrolujte, zda jsou tyto informace správné.

Tip: Než začnete vytvářet účty systémuWindows, přečtěte si dokumentaci ke správě systému
Microsoft Windows a požádejte jeho správce o další informace.

Chcete-li přidat uživatelské účty systému Windows do počítače se softwarem CFX Maestro
Dx SE

1. Přihlaste se na počítači CFX Maestro Dx SE jako člen skupiny správce systémuWindows.

2. Na ploše klikněte pravým tlačítkem na ikonu My Computer (Tento počítač) a výběremmožnosti
Manage (Spravovat) otevřete konzolu Computer Management (Správa počítače).

3. V konzole Computer Management (Správa počítače) rozbalte položku Local Users and Groups
(Místní uživatelé a skupiny).

4. Klepněte pravým tlačítkemmyši na složku Users (Uživatelé) a výběremmožnosti New User (Nový
uživatel) otevřete dialogové okno New User (Nový uživatel).
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5. V dialogovém okně New User (Nový uživatel) musíte vyplnit následující pole:

n User name (Uživatelské jméno),

n Full name (Celé jméno),

n Password (Heslo),

n Confirm password (Potvrďte heslo).

6. Klikněte na Create (Vytvořit).
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Software CFX Maestro Dx, bezpečnostní edice, a přidávání a
odstraňování uživatelů

Tip: Pouze uživatelé v roli správce CFX Maestro Dx SE mohou vytvářet a odebírat CFX Maestro Dx
SE uživatelské účty. Osobě, která nainstalovala CFX Maestro Dx SE, je automaticky přiřazena role
správce. Tato osoba může přiřadit roli správce dalším uživatelům.

Poznámka: V CFX Maestro Dx SE se musí alespoň jednomu uživateli přiřadit role správce.

Jak přidat uživatelský účet v CFX Maestro Dx SE

1. Ověřte, zda jsou všichni zamýšlení uživatelé členy skupiny uživatelů systémuWindows nebo skupiny
správců systémuWindows a mají v systémuWindows heslo na počítač CFX Maestro Dx SE.

2. Spusťte CFX Maestro Dx SE a přihlaste se jako Administrator (Správce).

3. V okně Home (Domů) vyberte možnost User > User Administration (Uživatel > Správa uživatelů).

Otevře se dialogové okno User Administration (Správa uživatelů).
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4. V části Manage Users (Správa uživatelů) uveďte ke každému uživateli následující informace:

n User name (Uživatelské jméno) – v aplikaci CFX Maestro Dx SE tomusí být přihlašovací
uživatelské jméno uživatele Windows.

n Full name (Celé jméno) – celé jméno uživatele.

Toto jméno se objeví v poli Full User (Úplný uživatel) v revizním záznamu. Toto jméno musí být
stejné jako jméno zadané do pole Full name (Celé jméno) při vytváření uživatele systému
Windows.

n Role (Role) - role, která se má uživateli přiřadit.

Poznámka: Z rozevíracího seznamu můžete vybrat pouze jednu roli. Další informace
najdete v části Správa rolí uživatelů v Software CFX Maestro Dx, bezpečnostní edice.

n Doména (Domain) – doménaWindows, ze které uživatel přistupuje k softwaru.

Další informace získáte od správce systémuWindows.

5. Klikněte na OK a poté na Yes (Ano) pro uložení změn a zavření dialogového okna User
Administration (Správa uživatelů).

Odebrání uživatelského účtu CFX Maestro Dx SE

1. Spusťte CFX Maestro Dx SE a přihlaste se jako Administrator (Správce).

2. V okně Home (Domů) vyberte položku User > User Administration (Uživatel> Správa uživatelů)
a otevřete dialogové okno User Administration (Správa uživatelů).

3. V podokně Manage Users (Spravovat uživatele) vyberte možnost Remove (Odstranit) u každého
uživatele, kterého chcete odstranit.

4. Klikněte na OK a poté na Yes (Ano) pro uložení změn a zavření dialogového okna User
Administration (Správa uživatelů).

Správa rolí uživatelů v Software CFX Maestro Dx,
bezpečnostní edice

Důležité: V CFX Maestro Dx SE je nutné, aby alespoň jeden uživatel měl přiřazenu roli správce. Tuto
roli můžete přiřadit více než jednomu uživateli.

CFX Maestro Dx SE má čtyři uživatelské role. Každý uživatel musí mít přiřazenou roli, aby měl přístup k
softwaru. Ačkoli lze uživatelům přiřadit pouze jednu roli, můžete roli uživatele kdykoli změnit.

Kromě role správce můžete změnit oprávnění přiřazená každé roli. Všichni uživatelé, kterým byla
přiřazena role, dědí pouze oprávnění dané role.
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Ve výchozím nastavení jsou práva pro každou roli následující:

n Administrator (Správce) – tato role má všechna oprávnění; tato oprávnění nemůžete změnit.

n Principal (Vedoucí) – tato role má všechna oprávnění kromě nastavení e-mailu.

n Operator (Provozovatel) –– tato role má všechna oprávnění kromě přeskočení běhů a nastavení e-
mailu.

n Guest (Host) – tato role může číst pouze soubory.

Při přiřazování rolí v CFX Maestro Dx SE pozorně určete požadavky pro každého uživatele. Například
bez oprávnění k ukládání nebudou uživatelé s rolí hosta moci podepsat soubor. Bez oprávnění
k nastavení e-mailového účtu nebude role po dokončení běhu dostávat e-maily.

Chcete-li upravit oprávnění pro roli

1. Spusťte CFX Maestro Dx SE a přihlaste se jako Administrator (Správce).

2. V okně Home (Domů) vyberte položku User > User Administration (Uživatel> Správa uživatelů) a
otevřete dialogové okno User Administration (Správa uživatelů).

3. V části Manage Rights (Správa práv) u každé role zrušte nebo podle potřeby zaškrtněte políčko
konkrétních oprávnění.

4. Klikněte na OK a poté na Yes (Ano) pro uložení změn a zavření dialogového okna User
Administration (Správa uživatelů).

Zobrazení vaší role a oprávnění
Tip: Uživatelé, kterým byla přiřazena role Principal (Vedoucí), Operator (Operátor) nebo Guest
(Host), mohou zobrazit pouze svá uživatelská nastavení, oprávnění a role. Uživatelé s přiřazenou rolí
Administrator (Správce) mohou zobrazit všechna uživatelská oprávnění a role.

Zobrazení aktuální role a oprávnění uživatele

u V okně Home (Domů) vyberte možnost User > User Administration (Uživatel > Správa uživatelů).

Chcete-li upravit uživatelská nastavení, práva a role uvedené v okně User Administration (Správa
uživatelů), obraťte se na správce CFX Maestro Dx SE.
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Důležité: Software CFX Maestro Dx, bezpečnostní edice používá k ověření přístupu
k zabezpečeným datovým souborům CFX ověřování uživatelů systému Microsoft Windows.
Požádejte svého správce systémuWindows o vytvoření prostředí, které vyhovuje požadavkům
předpisu 21 CFR, část 11.

Při použití CFX Maestro Dx SE mohou uživatelé

n Podepisovat datové soubory a soubory genových studií.

n Chránit datové soubory heslem.

n Zobrazit a vytisknout si revizní záznamy.

Tato část tyto funkce podrobně vysvětluje.

Zabezpečené soubory
Ve výchozím stavu ukládá CFX Maestro Dx SE zabezpečené soubory do osobní složky přihlášeného
uživatele, která je umístěna na

C:\Users\<username>\Documents\Bio-Rad\CFX_MDX\My qPCR

Soubory .pcrd můžete ukládat a upravovat v této složce. Tato složka obsahuje odkazy na ostatní složky
(například na složku se soubory vzorků), které obsahují soubory pouze ke čtení. Správce však obsah této
složky může odstranit.

Tip: Alternativně může váš správce systémuWindows vytvořit sdílenou složku a váš správce
CFX Maestro Dx SE může nastavit software tak, aby ukládal všechny soubory do této složky.

V CFX Maestro Dx SE se soubory destiček, protokolů, dat a genových studií označují při uložení jako
zabezpečené. Tyto soubory můžete vytvořit v softwaru CFX Maestro nebo v CFX Maestro Dx SE. Poté,
co jsou uloženy v CFX Maestro Dx SE, můžete tyto soubory otevřít pouze v CFX Maestro Dx SE.

CFX Maestro Dx SE vytvoří revizní záznam pro všechny zabezpečené datové soubory a soubory
genových studií (soubory .pcrd a .mgxd). Software zaznamenává veškerou auditovatelnou aktivitu do
revizního záznamu souboru. Další informace najdete v části Revizní záznamy na straně 303.
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Podepisování zabezpečených souborů

Po uložení souboru do CFX Maestro Dx SE mohou uživatelé přidat elektronický podpis. K podepsání
souboru musí uživatel mít roli s oprávněním k uložení souboru. Například ve výchozím nastavení nemá
role Guest (Host) oprávnění k uložení souboru, a proto uživatelé s touto přiřazenou rolí nemohou soubor
podepsat.

V CFX Maestro Dx SE nejsou podepsané soubory nastaveny jen pro čtení. Mohou být zkontrolovány,
upraveny a podepsány několikrát. Všechny změny a podpisy jsou zachyceny v revizním záznamu
souboru. Můžete podepsat následující typy souborů:

n datové soubory (.pcrd),

n soubory genových studií (.mgxd).

Poznámka: Před podpisem je nutné soubory uložit. Pokud jste nedávno provedli běh v CFX Maestro
Dx SE, nejprve uložte výsledný datový soubor.

Chcete-li podepsat soubor

1. Přihlaste se do CFX Maestro Dx SE pomocí přihlašovacích údajů pro Windows.

2. Otevřete zabezpečený datový soubor nebo soubor genové studie určený k podpisu.

3. Zvolte možnost File > Sign (Soubor > Podepsat). Zobrazí se dialogové okno Electronic Signature
(Elektronický podpis).
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4. Zadejte své uživatelské jméno a heslo pro systémWindows a důvod podpisu souboru.

Uživatelské jméno a důvod podpisu jsou zahrnuty v revizním záznamu (více informací uvádí oddíl
Revizní záznamy na straně 303).

5. Kliknutím na OK odešlete podpis a zavřete dialogové okno.

Úpravy zabezpečených souborů

V CFX Maestro Dx SE mohou uživatelé upravovat zabezpečené soubory, včetně podepsaných
a nepodepsaných datových souborů a souborů genových studií. Když uložíte upravený zabezpečený
soubor dat nebo soubor studie genů, software vás vyzve k uvedení důvodu této změny. Tyto změny jsou
zachyceny v revizním záznamu souboru.

Tip: Jelikož software nevytváří revizní záznamy pro soubory destiček nebo protokolů, nebudete při
uložení změn v těchto souborech vyzváni k uvedení důvodu.

Chcete-li uložit upravený datový soubor nebo soubor genové studie

1. Přihlaste se do CFX Maestro Dx SE pomocí přihlašovacích údajů pro Windows.

2. Otevřete a upravte zabezpečený datový soubor nebo soubor genové studie.

Tip: Seznam auditovatelných aktivit najdete v části Auditovatelné události na straně 305.
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3. Zvolte File > Save (Soubor > Uložit). Zobrazí se dialogové okno Audit Trail Change Reason (Důvod
změny revizního záznamu).

Toto dialogové okno zobrazuje následující informace, které jsou pro každou změnu zachyceny
v záhlaví souboru revizních záznamů:

n Date (Datum) – datum, kdy ke změně došlo.

n User (Uživatel) – doménaWindows a uživatelské jméno přihlášeného uživatele.

n Comment (Komentář) – poslední uložený komentář.

n Signature (Podpis) – elektronický podpis poslední osoby, která soubor podepsala.

n Signature reason (Důvod podpisu) – důvod podpisu.

n Application (Aplikace) – CFX Maestro Dx SE (zobrazí se jako BioRadCFXManager.exe).

n Application version (Verze aplikace) – aktuální verze CFX Maestro Dx SE.

n Full User (Úplný uživatel) – celé jméno přihlášeného uživatele.

Poznámka: Tento název se objeví v revizním záznamu.

n Machine (Stroj) – počítač, na kterém je nainstalován.
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Tabulka změn zobrazuje auditovatelné změny, ke kterým došlo v důsledku úpravy. Může se také
zobrazit krátký popis důvodu změny.

Tip: Popisy můžete přidat nebo upravit ve sloupci Důvod změny.

4. Projděte si seznam změn. V případě potřeby uveďte podrobné důvody.

5. Postupujte následovně:

n Kliknutím na Save Changes (Uložit změny) uložíte změny do souboru i všechny změny
provedené v tabulce a zavřete dialogové okno.

Změny souboru a důvody těchto změn se objeví v revizním záznamu souboru.

n Kliknutím na Cancel Changes (Zrušit změny) vrátíte soubor do předchozího stavu a zavřete
dialogové okno.

Změny se do souboru neuloží a revizní záznam se neaktualizuje.
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Soubory chráněné heslem

Jako další úroveň zabezpečení umožňuje CFX Maestro Dx SE uživatelům nastavit hesla pro všechny
zabezpečené soubory. Když budete nastavovat hesla zabezpečeného souboru, uvažte také následující
podmínky:

Podmínka Akce

Nevyžaduje se žádné heslo. Všichni uživatelé mohou na základě svých oprávnění
zabezpečený soubor otevřít, upravit a uložit.

Soubor vyžaduje heslo pro
uložení (Save).

Zabezpečený soubor mohou otevřít všichni uživatelé,
ale uživatelé, kteří znají heslo pro uložení, mohou
zabezpečený soubor také upravit a uložit.

Soubor vyžaduje heslo pro
otevření (Open).

Pouze uživatelé, kteří znají heslo pro otevření, mohou
zabezpečený soubor otevřít, upravit a uložit.

Soubor vyžaduje hesla pro
otevření i uložení.

Někteří uživatelé mohou zabezpečený soubor otevřít
a podskupina těchto uživatelů může soubor upravit
a uložit.

Podle své role může uživatel pomocí příkazu Save as (Uložit jako) vytvořit nový zabezpečený soubor
s jiným názvem nebo uložit soubor se stejným názvem do jiného umístění, pokud ovšem platí některá
z následujících možností:

n Zabezpečený soubor není chráněn heslem.

n Uživatel má heslo pro otevření souboru.

Tip: Nový soubor se uloží bez ochrany heslem. Původní soubor si uchová svá hesla.

Podle své role může uživatel upravit a uložit původní soubor, pokud ovšem platí některá z následujících
možností:

n Soubor není chráněn heslem.

n Uživatel má heslo pro otevření a heslo pro uložení souboru.

Poznámka: Aby mohl uživatel nastavovat hesla, musí jeho role zahrnovat právo ukládat soubory.
Například uživatelé s rolí Guest (Host) nemohou ukládat soubory, a proto nemohou nastavovat hesla
souboru.

Důležité: Pouze správci CFX Maestro Dx SE mohou obnovit nebo odstranit hesla.

50 | Software CFX Maestro Dx SE



Pro ochranu souboru heslem

1. Přihlaste se do CFX Maestro Dx SE pomocí svých přihlašovacích údajů Windows.

2. Otevřete zabezpečený soubor.

3. Zvolte možnost File > File Passwords (Soubor > Hesla souborů). Zobrazí se dialogové okno File
Passwords (Hesla souborů).

4. Zadejte hesla do polí Save Password (Heslo pro uložení) a Open Password (Heslo pro otevření).

Tip: Ve výchozím nastavení se hesla při psaní zobrazují jako hvězdičky. Výběremmožnosti
Show Password (Zobrazit heslo) zobrazíte heslo při jeho zadávání.

Důležité: V heslech se rozlišují velká a malá písmena. CFX Maestro Dx SE nemá omezení
hesel. U správce systému můžete zjistit optimální postupy a požadavky na heslo na vašem
pracovišti.

5. Kliknutím na možnost Set Passwords (Nastavit hesla) nastavíte hesla a zavřete dialogové okno.

6. Pro uložení změn do souboru zvolte možnost File > Save (Soubor > Uložit).
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Odebrání hesel

Důležité: Abyste mohli odebírat hesla, musíte být správcem CFX Maestro Dx SE.

1. V dialogovém okně Password Required (Je vyžadováno heslo) klikněte na možnost Remove
Passwords (Odebrat hesla).

Zobrazí se dialogové okno Login (Přihlášení) do CFX Maestro Dx SE.

2. Zadejte uživatelské jméno a heslo systémuWindows pro správce CFX Maestro Dx SE a klikněte na
OK.

Zobrazí se původní datový soubor.

Důležité: Chcete-li hesla odstranit, musíte soubor uložit.

3. Pro uložení změn do souboru zvolte možnost File > Save (Soubor > Uložit).
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Pro změnu hesel

Důležité: Pouze správci CFX Maestro Dx SE mohou měnit hesla.

1. Otevřete zabezpečený soubor.

2. Zvolte možnost File > File Passwords (Soubor > Hesla souborů). Zobrazí se dialogové okno File
Passwords (Hesla souborů).

Tip: Možnosti Save Password (Heslo pro uložení), Open Password (Heslo pro otevření) a Show
Password (Zobrazit heslo) jsou deaktivovány.

3. Klikněte na možnost Reset Passwords (Obnovit hesla).

Zobrazí se dialogové okno Login (Přihlášení) do CFX Maestro Dx SE.
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4. Zadejte uživatelské jméno a heslo systémuWindows pro správce CFX Maestro Dx SE a klikněte na
OK.

Zobrazí se dialogové okno File Passwords (Hesla souborů).

5. Postupujte následovně:

n Chcete-li obnovit ochranu heslem, zadejte nové heslo do příslušného pole pro heslo.

n Chcete-li odstranit ochranu heslem, vymažte pole s hesly.

6. Kliknutím na možnost Set Passwords (Nastavit hesla) uložte změny hesla a zavřete dialogové okno.
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Kapitola 5 Pracovní plocha
Software CFX Maestro Dx, bezpečnostní edice nabízí rozhraní pro nastavení destiček, přípravu protokolů
PCR, jejich spouštění na přístrojích CFX Opus Dx Deepwell Dx a analýzu dat z cyklů PCR.

Software CFX Maestro Dx SE obsahuje pět primárních pracovních ploch:

n okno Home (Domů),

n Startup Wizard (Průvodce spuštěním),

n okno Protocol Editor (Editor protokolu),

n okno Plate Editor (Editor destiček),

n okno Data Analysis (Analýza dat).

Každá pracovní plocha je zobrazena a stručně popsána v této kapitole.
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Okno Home (Domů)
CFX Maestro Dx SE se otevře v okně Home (Domů) a zobrazí se nástroj Startup Wizard (Průvodce
spuštěním), ze kterého můžete nastavit experiment, spustit nebo zopakovat běh nebo analyzovat
stávající běh. Z okna Home (Domů) můžete také prohlížet protokoly jednotlivých aplikací, vytvářet a
spravovat uživatele a získat přístup k dalším užitečným nástrojům. Více informací naleznete v Kapitola 6,
Okno Home (Domů).
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Startup Wizard (Průvodce spuštěním)

Startup Wizard (Průvodce spuštěním)
Pomocí nástroje Startup Wizard (Průvodce spouštěním) můžete rychle nastavit a provádět uživatelem
definované experimenty nebo vybrat a provést experiment PrimePCR. Rovněž je možné přes tohoto
průvodce zopakovat běh nebo analyzovat data běhu.
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Okno Protocol Editor (Editor protokolu)
V nástroji Protocol Editor (Editor protokolu) můžete vytvářet, otevírat, kontrolovat a upravovat protokol.
Můžete také změnit teplotu víka pro otevřený protokol. Funkce Protocol Editor (Editor protokol) je
podrobně popsána v Kapitola 7, Vytvoření protokolů.
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Okno Plate Editor (Editor destiček)

Okno Plate Editor (Editor destiček)
V nástroji Plate Editor (Editor destiček) můžete vytvářet, otevírat, kontrolovat a upravovat destičky.
Funkce nástroje Kapitola 8, Příprava destiček.
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Okno Data Analysis (Analýza dat)
V okně Data Analysis (Analýza dat) můžete prohlížet a porovnávat data běhu, provádět statistické
analýzy, exportovat data a vytvářet reporty připravené k publikování. Funkce analýzy dat jsou podrobně
popsány v Kapitola 10, Analýza dat - přehled a Kapitola 11, Podrobnosti o analýze dat.
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Kapitola 6 Okno Home (Domů)
Software CFX Maestro Dx, bezpečnostní edice nabízí rozhraní pro vývoj protokolů PCR, jejich spouštění
na systémech CFX Dx a analýzu dat cyklu PCR.

Tato kapitola představuje software CFX Maestro Dx SE a popisuje funkce přístupné z okna Home
(Domů).
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Okno Home (Domů)
Software CFX Maestro Dx SE se otevře v okně Home (Domů) a zobrazí se nástroj Startup Wizard
(Průvodce spuštěním), ze kterého můžete nastavit nebo zopakovat experiment nebo analyzovat stávající
běh. Z okna Home (Domů) můžete také prohlížet protokoly jednotlivých aplikací, vytvářet a spravovat
uživatele a získat přístup k dalším užitečným nástrojům.

1. Záhlaví softwaru obsahuje název softwaru a přihlášeného uživatele.

2. Panel nabídek umožňuje rychlý přístup k příkazům nabídek File (Soubor), View (Zobrazit),
Users (Uživatelé), Run (Běh), Tools (Nástroje), Window (Okno) a Help (Nápověda).

3. Příkazy na panelu nástrojů umožňují rychlý přístup k možnostem nabídek.

4. Levý panel ukazuje přístroje připojené k počítači se softwarem CFX Maestro Dx SE a obsahuje
tlačítka, kterými můžete ovládat víko a zobrazovat stav přístrojů.

5. Hlavní panel obsahuje pracovní okno. Výchozím pracovním oknem na obrazovce Home
(Domů) je Startup Wizard (Průvodce spuštěním).

LEGENDA
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6. Na stavovém řádku jsou uvedeny názvy připojených přístrojů a přihlášený uživatel.

Příkazy nabídky File (Soubor)
New (Nový) – otevře dialogové okno, ze kterého můžete zvolit vytvoření nového protokolu, tabulky nebo
genové studie.

Open (Otevřít) – otevře dialogové okno, ze kterého můžete zvolit navigaci a otevření existujícího
protokolu, destičky, datového souboru, genové studie, souboru LIMS, spuštění z nepřipojeného přístroje
(Stand-alone Run) nebo soubor běhu PrimePCR.

Recent Data Files (Poslední datové soubory) – zobrazí seznam naposledy otevřených souborů PCR.

Repeat a Run (Opakovat běh) – otevře Průzkumníka Windows do umístění uložených souborů PCR, ve
kterémmůžete vyhledat běh, který se má opakovat.

Exit (Odejít) – zavře CFX Maestro Dx SE.

Příkazy nabídky View (Zobrazit)
Application Log (Protokol aplikací) – zobrazuje protokol o použití softwaru od počáteční instalace až
po aktuální den.

Run Reports (Reporty proběhlých experimentů) – zobrazí seznam reportů proběhlých experimentů.

Startup Wizard (Průvodce spuštěním) – zobrazí v hlavním panelu Startup Wizard (Průvodce
spuštěním).

Run Setup (Nastavení běhu) – zobrazí v hlavním panelu okno Run Setup (Nastavení běhu).

Instrument Summary (Ovládání přístroje) – zobrazí v hlavním panelu okno Instrument Summary
(Ovládání přístroje).

Detected Instruments (Detekované přístroje) – přepíná mezi zobrazením a nezobrazováním
připojených přístrojů v levém podokně. Ve výchozím nastavení software zobrazuje v levém podokně
připojené přístroje.

Toolbar (Panel nástrojů) – přepíná mezi zobrazením a nezobrazováním panelu nástrojů v horní části
obrazovky. Ve výchozím nastavení software zobrazuje panel nástrojů.

Status Bar (Stavový řádek) – přepíná mezi zobrazením a nezobrazením stavového řádku ve spodní
části obrazovky. Ve výchozím nastavení software zobrazuje stavový řádek.

Show (Zobrazit) – otevře dialogové okno, ze kterého můžete

n Zobrazit nebo blokovat zobrazení protokolu Status (Stav).

n Otevřít a zobrazit datovou složku CFX Maestro Dx SE.
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n Otevřít a zobrazit datovou složku uživatele.

n Otevřít a zobrazit složku se soubory LIMS.

n Otevřít a zobrazit složku PrimePCR.

n Zobrazit historii běhů.

n Zobrazit vlastnosti všech připojených přístrojů.

Příkazy nabídky User (Uživatel)
Select User (Vybrat uživatele) – otevře obrazovku Login (Přihlášení), na které můžete vybrat uživatele
z rozevíracího seznamu User Name (Uživatelské jméno) a přihlásit se do aplikace.

Change Password (Změnit heslo) – otevře dialogové okno Change Password (Změnit heslo), ve
kterémmohou uživatelé měnit své heslo .

Poznámka: Tato možnost je pro CFX Maestro Dx SE deaktivovaná. Uživatelé musí změnit své heslo
pro Windows, aby si mohli změnit své heslo pro CFX Maestro Dx SE.

User Preferences (Uživatelské předvolby) – otevře dialogové okno User Preferences (Uživatelské
předvolby), ve kterémmohou uživatelé měnit výchozí nastavení pro

n Odesílání a příjem e-mailových oznámení při dokončení běhu

n Ukládání datových souborů

n Vytváření protokolů pomocí nástroje Protocol Editor (Editor protokolu) nebo Protocol AutoWriter
(Automatický generátor protokolu),

n Popisy destiček

n Analýza dat

n Provádění analýzy genové exprese

n Nastavení kvality dat (QC)

n Export dat pro přístroj CFX

User Administration (Správa uživatelů) – otevře dialogové okno User Administration (Správa
uživatelů), ve kterémmohou administrátoři vytvářet uživatele, měnit povolení rolí a přiřazovat role
uživatelům.

Bio-Rad Service Login (Servisní přihlášení Bio-Rad) – pouze pro použití pracovníky technického
servisu Bio-Rad. Tento příkaz nepoužívejte.
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Příkazy nabídky Run (Běh)
User-defined Run (Běh definovaný uživatelem) – otevře okno Run Setup (Nastavení běhu), ve kterém
můžete nastavit uživatelem definovaný protokol a destičku a následně provést PCR experiment na
vybraném přístroji.

PrimePCR Run (PrimePCR experiment) – otevře kartu Start Run (Spustit běh) v okně Run Setup
(Nastavení běhu) s načteným výchozím protokolem PrimePCR s použitím definované destičky pro
vybraný přístroj.

End-Point Only Run (Běh pouze s koncovými body) – otevře kartu Start Run (Spustit běh) v okně
Run Setup (Nastavení běhu) s načteným výchozím protokolem pro End-Point analýzu s použitím
definované destičky pro vybraný přístroj.

Qualification Run (Běh kvalifikace) – otevře kartu Start Run (Spustit běh) v okně Run Setup (Nastavení
běhu) s načteným výchozím protokolem Bio-Rad pro provedení standardního měření s použitím
kvalifikačního protokolu a destičky pro určený přístroj.

Příkazy nabídky Tools (Nástroje)
Master Mix Calculator (Kalkulačka Master Mix) – otevře Master Mix Calculator (Kalkulačka Master
Mix), ve které můžete vytvořit reakční směs a tisknout výpočty.

Protocol AutoWriter (Automatický generátor protokolu) – otevře dialogové okno Protocol AutoWriter
(Automatický generátor protokolu), ve kterémmůžete snadno vytvořit nový protokol.

TaCalculator (Kalkulačka Ta) – otevře nástroj Ta Calculator (Kalkulačka Ta), ve kterémmůžete snadno
spočítat teplotu nasedání primerů.

Dye Calibration Wizard (Průvodce kalibrací barviva) – otevře nástroj Dye Calibration (Průvodce
kalibrací barviva), ve kterémmůžete kalibrovat přístroj pro nový fluorofor.

Reinstall Instrument Drivers (Přeinstalovat ovladače přístroje) – přeinstaluje ovladače, které řídí
komunikaci se systémy Bio-Rad PCR v reálném čase.

Zip Data and Log Files (Zip Data a soubory protokolu) – otevře dialogové okno, ve kterémmůžete
vybrat soubory, které chcete komprimovat a uložit do zazipovaného souboru pro uložení nebo odeslání e-
mailem.

Batch Analysis (Analýza dávek) – otevře dialogové okno Batch Analysis (Analýza dávek), ve kterém
můžete nastavit parametry pro analýzu více než jednoho datového souboru najednou.

Options (Možnosti) – otevře dialogové okno, ve kterémmůžete

n Konfigurovat nastavení e-mailového serveru.

n Konfigurovat nastavení exportu pro LIMS a další datové soubory.
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Tip: Můžete také vybrat možnost automatického spuštění prohlížeče Seegene při exportu,
pokud se rozhodnete exportovat data ve formátu Seegene.

n Změna jazyka uživatelského rozhraní (angličtina, čínština, ruština)

Důležité: K zobrazení vybraného jazyka musíte CFX Maestro Dx SE restartovat.

Důležité: Jazyk operačního systému musí odpovídat jazyku, který chcete zobrazit
v rozhraní CFX Maestro Dx SE.

Příkazy nabídky Help (Nápověda)
Tip: Nabídka Help (Nápověda) je k dispozici na panelu nástrojů ve všech oknech CFX Maestro Dx
SE.

Contents (Obsah) – zobrazí kartu Contents (Obsah) systému Help (Nápověda) softwaru CFX Maestro
Dx SE.

Index (Rejstřík) - zobrazí kartu Index (Rejstřík) v systému Help (Nápověda) softwaru CFX Maestro Dx
SE.

Search (Hledat) – zobrazí kartu Search (Hledat) systému Help (Nápověda) softwaru CFX Maestro Dx
SE.

Open User Guide (Otevřít uživatelskou příručku) – otevře soubor PDF této příručky.

Additional Documentation (Další dokumentace) – poskytuje přístup k provozní příručce systému PCR
typu CFX Opus Dx pro práci v reálném čase.

Release Notes (Poznámky k vydání) – otevře dokument Release Notes (Poznámky k vydání) pro
nainstalovanou verzi softwaru CFX Maestro Dx SE.

Video Resources (Video zdroje) – otevře internetové stránky s různými video zdroji Bio-Rad, například
výukovými videi.

qPCR Applications and Technologies Web Site (Internetové stránky qPCR aplikací a technologií)
– otevře internetové stránky qPCR aplikací a technologií Bio-Rad, na kterých se dozvíte více
o zpracování PCR (qPCR) v reálném čase.

PCR Reagents Web Site (Internetové stránky pro qPCR reagencie) – otevře internetové stránky
Bio-Rad pro reagencie PCR a qPCR, na kterých si můžete objednat reagencie PCR, supermixy, barviva
a kity.

PCR Plastic Consumables Web Site (Internetové stránky s plasty a spotřebními materiály pro
PCR) – otevře internetové stránky společnosti Bio-Rad s plastovými díly a spotřebními materiály PCR, na
kterých si můžete objednat destičky, fólie k destičkám, zkumavky, uzávěry a další plastové příslušenství.

66 | Software CFX Maestro Dx SE



Okno Home (Domů)

Software Web Site (Internetové stránky softwaru) – otevře internetové stránky společnosti Bio-Rad
pro software pro analýzu PCR, na kterých si můžete objednat aktualizované verze softwaru CFX Maestro
Dx SE této společnosti.

About (O softwaru) – zobrazí informace o autorských právech a verzi softwaru CFX Maestro Dx SE.

Příkazy panelu nástrojů

– otevře Průzkumníka Windows, ve kterémmůžete procházet a otevírat datový soubor nebo
soubor genové studie.

– otevře Master Mix Calculator (Kalkulačka Master Mix).

– otevře okno Run Setup (Nastavení běhu).

– otevře okno Run Setup (Nastavení běhu) s výchozím protokolem PrimePCR a nastavením
destičky pro vybraný přístroj.

– otevře Startup Wizard (Průvodce spuštěním).
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Startup Wizard (Průvodce spuštěním)
Když se spustí software CFX Maestro Dx SE, pracovní podokno zobrazí průvodce Startup Wizard
(Průvodce spuštěním). Z dialogového okna Startup Wizard (Průvodce spuštěním) můžete

n Vybrat přístroj ze seznamu nabízených možností a nastavit uživatelem definovaný běh nebo
PrimePCR běh.

n Otevřít a opakovat běh.

n Otevřít soubor s daty pro analýzu výsledků jednoho běhu nebo pro získání výsledků z několika běhů
při sledování genové exprese.

Tyto úkoly jsou podrobně vysvětleny v dalších kapitolách.

Stavový řádek
V levé části stavového řádku ve spodní části hlavního okna softwaru je zobrazen aktuální stav
detekovaných přístrojů. Na pravé straně stavového řádku je vidět jméno aktuálního uživatele a datum
a čas.
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Panel Detected Instruments (Detekované přístroje)
Podokno Detected Instruments (Detekované přístroje) zobrazuje každý přístroj, který je připojen k počítači
CFX Maestro Dx SE. Ve výchozím nastavení se každý nástroj zobrazí jako ikona a jeho sériové číslo se zobrazí
jako jeho název.

Z tohoto panelu můžete

n Zobrazit vlastnosti a kalibrovaná barviva pro vybraný přístroj

Další informace o vlastnostech přístroje naleznete v části Zobrazení vlastností přístroje na straně 72.

n Zobrazit stav připojeného přístroje

n Otevřít motorizované víko na vybraném přístroji

n Zavřít motorizované víko na vybraném přístroji

n Zobrazit stav všech připojených přístrojů

Zobrazení stavu připojeného přístroje

u V podokně Detected Instruments (Detekované přístroje) vyberte cílový přístroj a postupujte
následovně:

n Klikněte na položku View Status (Zobrazit stav) v části Selected Instrument (Vybraný přístroj).

n Klikněte pravým tlačítkemmyši a v zobrazené nabídce vyberte příkaz View Status (Zobrazit
stav).

Objeví se dialogové okno Run Details (Podrobnosti o běhu) zobrazující kartu Run Status (Stav
běhu). Stav vybraného přístroje se zobrazí pod podoknem stavu spuštění, například:
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Otevření nebo uzavření víka přístroje

u V podokně Detected Instruments (Detekované přístroje) vyberte cílový přístroj a postupujte
následovně:

n Klikněte na položku Open Lid (Otevřít víko) nebo Close Lid (Zavřít víko) v části Selected
Instrument (Vybraný přístroj).

n Klikněte pravým tlačítkemmyši a vyberte příslušnou akci v zobrazené nabídce.

n Otevřete dialogové okno Run Details (Podrobnosti o běhu) a vyberte kartu Run Status (Stav
běhu) a klikněte na Open Lid (Otevřít víko) nebo Close Lid (Zavřít víko).

Zobrazení stavu všech detekovaných přístrojů

u Postupujte následovně:

n V části All Instruments (Všechny přístroje) v podokně Detected Instruments (Detekované
přístroje) klikněte na položku View Summary (Zobrazit souhrn).

n V panelu nabídky vyberte položky View > Instrument Summary (Zobrazit > Ovládání přístroje).

Zobrazí se dialogové okno Instrument Summary (Ovládání přístroje).

Tip: Pokud systém detekuje pouze jeden připojený přístroj, část All Instruments (Všechny
přístroje) se na panelu Detected Instruments (Detekované přístroje) neobjeví. Chcete-li zobrazit
informace pouze pro jeden nástroj, vyberte položky View > Instrument Summary (Zobrazit >
Ovládání přístroje).
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Ovládací prvky panelu nástrojů Instrument Summary (Ovládání přístroje)

Tabulka 5 uvádí seznam ovládacích prvků a funkcí na panelu nástrojů Instrument Summary (Ovládání
přístroje).

Tlačítko Název tlačítka Funkce

Create a new Run (Vytvořit
nový běh)

Vytvoří běh na vybraném bloku otevřením
okna Run Setup (Nastavení běhu).

Stop (Zastavit) Zastaví aktuální běh na vybraných
blocích.

Pause (Pozastavit) Pozastaví aktuální běh na vybraných
blocích.

Resume (Pokračovat) Obnoví aktuální běh na vybraných
blocích.

Flash Block Indicator
(Indikátor Flash Block)

Rozsvítí indikátor LED na víku vybraných
bloků.

Open Lid (Otevřít víko) Otevře motorizované víko na vybraném
přístroji.

Close Lid (Zavřít víko) Zavře motorizované víko na vybraném
přístroji.

Hide Selected Blocks
(Skrýt vybrané bloky)

Skryje vybrané bloky v seznamu
Instrument Summary (Ovládání přístroje).

Show All Blocks (Zobrazit
všechny bloky)

Zobrazí všechny bloky v seznamu
Instrument Summary (Ovládání přístroje).

Show (Zobrazit) Vyberte bloky, které chcete zobrazit
v seznamu. Vyberte jednu z možností pro
zobrazení všech zjištěných bloků, všech
neaktivních bloků, všech bloků, které jsou
spuštěny aktuálním uživatelem, nebo
všech běžících bloků.

Tabulka 5. Ovládací prvky panelu nástrojů Instrument Summary (Ovládání přístroje)
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Zobrazení vlastností přístroje
Na panelu Detected Instruments (Detekované přístroje) můžete zobrazit podrobnosti o vybraném
přístroji, včetně jeho vlastností, stavu jeho přepravního šroubu (pouze přístroje CFX Connect a CFX
Touch) a seznamu jeho kalibrovaných barviv (fluoroforů).

Zobrazení vlastností přístroje

u V podokně Detected Instruments (Detekované přístroje) klikněte pravým tlačítkemmyši na cílový
přístroj a v zobrazené nabídce vyberte položku Properties (Vlastnosti).

Karta Properties (Vlastnosti)

Karta Properties (Vlastnosti) obsahuje technické podrobnosti o vybraném přístroji včetně modelu,
sériových čísel jeho součástí a verzí firmwaru. Výchozí název přístroje (jeho sériové číslo) se objeví na
mnoha místech, včetně podokna Detected Instruments (Detekované přístroje) a v záhlaví dialogového
okna Instrument Properties (Vlastnosti přístroje). Přístroj můžete přejmenovat, abyste ho mohli snadněji
identifikovat.

Poznámka: Název nástroje CFX Opus nelze pomocí CFX Maestro změnit.

Karta Calibrated Dyes (Kalibrovaná barviva)

Karta Calibrated Dyes (Kalibrovaná barviva) zobrazuje kalibrované fluorofory a destičky pro vybraný
přístroj.

Chcete-li zobrazit podrobné informace o kalibraci, klepněte na tlačítko Informace ve sloupci Detail
(Podrobnosti).
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Než začnete
Tato část vysvětluje úkoly, které případně budete muset provést před použitím CFX Maestro Dx SE. To
zahrnuje

n vytvoření reakčního Master Mixu,

n kalibrace nových barviv.

Vytvoření reakčního Master Mixu
Díky nástroji CFX Maestro Dx SE Master Mix Calculator (Kalkulačka Master Mix) můžete snadno
vypočítat požadovaný objem všech komponent ve svémMaster Mixu. Tabulku s výpočtemMaster Mixu
můžete vytisknout na své výchozí tiskárně a výpočty pro každý cíl uložit pro pozdější použití.

Jak vytvořit reakční Master Mix pomocí nástroje Master Mix Calculator (Kalkulačka Master
Mix)

1. Abyste otevřeli nástroj Master Mix Calculator (Kalkulačka Master Mix), postupujte následovně:

n Vyberte možnosti Tools > Master Mix Calculator (Nástroje > Kalkulačka Master Mix).

n Na panel nástrojů klikněte na možnost Master Mix Calculator (Kalkulačka Master Mix).

Zobrazí se Master Mix Calculator (Kalkulačka Master Mix).
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2. V části Reaction (Reakce) vyberte metodu detekce:

n SYBR®Green/EvaGreen®

n Probes (Sondy)

3. Abyste vytvořili nový cíl, klikněte v části Target (Produkt) na možnost Create New (Vytvořit nový).
V rozevíracím seznamu produktů se objeví nový název produktu.

4. (Volitelné) Jak změnit výchozí název produktu:

a. V rozevíracím seznamu produktů zvýrazněte název produktu.

b. V kolonce Target (Produkt) zadejte nový název produktu.

c. Stiskněte tlačítko Enter.

5. Nastavte počáteční a koncovou koncentraci obou primerů a všechny sondy.

6. V části Master Mix Setup (Nastavení Master Mix) nastavte hodnoty

n plánovaný počet reakcí,
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n reakční objem na jamku,

n objem templátu na jamku,

n koncentrace supermixu na jamku,

n nadbytečný reakční objem na jamku.

7. (Volitelné) Proveďte kroky 2–6 pro potřebný počet produktů.

8. V části Choose Target to Calculate (Vybrat produkt k výpočtu) vyberte produkt, který chcete
vypočítat.

Tip: Můžete současně vypočítat buď jeden, nebo několik, nebo všechny produkty.

Vypočítané objemy požadovaných komponentů pro každý vybraný produkt se objeví v tabulce
Master Mix.

9. Kliknutím na možnost Set as Default (Nastavit jako výchozí) nastavíte množství zadaná v částech
Target (Produkt) a Master Mix Setup (Nastavení Master Mix) jako nové výchozí hodnoty.

10. Kliknutím na OK uložíte obsah dialogového okna Master Mix Calculator (Kalkulačka Master Mix).

Jak vytisknout tabulku s výpočtem Master Mixu

u Abyste vytiskli tabulku s výpočtemMaster Mixu, klikněte na možnost Print (Tisk).

Tabulka s výpočtem se vytiskne na vaší výchozí tiskárně.

Jak uložit tabulku s výpočtem Master Mixu jako PDF

u Změňte svou výchozí tiskárnu na ovladač PDF a klikněte na možnost Print (Tisk) v nástroji Master
Mix Calculator (Kalkulačka Master Mix).

Jak odstranit produkty

u V rozevíracím seznamu produktů vyberte produkt a klikněte na možnost Remove (Odstranit).

Důležité: Odstraněním produktu ze seznamu produktů se tento produkt odstraní i ze všech
výpočtů Master Mixu, pro který je použit. Při mazání produktu buďte opatrní.

Kalibrace nových barviv
Systémy CFX Opus 96 Dx a CFX Opus Deepwell Dx jsou z výroby kalibrovány pro běžně používané
fluorofory v destičkách s bílými a čirými jamkami. Systémy CFX Opus 384 Dx jsou z výroby kalibrovány pro
běžně používané fluorofory pouze na destičkách s bílými jamkami. Tabulka 6 uvádí fluorofory a kanály, pro
které je každý přístroj kalibrován.
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Poznámka: Systémy CFX Opus 96 Dx, CFX Opus 384 Dx a CFX Opus Deepwell Dx také obsahují
kanál věnovaný chemii FRET. Tento kanál nevyžaduje kalibraci pro specifická barviva.

Důležité: Pokud provedete uživatelem definovanou kalibraci barviva, které bylo kalibrováno
z výroby, použije přístroj místo původní kalibrace z výroby tuto nově definovanou kalibraci.

Fluorofory Kanál Excitace, nm Detekce, nm Přístroj

FAM, SYBR®
Green I

1 450–490 515–530 Systémy
CFX Opus
96 Dx, CFX
Opus 384 Dx
a CFX Opus
Deepwell Dx

VIC, HEX, CAL
Fluor Gold 540,
Cal Fluor Orange
560

2 515–535 560–580 Systémy
CFX Opus
96 Dx, CFX
Opus 384 Dx
a CFX Opus
Deepwell Dx

ROX, Texas Red,
CAL Fluor Red
610, TEX 615

3 560–590 610–650 Systémy
CFX Opus
96 Dx, CFX
Opus 384 Dx
a CFX Opus
Deepwell Dx

CY5, Quasar 670 4 620–650 675–690 Systémy
CFX Opus
96 Dx, CFX
Opus 384 Dx
a CFX Opus
Deepwell Dx

Quasar 705,
Cy5.5

5 672–684 705–730 Pouze
systémy CFX
Opus 96 Dx

Chemie FRET (nekalibrovaná v továrně)

Tabulka 6. Továrně kalibrované fluorofory, kanály a nástroje
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Fluorofory Kanál Excitace, nm Detekce, nm Přístroj

Barva
nekalibrovaná z
výroby

FRET 450–490 560-580 Systémy
CFX Opus
96 Dx, CFX
Opus 384 Dx
a CFX Opus
Deepwell Dx

Kalibrace nových barviv pro systémy CFX

1. V okně Home (Domů) vyberte cílový přístroj v podokně Detected Instruments (Detekované přístroje).

2. Vyberte položku Tools > Calibration Wizard (Nástroje > Průvodce kalibrací), chcete-li otevřít
průvodce Dye Calibration (Kalibrace barviva).

Již kalibrované fluorofory pro cílový přístroj se objeví v tabulce Calibrated Fluorophores (Kalibrované
fluorofory).

3. V části Calibrate New or Existing Fluorophores (Kalibrace nových nebo existujících fluoroforů)
vyberte v rozevíracím seznamu fluorofor, který chcete kalibrovat.

Není-li v seznamu uveden název fluoroforu, zadejte jeho název do textového pole a přidejte jej do
seznamu.
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Důležité: Při pojmenovávání vlastních kalibrovaných fluoroforů buďte opatrní. Pokud vytvoříte
vlastní kalibraci barviva pro fluorofor se stejným názvem jako továrně kalibrovaný fluorofor, bude
použit vlastní fluorofor (nikoli továrně kalibrovaný fluorofor), který přístroj používá standardně.

4. Vyberte typ destičky pro fluorofor.

Není-li v seznamu uveden typ destičky, zadejte jeho název do textového pole a přidejte jej do
seznamu.

5. Vyberte kanál pro fluorofor.

6. Vyberte sloupec pro fluorofor na destičce.

7. (Volitelné) Zadejte barvu, kterou chcete přiřadit fluoroforu.

8. Pro přidání fluoroforu klikněte na položku Add to Plate (Přidat na destičku).

9. (Volitelné) Opakujte kroky 3–8 pro přidání každého fluoroforu, který chcete kalibrovat pro destičku.

10. Až dokončíte přidávání fluoroforů, otevřete kliknutím na položku View Plate (Zobrazit destičku) okno
Pure Dye Plate Display (Zobrazení destičky pro čisté barvivo).

Toto okno použijte jako vodítko pro vkládání barviv na destičku.

11. Připravte si 96-, 384- nebo hlubokojamkovou destičku pro kalibraci barviva:

a. Přidejte pipetou do každé jamky roztok barviva podle vzoru zobrazeného na displeji Pure Dye
Plate Display (Zobrazení destičky pro čisté barvivo).

b. Pro každý fluorofor naplňte do čtyř jamek 50 µl (96jamková destička nebo destička s hlubokými
jamkami) 30 µl (384jamková destička) roztoku barviva 300 nM. Všimněte si, že alespoň polovina
destičky obsahuje prázdné jamky.

c. Destičku utěsněte těsnicí metodou, kterou používáte ve svém experimentu.

12. Umístěte kalibrační destičku do bloku a zavřete víko.

13. V průvodci Dye Calibration (Kalibrace barviva) kliknutím na položku Calibrate (Kalibrovat) a OK
potvrďte, že je destička v bloku.

14. Jakmile Software CFX Maestro Dx, bezpečnostní edice dokončí běh kalibrace, zobrazí se dialogové
okno. Kliknutím na tlačítko Yes (Ano) dokončete kalibraci a otevřete prohlížeč Dye Calibration Viewer
(Prohlížeč kalibrace barviva).

15. Klepněte na tlačítko OK a okno se zavře.

Nastavení uživatelských předvoleb
Tip: Pro použití softwaru CFX Maestro Dx SE není nutné tyto úkony provádět. Tuto část můžete
klidně přeskočit nebo tyto úkony provést kdykoliv jindy.
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V CFX Maestro Dx SE si každý uživatel může přizpůsobit své pracovní prostředí. Například v nabídce
Users > User Preferences (Uživatelé > Uživatelské předvolby) můžete provádět následující úkony:

n Nastavit e-mailové oznámení o dokončení běhu.

Poznámka: Tato funkce je k dispozici pouze uživatelům, jejichž roli bylo uděleno toto právo.
Další informace viz Správa rolí uživatelů v Software CFX Maestro Dx, bezpečnostní edice na
straně 43.

n Změnit výchozí nastavení pro

o Umístění pro ukládání souborů

o Soubory nastavení běhu

o Předpona názvu souboru

n Nastavit výchozí parametry použité při tvorbě nového protokolu a destičky.

n Nastavit výchozí parametry analýzy dat a genové exprese.

n Přizpůsobit výchozí parametry kontroly kvality (QC).

n Přizpůsobit parametry pro export dat.

V nabídce Tools (Nástroje) můžete provádět následující:

n Vytvořit Master Mix.

n Kalibrovat barviva pro konkrétní přístroj.

Poznámka: Tvorba Master Mixu a kalibrace barviva jsou k dispozici každému, kdo se přihlásí do
softwaru.

Tato část podrobně vysvětluje, jak tyto úkony provádět.

Nastavení e-mailových oznámení

Můžete software CFX Maestro Dx SE připojit ke svému serveru odchozí pošty, aby mohl odesílat
e-mailová oznámení o dokončení běhu na seznam uživatelů. K seznamu uživatelů můžete rovněž připojit
datový soubor a reporty z analýzy. K nastavení připojení mezi softwarem CFX Maestro Dx SE a serverem
SMTP viz část Připojení bezpečnostní edice k serveru SMTP na straně 81.

Poznámka: Možnosti přístupu uživatele k funkcím nastavení e-mailu závisejí na uživatelské roli
a povoleních přiřazených správcem. Podrobnosti o správě uživatelů a jejich rolích jsou uvedeny v
části Správa rolí uživatelů v Software CFX Maestro Dx, bezpečnostní edice na straně 43.
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Jak nastavit e-mailová oznámení

1. Vyberte User > User Preferences (Uživatel > Uživatelské předvolby) a otevře se dialogové okno User
Preferences (Uživatelské předvolby).

Otevře se dialogové okno User Preferences (Uživatelské předvolby) s kartou Email (E-mail).

Poznámka: Jestliže systém rozpozná, že jste nenastavili platný SMTP server pro software
CFX Maestro Dx SE, budete o tom informováni. Kliknutím na položku Configure Outgoing Email
(Konfigurovat odchozí e-mail) otevřete dialogové okno Options (Možnosti), kde můžete
nakonfigurovat e-mailový SMTP server. Další informace naleznete v části Připojení
bezpečnostní edice k serveru SMTP na straně 81.

2. V textovém rámečku To (Komu) zadejte e-mailovou adresu každé osoby, kterou chcete informovat
o dokončení běhu. Všichni příjemci obdrží po dokončení běhu e-mail.

Poznámka: Každou e-mailovou adresu musíte zadat na samostatném řádku. Za každou
e-mailovou adresou stiskněte Enter nebo Return.

3. (Volitelné) V textovém rámečku cc (Kopie) zadejte e-mailovou adresy příjemců, kterým chcete poslat
kopii každého e-mailového oznámení.

4. (Volitelné) Ve výchozím nastavení obdrží všichni příjemci kopii datového souboru v příloze.
Odznačte toto zaškrtávací políčko, pokud nechcete přiložit kopii datového souboru.

5. (Volitelné) Vyberte možnost Attach Analysis Report (Připojit report o analýze), abyste k e-mailu
připojili PDF soubor reportu o analýze.

6. Kliknutím na OK uložíte změny a zavřete dialogové okno User Preferences (Uživatelské předvolby).

Poznámka: Systém je možné nakonfigurovat pro odesílání e-mailových oznámení do mobilního
telefonu, je to však závislé na poskytovateli služeb. Informace o e-mailové adrese pro váš telefon
zjistíte kontaktováním mobilního operátora. Na obrazovce User Preferences (Uživatelské předvolby)
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zadejte e-mailovou adresu telefonu (například 5552221234@e-mailovádoména_poskytovatele_
služeb.net) do textového pole To (Komu).

Jak upravit e-mailovou adresu příjemce

u Upravte e-mailovou adresu podle potřeby a klikněte na OK.

Jak odstranit příjemce e-mailu

1. Vyberte příjemce e-mailu a stiskněte tlačítko Delete (Odstranit).

2. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně User
Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na původní
tovární nastavení. Při kliknutí na toto tlačítko postupujte opatrně.

Připojení bezpečnostní edice k serveru SMTP

Důležité: Někteří komerční poskytovatelé služeb webmailu mají zvýšené zabezpečení e-mailu.
Pokud použijete tyto účty, musíte povolit nastavení Allow less secure apps (Povolit méně
zabezpečené aplikace) v nastavení účtu, které umožní CFX Maestro Dx SE odesílat e-maily. Další
informace naleznete v informacích o zabezpečení poskytovatele služeb webmailu.

Pokud k odesílání e-mailů používáte server SMTP služby Google Gmail nebo Microsoft Office 365,
musíte v nastavení účtu Gmail nebo Office365 povolit dvoufaktorové ověřování a vygenerovat „heslo
aplikace“. Pro ověření v dialogovém okně Maestro Email Setup (Nastavení e-mailu Mestro) zkopírujte
„heslo aplikace“ do pole Heslo místo běžného e-mailového hesla.

Před odesláním e-mailového oznámení musíte navázat spojení ze softwaru CFX Maestro Dx SE na svůj
e-mailový server.

Připojení CFX Maestro Dx SE na e-mailový server

1. Postupujte následovně:

n Vyberte položku User > User Preferences (Uživatel > Uživatelské předvolby) a klikněte na
položku Configure Outgoing Email (Konfigurovat odchozí e-mail) na kartě Email (E-mail).

n Vyberte položky Tools > Options (Nástroje > Možnosti).

Otevře se dialogové okno Options (Možnosti) a zobrazí kartu Email (E-mail).
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2. Zadejte pro vaši společnost následující informace:

n SMTP Server Name (Název serveru SMTP) – název odchozího e-mailového serveru vaší
společnosti.

n Port – číslo portu serveru SMTP. To je obvykle 25.

n Use SSL (Použít možnost SSL) – možnost Secure Sockets Layer (SSL). Toto nastavení
vyžadují některé servery SMTP. Pokud to ve vaší společnosti není vyžadováno, zrušte
zaškrtnutí tohoto políčka.

n Use Default “From” Address (Použít výchozí adresu „Od“) – název e-mailového serveru ve
vaší společnosti. Servery SMTP vyžadují, aby všechny odeslané e-maily měly adresu „Od“,
která je z určité domény, například jméno@VašeSpolečnost.com. V takovém případě zrušte
zaškrtnutí tohoto políčka a zadejte platnou e-mailovou adresu.

n Authentication Required (Požadováno ověření) – pokud vaše stránky vyžadují ověření účtu,
ověřte, zda je toto políčko zaškrtnuto.

n User Name (Jméno uživatele) – jméno ověřeného účtu. To je vyžadováno pouze v případě, že
je vybrána možnost Authentication Required (Požadováno ověření).
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n Password (Heslo) – heslo pro ověřený účet. To je vyžadováno pouze v případě, že je vybrána
možnost Authentication Required (Požadováno ověření).

Důležité: Pokud k odesílání e-mailů používáte server SMTP služby Google Gmail nebo
Microsoft Office 365, musíte v nastavení účtu Gmail nebo Office365 povolit dvoufaktorové
ověřování a vygenerovat „heslo aplikace“. Pro ověření v dialogovém okně Maestro Email Setup
(Nastavení e-mailu Mestro) zkopírujte „heslo aplikace“ do pole Heslo CFX Maestro Dx SE místo
běžného e-mailového hesla.

Chcete-li ověřit, zda jsou nastavení serveru SMTP správná, zadejte do textového pole Test Email
Address (Test e-mailové adresy) platnou e-mailovou adresu a klikněte na položku Test Email
(Testovat e-mail).

Poznámka: Některé servery SMTP nepovolují přílohy a jiné povolují přílohy pouze do určité
velikosti. Pokud plánujete e-mailové datové soubory nebo reporty pomocí softwaru
CFX Maestro Dx SE, vyberte položku Test Attachment (Příloha testu) a nastavte pro položku
Attachment Size in MB (Velikost přílohy v MB) hodnotu 5 megabytů (MB) nebo více.

3. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Změna výchozího nastavení souboru

Na kartě Files (Soubor) dialogového okna User Preference (Uživatelské předvolby) můžete měnit
následující:

n výchozí umístění pro ukládání souborů CFX Maestro Dx SE,

n výchozí soubory pro nastavení běhu,

n výchozí parametry pro pojmenovávání souborů.

Jak změnit výchozí nastavení souboru

1. Vyberte User > User Preferences (Uživatel > Uživatelské předvolby) a otevře se dialogové okno User
Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Files (Soubory).
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3. V části Default Folder for File Creation (Výchozí složka pro tvorbu souborů) najděte a vyberte výchozí
složku, do které chcete ukládat nové soubory. Pro každý typ souboru můžete vybrat jiné umístění:

n Protokol

n Plate (Destička)

n Data File (Datový soubor)

n Gene Study (Genová studie)

4. V části File Selection for Run Setup (Výběr souboru pro nastavení běhu) najděte a vyberte cílové
soubory protokolu a destičky, které se mají zobrazit, když otevřete okno Experiment Setup
(Nastavení experimentu).

5. V části Data File (Datový soubor) definujte předponu nebo příponu datových souborů. Pro každý díl
vyberte z rozevíracího seznamu novou hodnotu. V textových rámečcích Prefix (Předpona) a Suffix
(Přípona) můžete také uvést vlastní hodnoty předpony a přípony.

Software CFX Maestro Dx SE zobrazí pod rámečky pro výběr náhled názvu souboru.

6. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně User
Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na původní
tovární nastavení. Při kliknutí na toto tlačítko postupujte opatrně.
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Nastavení výchozích parametrů protokolu

Nastavení výchozích parametrů protokolu pro Protocol Editor (Editor protokolu) a Protocol
AutoWriter (Automatický generátor protokolu)

1. Vyberte User > User Preferences (Uživatel > Uživatelské předvolby) a otevře se dialogové okno User
Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Protocol (Protokol).

3. V části Protocol Editor (Editor protokolu) zadejte hodnoty pro následující nastavení, která se zobrazí
v editoru Protocol Editor (Editor protokolu):

n Sample volume (Objem vzorku) – objem vzorku v jamkách (v μl).

n Lid Shutoff temperature (Teplota vypínání víka) – teplota v °C, při které se vypne vyhřívání
víka v průběhu experimentu.

4. V části Protocol AutoWriter (Automatický generátor protokolu) zadejte hodnoty pro následující
nastavení, která se zobrazí v nástroji Protocol AutoWriter (Automatický generátor protokolu):

n Annealing temperature (Teplota nasedání primerů) – teplota v °C pro experimenty, které
používají iProof DNA polymerázu, iTaq DNA polymerázu nebo jiné polymerázy.

n Amplicon length (Délka amplikonu) – délka amplikonu v párech bází (bp).

5. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně User
Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na původní
tovární nastavení. Při kliknutí na toto tlačítko postupujte opatrně.
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Nastavení výchozích parametrů destičky

Změny, které provedete na kartě Plate (Destička), jsou dostupné všem uživatelům softwaru. Změny
provedené během nastavení destičky jsou uživatelům k dispozici po uložení a zavření souboru destičky.

V dialogovém okně User Preferences (Uživatelské předvolby) můžete provádět následující akce:

n Nastavit výchozí parametry destičky.

n Přidávat nové názvy produktů, vzorků a biologických skupin do příslušných knihoven.

n Odstranit nové názvy produktů, vzorků a biologických skupin produktů a vzorků z příslušných
knihoven.

Nastavení výchozích parametrů destičky

1. Vyberte User > User Preferences (Uživatel > Uživatelské předvolby) a otevře se dialogové okno User
Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Plate (Destička).
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3. Zadejte hodnoty pro následující nastavení nového souboru destiček. Tyto hodnoty se objevují v okně
Plate Editor (Editor destiček):

n Plate type (Typ destičky)

n Plate size (Velikost destičky)

n Units (Jednotky) – koncentrace počátečního množství templátu pro jamky, které obsahují
standardy.

CFX Maestro Dx SE používá tyto jednotky k vytvoření standardní křivky na kartě Data Analysis
Quantification (Kvantifikace dat analýzy).

n Scientific notation (Vědecký zápis) – když je vybrán, software CFX Maestro Dx SE zobrazí
jednotky koncentrace ve formátu vědeckého zápisu.

n Scan mode (Režim skenování) – počet nebo typ kanálů, které mají být skenovány v době
běhu.

n Fluorophores (Fluorofory) – výchozí fluorofory, které se objevují v editoru Plate Editor (Editor
destiček).

n Libraries (Knihovny) – názvy produktů, vzorků a biologických skupin, které obvykle používáte
ve svých experimentech:

o Target names (Názvy produktů) – názvy cílových genů a sekvencí.

o Sample names (Názvy vzorků) – názvy experimentálních vzorků nebo identifikační
charakteristika vzorků (například Myš1, Myš2, Myš3).

o Biological group names (Názvy biologických skupin) – názvy skupin podobných
vzorků, které mají stejný léčebný status nebo podmínky (například 0hod, 1hod, 2hod).

4. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Chcete-li přidat nový produkt, vzorek nebo název biologické skupiny

u Do pole příslušné knihovny zadejte název produktu, vzorku nebo biologické skupiny a klikněte na
tlačítko OK.

Odstranění názvu produktu, vzorku nebo biologické skupiny

u V příslušném poli knihovny vyberte název, stiskněte klávesu Delete a klikněte na tlačítko OK.

Důležité: Názvy, které odstraníte z knihovny, jsou ze softwaru trvale odstraněny a uživatelům již
nejsou k dispozici. Pro obnovení možností do výchozích názvů CFX Maestro Dx SE klikněte na
Restore Defaults (Obnovit výchozí hodnoty). Kliknutím na možnost Restore Defaults (Obnovit
výchozí hodnoty) v dialogovém okně User Preferences (Uživatelské předvolby) se obnoví všechny
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předvolby na všech kartách na původní tovární nastavení. Při odstraňování výchozích názvů
CFX Maestro Dx SE a při klepnutí na toto tlačítko buďte opatrní.
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Nastavení výchozích parametrů analýzy dat

Nastavení výchozích parametrů analýzy dat

1. Vyberte User > User Preferences (Uživatel > Uživatelské předvolby) a otevře se dialogové okno User
Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Data Analysis (Analýza
dat).

3. V části Analysis Mode (Režim analýzy) vyberte režim, ve kterém chcete analyzovat data (buď
Fluorophore (Fluorofor), nebo Target (Produkt)).

4. V části PCR Quantitation (Kvantifikace PCR) nastavte výchozí parametry pro následující možnosti:

n Baseline Setting (Poloha baseline) – základní metoda pro režim analýzy.

n Cq Determination Mode (Režim stanovení hodnoty Cq) – režim, ve kterém jsou hodnoty Cq
vypočteny pro každou fluorescenční stopu (buď regresní, nebo jednoprahovou).

n Threshold Calc. Mode (Režim výpoč. prahové hodnoty) – hodnota end-point.

Výchozí hodnota je Auto (Automaticky). To znamená, že software automaticky vypočítá hodnotu
end-point. Chcete-li nastavit konkrétní prahovou hodnotu, zrušte zaškrtnutí políčka Auto
(Automaticky) a zadejte hodnotu end-point vypočítanou v jednotkách relativní fluorescence
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(nebo RFU). Maximální hodnota je 65 000,00 RFU. Datové soubory pro následné běhy budou
používat toto nastavení prahu.

n Baseline Calc. Mode (Režim výpoč. hodnoty baseline) – hodnota baseline pro všechny
křivky.

Výchozí hodnota je Auto (Automaticky). To znamená, že software automaticky vypočítá hodnotu
baseline pro všechny křivky. Chcete-li nastavit konkrétní hodnotu baseline, zrušte zaškrtnutí
políčka Auto (Automaticky) a zadejte minimální a maximální hodnoty pro rozsah běhu (1 až
9 999). Datové soubory pro následné běhy budou používat tento rozsah běhu.

n Log View (Zobrazení protokolu) – určuje, jak bude software zobrazovat data amplifikace:

o On (Zapnuto) – data amplifikace jsou zobrazena v semilogaritmickém grafu.

o Off (Vypnuto) – (výchozí) data amplifikace jsou zobrazena v lineárním grafu.

5. V části End Point (Koncový bod) vyberte počet koncových cyklů, které se mají při výpočtu hodnoty
end-point průměrovat:

n PCR – počet ukončených cyklů pro stanovení průměru pro výpočet kvantifikace (výchozí
hodnota je 5).

n End Point Only run (End-Point reakce) – počet ukončených cyklů pro end-point analýzu
(výchozí hodnota je 2).

6. V části Melt Curve (Křivka tání) vyberte typ vrcholu, který chcete detekovat (buď pozitivní, nebo
negativní).

7. V části Well Selector (Nástroj pro výběr jamky) vyberte, jak zobrazit popisky jamky (podle typu
vzorku, názvu produktu nebo názvu vzorku).

8. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně User
Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na původní
tovární nastavení. Při kliknutí na toto tlačítko postupujte opatrně.
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Nastavení výchozích parametrů datového souboru genové exprese

Jak nastavit výchozí parametry nového datového souboru genové exprese

1. Vyberte User > User Preferences (Uživatel > Uživatelské předvolby) a otevře se dialogové okno User
Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Gene Expression
(Genová exprese).

3. Nastavte výchozí hodnoty pro následující nastavení:

n Relative to (Vzhledem k) – sestaví graf z dat genové exprese vzhledem ke kontrole
(s počátkem v bodě 1) nebo nule:

o Zero (Nula) – software kontrolu ignoruje. Toto je výchozí hodnota, když není v okně
Experiment Settings (Nastavení experimentu) přiřazen žádný kontrolní vzorek.

o Control (Kontrola) – software vypočítá data vzhledem ke kontrolnímu vzorku přiřazenému
v okně Experiment Setup (Nastavení experimentu).

n X-axis (Osa X) – sestaví graf vzorku nebo produktu na ose X.

n Y-axis (Osa Y) – sestaví graf v lineárním, log2 nebo log10 měřítku na ose Y.

n Scaling (Úprava měřítka) – možnost úpravy měřítka grafu (výchozí možnost je bez úpravy
měřítka):

o Highest (Nejvyšší) – software upraví měřítko grafu podle datového bodu s nejvyšší
hodnotou.

o Lowest (Nejnižší) – software upraví měřítko grafu podle datového bodu s nejnižší
hodnotou.

o Unscaled (Bez úpravy měřítka) – software prezentuje data v grafu bez úpravy měřítka.

n Mode (Režim) – režim analýzy, buď relativní množství (∆Cq), nebo normalizovaná exprese
(∆∆Cq).

n Error Bar (Chybová úsečka) – variabilita dat prezentovaná jako směrodatná odchylka (Std.
Dev.), nebo jako standardní chyba průměru (Std. Error Mean).

n Error Bar Multiplier (Násobitel chybové úsečky) – násobitel směrodatné odchylky použitý
k sestavení grafu chybových úseček (výchozí hodnota je 1).

Násobitel můžete zvýšit na 2 nebo 3.

n Sample Types to Exclude (Vyloučené typy vzorků) – typy vzorků, které budou vyloučeny
z analýzy.
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Můžete vybrat jeden nebo několik vzorků, které budou vyloučeny z analýzy. Pokud chcete
vyloučit všechny typy vzorků, odznačte zaškrtávací políčka všech vybraných typů vzorků.

4. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně User
Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na původní
tovární nastavení. Při kliknutí na toto tlačítko postupujte opatrně.

Přizpůsobení pravidel pro kontrolu kvality

V softwaru CFX Maestro Dx SE můžete nastavit pravidla kontroly kvality, která se použijí na data v okně
Data Analysis (Analýza dat). Software validuje data podle nastavených pravidel.

Poznámka: Ve výchozím nastavení jsou povolena všechna pravidla kontroly kvality.

Tip: Jamky, které nesplňují parametry QC (Kontrola kvality), můžete snadno vyloučit z analýzy
v modulu QC okna Data Analysis (Analýza dat).

Přizpůsobení pravidel pro kontrolu kvality

1. Vyberte User > User Preferences (Uživatel > Uživatelské předvolby) a otevře se dialogové okno User
Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu QC (Kontrola kvality).
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Kde:

n NTC (No template control) – kontrola bez templátu

n NRT (No reverse transcriptase control) – kontrola bez reverzní transkriptázy

n Efficiency (Účinnost) – účinnost reakce

n Std Curve R^2 (Std křivka R^2) – Hodnota R^2 pro standardní křivku

n Replicate group Cq Std Dev (Vyp. std. odch. skupiny replikátů) – směrodatná odchylka
vypočtená pro každou skupinu replikátů

3. U každého pravidla QC (Kontrola kvality) postupujte následovně:

n Chcete-li použít výchozí hodnotu, nedělejte nic.

n Chcete-li změnit hodnotu, klikněte na textové pole Value (Hodnota), zadejte novou hodnotu
a stiskněte klávesu Enter.

n Chcete-li pravidlo zakázat, zrušte zaškrtnutí políčka Use (Použít).

4. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně User
Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na původní
tovární nastavení. Při kliknutí na toto tlačítko postupujte opatrně.

Přizpůsobení parametrů pro export dat

Data CFX Maestro Dx SE můžete exportovat v následujících formátech:

n Text (.txt)

n CSV (.csv)

n Excel (.xls, .xlsx)

n XML (.xml)

n HTML (.html)

Důležité: Abyste mohli exportovat data do tabulky Microsoft Excel, musí být v počítači nainstalován
programMicrosoft Excel.

Můžete určit typ dat pro export a přizpůsobit výstup exportovaných dat.
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Přizpůsobení parametrů pro export dat

1. Vyberte User > User Preferences (Uživatel > Uživatelské předvolby) a otevře se dialogové okno User
Preferences (Uživatelské předvolby).

2. V dialogovém okně User Preferences (Uživatelské předvolby) vyberte kartu Custom Export (Vlastní
export).

3. V rozevíracím seznamu Export Format (Formát exportu) vyberte formát, do kterého chcete data
exportovat.

4. V části Data to Export (Data do exportu) zaškrtněte nebo odznačte zaškrtávací políčka pro typ dat,
která mají být exportována. Vybrané položky se zobrazí v seznamu Exported Columns (Exportované
sloupce).

Poznámka: Ve výchozím nastavení jsou informace o běhu zahrnuty do záhlaví. Odznačte toto
zaškrtávací políčko, pokud nechcete zahrnout informace o běhu.

5. Můžete změnit pořadí zobrazení výstupu vybraných položek.

V seznamu Exported Columns (Exportované sloupce) zvýrazněte položku a potom klikněte pro
pohyb nahoru nebo dolů na tlačítka se šipkami vlevo od seznamu.

6. Volitelně můžete změnit názvy sloupců výstupu vybraných položek:
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a. Klikněte na Customize Column Names (Upravit názvy sloupců).

Zobrazí se dialogové okno Column Name Customizer (Vlastní název sloupce).

b. Pro každý výchozí název sloupce, který chcete změnit, zadejte nový název do pole Custom
Name (Vlastní název).

c. Postupujte následovně:

n Kliknutím na tlačítko OK uložte změny a vraťte se na kartu Custom Export (Vlastní export).
Nový název se zobrazí v závorkách vedle výchozího názvu sloupce v seznamu Exported
Columns (Exportované sloupce).

n Kliknutím na tlačítko Cancel (Zrušit) zrušte změny a vraťte se na kartu Custom Export
(Vlastní export).

7. Kliknutím na tlačítko OK uložte změny a zavřete dialogové okno.

Důležité: Kliknutím na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně User
Preferences (Uživatelské předvolby) se obnoví všechny předvolby na všech kartách na původní
tovární nastavení. Při kliknutí na toto tlačítko postupujte opatrně.
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Kapitola 7 Vytvoření protokolů
Protokol je sada kroků, které jsou prováděny v definovaném pořadí. Software CFX Maestro Dx,
bezpečnostní edice umožňuje nastavení následujících kroků. Kontrola teploty bloku a víka, udržování
teplotního rozdílu bloku, odečet fluorescence destičky a analýza křivky tání. Každá varianta je definována
pro různé typy destiček a cyklů.

CFX Maestro Dx SE poskytuje dvě možnosti pro vytváření protokolů: Protocol Editor (Editor protokolu)
a Protocol AutoWriter (Automatický generátor protokolu).

Funkce nástroje Protocol Editor (Editor protokolu) zahrnují následující:

n standardní ovládací prvky pro rychlé vytváření protokolů,

n schopnost rychle vypočítat gradient pro vybraný počet řádků,

n schopnost rychle vypočítat dobu běhu pro vybraný typ destičky,

n schopnost upravovat kroky protokolu,

n schopnost ukládat protokoly pro opětovné použití,

n schopnost vytisknout protokol na výchozí tiskárně.

Protocol AutoWriter (Automatický generátor protokolu) automaticky generuje přizpůsobený protokol PCR
s kroky horkého startu, počáteční denaturace, nasedání primerů a extense na základě zadaných
parametrů. Následně je možné zobrazit grafické znázornění návrhu protokolu a tento protokol upravit,
spustit nebo uložit.
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Parametry a rozsahy pro jednotlivé kroky protokolu
Tabulka 7 uvádí informace, podle kterých upravte výchozí nastavení kroků ve vašem protokolu.

Teplotní kroky

Cílová teplota je hodnota v rozsahu od 4,0 do 100,0 °C, nastavitelná v desetinách stupně. Systém navýší
teplotu na tuto hodnotu a udržuje ji po stanovenou dobu (doba prodlevy).

Kroky gradientu

Rozsah gradientu je rozdíl mezi dolní a horní teplotou v kroku gradientu. Maximální povolený rozsah je
24 °C. Dolní teplota je hodnota mezi 30,0 a 99,0 °C, nastavitelná v desetinách stupně. Maximální horní
teplota je 100 °C. Termocykler navýší teplotu na cílový teplotní gradient napříč celým blokem a udržuje
tuto teplotu po stanovenou dobu prodlevy.

Důležité: Přístroj vypočítá hodnotu gradientu. Pokud zadáte hodnotu do horního a dolního pole
kalkulačky výpočtu gradientu, software pak automaticky vypočítá a přiřadí teploty zbývajícím polím.
Zadáte-li teplotu do některého pole mezi horním a dolním polem, přístroj automaticky dopočítá
zbývající pole. Nelze ručně zadat hodnotu teploty do každého pole.

Parametr Rozsah Popis

Ramp rate (Rychlost
ohřevu/ochlazování)

n Pro systémy CFX Opus 96 Dx:
0,1–5 °C za sekundu

n Pro systémy CFX Opus 384
Dx:
0,1–2,5 °C za sekundu

n Pro systémy CFX Opus
Deepwell Dx:
0,1–2,5 °C za sekundu

Dává termocykleru pokyn, aby v daném
kroku dosáhl cílové teploty stanovenou
rychlostí ohřevu/ochlazování.

K dispozici pouze pro teplotní kroky.

Increment (Přírůstek) Číslo od –10,0 do 10,0 ° C za
cyklus na desetiny stupně

Dává termocykleru pokyn, aby s každým
cyklem změnil cílovou teplotu kroku, kde
kladné číslo znamená zvýšení teploty a
záporné číslo její snížení.

K dispozici pouze pro teplotní kroky.

Tabulka 7. Parametry a rozsahy pro jednotlivé kroky protokolu
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Parametr Rozsah Popis

Extend (Prodloužení) Doba v rozsahu od –60 do 60
sekund na cyklus

Dává termocykleru pokyn, aby s každým
cyklem prodloužil dobu prodlevy. Kladné
číslo zvyšuje dobu prodlevy a záporné ji
zkracuje.

K dispozici pro kroky teploty i gradientu.

Zvuková signalizace
(pípnutí)

(Žádné parametry) Dává termocykleru pokyn, aby pípnutím
signalizoval, že termocykler dosáhl
cílové teploty pro daný krok.

K dispozici pouze pro teplotní kroky.

Plate Read (Čtení
destičky)

(Žádné parametry) Dává termocykleru pokyn, aby do
vybraného kroku přidal čtení destičky.

K dispozici pro kroky teploty i gradientu.

Tabulka 7. Parametry a rozsahy pro jednotlivé kroky protokolu, pokračování
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Okno Protocol Editor (Editor protokolu)
Pomocí nástroje Protocol Editor (Editor protokolu) můžete vytvářet, otevírat, kontrolovat a upravovat
protokoly. Ve výchozím nastavení se nástroj Protocol Editor (Editor protokolu) otevře s obecným
protokolem pro destičku s 96 jamkami pro detekci v reálném čase ve dvou krocích.

1. Panel nabídek poskytuje rychlý přístup k příkazům nabídek File (Soubor), Settings (Nastavení)
a Tools (Nástroje).

2. Panel nástrojů umožňuje rychlý přístup k uložení a tisku protokolu, k vložení kroku, stanovení
objemu vzorku a zobrazení předpokládané doby trvání cyklu protokolu.

3. Hlavní podokno obsahuje grafické zobrazení protokolu.

4. V dolním podokně je přehled protokolu.

5. V levém podokně jsou ovládací prvky protokolu, které můžete přidávat, abyste protokol
přizpůsobili svým potřebám.

LEGENDA

Příkazy nabídky File (Soubor)
Save (Uložit) – uloží aktuální protokol.
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Save As (Uložit jako) – uloží aktuální protokol s novým názvem nebo do nového umístění.

File Passwords (Hesla souborů) – umožňuje uživatelům nastavit hesla pro ukládání souborů a otevření
souborů.

Tip: Další informace najdete v části Soubory chráněné heslem na straně 50.

Close (Zavřít) – zavře nástroj Protocol Editor (Editor protokolu).

Příkaz karty Settings (Nastavení)
Lid Settings (Nastavení víka) – otevře dialogové okno Lid Setting (Nastavení víka), ve kterémmůžete
měnit nebo nastavovat teplotu víka.

Příkazy nabídky Tools (Nástroje)
Gradient Calculator (Kalkulačka gradientu) – otevře dialogové okno, ze kterého můžete vybrat typ
bloku pro krok gradientu. Výchozí hodnota je 96 jamek.

Run time Calculator (Kalkulačka doby trvání běhu) – otevře dialogové okno, ze kterého můžete
vybrat typ destičky a režim skenování, abyste mohli vypočítat odhadovaný čas trvání běhu v okně Run
Setup (Nastavení běhu). Výchozí hodnota je 96 jamek, všechny kanály.

Příkazy panelu nástrojů

– uloží soubor aktuálního protokolu.

– vytiskne vybrané okno.

– pomocí tohoto příkazu vyberte, kammají být vloženy kroky vzhledem
k aktuálně vybranému kroku.

– pomocí tohoto příkazu zadáte objem vzorku v µl. Objemy vzorků se liší
v závislosti na typu bloku:

n Pro 96jamkový blok je rozsah 0–50 µl.

n Pro 384jamkový blok je rozsah 0–30 µl.

n Pro 96jamkový, hluboký blok je rozsah 0–125 µl.
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– zobrazí odhadovanou dobu běhu podle jednotlivých kroků protokolu, rychlosti
ohřevu a typu vybraného bloku.

– zobrazí nápovědu k protokolům.

Ovládací prvky pro úpravu protokolu
Levé podokno okna Protocol Editor (Editor protokolu) nabízí ovládací prvky pro vytváření protokolů.

Každý prvek je tvořen sadou parametrů, které představují kroky protokolu. Každý parametr můžete
upravit nebo je přidávat či odstraňovat tak, abyste protokol přizpůsobili svým potřebám. Tato kapitola
popisuje možnosti těchto ovládacích prvků.

n Insert Step (Vložit krok) – vloží krok před nebo za vybraný krok.
Teplotu a dobu prodlevy můžete upravit v grafickém znázornění
protokolu nebo v přehledu protokolu.

n Insert Gradient (Vložit gradient) – vloží krok gradient podle typu bloku
vybraného v kalkulačce gradientu. Rozsah gradientu můžete upravovat
na panelu Gradient, který se otevře po vložení kroku Gradient.

n Insert GOTO (Vložit GOTO) – vloží krok cyklování (smyčky), podle
kterého software opakuje konkrétní kroky v sekvenci po stanovený počet
cyklů. Opakování začne po dokončení prvního cyklu. Můžete například
nastavit software, aby provedl 39 opakování kroků 2–4. Po posledním
opakování provede software kroky 2–4 celkem 40krát. Krok návratu

(GOTO) a počet cyklů můžete upravit v grafickém znázornění protokolu nebo v přehledu protokolu.

n Insert Melt Curve (Vložit křivku tání) – vloží krok čtení křivky tání.

n Insert Plate Read to Step (Vložit čtení destičky do kroku) – přidá povel pro čtení destičky do
vybraného kroku. Při čtení destičky se změří množství fluorescence na konci cyklu. Krok čtení
destičky je obecně posledním krokem smyčky GOTO.

Tip: Po přidání povelu pro čtení destičky do kroku se tlačítko změní na Remove Plate Read
(Odstranit čtení destičky), když tento krok vyberete.

n Remove Plate Read (Odstranit čtení destičky) – odstraní povel pro čtení destičky z vybraného
kroku.

Tip: Po odstranění povelu pro čtení destičky z kroku se tlačítko změní na Add Plate Read to
Step (Přidat čtení destičky do kroku), když tento krok vyberete.
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n Step Options (Možnosti kroku) – otevře dialogové okno Step Options (Možnosti kroku) a zobrazí
dostupné možnosti pro vybraný krok. Podrobné informace o možnostech kroku jsou uvedeny v části
Možnosti kroku na straně 104.

Tip: Do nabídky Step Options (Možnosti kroku) se rovněž dostanete kliknutím pravým tlačítkem
myši na krok v grafickém zobrazení.

n Delete Step (Vymazat krok) – vymaže vybraný krok z protokolu.
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Možnosti kroku

Otevřete dialogové okno Step Options (Možnosti kroku), zobrazí se vámmožnosti, které můžete přidat,
změnit nebo odstranit z kroku.

n Plate Read (Číst destičku) – je-li toto políčko zaškrtnuto, přidá se do kroku čtení destičky.

n Temperature (Teplota) – stanoví cílovou teplotu pro vybraný krok.

n Gradient – stanoví rozsah gradientu pro krok; rozsah je 1–24 °C.

Poznámka: Gradient pracuje s nejnižší teplotou na přední straně bloku (na tomto obrázku řádek
H) a nejvyšší teplotou na zadní straně bloku (na tomto obrázku řádek A).

n Increment (Přírůstek) – hodnota zvýšení (nebo snížení) teploty vybraného kroku; tato hodnota je
v každém cyklu přidána k cílové teplotě. Rozsah je ±0,1–10 °C.

Poznámka: Pro snížení teploty zadejte před číselnou hodnotu záporné znaménko (–) (například
−5 °C).

n Ramp Rate (Rychlost ohřevu/ochlazování) – rychlost ohřevu/ochlazování pro vybraný krok;
rozsah závisí na typu bloku.

n Time (Doba) – doba trvání pro vybraný krok.
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n Extend (Prodloužení) – doba, o kterou se vybraný krok prodlouží nebo zkrátí (v sekundách); tato
možnost je v každém cyklu přidána k době trvání; rozsah je 1–60 s.

n Beep (Pípnutí) - je-li vybráno, během kroku zazní pípnutí.

Tip: Pokud zadáte číslo mimo rozsah možnosti, software tuto hodnotu změní na nejbližší údaj
v daném rozsahu.
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Vytvoření protokolu v nástroji Protocol Editor (Editor
protokolu)

Pomocí nástroje Protocol Editor (Editor protokolu) můžete vytvářet vlastní soubory protokolu. Současně
můžete upravovat a ukládat již uložené soubory protokolů nebo vzorové soubory protokolů dodané se
softwarem CFX Maestro Dx SE.

Abyste vytvořili nový soubor protokolu, postupujte následovně:

n Otevřete soubor protokolu v nástroji Protocol Editor (Editor protokolu).

Tip: V nástroji Protocol Editor (Editor protokolu) můžete otevřít nový nebo existující protokol.

n Nastavte nový protokol.

n Přidejte do protokolu kroky z podokna s ovládacími prvky pro protokoly.

n Upravte vlastnosti kroků.

n Uložte protokol.

Tip: Informace o tvorbě nového protokolu z již uloženého vzorového souboru protokolu jsou uvedeny
v části Otevření existujícího souboru protokolu v nástroji Protocol Editor (Editor protokolu) na straně
108.

Otevření nového souboru protokolu v nástroji Protocol Editor
(Editor protokolu)
CFX Maestro Dx SE nabízí více možností otevření nového souboru protokolu:

n Z nabídky File (Soubor) v okně Home (Domů)

n V dialogovém okně Run Setup (Spustit nastavení) v okně Home (Domů)

n V dialogovém okně Startup Wizard (Průvodce spuštěním) v okně Home (Domů)

Jak otevřít nový soubor protokolu z nabídky Home (Domů)

u V okně Home (Domů) vyberte položky File > New > Protocol (Soubor > Nový > Protokol).

Otevře se okno Protocol Editor (Editor protokolu), které zobrazí výchozí soubor protokolu.

Tip: Informace o nastavení výchozího souboru protokolu jsou uvedeny v části Změna výchozího
nastavení souboru na straně 83.
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Jak otevřít nový protokol z dialogového okna Run Setup (Nastavení běhu)

1. V okně Home (Domů) postupujte následovně, abyste otevřeli dialogové okno Run Setup (Nastavení
běhu):

n Vyberte možnost Run > User-defined Run (Běh > Běh definovaný uživatelem).

n Na panelu nástrojů klikněte na možnost User-defined Run Setup (Nastavení běhu definovaného
uživatelem).

Otevře se dialogové okno Run Setup (Nastavení běhu) na kartě Protocol (Protokol) a zobrazí se
výchozí soubor protokolu.

2. Klikněte na Create New (Vytvořit nový).

Otevře se okno Protocol Editor (Editor protokolu), které zobrazí výchozí protokol v reálném čase.

Otevření nového souboru protokolu z nástroje Startup Wizard (Průvodce spuštěním)

1. V okně Home (Domů) postupujte následovně, abyste otevřeli nástroj Startup Wizard (Průvodce
spuštěním), pokud ještě není otevřen:

n Vyberte možnost View > Startup Wizard (Zobrazit > Průvodce spuštěním).

n Na panelu nástrojů klikněte na Startup Wizard (Průvodce spuštěním).

2. V případě potřeby vyberte typ přístroje z rozevíracího seznamu.

3. Jako typ běhu vyberte kliknutím položku User-defined (Definovaný uživatelem).

Otevře se dialogové okno Run Setup (Nastavení běhu), na kartě Protocol (Protokol) a zobrazí
výchozí soubor protokolu.

4. Klikněte na Create New (Vytvořit nový).

Otevře se okno Protocol Editor (Editor protokolu), které zobrazí výchozí protokol v reálném čase.

Chcete-li otevřít nový protokol z nabídky Run (Spustit)

1. V okně Home (Domů) postupujte následovně, abyste otevřeli dialogové okno Run Setup (Nastavení
běhu):

n Vyberte možnost Run > User-defined Run (Běh > Běh definovaný uživatelem).

n Na panelu nástrojů klikněte na možnost User-defined Run Setup (Nastavení běhu definovaného
uživatelem).

Otevře se dialogové okno Run Setup (Nastavení běhu) na kartě Protocol (Protokol) a zobrazí se
výchozí soubor protokolu.

2. Klikněte na Create New (Vytvořit nový).
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Otevře se okno Protocol Editor (Editor protokolu), které zobrazí výchozí protokol v reálném čase.

Otevření existujícího souboru protokolu v nástroji Protocol Editor
(Editor protokolu)
CFX Maestro Dx SE nabízí vzorové protokoly, které můžete upravovat a ukládat jako vlastní nové
protokoly. Můžete také vytvořit nový protokol z existujícího vlastního protokolu.

Otevření souboru se vzorovým protokolem

1. V okně Home (Domů) vyberte položky File > Open > Protocol (Soubor > Otevřít > Protokol).

Ve výchozím nastavení Průzkumník Windows otevře složku Sample files (Soubory vzorků).
CFX Maestro Dx SE.

2. Otevřete složku Sample files (Soubory vzorků). Zobrazí se následující složky:

n ConventionalProtocols (Běžné protokoly) – obsahuje příklady souborů protokolu pro
konvenční analýzu PCR.

n DataFiles (Datové soubory) – obsahuje příklady datových souborů, které můžete použít
k prozkoumání funkcí CFX Maestro Dx SE.

n MeltCalibration (Kalibrace táni) – obsahuje ukázkové soubory protokolů pro použití
s programem Bio-Rad pro Precision Melt Analysis (Přesnou analýzu tání).

n Plates (Destičky) – obsahuje vzorové templáty.

n RealTimeProtocols (Protokoly v reálném čase) – obsahuje příklady souborů protokolu pro
analýzu PCR v reálném čase.

3. Otevřete složku protokolu pro typ běhu, který chcete provést, buď ConventionalProtocols (Běžné
protokoly), anebo RealTimeProtocols (Protokoly v reálném čase).

4. Vyberte požadovaný protokol a klikněte na tlačítko Open (Otevřít).

Soubor se vzorovým protokolem se otevře v okně Protocol Editor (Editor protokolu).

5. Vyberte položky File > Save As (Soubor > Uložit jako) a uložte protokol s novým názvem nebo do
nové složky.

Otevření existujícího protokolu

1. V okně Home (Domů) postupujte následovně:

n Vyberte položky File > Open > Protocol (Soubor > Otevřít > Protokol), přejděte na cílový soubor,
vyberte ho a klikněte na položku Open (Otevřít).

n Otevřete Startup Wizard (Průvodce spuštěním) a postupujte následovně:
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o Chcete-li zobrazený protokol upravit, klikněte na tlačítko Edit Selected (Upravit vybraný).

o Chcete-li upravit jiný existující protokol, klikněte na tlačítko Select Existing (Vybrat existující)
a přejděte na cílový soubor.

Protokol se otevře v okně Protocol Editor (Editor protokolu).

2. Vyberte položky File > Save As (Soubor > Uložit jako) a uložte protokol s novým názvem nebo do
nové složky.

Nastavení nového protokolu
Tip: Pokud váš soubor protokolu obsahuje požadované parametry (například, pokud upravujete
existující soubor destičky), můžete tuto část přeskočit. Přejděte na Přidání kroků do protokolu na
straně 111.

Nové soubory protokolu vyžadují následující parametry:

n typ bloku,

n režim skenování pro zvolený typ bloku,

n Lid temperature (Teplota víka).

n objem vzorku.
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Nastavení typu bloku

CFX Maestro Dx SE automaticky vypočítává teplotní přírůstky pro kroky gradientu podle typu bloku.

Poznámka: Typ destičky nastavený v editoru Protocol Editor (Editor protokolu) musí být stejný jako
destička v reakčním modulu.

Nastavení typu bloku

u V okně Protocol Editor (Editor protokolu) vyberte Tools > Gradient Calculator (Nástroje > Kalkulačka
gradientu) a v rozevíracím seznamu, který se objeví, vyberte příslušný typ destičky.

Výběr režimu skenování pro zvolený typ bloku

Abyste určili délku trvání běhu pro zvolený protokol, vyberte typ cílového bloku a režim skenování.

Výběr skenovacího módu pro daný typ bloku

u V okně Protocol Editor (Editor protokolu) vyberte položky Tools > Run time Calculator (Nástroje >
Kalkulačka doby běhu) a v otevřeném rozevíracím seznamu zvolte vhodný typ destičky a režim
skenování.

Nastavení teploty víka

Software CFX Maestro Dx SE nastaví výchozí teplotu víka následujícím způsobem:

n 96jamkové přístroje a přístroje s hlubokými jamkami – 105,0 °C

n 384jamkové přístroje – 95,0 °C

Pokud to protokol vyžaduje, můžete změnit výchozí nastavení nebo vypnout ohřev víka.

Nastavení teploty víka

1. V okně Plate Editor (Editor destiček) vyberte Settings > Lid Settings (Nastavení > Nastavení víka).

Zobrazí se dialogové okno Lid Settings (Nastavení víka).

2. Postupujte následovně:

n Vyberte User Defined (Uživatelsky definovaná) a do textového pole zadejte hodnotu teploty.

n Vyberte Turn Off Lid Heater (Vypnout ohřev víka).

3. Dotykem na tlačítko OK změny potvrďte a zavřete dialogové okno.
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Nastavení objemu vzorku

Standardně nastavuje CFX Maestro Dx SE objem vzorku pro každou jamku na 25 μl. Objemy vzorků se
liší v závislosti na typu bloku, například:

n 0–50 µl pro 96jamkový blok

n 0–30 µl pro 384jamkový blok

Přístroj používá jeden ze dvou režimů regulace teploty, aby určil, kdy vzorek dosáhne cílové teploty
v protokolu:

n Calculated mode (Vypočítaný režim) – když je objem vzorku nastaven na nenulový objem
odpovídající bloku, přístroj vypočítá teplotu vzorku na základě objemu vzorku. Toto je výchozí režim.

n Block mode (Režim bloku) – když je objem vzorku nastaven na nulu (0) μl, přístroj zaznamená
teplotu vzorku jako naměřenou teplotu bloku.

Nastavení objemu vzorku pro konkrétní blok

u V okně Plate Editor (Editor destiček) zadejte správnou hodnotu na panelu nástrojů do textového pole
Sample Volume (Objem vzorku).

Tip: Výchozí objem vzorku můžete změnit v dialogovém okně User Preferences (Uživatelské
předvolby). Více informací naleznete v části Změna výchozího nastavení souboru na straně 83.

Přidání kroků do protokolu
Jak přidat krok do protokolu

1. Otevřete protokol v okně Protocol Editor (Editor protokolu).

2. Určete, kam chcete nový krok vložit. Na panelu nástrojů vyberte v rozevíracím seznamu Step (Krok)
možnost Before (Před) nebo After (Za).

3. V grafu vyberte krok, před kterým nebo za který chcete vložit nový krok.

4. V levém podokně klikněte na položku Insert Step (Vložit krok).

5. Chcete-li změnit teplotu nebo dobu prodlevy, klikněte na výchozí hodnotu v grafu nebo v přehledu
protokolu a zadejte novou hodnotu.

6. (Volitelné) V levém podokně klikněte na Step Options (Možnosti kroku), otevře se dialogové okno
Step Options (Možnosti kroku), ve kterémmůžete upravovat dostupné možnosti pro vybraný krok.

Tip: Dialogové okno Step Options (Možnosti kroku) můžete otevřít přes nabídku po kliknutí
pravým tlačítkemmyši na podokno grafu nebo podokno přehledu protokolu.

7. Abyste uložili změny v protokolu, klikněte na OK a následně na Yes (Ano).
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Otevře se dialogové okno Save As (Uložit jako).

8. V dialogovém okně Save As (Uložit jako) zadejte název nového souboru protokolu a klikněte na
položku Save (Uložit).

Vložení kroku gradientu
Jak vložit krok gradientu

1. Ujistěte se, že velikost destičky pro gradient je stejná jako typ bloku přístroje, 96 jamek, 384 jamek
nebo hluboké jamky.

2. Pokud jste tak doposud neučinili, vyberte velikost destičky pro gradient:

Vyberte položku Tools > Gradient Calculator (Nástroje > Kalkulačka gradientu) a zvolte v rozevíracím
seznamu odpovídající typ destičky.

3. Na panelu nástrojů vyberte v rozevíracím seznamu Insert Step (Vložit krok) možnost Before (Před)
nebo After (Za).

4. V grafu nebo na přehledovém panelu vyberte krok, před kterým nebo za který chcete vložit krok
gradientu.

5. Na levém panelu klikněte na Insert Gradient (Vložit gradient). Nový krok gradientu bude v grafu
a v přehledovém podokně zvýrazněn, například:
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Teplota každého řádku v gradientu se objeví v tabulce Gradient v pravém podokně.

6. Při úpravě rozsahu teploty gradientu postupujte následovně:

n Klikněte na výchozí teplotu v grafu nebo v přehledovém podokně a zadejte novou teplotu.

n Klikněte na Step Options (Možnosti kroku) pro zadání rozsahu gradientu v okně Step Options
(Možnosti kroku).

n Změňte hodnotu Range (Rozsah) v tabulce Gradient.

7. Chcete-li upravit délku kroku, klikněte v grafickém nebo textovém zobrazení na výchozí dobu
a zadejte novou hodnotu.

8. Kliknutím na OK a poté na Yes (Ano) změny uložíte.

Vložení kroku GOTO
Poznámka: Krok GOTO nelze vložit do souboru GOTO; nelze vytvořit vnořené smyčky GOTO.

Jak vložit krok GOTO

1. Na panelu nástrojů vyberte v rozevíracím seznamu Insert Step (Vložit krok) možnost Before (Před)
nebo After (Za).

2. V grafu vyberte krok, před kterým nebo za který chcete vložit krok GOTO.

3. V levém podokně klikněte na Insert GOTO (Vložit GOTO).

4. Chcete-li změnit počet kroků GOTO nebo opakování GOTO, vyberte v grafu nebo na přehledovém
panelu výchozí hodnotu a zadejte novou hodnotu.

5. Kliknutím na OK a poté na Yes (Ano) změny uložíte.

Vložení kroku Křivka tání
Tip: Není možné vložit krok Křivka tání dovnitř smyčky GOTO.

Poznámka: Krok křivka tání obsahuje na začátku 30s prodlevu, která není v protokolu zobrazena.

Jak vložit krok Křivka tání

1. Na panelu nástrojů vyberte v rozevíracím seznamu Insert Step (Vložit krok) možnost Before (Před)
nebo After (Za).

2. V grafu vyberte krok, před který nebo za který chcete vložit krok Křivka tání.
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3. Na levém panelu klikněte na Insert Melt Curve (Vložit křivku tání). Nový krok Křivka tání bude v grafu
a v přehledovém podokně zvýrazněn, například:

4. Chcete-li upravit rozsah teploty tání nebo délku kroku, vyberte v grafu nebo v přehledovém podokně
výchozí hodnotu a zadejte novou hodnotu.

5. Kliknutím na OK a poté na Yes (Ano) změny uložíte.
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Přidání nebo odstranění kroku Čtení destičky
Tip: Po přidání povelu pro čtení destičky do kroku se tlačítko změní na Remove Plate Read
(Odstranit čtení destičky), když tento krok vyberete.

Jak přidat čtení destičky do kroku

1. Na panelu nástrojů vyberte v rozevíracím seznamu Insert Step (Vložit krok) možnost Before (Před)
nebo After (Za).

2. V grafu vyberte krok, před který nebo za který chcete vložit krok čtení destičky.

3. Chcete-li přidat čtení destičky do vybraného kroku, klikněte v levém podokně na možnost Add Plate
Read to Step (Přidat čtení destičky do kroku).

4. Kliknutím na OK a poté na Yes (Ano) změny uložíte.

Jak odstranit čtení destičky z kroku

u V grafu vyberte krok, jenž obsahuje čtení destičky, a v levém podokně klikněte na položku Remove
Plate Read (Odstranit čtení destičky).

Změna nastavení kroku
Změna nastavení kroku pro vybraný krok

1. V grafu nebo na přehledovém panelu vyberte cílový krok.

2. V levém podokně klikněte na položku Step Options (Možnosti kroku). Otevře se dialogové okno Step
Options (Možnosti kroku).

Případně klikněte pravým tlačítkemmyši na cílový krok v libovolném podokně a v zobrazené nabídce
vyberte položku Step Options (Možnosti kroku).

3. Přidání, úprava nebo odstranění možností:

n Do příslušného textového pole zadejte hodnotu.

n Upravte hodnotu v konkrétním textovém poli.

n Označte nebo odznačte zaškrtávací políčko.

4. Kliknutím na tlačítko OK uložíte změny a zavřete dialogové okno Step Options (Možnosti kroku).

5. Klepnutím na OK a poté na Yes (Ano) protokol uložíte.
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Odstranění kroku
Důležité: Tuto funkci nelze vrátit zpět. Při odstraňování kroků buďte opatrní.

Odstranění kroku v protokolu

1. V grafu nebo na přehledovém panelu vyberte krok.

2. Chcete-li odstranit vybraný krok, klikněte na levém panelu na možnost Delete Step (Odstranit krok).

3. Klepnutím na OK a poté na Yes (Ano) protokol uložíte.

Kopírování, export nebo tisk protokolu
Jak kopírovat protokol

u Klikněte pravým tlačítkemmyši na přehled protokolu a vyberte možnost Copy Protocol (Kopírovat
protokol).

Přehled můžete vložit do souboru .txt, .xls, .doc nebo .ppt.

Jak exportovat protokol

1. Klikněte pravým tlačítkemmyši na přehled protokolu a vyberte možnost Export Protocol (Exportovat
protokol).

Otevře se dialogové okno Save As (Uložit jako).

2. (Volitelné) V Průzkumníkovi Windows přejděte do složky, do které chcete soubor protokolu uložit.

3. Do pole File name (Název souboru) zadejte název exportovaného souboru protokolu.

4. Klikněte na Save (Uložit).

Jak vytisknout protokol

u Klikněte pravým tlačítkemmyši na přehled protokolu a vyberte možnost Print (Tisk).

Na své výchozí tiskárně můžete vytisknout přehled protokolu.
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Vytvoření protokolu pomocí nástroje Protocol AutoWriter
(Automatický generátor protokolu)

Důležité: Společnost Bio-Rad neručí za to, že použití protokolu vytvořeného pomocí nástroje
Protocol AutoWriter (Automatický generátor protokolu) vždy povede k očekávanému produktu PCR.

Nástroj softwaru CFX Maestro Dx SE Protocol AutoWriter (Automatický generátor protokolu) automaticky
vytváří protokoly cyklů na základě následujících vstupních parametrů:

n Amplicon length (Délka amplikonu) – předpokládaná délka produktu PCR

n Annealing temperature (Teplota nasedání primerů) – reakční Ta pro použité primery

Pokud je Ta neznámá, můžete pro její automatický výpočet na základě sekvencí primerů použít
nástroj Ta Calculator (Kalkulačka Ta).

Poznámka: Hodnota Ta je upravena na základě informací o teplotě tání primeru (Tm), která
vychází z vybraného enzymu a rychlosti protokolu.

n Enzyme type (Typ enzymu) – enzym polymeráza DNA (polymeráza iTaq, iProof DNA, nebo Other
(Jiné))

Pokud použijete jiný enzym než iTaq nebo iProof DNA, můžete zadat další informace, včetně
rozsahu gradientu, doby pro hot-start aktivace (s) a doby závěrečné extense (s).

n Run speed (Rychlost běhu) – rychlost reakce (standardní, rychlá, ultrarychlá)

Nástroj Protocol AutoWriter (Automatický generátor protokolu) optimalizuje protokol podle vybraného
nastavení rychlosti. Celková doba běhu je určena počtem kroků a cyklů, dobou inkubace v každém
kroku a dobou dosažení teplotní uniformity při cílové teplotě.

Na základě vámi zadaných parametrů a standardních pokynů PCR nástroj Protocol AutoWriter
(Automatický generátor protokolu) automaticky vygeneruje přizpůsobený protokol PCR s kroky hot-startu,
počáteční denaturace, nasedání primerů a extense. Následně můžete zobrazit grafické znázornění
návrhu protokolu a tento protokol upravit, spustit nebo uložit.
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Jak vytvořit nový protokol nástrojem Protocol AutoWriter (Automatický generátor
protokolu) softwaru CFX Maestro Dx SE

1. V okně Home (Domů) vyberte Tools > Protocol AutoWriter (Nástroje > Automatický generátor
protokolu).

Objeví se dialogové okno Protocol AutoWriter (Automatický generátor protokolu).

2. V části Enter Target Values/Enzyme (Zadat cílové hodnoty/enzym) postupujte následovně:

n Zadejte teplotu hybridizace (Ta) pro primery, pokud ji znáte.

Tip: Více informací naleznete v části Použití nástroje Ta Calculator (Kalkulačka Ta) na
straně 119.

Poznámka: Pro informace o výpočtech použitých nástrojem Ta Calculator (Kalkulačka Ta)
viz Breslauer a kol. 1986.

n Zadejte délku amplikonu v párech bází (bp).

n Vyberte typ enzymu ze seznamu možností (polymeráza iTaq DNA, polymeráza iProof DNA
nebo Other (Jiné)).

Tip: Pokud jako typ enzymu zvolíte Other (Jiné), aktivují se parametry v části Additional
Parameters (Optional) (Další parametry (volitelné)).
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3. Jestliže jste jako typ enzymu vybrali Other (Jiné), můžete do protokolu přidávat následující
parametry:

n Rozsah gradientu

n Aktivační teplota hot-start

n Doba závěrečné extense

4. V části Type (Typ) přesuňte posuvnou lištu pro výběr rychlosti protokolu Standard, Fast (Rychlá),
Ultrafast (Ultrarychlá). CFX Maestro Dx SE upraví celkovou dobu běhu.

5. Vyberte prováděný typ PCR (výchozí je Real-time PCR (PCR v reálném čase)).

Při použití PCR v reálném čase přidá software CFX Maestro Dx SE krok čtení destičky pro sběr
fluorescenčních dat.

6. V části Preview (Náhled) protokol zkontrolujte. Podle potřeby můžete provádět změny.

7. Postupujte následovně:

n Kliknutím na OK nový protokol uložíte. Po uložení se protokol otevře v nástroji Startup Wizard
(Průvodce spuštěním). Po kliknutí na položku Edit Selected (Editovat vybrané) můžete
v protokolu provádět změny. Můžete například změnit teplotu víka a objem vzorku.

n Kliknutím na Cancel (Zrušit) okno zavřete bez uložení protokolu.

Použití nástroje Ta Calculator (Kalkulačka Ta)
Je-li teplota nasedání primeru neznámá, můžete pro výpočet hodnoty použít nástroj Ta Calculator
(Kalkulačka Ta). Hodnotu můžete použít k vytvoření protokolu v okně Protocol AutoWriter (Automatický
generátor protokolu) nebo Protocol Editor (Editor protokolu).

O nástroji Ta Calculator (Kalkulačka Ta)
Nástroj Ta Calculator (Kalkulačka Ta) počítá hodnotu Tm pro každý primer a hodnotu Ta pro protokol při
standardní rychlosti.

Hodnota Ta pro protokol vychází z průměrných hodnot Tm primerů s použitím následujících pravidel:

n Pokud je rozdíl mezi hodnotami Tm primerů >4 °C, pak Ta = (nižší z obou hodnot Tm primerů + 2) –
4 °C

n Pokud je rozdíl mezi hodnotami Tm ≤ 4 °C, pak Ta = (průměr hodnot Tm primeru) – 4 °C
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Metoda počítání párů bází

Pro každý primer používá Ta Calculator (Kalkulačka Ta) metodu počítání párů bází pro sekvence 14 párů
bází (bp) nebo méně.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

kde w, x, y a z jsou počty bází A, T, G, a C v daném pořadí.

Metoda „nejbližších sousedů“

Pro sekvence delší než 14 párů bází (bp) se používá metoda nejbližšího souseda. V metodě nejbližších
sousedů jsou výpočty teploty tání založeny na termodynamickém vztahu mezi entropií (pořadí nebo míra
náhodnosti oligonukleotidu), entalpií (teplo uvolněné nebo absorbované oligonukleotidem), volnou
energií a teplotou.

∆H = ∆G + T* ∆S

kde:

n ∆H = hodnota entalpie, cal/mol*K

n T = teplota, Kelvin

n ∆S = hodnota entropie, cal/mol*K

n ∆G = Gibbsova volná energie v cal/mol*K

Změna entropie a entalpie se vypočítá přímo součtem hodnot pro nukleotidové páry uvedené v Tabulka 8
(Breslauer et al. 1986).

Vztah mezi volnou energií a koncentrací reaktantů a produktů v rovnováze je dán vztahem:

∆G = R*T*ln ((DNA * Primer)/(DNA + Primer))

kde R je plynová konstanta (1,986 cal/mol*K).

Nahrazení G ve dvou rovnicích a řešení pro T dává

T = ∆H/(∆S + R*Ln((DNA * Primer)/(DNA + Primer)))

za předpokladu, že koncentrace komplexu DNA a DNA-primeru je stejná.

Empiricky bylo stanoveno, že během přechodu z jednovláknové DNA na B-formu existuje 5 kcal volné
energie (3,4 kcal) (Sugimoto et al. 1996). To je pravděpodobně spirálová iniciační energie. Přidání úpravy
pro sůl nakonec dává rovnici, kterou kalkulačka Ta používá:

T = (∆H – 5(KCal/K*mol))/(∆S + (R * ln(1/(primer)))) + 16.6 log10 (molarita soli)
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Nastavení konstantní hodnoty pro koncentraci soli není třeba vzhledem k tomu, že parametry byly
stanoveny při 1 M NaCl a hodnota log10 z 1 je nula.

Termodynamické výpočty předpokládají, že nasedání primerů probíhá při pH 7,0. Výpočty Tm
předpokládají, že sekvence nejsou symetrické a obsahují alespoň jednu G nebo C.

Oligonukleotidová sekvence by měla být alespoň 14 bází dlouhá, aby poskytla rozumné hodnoty Tm.
Méně než 14 bází používá metody párování základních párů (viz Tabulka 8 níže).

Interakce ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabulka 8. Breslauerovy interakční konstanty
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Použití nástroje Ta Calculator (Kalkulačka Ta)

Jak používat nástroj Ta Calculator (Kalkulačka Ta)

1. Abyste otevřeli nástroj Ta Calculator (Kalkulačka Ta), postupujte následovně:

n Pokud se aktuálně nacházíte v nástroji Protocol AutoWriter (Automatický generátor protokolu),
klikněte na T a Calculator (Kalkulačka Ta).

n V okně Home (Domů) vyberte položky Tools (Nástroje) > Ta Calculator (Kalkulačka Ta).

Otevře se dialogové okno Ta Calculator (Kalkulačka Ta).

2. Do textového rámečku Forward Primer (Přední primer) zadejte nebo vložte sekvenci předního
primeru.

Tip: Pro zadání sekvence můžete rovněž využít tlačítka A, T, G, C na levé straně dialogového
okna.

3. Do textového rámečku Reverse Primer (Zadní primer) zadejte nebo vložte sekvenci zadního primeru.

4. Klikněte na Calculate (Vypočítat).
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Nástroj Ta Calculator (Kalkulačka T a) vypočítá a zobrazí Tm pro každý primer a průměrné hodnoty
Tm a Ta , například:

Pokud jsou hodnoty Tm primerů více než 4 °C od sebe, použije nástroj Protocol AutoWriter
(Automatický generátor protokolu) nižší hodnotu Tm primerů + 2 °C jako základ pro výpočet hodnoty
Ta, kterou můžete dále upravit změnou enzymu a rychlosti reakce.

Nástroj Ta Calculator (Kalkulačka Ta) vygeneruje teplotu nasedání primerů pro standardní rychlost
s polymerázou iTaq DNA. Při použití jiného enzymu nastavení rychlosti automaticky upraví hodnotu
Ta.

5. Postupujte následovně:

n Pokud jste nástroj Ta Calculator (Kalkulačka Ta) otevřeli z nástroje Protocol AutoWriter
(Automatický generátor protokolu), klikněte na OK. Vrátíte se do nástroje Protocol AutoWriter
(Automatický generátor protokolu). Teplota nasedání primerů se automaticky upraví.

n Pokud jste nástroj Ta Calculator (Kalkulačka Ta) otevřeli z nabídky Tools (Nástroje),
zaznamenejte si výpočty a klikněte na možnost Cancel (Zrušit). Kalkulačka se zavře.
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Soubor destičky obsahuje informace o parametrech běhu, jako je režim skenování, fluorofory a obsah
jamky. Po běhu Software CFX Maestro Dx, bezpečnostní edice propojí obsah jamky s fluorescenčními
daty shromážděnými během experimentu a v okně Data Analysis (Analýza dat) zobrazí průběh příslušné
analýzy. Např. pro vytvoření standardní křivky jsou využity jamky obsahující vzorky standardu.

CFX Maestro Dx SE poskytuje dvě možnosti pro přípravu destiček: Spustí se Plate Editor (Editor
destiček) pro PCR v reálném čase a Setup Wizard (Průvodce nastavením) pro analýzu normalizované
genové exprese.

Plate Editor (Editor destiček) obsahuje následující funkce:

n standardní fluorofory a typy vzorků, které mají být přiřazeny jamkám destiček;

n možnost nastavit referenční produkt a kontrolní vzorek pro analýzu genové exprese;

n možnost upravovat nastavení destičky před spuštěním běhu, v jeho průběhu nebo až po dokončení;

n možnost ukládat soubory destiček pro opakované použití;

n možnost vytisknout soubor destičky na výchozí tiskárnu.

Setup Wizard (Průvodce nastavením) vás provede vytvořením destičky pro analýzu normalizované
genové exprese. Nástroj Setup Wizard (Průvodce nastavením) můžete použít před během, v jeho
průběhu i po něm.
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Okno Plate Editor (Editor destiček)
Pomocí nástroje Plate Editor (Editor destiček) můžete vytvářet vlastní destičky nebo měnit existující
destičky.

1. Panel nabídek poskytuje rychlý přístup k příkazům nabídek File (Soubor) a Settings
(Nastavení) i k možnostem nástrojů pro úpravu destiček.

2. Panel nástrojů poskytuje rychlý přístup k důležitým funkcím zakládání destiček.

3. Hlavní podokno obsahuje přehled destičky a možnosti pro destičku, které můžete použít.

4. Pravé podokno obsahuje možnosti, kterými můžete svou destičku přizpůsobit.

5. Spodní podokno zobrazuje typ destičky a poskytuje rychlý přístup k možnostem zobrazení.

LEGENDA

Příkazy nabídky File (Soubor)
Save (Uložit) – uloží datový soubor destičky do umístění stanoveného na kartě File (Soubor)
v dialogovém okně User Preferences (Uživatelské předvolby). Více informací naleznete v části Změna
výchozího nastavení souboru na straně 83. Tato položka nabídky je dostupná pouze při vytváření nového
souboru destičky.
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Save As (Uložit jako) – uloží otevřený soubor destičky s novým názvem, který zadáte. Tato položka
nabídky je dostupná pouze při vytváření nového souboru destičky.

File Passwords (Hesla souborů) – umožňuje uživatelům nastavit hesla pro ukládání souborů a otevření
souborů.

Extract Plate (Vybrat destičku) – otevře dialogové okno, ve kterémmůžete vybrat/uložit soubor
destičky (.pltd). Tato položka nabídky je dostupná pouze při zobrazení nebo úpravách existujícího
souboru destičky.

Print (Tisk) – vytiskne otevřený datový soubor destičky.

Close (Zavřít) – zavře nástroj Plate Editor (Editor destiček).

Příkazy nabídky Edit (Upravit)
Undo (Vrátit zpět) – vrátí zpět změnu souboru destičky, dokud nebude soubor uložen.

Redo (Znovu) – vrátí zpět poslední akci Undo (Zrušit), pokud nebyl soubor destičky uložen.

Příkazy karty Settings (Nastavení)
Plate Size (Velikost destičky) – dialogové okno poskytuje možnosti, ze kterých můžete vybrat velikost
destičky pro daný běh.

Poznámka: Velikost destičky musí být totožná jako velikost bloku na přístroji, na kterém je běh
prováděn.

96jamková se hodí pro:

n CFX Opus 96 Dx

n CFX Opus Deepwell Dx

384jamková se hodí pro:

n CFX Opus 384Dx

Plate Type (Typ destičky) – umožňuje vybrat typ jamek na destičce, na které jsou uloženy vzorky, buď
jako BRWhite (BR bílá), nebo BR Clear (BR čirá). Pro přesnou analýzu dat musí být zvolený typ destičky
shodný s typem destičky použitým v běhu.

Poznámka: Je nutné provést kalibraci nových typů destiček. Více informací je uvedeno v části
Kalibrace nových barviv na straně 75.

Number Convention (Konvence čísel) – umožňuje vybrat nebo zrušit výběr možností zobrazení
jednotek ve formátu vědeckého zápisu. Výchozí nastavení je zobrazení jednotek ve formátu vědeckého
zápisu.
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Units (Jednotky) – umožňuje vybrat jednotky, které se mají zobrazovat v tabulkách při kvantifikaci
neznámých hodnot oproti standardní křivce.

Úprava příkazů nabídky Tools (Nástroje)
Setup Wizard (Průvodce nastavením) – otevře nástroj Setup Wizard (Průvodce nastavením), ve
kterémmůžete definovat parametry rozložení a analýzy pro aktuální destičku. Nástroj Setup Wizard
(Průvodce nastavením) můžete použít před spuštěním běhu, během něj i po jeho dokončení.

Spreadsheet View/Importer (Zobrazení/import tabulky)– otevře dialogové okno View (Zobrazit), které
ukazuje nastavení destičky jako šablonu ve formátu tabulky. V tomto dialogovém okně můžete exportovat
nebo importovat data o šabloně destičky ve formátu .csv.

Flip Plate (Otočit destičku) – otočí obsah destičky o 180o.

Příkazy panelu nástrojů

Vrátí změnu destičky. CFX Maestro Dx SE podporuje až deset akcí zpět

Obrátí poslední akci Undo (Vrátit zpět). CFX Maestro Dx SE podporuje až
deset opakovaných akcí.

Uloží aktuální soubor destičky.

Zobrazí rozevírací seznam, ze kterého můžete zvýšit nebo snížit zvětšení
náhledu destičky.

Zobrazí rozevírací seznam, ze kterého můžete vybrat režim skenování,
jenž přístroji řekne, ze kterých kanálů má v průběhu experimentu sbírat
fluorescenční data.

Otevře nástroj Well Groups Manager (Správce skupin jamek), ve kterém
můžete vytvářet skupiny jamek pro aktuální destičku.

Zobrazí dialogové okno, ve kterémmůžete zvolit barvy a symboly pro
amplifikační křivky.

Otevře dialogové okno View (Zobrazit), které ukazuje nastavení destičky
jako šablonu ve formátu tabulky. V tomto dialogovém okně můžete
exportovat nebo importovat data o šabloně destičky ve formátu .csv.

Otevře nástroj Setup Wizard (Průvodce nastavením), ve kterém můžete
definovat parametry rozložení a analýzy pro aktuální destičku. Nástroj
Setup Wizard (Průvodce nastavením) můžete použít před během, v jeho
průběhu i po něm.
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Otevře kartu Plate (Destička) v dialogovém okně User Preferences
(Uživatelské předvolby), na které můžete definovat parametry nastavení
destičky a vytvářet nebo odstraňovat názvy produktů, vzorků
a biologických skupin. Změny, které provedete na kartě Plate (Destička),
budou dostupné při příštím otevření nástroje Plate Editor (Editor
destiček).

Zobrazí nezbytné kroky pro přípravu a nastavení destičky a jamek.
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Vytvoření souboru destičky pomocí Plate Editor (Editor
destiček)

Pomocí nástroje Plate Editor (Editor destiček) můžete vytvářet vlastní design destičky. Můžete také
upravovat a ukládat již uložené soubory destiček nebo soubory vzorku, které byly součástí dodávky pro
Systém CFX Opus Dx.

Abyste vytvořili nový soubor destičky, postupujte následovně:

n Otevřete soubor destičky v nástroji Plate Editor (Editor destiček).

n Vyberte typ destičky.

Poznámka: Typ destičky pro soubor destičky musí být stejný jako destička v reakčním modulu.

n Vyberte režim skenování, který má být použit v protokolu.

n Vyberte fluorofory, které budou použity na destičce.

n Vyberte typy vzorků, produkty a vzorky.

n V případě potřeby vyberte technické replikáty.

n Uložte uspořádání destičky.

Tip: Chcete-li vytvořit novou destičku z dříve uložených nebo souborů destiček, viz Otevření
existujícího souboru destičky v nástroji Plate Editor (Editor destiček) na straně 132.

Otevření nového souboru destičky v nástroji Plate Editor (Editor
destiček)
CFX Maestro Dx SE nabízí několik možností, jak otevřít nový soubor destičky:

n Z okna Home (Domů)

n Z dialogového okna Startup Wizard (Průvodce spuštěním)

n Z dialogového okna Run Setup (Nastavení běhu)

Jak otevřít nový soubor destičky z okna Home (Domů)

u Vyberte možnost File > New Plate (Soubor > Nová destička).

Otevře se okno Plate Editor (Editor destiček), které zobrazí výchozí soubor destičky pro vybraný
přístroj.

Tip: Informace o nastavení vašeho výchozího souboru destičky jsou uvedeny v části Změna
výchozího nastavení souboru na straně 83.
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Jak otevřít nový soubor destičky z nástroje Startup Wizard (Průvodce spuštěním)

1. V okně Home (Domů) postupujte následovně, abyste otevřeli nástroj Startup Wizard (Průvodce
spuštěním), pokud ještě není otevřen:

n Vyberte možnost View > Startup Wizard (Zobrazit > Průvodce spuštěním).

n Na panelu nástrojů klikněte na Startup Wizard (Průvodce spuštěním).

2. V případě potřeby vyberte typ přístroje z rozevíracího seznamu.

3. Pro vytvoření nové destičky klikněte na User-defined (Definovaný uživatelem) jako typ běhu.

Otevře se dialogové okno Run Setup (Nastavení běhu), které obsahuje kartu Protocol (Protokol).

4. Klikněte na kartu Plate (Destička) a na možnost Create New (Vytvořit novou).

Otevře se okno Plate Editor (Editor destiček), které zobrazí výchozí nastavení destičky pro vybraný
přístroj.

Jak otevřít nový soubor destičky z dialogového okna Run Setup (Nastavení běhu)

1. V okně Home (Domů) postupujte následovně, abyste otevřeli dialogové okno Run Setup (Nastavení
běhu):

n Vyberte možnost Run > User-defined Run (Běh > Běh definovaný uživatelem).

n Na panelu nástrojů klikněte na možnost User-defined Run Setup (Nastavení běhu definovaného
uživatelem).

Otevře se dialogové okno Run Setup (Nastavení běhu) na kartě Protocol (Protokol).

2. Abyste vytvořili novou destičku, klikněte na kartu Plate (Destička) a na možnost Create New (Vytvořit
novou).

Otevře se okno Plate Editor (Editor destiček), které zobrazí výchozí nastavení destičky pro vybraný
přístroj.
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Otevření existujícího souboru destičky v nástroji Plate Editor
(Editor destiček)
CFX Maestro Dx SE nabízí vzorové protokoly, které můžete upravovat a ukládat jako vlastní nové
soubory. Můžete také vytvořit nový soubor destičky z dříve uloženého souboru destiček.

Otevření souboru destičky

1. V okně Home (Domů) vyberte položky File > Open > Plate (Soubor > Otevřít > Destička).

Průzkumník Windows otevře složku Systém CFX Opus Dx Sample files (Soubory vzorků).

2. Otevřete složku Sample files (Soubory vzorků) a potom otevřete složku Plates (Destičky).

3. Vyberte soubor destičky a klikněte na Open (Otevřít).

Otevře se vzorový soubor destičky v okně Plate Editor (Editor destiček).

4. Vyberte File > Save As (Soubor > Uložit jako) a uložte soubor destičky s novým názvem nebo do
nové složky.

Otevření předchozího uloženého souboru destičky

1. V okně Home (Domů) postupujte následovně:

n Vyberte položky File > Open > Plate (Soubor > Otevřít > Destička), přejděte na cílovou destičku
a klikněte na položku Open (Otevřít).

n Otevřete Startup Wizard (Průvodce spuštěním) a postupujte následovně:

o Chcete-li upravit existující soubor destičky, klikněte na tlačítko Select Existing (Vybrat
existující) a přejděte na cílový soubor.

o Chcete-li zobrazený soubor destičky upravit, klikněte na tlačítko Edit Selected (Upravit
vybraný).

Otevře se cílová destička v okně Plate Editor (Editor destiček).

2. Vyberte File > Save As (Soubor > Uložit jako) a uložte soubor destičky s novým názvem nebo do
nové složky.
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Nastavení nového souboru destičky
Tip: Pokud váš soubor destičky obsahuje požadované parametry (například pokud upravujete
vzorek nebo existující soubor destičky), můžete tuto část přeskočit. Přejděte na část Přiřazení
volitelných parametrů k souboru destičky na straně 140.

Nové soubory destičky vyžadují následující parametry:

n Plate size (Velikost destičky),

n Plate type (Typ destičky),

n režim skenování,

n jeden fluorofor (barvivo),

n jeden typ vzorku.

Výběr velikosti a typu destičky

Důležité: Velikost destičky musíte vybrat během nastavení destičky. V době běhu nebo po něm
nemůžete velikost destičky měnit.

Software použije v průběhu experimentu velikost a typ destičky pro všechny jamky. Ujistěte se, že
vybraná velikost destičky je stejná jako destička, kterou jste zvolili.

CFX Opus Dx Bio-Rad jsou z výroby nakalibrované na mnoho kombinací barviv a destiček. Kalibrace platí
pouze pro daný přístroj, barvivo a typ destičky. Ujistěte se, že fluorofor, který chcete použít, je pro vybraný
typ destičky kalibrován.

Tip: Pokud chcete na přístroji kalibrovat novou kombinaci barviva a typu destičky, vyberte možnost
Tools > Calibration Wizard (Nástroje > Průvodce kalibrací). Informace o kalibraci barviv a typů
destiček jsou uvedeny v části Kalibrace nových barviv na straně 75.

Výběr režimu skenování

Systémy CFX Opus 96 Dx a CFX Opus Deepwell Dx excitují a detekují fluorofory v pěti kanálech (plus
FRET). Systémy CFX Opus 384 Dx excitují a detekují fluorofory ve čtyřech kanálech (plus FRET).
Všechny systémy používají více režimů snímání dat pro sběr dat fluorescence během běhu.

CFX Maestro Dx SE poskytuje tři režimy skenování:

n All Channels (Všechny kanály)

o Skenuje kanály 1 až 5 na systémech CFX Opus 96 Dx a CFX Opus Deepwell Dx

o Skenuje kanály 1 až 4 na systémech CFX Opus 384 Dx
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n SYBR®/FAM

o Skenuje pouze kanál 1

o Provádí rychlé skenování

n FRET

o Skenuje pouze kanál FRET

o Provádí rychlé skenování

Výběr fluoroforů

Důležité: Před zahájením běhu systémy CFX ověří, zda jsou vámi uvedené fluorofory na destičce
kalibrovány pro daný přístroj. Není možné zpracovat destičku, pokud obsahuje fluorofory, které
nebyly pro příslušný přístroj kalibrovány.

Před běhemmusíte založit alespoň jeden fluorofor. Můžete definovat rovnou všechny potřebné fluorofory,
nicméně pro zahájení běhu musí destička obsahovat alespoň jeden. V nabídce Target Names (Názvy
produktů) se objeví vybrané fluorofory.

Pomocí dialogového okna Select Fluorophores (Vybrat fluorofory) načtete fluorofory (nebo barviva
destičky), které jsou k dispozici v nástroji Plate Editor (Editor destiček). Fluorofory, které se objeví
v dialogovém okně Select Fluorophores (Vybrat fluorofory), závisí na vámi vybraném režimu skenování:

n All Channels (Všechny kanály)

Jsou zobrazeny všechny dostupné fluorofory.

Tip: Můžete přidat více fluoroforů, avšak pouze jeden fluorofor na jeden kanál v každé jamce.

n SYBR®/FAM

Zobrazí se pouze fluorofory pro kanál 1.

n FRET

Zobrazí se pouze fluorofor pro kanál 6.

Tip: Fluorofor FRET pro kanál 6 bude zobrazen pouze v případě, že je vybraným režimem
skenování FRET. Tato možnost není k dispozici pro režim skenování All Channels (Všechny
kanály).

Poznámka: Není možné fluorofory přímo přidávat nebo odstraňovat z dialogového okna Select
Fluorophore (Vybrat fluorofor). Musíte provést kalibraci nových fluoroforů pro přístroj pomocí nástroje
Dye Calibration Wizard (Průvodce kalibrací barviva). Po kalibraci je nový fluorofor automaticky přidán
do tohoto seznamu. Více informací je uvedeno v části Kalibrace nových barviv na straně 75.
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Výběr typů vzorků

Důležité: Před zahájením běhu je třeba vybrat alespoň jeden typ vzorku na destičce.

CFX Maestro Dx SE nabízí pět typů vzorků:

n Unknown (Neznámý)

n Standard

n NTC (Kontrola bez templátu)

n Positive Control (Pozitivní kontrola)

n Negative Control (Negativní kontrola)

n NRT (Kontrola bez reverzní transkriptázy)

Typy vzorků přiřazujete k jednotlivým jamkám destičky.

Nastavení nové destičky

Nastavení nové destičky

1. Otevřete novou destičku v okně Plate Editor (Editor destiček).

2. Chcete-li nastavit velikost destičky, vyberte Settings > Plate Size (Nastavení > Velikost destičky)
a vyberte příslušnou velikost destičky z rozevírací nabídky.

3. Chcete-li nastavit typ desky, vyberte možnost Settings > Plate Type (Nastavení > Typ destičky)
a v rozevírací nabídce vyberte možnost buď BRWhite (BR bílá), nebo BR Clear (BR čirá).

4. Volitelně můžete v nabídce Settings (Nastavení) změnit konvence čísel a jednotky zobrazení:

n Chcete-li změnit konvenci čísel, vyberte Settings > Number Convention (Nastavení > Konvence
o číslech) a vyberte položku Scientific Notation (Vědecký zápis).

Tip: Ve výchozím nastavení je vybrán Scientific Notation (Vědecký zápis). V tomto případě
výběr Scientific Notation (Vědecký zápis) zruší výchozí nastavení a nastaví konvenci
o číslech do standardní formy.

n Chcete-li změnit jednotky zobrazení, zvolte Settings > Units (Nastavení > Jednotky) a vyberte
novou hodnotu jednotky.

5. Chcete-li nastavit režim skenování, vyberte příslušný režim skenování z rozevíracího seznamu Scan
Mode (Režim skenování) na panelu nástrojů okna Plate Editor (Editor destiček) .

Uživatelská příručka | 135



Kapitola 8 Příprava destiček

6. Vyberte potřebné fluorofory pro destičku:

a. V pravém podokně klikněte na tlačítko Select Fluorophores (Vybrat fluorofory).

Zobrazí se dialogové okno Select Fluorophores (Vybrat fluorofory). Uvidíte fluorofory dostupné
pro zvolený režim skenování v Krok 5, příklad:

b. Chcete-li vybrat fluorofor, klikněte na zaškrtávací políčko Selected (Vybrané).

Tip: Chcete-li odstranit fluorofor ze seznamu, odškrtněte zaškrtávací políčko Selected
(Vybrané).

c. Chcete-li změnit barvu zobrazení fluoroforu, klikněte na jeho pole Color (Barva).

Poznámka: Vybraná barva reprezentuje fluorofor jak v okně Plate Editor (Editor destiček),
tak v grafu Data Analysis (Analýza dat).

d. V dialogovém okně Color (Barva) vyberte požadovanou barvu nebo klikněte na tlačítko Define
Custom Colors (Definovat vlastní barvy) a vytvořte novou barvu, která bude představovat
fluorofor.

e. Kliknutím na tlačítko OK uložte změny a ukončete dialogové okno Select Fluorophores (Vybrat
fluorofory).
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7. Musíte vybrat alespoň jednu jamku, do které chcete načíst typ vzorku. Ve výchozím nastavení je
vybrána jamka A1.

V podokně tabulky postupujte následovně:

n Chcete-li načíst více sousedních jamek, klikněte na jamku a táhněte až k cílové jamce.

n Chcete-li načíst více nesousedících jamek, podržte klávesu Control a klikněte na každou jamku.

n Chcete-li načíst celý sloupec se stejným typem vzorku, klikněte na číslo sloupce.

n Chcete-li načíst celý řádek, klikněte na číslo řádku.

n Chcete-li načíst celou destičku, klikněte na levý horní roh destičky.

Například:

8. V rozevírací nabídce Sample Type (Typ vzorku) přiřaďte vybrané jamce nebo jamkám typ vzorku.
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9. Přiřaďte alespoň jeden fluorofor do všech jamek, které obsahují typ vzorku. Do jamky nebo skupiny
jamek můžete přiřadit více než jeden fluorofor.

Poznámka: Na každý kanál můžete přiřadit pouze jeden fluorofor. Nelze přiřadit více než jeden
fluorofor ze stejného kanálu do stejné jamky.

Tip: Fluoroforu můžete přiřadit produkt nebo můžete přiřadit do jamky v tomto okamžiku pouze
fluorofor a po provedení experimentu přiřadit produkt k fluoroforu.

n Chcete-li vybraným jamkám přiřadit pouze fluorofor, v části Target Names (Názvy produktu)
v pravém podokně označte zaškrtávací políčko Load (Načtení) pro konkrétní fluorofor.

n Chcete-li přiřadit fluoroforu produkt, vyberte v části Target Names (Názvy produktu)
z rozevíracího seznamu název produktu pro konkrétní fluorofor. Software automaticky vybere
zaškrtávací políčko Load (Načíst).

10. U jamek, které obsahují typ vzorku Standard, musíte načíst koncentraci. Každá jamka může mít jinou
hodnotu koncentrace. Standardně software CFX Maestro Dx SE načítá koncentraci 1,00E+06 do
všech jamek s typem vzorku Standard. V případě potřeby můžete hodnotu změnit.

a. V podokně destičky vyberte jamku nebo skupinu jamek Standard.

b. V části Concentration (Koncentrace) klikněte na Load (Načíst) a načtěte hodnotu do vybrané
jamky nebo vybraných jamek.

c. (Volitelné) Chcete-li načíst jinou koncentraci, zadejte novou hodnotu do textového pole
Concentration (Koncentrace) a stiskněte klávesu Enter.

d. Tento krok proveďte pro všechny jamky se vzorkem typu Standard.

Tip: Pro načtení stejné koncentrace do všech jamek Standard se ujistěte, že se zobrazuje
v rozevíracím seznamu pod hodnotou Concentration (Koncentrace) možnost <All>
(<Všechny>). Pro načtení stejné hodnoty koncentrace do všech jamek se specifickým
fluoroforem klikněte na rozevírací seznam a vyberte fluorofor.

11. Klepnutím na OK novou destičku uložíte.
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Položky nabídky Plate Editor Tool (Nástroj editoru destiček) po kliknutí pravým
tlačítkem myši

Tabulka 9 uvádí seznam položek nabídky dostupné v nástroji Plate Editor (Editor destiček) poté, když
v nástroji kliknete pravým tlačítkemmyši na jakoukoliv jamku. Tato nabídka se zobrazuje také v nástroji
Spreadsheet View/Importer (Zobrazení/Import tabulky).

Položka Funkce

Copy (Kopírovat) Zkopíruje celou tabulku.

Copy as Image
(Kopírovat jako
obrázek)

Zkopíruje tabulku jako soubor obrázku.

Print (Tisk) Vytiskne tabulku.

Print Selection
(Vytisknout výběr)

Vytiskne pouze vybrané buňky.

Export to Excel (Export
do aplikace Excel)

Exportuje soubor do tabulky aplikace Excel.

Export to CSV (Export
do souboru CSV)

Exportuje soubor jako soubor .csv.

Export to Xml (Export
do souboru XML)

Exportuje soubor jako soubor .xml.

Export to Html (Export
do souboru HTML)

Exportuje soubor jako soubor .html.

Find (Najít) Vyhledá konkrétní text.

Sort (Řazení) Seřadí tabulku na základě výběru až tří sloupců dat v okně Sort
(Řazení).

Tabulka 9. Na položky nabídky nástroje Plate Spreadsheet View/Importer
(Zobrazení/import tabulky destiček) klikněte pravým tlačítkem myši

Uživatelská příručka | 139



Kapitola 8 Příprava destiček

Přiřazení volitelných parametrů k souboru destičky
Soubor destičky obsahuje informace o obsahu každé jamky, která obsahuje vzorek v připraveném
experimentu. Po ukončení běhu software CFX Maestro Dx SE propojí obsah jamky s fluorescenčními
daty shromážděnými během protokolu a v okně Data Analysis (Analýza dat) zobrazí příslušnou analýzu.

Pomocí softwaru CFX Maestro Dx SE můžete přiřazovat parametry každé jamce na destičce před
provedením experimentů, během nich nebo i po nich. Parametry můžete přiřadit k existujícímu nebo
novému souboru destičky. Tyto parametry zahrnují:

n Target names (Názvy produktů) – vybraný produkt (geny nebo sekvence) v každé definované
jamce.

n Sample names (Názvy vzorků) – identifikátor nebo podmínka, která odpovídá vzorku v každé
konkrétní jamce, například myš1, myš2 nebo myš3.

n Biological groups (Biologické skupiny) – identifikátor nebo podmínka, která odpovídá skupině
jamek, například 0hod, 1hod nebo 2hod.

Tip: Názvy produktů, názvy vzorků a biologické skupiny musejí být mezi jamkami stejné, aby
bylo možné srovnávat data na kartě Gene Expression (Genová exprese) v okně Data Analysis
(Analýza dat). Každý název musí obsahovat stejná velká písmena, interpunkci a mezery.
Například název „Actin“ není stejný jako „aktin“, „2Hr“ není stejný jako „2 h“ a „Myš 1“ není stejný
jako „myš 1“. Chcete-li zajistit konzistenci pojmenování, zadejte názvy v sekci (Libraries)
Knihovny v části User > User Preferences > Plate (Uživatel > Uživatelské předvolby > Destička),
která je k dispozici v okně Home (Domů).

n Technical replicates (Technické replikáty) – všechny jamky použité k analýze identického
vzorku; tj. qPCR replikáty.

n Dilution series (Série ředění) – série ředění pro změnu koncentrace typu vzorku Standard ve
skupině replikátů, zdroj dat pro vytvoření standardní křivky k analýze.

Přiřazení produktu jamkám
Tip: Jedné nebo několika jamkámmůžete přiřadit stejný název produktu. Rovněž můžete přiřadit
několik produktů jedné jamce.

Důležité: Kliknutím na OK po přiřazení produktu uložíte změny a deaktivujete možnost Undo (Vrátit
zpět) na panelu nástrojů Plate Editor (Editor destiček). Při kliknutí na OK postupujte opatrně.
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Jak přiřadit produkt jamce nebo skupině jamek

1. V nástroji Plate Editor (Editor destiček) se ujistěte, že je jamce nebo skupině jamek přiřazen typ
vzorku.

Další informace o přiřazení typů vzorku jamkám jsou uvedeny v části Výběr typů vzorků na straně
135.

2. Na panelu destiček vyberte jamku nebo skupinu jamek:

n Chcete-li vybrat jednu jamku, klikněte na ni.

n Chcete-li vybrat více sousedních jamek, klikněte na jamku a táhněte až k cílové jamce.

n Chcete-li vybrat více nesousedících jamek, podržte klávesu Control a klikněte na každou jamku.

n Chcete-li vybrat celý sloupec se stejným typem vzorku, klikněte na číslo sloupce.

n Chcete-li vybrat celý řádek, klikněte na číslo řádku.

3. V pravém podokně vyberte z rozevíracího seznamu Target Name (Název produktu) název pro každý
vybraný fluorofor.

4. Opakujte Krok 3 pro každou jamku nebo skupinu jamek, kterým musíte přiřadit produkt.

Tip: Každému vybranému fluoroforu můžete přiřadit stejný nebo odlišný název produktu.

5. Klikněte na tlačítko OK, aby se potvrdily změny a uložila destička.

Poznámka: Pokud jste destičku omylem změnili, klikněte na Undo (Vrátit zpět) na panelu
nástrojů Plate Editor (Editor destiček) , než kliknete pro potvrzení změn na OK.

Jak odstranit název produktu

u Abyste odstranili název produktu z vybrané jamky nebo skupiny jamek, odznačte její zaškrtávací
políčko Load (Načíst).

Důležité: Odstraněním názvu produktu z jamky se rovněž odstraní příslušný fluorofor. Při
odstraňování názvu produktu z jamky postupujte opatrně.

Jak přidat název produktu do seznamu

u Chcete-li do rozevíracího seznamu přidat název produktu, postupujte následovně:
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n Do rozevíracího seznamu Target Name (Název produktu) zadejte název a stiskněte Enter.

Tip: Názvy produktů, které přidáte do jednoho seznamu, se objeví ve všech ostatních
seznamech produktů.

n Klikněte na zelený symbol + napravo od rozevíracího seznamu, zadejte název pro produkt a
stiskněte Enter.

n Na panelu nástrojů klikněte na položku User Preferences (Uživatelské předvolby) a přidejte
název do knihovny Target Names (Názvy produktů) na kartě Plate (Destička).

Důležité: Názvy produktů, které jste přidali do rozevíracího seznamu, budou dostupné pouze
pro aktuální destičku a pouze v případě, že název přiřadíte k jamce a uložíte rozvržení destičky.
Pokud název nepřiřadíte k jamce a neuložíte rozvržení destičky, název se neuloží a nebude
v budoucnu dostupný. Chcete-li název produktu přidat natrvalo, přidejte jej také do knihovny
Target Names (Názvy produktů) pomocí dialogového okna User Preferences (Uživatelské
předvolby). Názvy, které přidáte do knihovny, jsou k dispozici poté, co znovu otevřete Plate
Editor (Editor destiček). Více informací naleznete v části Nastavení výchozích parametrů
destičky na straně 86.

Jak odstranit název produktu ze seznamu

1. Na panelu nástrojů klikněte na položku User Preferences (Uživatelské předvolby).

Dialogové okno User Preferences (Uživatelské předvolby) zobrazí kartu Plate (Destička).

2. V knihovně Target Names (Názvy produktů) na kartě Plate (Destička) vyberte název, který chcete
odstranit, a stiskněte tlačítko Delete (Odstranit).

3. Klikněte na OK , aby se změny uložily, a opusťte dialogové okno User Preferences (Uživatelské
předvolby).

Důležité: Názvy produktů, které jste uložili se souborem destičky, nelze odstranit. Vlastní názvy,
které přidáte do rozevíracího seznamu Target Names (Názvy produktů), nepoužijete je
a neuložíte je s destičkou, jsou ze seznamu automaticky odstraněny. Názvy, které odstraníte
z knihovny Target Names (Názvy produktů), jsou ze softwaru trvale odstraněny a uživatelům již
nejsou k dispozici. Při odstraňování názvů produktů postupujte opatrně.

Přiřazení názvu vzorku jamkám
Poznámka: Pro přiřazení názvu vzorku musíte vybraným jamkám přiřadit alespoň jeden fluorofor.
Pokud vybraným jamkám není přiřazen fluorofor, rozevírací seznam Sample Names (Název vzorku)
bude neaktivní. Další informace o přiřazení fluoroforů naleznete v části Přiřazení produktu jamkám
na straně 140.

Tip: Ke každé jamce nebo skupině jamek můžete přiřadit pouze jeden název vzorku.
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Přiřazení názvu vzorku k jamce nebo skupině jamek

1. V nástroji Plate Editor (Editor destiček) zkontrolujte, zda byl k jamce nebo skupině jamek přiřazen
fluorofor.

2. V podokně destiček vyberte jamku nebo skupinu jamek.

3. V pravém podokně vyberte z rozevíracího seznamu název Sample Names (Název vzorku).

Software automaticky vybere zaškrtávací políčko Load (Načíst).

4. Opakujte Krok 3 pro každou jamku nebo skupinu jamek, kterým musíte přiřadit název vzorku.

5. Klikněte na tlačítko OK, aby se potvrdily změny a uložila destička.

Poznámka: Pokud jste destičku omylem změnili, klikněte na Undo (Vrátit zpět) na panelu
nástrojů Plate Editor (Editor destiček) , než kliknete pro potvrzení změn na OK.

Odstranění názvu vzorku

u K odstranění názvu vzorku z vybrané jamky nebo skupiny jamek zrušte zaškrtnutí políčka Load
(Načíst).

Přidání názvu vzorku do seznamu

u Chcete-li do rozevíracího seznamu přidat název vzorku, postupujte následovně:

n Do rozevíracího seznamu Sample Names (Název vzorku) zadejte název a stiskněte Enter.

n Klikněte na zelený symbol + napravo od rozevíracího seznamu a zadejte název pro vzorek.

n Na panelu nástrojů klikněte na položku User Preferences (Uživatelské předvolby) a přidejte
název do knihovny Sample Names (Název vzorku) na kartě Plate (Destička).

Důležité: Název vzorku, který jste přidali do rozevíracího seznamu, bude dostupný pouze pro
aktuální destičku a pouze v případě, že název přiřadíte k jamce a uložíte rozvržení destičky.
Pokud název nepřiřadíte k jamce a neuložíte rozvržení destičky, název se neuloží a nebude
v budoucnu dostupný. Chcete-li trvale přidat název vzorku, přidejte ho také do knihovny Sample
Names (Název vzorku) pomocí dialogového okna User Preferences (Uživatelské předvolby).
Názvy, které přidáte do knihovny, jsou k dispozici poté, co znovu otevřete Plate Editor (Editor
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destiček). Více informací naleznete v části Nastavení výchozích parametrů destičky na straně
86.

Odstranění názvu vzorku ze seznamu

1. Na panelu nástrojů klikněte na položku User Preferences (Uživatelské předvolby).

Dialogové okno User Preferences (Uživatelské předvolby) zobrazí kartu Plate (Destička).

2. V knihovně Sample Names (Název vzorku) na kartě Plate (Destička) vyberte název, který chcete
odstranit, a stiskněte tlačítko Delete (Odstranit).

3. Klikněte na OK , aby se změny uložily, a opusťte dialogové okno User Preferences (Uživatelské
předvolby).

Důležité: Názvy vzorku, které jste uložili se souborem destičky, nelze odstranit. Vlastní názvy,
které přidáte do rozevíracího seznamu Sample Names (Název vzorku) a nepoužíváte a uložíte
je s destičkou, jsou automaticky odstraněny ze seznamu. Názvy, které odstraníte z knihovny
Sample Names (Název vzorku), jsou ze softwaru trvale odstraněny a uživatelům již nejsou k
dispozici. Při odstraňování názvů vzorku buďte opatrní.

Přiřazení biologických skupin jamkám
Poznámka: Pro přiřazení biologické skupiny musíte vybraným jamkám přiřadit alespoň jeden
fluorofor. Přiřazení fluoroforu umožňuje rozevírací seznam Biological Groups (Biologické skupiny).
Další informace o přiřazení fluoroforů naleznete v části Přiřazení produktu jamkám na straně 140.

Tip: Ke každé jamce nebo skupině jamek můžete přiřadit jednu biologickou skupinu.

Přiřadit biologickou skupinu k jamce nebo skupině jamek

1. V nástroji Plate Editor (Editor destiček) zkontrolujte, zda byl k jamce nebo skupině jamek přiřazen
fluorofor.

2. V podokně destiček vyberte jamku nebo skupinu jamek.

3. V pravém podokně proveďte výběr z rozevíracího seznamu Biological Group (Biologická skupina).

CFX Maestro Dx SE automaticky zaškrtne políčko Load (Načíst).
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4. Opakujte Krok 3 pro každou jamku nebo skupinu jamek, kterým chcete přiřadit biologickou skupinu.

5. Klikněte na tlačítko OK, aby se potvrdily změny a uložila destička.

Poznámka: Pokud jste destičku omylem změnili, klikněte na Undo (Vrátit zpět) na panelu
nástrojů Plate Editor (Editor destiček) , než kliknete pro potvrzení změn na OK.

Odstranění biologické skupiny

u K odstranění biologické skupiny z vybrané jamky zrušte zaškrtnutí políčka Load (Načíst).

Přidání biologické skupiny do seznamu

u Chcete-li přidat biologickou skupinu do rozevíracího seznamu, proveďte jednu z následujících akcí:

n Napište název do rozevíracího políčka Biological Group (Biologická skupina) a stiskněte tlačítko
Enter.

n Klikněte na zelený symbol + napravo od rozevíracího seznamu a zadejte název biologické
skupiny.

n Na panelu nástrojů klikněte na položku User Preferences (Uživatelské předvolby) a přidejte
název do knihovny Biological Group Names (Názvy biologických skupin) na kartě Plate
(Destička).

Důležité: Názvy produktů, které jste přidali do rozevíracího seznamu, budou dostupné pouze
pro aktuální destičku a pouze v případě, že název přiřadíte k jamce a uložíte rozvržení destičky.
Pokud název nepřiřadíte k jamce a neuložíte rozvržení destičky, název se neuloží a nebude
v budoucnu dostupný. Chcete-li trvale přidat název biologické skupiny, přidejte ho také do
knihovny Biological Group Names (Názvy biologických skupin) pomocí dialogového okna User
Preferences (Uživatelské předvolby). Názvy, které přidáte do knihovny, jsou k dispozici poté, co
znovu otevřete Plate Editor (Editor destiček). Více informací naleznete v části Nastavení
výchozích parametrů destičky na straně 86.

Odstranění názvu biologické skupiny ze seznamu

1. Na panelu nástrojů klikněte na položku User Preferences (Uživatelské předvolby).

Dialogové okno User Preferences (Uživatelské předvolby) zobrazí kartu Plate (Destička).

2. V knihovně Biological Group Names (Názvy biologických skupin) na kartě Plate (Destička) vyberte
název, který chcete odstranit, a stiskněte tlačítko Delete (Odstranit).

3. Klikněte na OK , aby se změny uložily, a opusťte dialogové okno User Preferences (Uživatelské
předvolby).

Důležité: Názvy biologických skupin, které jste uložili se souborem destičky, nelze odstranit.
Vlastní názvy, které přidáte do rozevíracího seznamu Biological Group Names (Názvy
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biologických skupin) a nepoužíváte a uložíte je s destičkou, jsou automaticky odstraněny ze
seznamu. Názvy, které odstraníte z knihovny Biological Group Names (Názvy biologických
skupin), jsou ze softwaru trvale odstraněny a uživatelům již nejsou k dispozici. Při odstraňování
biologických názvů buďte opatrní.

Zobrazit všechny biologické skupiny na destičce

u Chcete-li zobrazit všechny biologické skupiny na destičce, klikněte na položku Show Biological
Groups (Zobrazit biologické skupiny).

Každá skupina je identifikována specifickou barvou a tlačítko Show Biological Groups (Zobrazit
biologické skupiny) se změní na Hide Biological Groups (Skrýt biologické skupiny).

Klikněte na položku Hide Biological Groups (Skrýt biologické skupiny), chcete-li odstranit barvu
jamky. Nebo můžete také kliknout na jakoukoli jamku na destičce, abyste skryli biologické skupiny.

Přiřazení čísel technických replikátů jamkám
Důležité: Pro přiřazení čísel technických replikátů musí vybrané jamky mít totožný obsah jamky. To
znamená, že vybrané jamky musí mít stejný typ vzorku a fluorofor. Je-li to možné, musí jim být
rovněž přiřazeny stejné názvy produktu a vzorku a stejná biologická skupina. Pokud nejsou stejné,
software CFX Maestro Dx SE tuto možnost nepovolí.

Jak přiřadit čísla technických replikátů skupině jamek

1. V nástroji Plate Editor (Editor destiček) se ujistěte, že je obsah skupiny jamek totožný.

2. V podokně destičky vyberte cílovou skupinu jamek.

3. Abyste přiřadili stejné číslo replikátu všem vybraným jamkám, zadejte do rámečku v části Replicate #
(Číslo replikátu) v pravém podokně číslo replikátu a vyberte možnost Load (Načíst).
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4. (Volitelné) Jak použít sérii replikátů pro soubor vybraných jamek:

a. Klikněte na Technical Replicates (Technické replikáty). Část Replicate # (Číslo replikátu) se
změní a zobrazí následující možnosti:

n Replicate size (Velikost replikátu) – číslo představující počet jamek v každé skupině
replikátů

n Starting replicate # (První replikát) – první číslo v sérii replikátů pro vybranou skupinu
replikátů

Poznámka: Ve výchozím nastavení zobrazuje software CFX Maestro Dx SE počáteční
číslo replikátu, které je o jedno větší než poslední číslo technického replikátu přiřazené na
destičce. Například jestliže je poslední číslo technického replikátu na destičce pět, příští
počáteční číslo bude šest. Počáteční číslo můžete změnit na libovolné číslo, které zatím
není přiřazeno.

n Směr založení (vodorovný nebo svislý)

b. Kliknutím na Apply (Použít) použijete parametry na sérii a vrátíte se na obrazovku Replicate #
(Číslo replikátu).

5. Klikněte na tlačítko OK, aby se potvrdily změny a uložila destička.

Poznámka: Pokud jste destičku omylem změnili, klikněte na Undo (Vrátit zpět) na panelu
nástrojů Plate Editor (Editor destiček) , než kliknete pro potvrzení změn na OK.

Jak odstranit jamku ze série replikátů

u Vyberte jamku nebo skupinu jamek, kterou chcete odstranit, a odznačte zaškrtávací políčko
Replicate # Load (Načíst číslo replikátu).

Případně můžete kliknout na Clear Replicate # (Vymazat číslo replikátu), abyste vymazali číslo
replikátu z vybrané jamky nebo skupiny jamek.
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Jak zobrazit všechny technické replikáty na destičce

u Kliknutím na Show Technical Replicates (Zobrazit technické replikáty) zobrazíte všechny technické
replikáty na destičce.

Každá skupina je označena konkrétní barvou a tlačítko Show Technical Replicates (Zobrazit
technické replikáty) se změní na Hide Technical Replicates (Skrýt technické replikáty).

Kliknutím na Hide Technical Replicates (Skrýt technické replikáty) zrušíte barvu jamek. Případně
můžete také kliknout na jakoukoliv jamku na destičce, abyste skryli technické replikace.

Přiřazení série ředění ke standardům
Jak bylo uvedeno výše, musí být všem jamkám se vzorkem typu Standard přiřazena hodnota
koncentrace. Série ředění můžete přiřadit více jamkám s typem vzorku Standard.

Poznámka: Pro přiřazení série ředění do skupiny jamek musí být jamky zahrnuty v sériích
technických replikátů. Další informace o přidávání jamek k sériím replikátů naleznete v části
Přiřazení čísel technických replikátů jamkám na straně 146.

Přiřazení série ředění skupině standardů

1. V nástroji Plate Editor (Editor destiček) zajistěte splnění následujících požadavků:

n Typ vzorku pro skupinu jamek je Standard.

n Všem jamkám ve skupině je přiřazen alespoň jeden fluorofor a všechny obsahují stejné
fluorofory.

n Všechny jamky ve skupině jsou zahrnuty ve stejné sérii technických replikátů.

Poznámka: CFX Maestro Dx SE aktivuje možnost Dilution Series (Série ředění) pouze,
pokud vybrané jamky splňují tato kritéria.

2. V podokně destičky vyberte cílovou skupinu jamek.

3. V části Concentration (Koncentrace) v pravém podokně klikněte na položku Dilution Series (Série
ředění). V části Concentration (Koncentrace) se zobrazí následující možnosti:
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n Starting concentration (Počáteční koncentrace) – počáteční hodnota koncentrace

n Replicates from and to (Replikáty od - do) – replikáty v sérii, na kterou se použije faktor
ředění

n Dilution factor (Faktor ředění) – ředicí faktor použitý na změnu koncentrace v každé skupině
replikátů

4. Nastavte hodnoty možností, nebo potvrďte výchozí hodnoty.

5. Ve výchozím nastavení se série ředění snižuje o faktor ředění. Pro zvětšení série ředění vyberte
možnost Increasing (Zvětšení).

6. (Nepovinné) Ve výchozím nastavení se faktor ředění vztahuje na všechny fluorofory v sérii replikací.
Pokud vaše série obsahují více než jeden fluorofor a chcete ředění aplikovat na jeden fluorofor,
vyberte jej z rozevíracího seznamu.

7. Klikněte na Apply (Použít), chcete-li použít série ředění na skupinu jamek a vrátit se na zobrazení
Concentration (Koncentrace).

8. Klikněte na tlačítko OK, aby se potvrdily změny a uložila destička.

Kopírování obsahu jamky do jiné jamky
Obsah jamky můžete kopírovat a vložit jej do jedné nebo několika jamek. Můžete ale kopírovat pouze
obsah jedné jamky. Není možné vybrat více jamek a kopírovat jejich obsah.

Jak zkopírovat obsah jamky do jiné jamky

1. V podokně destiček vyberte jamku, kterou chcete kopírovat.

2. Klikněte pravým tlačítkemmyši na jamku a vyberte možnost Copy Well (Kopírovat jamku).

3. Vyberte jamku nebo jamky, do kterých chcete obsah vložit:

n Chcete-li vybrat jednu jamku, klikněte na jamku.

n Chcete-li vybrat více sousedních jamek, klikněte na jamku a táhněte až k cílové jamce.

n Chcete-li vybrat více nesousedících jamek, podržte klávesu Control a klikněte na každou jamku.

4. Když jsou cílové jamky vybrány, klikněte pravým tlačítkemmyši a vyberte možnost Paste Well (Vložit
do jamky).

Software CFX Maestro Dx SE vloží obsah první jamky do vybraných jamek.
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Přidání poznámky k jamce
Můžete k jamce přidávat popisné poznámky. Poznámky k jamce můžete zobrazit na kartě Quantification
(Kvantifikace) v okně Data Analysis (Analýza dat).

Jak přidat poznámku k jamce

1. V podokně destiček vyberte jamku nebo jamky, ke kterém chcete přidat poznámku.

2. V části View (Zobrazit) v dolním podokně vyberte možnost Well Note (Poznámka k jamce).

V pravém podokně se objeví oblast Well Note (Poznámka k jamce).

3. Do textového rámečku zadejte obsah poznámky a stiskněte Enter.

Text se objeví ve spodní části vybraných jamek.

Tip: Pokud jste již poznámku k jamce vytvořili, můžete ji vybrat v rozevíracím seznamu a použít
ji pro vybrané jamky.

Vymazání informace k obsahu jamky
Můžete vymazat individuální jamku, skupinu jamek nebo veškerý obsah destičky. Vymazání jamek
neodstraňuje data fluorescence shromážděná během čtení destičky.

Důležité: Vymazání jamky trvale odstraní obsah z jamky. Jestliže kliknete na OK a po vymazání
jamky uložíte destičku, nemůžete zrušit akci. Při odstraňování jamek buďte opatrní.

Kompletní vymazání jamky

1. V editoru Plate Editor (Editor destiček) vyberte jamku nebo skupinu jamek v podokně destičky:

n Chcete-li vybrat jednu jamku, klikněte na jamku.

n Chcete-li vybrat více sousedních jamek, klikněte na jamku a táhněte až k cílové jamce.

n Chcete-li vybrat více nesousedících jamek, podržte klávesu Control a klikněte na každou jamku.

n Chcete-li vybrat celý sloupec se stejným typem vzorku, klikněte na číslo sloupce.

n Chcete-li vybrat celý řádek, klikněte na číslo řádku.

2. V pravém podokně klikněte na tlačítko Clear Wells (Vymazat jamky).

CFX Maestro Dx SE vymaže všechna nastavení vybraných jamek.

3. Postupujte následovně:
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n Pokud jste destičku omylem vymazali, klikněte na Undo (Vrátit zpět) na panelu nástrojů Plate
Editor (Editor destiček), a teprve poté klikněte pro potvrzení změn na tlačítko OK.

Důležité: Kliknutí na OK před kliknutím na Undo (Vrátit zpět) uloží změny a deaktivuje
příkaz Undo (Vrátit zpět) na panelu nástrojů Plate Editor (Editor destiček).

n Klikněte na tlačítko OK, aby se potvrdily změny a uložila destička.
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Změna nastavení experimentu
Pomocí dialogového okna Experiment Settings (Nastavení experimentu) můžete zobrazit nebo měnit
seznam produktů, vzorků či biologických skupin, popř. nastavit skupinu vzorků pro analýzu genové
exprese, pokud jste jamkám na destičce přiřadili biologické skupiny.

V dialogovém okně Experiment Settings (Nastavení experimentu) obsahuje karta Targets (Produkty)
seznam názvů produktů pro každou reakci PCR, například cílový gen nebo zájmové sekvence genů.

Karta Samples (Vzorky) a Biological Groups (Biologické skupiny) obsahuje seznam názvů vzorků
a biologických skupin, který uvádí zdroj produktu, například vzorek odebraný po 1 hodině (1 h) nebo od
konkrétního jedince (myš1).

Jak změnit nastavení destiček v dialogovém okně Experiment Settings (Nastavení
experimentu)

1. Abyste otevřeli dialogové okno Experiment Settings (Nastavení experimentu), postupujte
následovně:

n V pravém podokně nástroje Plate Editor (Editor destiček) klikněte na položku Experiment
Settings (Nastavení experimentu).

n Na kartě Gene Expression (Genová exprese) v okně Data Analysis (Analýza dat) klikněte na
položku Experiment Settings (Nastavení experimentu).

Otevře se dialogové okno Experiment Settings (Nastavení experimentu) s obsahem karty Targets
(Produkty).
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2. Abyste přidali nový název produktu, vzorku nebo biologické skupiny, na příslušné kartě zadejte
název do textového rámečku New (Nový) a klikněte na Add (Přidat).

3. Abyste odstranili jeden nebo několik názvů produktu, vzorku nebo biologické skupiny produktu nebo
vzorku ze seznamu, na příslušné kartě označte zaškrtávací políčko položky v sloupci Select to
Remove (Vybrat k odstranění) a klikněte na položku Remove checked item(s) (Odstranit označené
položky).

4. CFX Maestro Dx SE vyloučí typ vzorku NTC (kontrola bez templátu) z analýzy genové exprese.

Pro zařazení typu vzorku NTC odznačte jeho zaškrtávací políčko v části Exclude the following
sample types (Vyloučit následující typy vzorků). Pomocí příslušných zaškrtávacích políček můžete
vyloučit následující typy vzorků:

n NRT (Kontrola bez reverzní transkriptázy)

n Negative Control (Negativní kontrola)

n Positive Control (Pozitivní kontrola)

n Standard

5. Na kartě Targets (Produkty):

a. Pokud chcete vybrat produkt jako referenci pro analýzu dat genové exprese, vyberte jej ve
sloupci Reference.

b. Pokud chcete skrýt nastavení, které bude použito na kartě Gene Expression (Genová exprese)
v okně Analysis Settings (Nastavení analýzy), odznačte položku Show Analysis Settings
(Zobrazit nastavení analýzy).

Software skryje následující sloupce:

n Color (Barva)

n Show Chart (Zobrazit graf)

n Auto Efficiency (Automatická účinnost)

n Efficiency (%) (Účinnost (%))

c. Chcete-li změnit barvu produktu zaneseného do grafu Gene Expression (Genová exprese),
klikněte na jeho buňku ve sloupci Color (Barva), vyberte v otevřeném dialogovém okně Color
(Barva) novou barvu a klikněte na OK.

d. Chcete-li zobrazit produkt vybranou barvou v grafu Gene Expression (Genová exprese),
označte jeho zaškrtávací políčko v sloupci Show Chart (Zobrazit graf).

e. Software CFX Maestro Dx SE ve výchozím nastavení automaticky vypočítá relativní účinnost
pro produkt, pokud jeho data obsahují standardní křivku.
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Chcete-li použít již stanovenou hodnotu účinnosti, zadejte hodnotu do příslušné buňky v sloupci
Efficiency (%) (Účinnost (%)) a stiskněte klávesu Enter. Software CFX Maestro Dx SE odznačí
zaškrtávací políčko Auto Efficiency (Automatická účinnost).

6. Na kartě Samples (Vzorky) a Biological Groups (Biologické skupiny):

a. Chcete-li vybrat vzorek nebo biologickou skupinu jako kontrolní vzorek pro analýzu dat genové
exprese, označte její zaškrtávací políčko v sloupci Control (Kontrola).

b. Chcete-li přiřadit kontrolní podmínku k vzorku nebo biologické skupině pro běh, klikněte na její
zaškrtávací políčko v sloupci Control (Kontrola).

c. Klikněte na možnost Show Analysis Settings (Zobrazit nastavení analýzy), pokud ještě není
vybrána, abyste zobrazili nebo změnili parametry analýzy, které budou použity na kartě Gene
Expression (Genová exprese). Software skryje sloupce Color (Barva) a Show Chart (Zobrazit
graf).

7. Kliknutím na OK uložíte parametry v dialogovém okně Experiment Settings (Nastavení experimentu)
a vrátíte se do okna Plate Editor (Editor destiček).
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Vytvoření skupin jamek
Pomocí funkce „skupiny jamek“ lze vzorky v jamkách rozdělit do skupin, které lze analyzovat nezávisle
v okně Data Analysis (Analýza dat). Po nastavení skupin jamek vyberte v okně Data Analysis (Analýza
dat) jednu z nich, abyste mohli data analyzovat jako nezávislou skupinu. Například nastavte skupiny
jamek pro analýzu více experimentů prováděných na jedné destičce nebo pro analýzu každé skupiny
jamek s jinou standardní křivkou.

Poznámka: Výchozí skupina jamek je All Wells (Všechny jamky).

Vytvoření skupin jamek

1. Chcete-li otevřít sekci Well Groups Manager (Správce skupin jamek), postupujte následovně:

n V panelu nástrojů Plate Editor (Editor destiček) klikněte na položku Well Groups (Skupiny
jamek).

n V okně Data Analysis (Analýza dat) klikněte na položku ManageWell Groups (Správce skupin
jamek).

Zobrazí se dialogové oknoWell Groups Manager (Správce skupin jamek).

2. Kliknutím na tlačítko Add (Přidat) vytvoříte novou skupinu. Rozevírací nabídka zobrazuje název
skupiny jako Group 1 (Skupina 1) pro první vytvořenou skupinu.
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3. Vyberte jamky pro skupinu jamek v zobrazení destičky kliknutím a přetažením přes skupinu jamek.
Vybrané jamky se objeví v okně Manager (Správce) modře.

4. (Volitelné) Chcete-li změnit název skupiny, vyberte její jméno v rozevírací nabídce a zadejte nový
název.

5. (Volitelné) Chcete-li odstranit skupinu jamek, vyberte její název v rozevíracím seznamu a klikněte na
tlačítko Delete (Odstranit).

6. Kliknutím na tlačítko OK dokončete a zavřete okno nebo kliknutím na tlačítko Cancel (Zrušit) okno
zavřete bez provedení změn.

Položky nabídky po kliknutí pravým tlačítkem myši pro dialogové okno Well
Groups Manager (Správce skupin jamek)

Tabulka 10 obsahuje seznam položek dostupných v dialogovém okněWell Groups Manager (Správce
skupin jamek) po kliknutí pravým tlačítkemmyši na jakoukoliv jamku.

Položka Funkce

Copy (Kopírovat) Zkopíruje obsah jamky, který pak může být vložen do
jiných jamek.

Copy as Image (Kopírovat jako
obrázek)

Zkopíruje zobrazení nástroje pro výběr jamek jako
obrázek.

Print (Tisk) Vytiskne zobrazení nástroje pro výběr jamek.

Print Selection (Vytisknout
výběr)

Vytiskne pouze vybrané buňky.

Export to Excel (Export do
aplikace Excel)

Exportuje data do tabulky Excel.

Export to CSV (Export do
souboru CSV)

Exportuje data jako dokument oddělený čárkami.

Export to Xml (Export do
souboru XML)

Exportuje data jako dokument ve formátu .xml.

Export to Html (Export do
souboru HTML)

Exportuje data jako dokument ve formátu .html.

Tabulka 10. Klepněte pravým tlačítkem na položky nabídky v dialogovém okně Well
Groups Manager (Správce skupin jamek) editoru Plate Editor (Editor destiček)

156 | Software CFX Maestro Dx SE



Změna typu zobrazení křivky

Změna typu zobrazení křivky
Během nastavení destičky a během probíhajícího experimentu můžete měnit barvu a typ zobrazení
amplifikačních křivek. Když jsou data shromažďována, můžete snadno zobrazit křivky v stavovém okně
v reálném čase.

Změna typu zobrazení křivky

1. Klikněte na Trace Styles (Možnosti křivek) v panelu nástrojů Plate Editor (Editor destiček).

Zobrazí se dialogové okno Trace Styles (Možnosti křivek) pro otevřenou destičku, například:

2. Chcete-li zobrazit křivku s konkrétním fluoroforem, vyberte jej z rozevíracího seznamu Fluorophores
(Fluorofory).

3. Změna zobrazení křivky:

a. Vyberte typ křivky z rozevíracího seznamuWells (Jamky).

b. Klikněte na její barvu ve sloupci Color (Barva).

c. V zobrazeném dialogovém okně Color (Barva) vyberte jinou barvu křivky a klikněte na tlačítko
OK.

CFX Maestro Dx SE zobrazí změnu barvy pro typ jamky v mřížce.

d. (Volitelné) V rozevíracím seznamu Symbols (Symboly) vyberte symbol pro konkrétní křivku.

4. Chcete-li sadu barev rychle změnit, klikněte na příslušnou volbu v části Color Quick Set (Rychlé
nastavení barev).
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5. Chcete-li zobrazit popisy v mřížce, vyberte typ popisu v části Well Labels (Popis jamek).

6. Klepnutím na tlačítko OK uložte změny nebo zrušte změny stisknutím tlačítka Cancel (Zrušit).
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Zobrazení, export a import destičky ve formátu tabulky
Nástroj Spreadsheet View/Importer (Zobrazení/Import tabulky) zobrazuje obsah destičky ve formátu
tabulkového procesoru. Prohlížeč poskytuje možnost zobrazovat, importovat a exportovat data jamek, jak
je popsáno níže.

Použití prohlížeče tabulek k exportu a importu dat destiček

V prohlížeči tabulek můžete exportovat název produktu, název vzorku, název biologické skupiny
a poznámky k jamce jako šablonu ve formátu odděleném tabulátory do aplikace, jako je Microsoft Excel.
Tato data můžete také importovat z aplikace ve formátu odděleném tabulátory do předem definované
destičky ze souboru s informacemi o experimentu.

Použití nástroje Spreadsheet View/Importer (Zobrazení/Import tabulky)

1. Vytvořte a uložte soubor destiček (viz Vytvoření souboru destičky pomocí Plate Editor (Editor
destiček)).

2. Na panelu nástrojů Plate Editor (Editor destiček) klikněte na Spreadsheet View/Importer
(Zobrazení/Import tabulky) a otevřete dialogové okno Plate Spreadsheet View (Zobrazit destičku
jako tabulku).

3. (Nepovinné) Kliknutím na políčka Biological Set Name (Název biologického souboru) a ShowWell
Note (Zobrazit poznámku k jamce) zobrazíte tyto sloupce v zobrazení tabulky a v exportovaném
souboru.

4. Kliknutím na tlačítko Export Template (Exportovat) šablonu vytvoříte prázdnou šablonu v souboru
Excel (formát .csv). Exportovaný soubor bude mít stejné rozvržení jako destička.
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Tip: Při ukládání souborů destičky použijte název souboru destičky, abyste soubor snadno
identifikovali.

5. Vyplňte buňky souboru Excel obsahem jamek.

Poznámka: Obsah libovolné buňky můžete upravit pouze ve sloupci, který má vedle názvu
sloupce hvězdičku (*) (*Název produktu, *Název vzorku, *Název biologické skupiny, *Poznámka
k jamce).

Poznámka: Do sloupců Standardní křivka a Množství v exportovaném souboru aplikace Excel
nelze přidávat hodnoty. Chcete-li tyto údaje upravit, vraťte se do nástroje Plate Editor (Editor
destiček) a v pruhu nabídky vyberte možnost Settings (Nastavení) > Units (Jednotky). Po
dokončení běhu destičky se data z těchto standardů zobrazí v grafu Standard Curve (Standardní
křivka) na kartě Quantification (Kvantifikace) v okně Data Analysis (Analýza dat) s vybranými
jednotkami.

6. Vyplněný soubor aplikace Excel importujte zpět do nástroje Plate Editor (Editor destiček) kliknutím na
tlačítko Import (Importovat). Data importované destičky se zobrazí v okně Plate Spreadsheet View
(Zobrazení tabulky destičky).

Důležité: Pokud máte více fluoroforů, budete muset provést kroky 3–5 pro každý fluorofor
pomocí rozevírací nabídky Flours List (Seznam fluoroforů) v Plate Spreadsheet View (Zobrazení
tabulky destičky).

7. Klikněte na tlačítko OK. V okně Plate Editor (Editor destiček) se nyní zobrazí nová data destičky.

Tip: Můžete zobrazit seznam položek nabídky dostupné v nástroji Spreadsheet View/Importer
(Zobrazení/import tabulky) poté, když v nástroji kliknete pravým tlačítkemmyši na jakoukoliv jamku
nebo v zobrazení tabulky destičky na libovolné záhlaví tabulky.
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Vytvoření destičky pomocí nástroje Plate Setup Wizard
(Průvodce nastavením destičky)

Nástroj Setup Wizard (Průvodce nastavením destičky) můžete použít k zadání informací o nastavení
destičky, které jsou nutné pro analýzu normalizované genové exprese, a to včetně:

n názvů produktů,

n názvů vzorků,

n umístění produktů a vzorků na destičce,

n referenčních genů,

n kontrolního vzorku.

Nástroj Setup Wizard (Průvodce nastavením) můžete použít před během, v jeho průběhu i po něm.

Použití Plate Setup Wizard (Průvodce nastavením destičky)
Tato část vysvětluje, jak vytvořit rozvržení destičky pomocí nástroje Setup Wizard (Průvodce nastavením)
pro destičku. Chcete-li snadněji prohlížet obsah každé jamky na destičce, klikněte na tlačítko Zoom plate
(Lupa) v horní části Setup Wizard (Průvodce nastavením) .

Důležité: Pokud se vrátíte na kartu Auto layout (Automatické rozvržení) a nacházíte se na jiné kartě
v Setup Wizard (Průvodce nastavením) , nastavení destičky se resetuje. Při výběru této karty
postupujte opatrně.

Tip: Rozvržení můžete obnovit výběrem položky Tools > Clear Plate (Nástroje > Vymazat destičku)
v Setup Wizard (Průvodce nastavením).

Použití Setup Wizard (Průvodce nastavením) pro destičku

1. Otevře editor Plate Editor (Editor destiček).

2. Chcete-li otevřít Průvodce nastavením, proveďte jednu z následujících akcí:

n Vyberte položky Editing Tools > Setup Wizard (Nástroje pro úpravy > Průvodce nastavením).

n Klikněte na Setup Wizard (Průvodce nastavením) na panelu nástrojů Plate Editor (Editor
destiček).

Zobrazí se okno Setup Wizard (Průvodce nastavením) , které zobrazuje kartu Auto layout
(Automatické rozložení).
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3. Na kartě Auto layout (Automatické rozložení) postupujte následovně:

a. Klikněte na jamku v mřížce a přetáhněte ji napříč a dolů pro specifikování oblasti na destičce, do
které chcete načíst vzorek.

b. Zadejte počet produktů a vzorků, které chcete načíst.

Tip: Počet produktů a vzorků se musí rovnat počtu vybraných buněk. Pokud se zadaná
čísla nevejdou do vybrané oblasti, upravte čísla nebo vybranou oblast destičky. Lze určit
orientaci položek na destičce a jejich seskupení.

c. (Volitelné) Změna orientace destičky. Můžete například nastavit produkty ve sloupcích a vzorky
v řádcích, nebo provést seskupení podle vzorků.

d. Klikněte na Next (Další) a pokračujte na kartu Target names (Názvy produktů).

Poznámka: Pokud rozvržení destičky nemá pravidelný vzor, použijte kartu Target names
(Názvy produktů) pro ruční umístění vašich produktů nebo kartu Sample names (Názvy vzorků)
pro ruční umístění vzorků na destičku. Kliknutím a přetažením vyberete více jamek.

4. Na kartě Target names (Názvy produktů) definujte názvy produktů pro cílové skupiny:

a. Postupujte následovně:

n Chcete-li přejmenovat produkty podle skupiny, nastavte pro parametr Select by (Vybrat
podle) položku Target (Produkt).
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n Chcete-li přejmenovat produkty podle jamky, nastavte pro parametr Select by (Vybrat
podle) položku Well (Jamka).

b. Vyberte cílovou skupinu nebo jamku v mřížce a zadejte název do rozevíracího seznamu Target
Name (Název produktu).

Tip: Stiskněte klávesu Tab pro výběr další skupiny nebo jamky vpravo nebo Enter pro výběr
další skupiny nebo jamky níže. Nebo na kartách Target Name (Název produktu) a Sample
name (Název vzorku) podržte klávesu Control a klikněte na jamku, abyste vybrali více
jamek, které nesousedí.

c. Klikněte na položku Next (Další) a pokračujte na kartu Sample names (Názvy vzorků).

5. Na kartě Sample names (Názvy vzorků) definujte názvy vzorků pro cílové skupiny.

6. Klikněte na položku Next (Další) a pokračujte na kartu Reference targets (Referenční geny).

7. Na kartě Reference targets (Referenční geny) vyberte jeden nebo více cílů, které se použijí jako
reference pro normalizaci genové exprese, a klikněte na tlačítko Next (Další) a přejděte na kartu
Control sample (Kontrolní vzorek).

8. Na kartě Control sample (Kontrolní vzorek) vyberte jeden vzorek, který se použije jako kontrola pro
výpočty relativní genové exprese.

9. Kliknutím na tlačítko OK uložíte rozvržení destičky a vrátíte se do nástroje Plate Editor (Editor
destiček), ve kterémmůžete dále definovat parametry destičky. Více informací naleznete v části
Přiřazení volitelných parametrů k souboru destičky na straně 140.

Případně klikněte na tlačítko Previous (Předchozí), chcete-li se vrátit na předchozí kartu a provést
změny.

Poznámka: Návrat na kartu Auto layout (Automatické rozvržení) automaticky obnoví destičku.
Dávejte pozor při klepnutí na tlačítko Previous (Předchozí).
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Kapitola 9 Provádění experimentů
Tato kapitola vysvětluje, jak spustit vlastní (uživatelem definované) nebo PrimePCR experimenty pomocí
Software CFX Maestro Dx, bezpečnostní edice.

Datový soubor obsahuje protokol a informace o nastavení destičky. Soubor také obsahuje analýzu dat,
kterou CFX Maestro Dx SE provádí po dokončení běhu.

Software CFX Maestro Dx SE umožňuje snadné nastavení a spuštění uživatelsky definovaných běhů
nebo PrimePCR experimentů. Okno Run Setup (Nastavení běhu) vás provede postupnými kroky
nastavení experimentu, zakončenými otevřením dialogového okna Start Run (Spustit běh), ze kterého
spustíte běh.
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Okno Run Setup (Nastavení běhu)
Okno Run Setup (Nastavení běhu) poskytuje rychlý přístup k souborům a nastavením potřebným pro
nastavení a spuštění experimentu. Pokud se rozhodnete spustit experiment definovaný uživatelem,
otevře se okno Run Setup (Nastavení běhu), které zobrazí kartu Protocol (Protokol). Pokud se
rozhodnete spustit experiment PrimePCR, otevře se okno Run Setup (Nastavení běhu), které zobrazí
kartu Start Run (Spustit běh).

Tip: V části Provádění experimentů PrimePCR na straně 184 naleznete informace o PrimePCR;
v části Karta Start Run (Spustit běh) na straně 174 naleznete další informace o kartě Start Run
(Spustit běh).
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1. Karty vás provedou nastavením a spuštěním experimentu:

n Na kartě Protocol (Protokol) – vyberte existující protokol, který chcete spustit
nebo upravit, nebo vytvořte nový protokol v editoru Protocol Editor (Editor
protokolu).

n Na kartě Plate (Destička) – vyberte existující destičku, kterou chcete spustit nebo
upravit, nebo vytvořte novou destičku v nástroji Plate Editor (Editor destičky).

n Karta Start Run (Spustit běh) – zobrazuje nastavení experimentu, vybere jeden
nebo více bloků přístrojů a spouští běh.

2. Hlavní okno zobrazuje možnosti pro každou variantu, kterou použijete.

3. Navigační tlačítka vedou na kartu Start Run (Spustit běh).

LEGENDA

Otevření okna Run Setup (Nastavení běhu)
Otevření okna Run Setup (Nastavení běhu)

u Postupujte následovně:

n Na kartě Run Setup (Nastavení běhu) v nástroji Startup Wizard (Průvodce spuštěním) klikněte
buď na položku User-defined (Možnost zadaná uživatelem), nebo PrimePCR.

n V okně Home (Domů) klikněte na panelu nástrojů buď na položku User-defined Run Setup
(Nastavení běhu definovaného uživatelem), nebo PrimePCR Run Setup (Nastavení PrimePCR
experimentu).

n V okně Home (Domů) klepněte buď na položky Run > User-defined Run (Běh > Běh zadaný
uživatelem) nebo Run > PrimePCR Run (Běh > PrimePCR experiment).
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Karta Protocol (Protokol)
Karta Protocol (Protokol) obsahuje náhled souboru protokolu, který chcete spustit. Soubor protokolu
obsahuje pokyny pro jednotlivé teplotní kroky a nastavení hodnot, kterými se řídí rychlost
ohřevu/ochlazování, objem vzorku a teplota víka.

Ve výchozím nastavení software zobrazuje protokol definovaný v části File Selection for Run Setup
(Výběr souboru pro nastavení běhu) karty Files (Soubory) v dialogovém okně User > User Preferences
(Uživatel > Uživatelské předvolby). Výchozí protokol můžete v dialogovém okně User Preferences
(Uživatelské předvolby) změnit. Více informací naleznete v části Změna výchozího nastavení souboru na
straně 83.

Na kartě Protocol (Protokol) můžete:

n vytvořit nový protokol;

n vybrat nebo upravit stávající protokol.

Více informací o tvorbě a úpravě protokolů uvádí Kapitola 7, Vytvoření protokolů.

Jak vytvořit nový protokol

1. Na kartě Protocol (Protokol) klikněte na možnost Create New (Vytvořit nový).

Objeví se okno Protocol Editor (Editor protokolu).
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2. Pomocí nástroje Protocol Editor (Editor protokolu) vytvořte nový protokol.

3. Kliknutím na OK protokol uložíte a vrátíte se na kartu Protocol (Protokol) v nabídce Run Setup
(Nastavení běhu).

4. Zobrazte podrobnosti o protokolu a postupujte následovně:

n Je-li protokol v pořádku, kliknutím na položku Next (Další) přejdete na kartu Plate (Destička).

n Pokud protokol neodpovídá požadavkům, kliknutím na položku Edit Selected (Upravit vybrané)
se vrátíte do nástroje Protocol Editor (Editor protokolu). Upravte protokol, uložte změny a poté
klikněte na položku Next (Další) na kartě Protocol (Protokol) a přejděte na kartu Plate (Destička).

Jak vybrat existující protokol

1. Na kartě Protocol (Protokol) postupujte následovně:

n Klikněte na položku Select Existing (Vybrat existující) a přejděte na existující protokol.

n Klikněte na položku Express Load (Expresní načtení) a z rozevíracího seznamu protokolů
vyberte protokol.

Tip: Z rozevíracího seznamu Express Load (Expresní načtení) můžete přidávat nebo
odstraňovat protokoly. Více informací je uvedeno v následující části Přidání a odstranění
protokolů pro expresní načtení.

2. Zobrazte podrobnosti o protokolu a postupujte následovně:

n Je-li protokol v pořádku, kliknutím na položku Next (Další) přejdete na kartu Plate (Destička).

n Pokud protokol neodpovídá požadavkům, kliknutím na položku Edit Selected (Upravit vybrané)
otevřete okno Protocol Editor (Editor protokolu). Upravte protokol, uložte změny a poté klikněte
na položku Next (Další) na kartě Protocol (Protokol) a přejděte na kartu Plate (Destička).

Přidání a odstranění protokolů pro expresní načtení

Můžete měnit obsah rozevíracího seznamu Express Load (Expresní načtení), který se zobrazuje v editoru
Protocol Editor (Editor protokolu). Protokoly v tomto seznamu jsou uloženy v následující složce:

c:\Users\Public\Public Documents\Bio-Rad\CFX_MDx\Users\<user_name>\ExpressLoad\

Změna seznamu Express Load (Expresní načtení) protokolů

1. Přejděte do složky ExpressLoad (Expresní načtení) a otevřete ji.

2. Zkontrolujte soubory protokolu (.pcrl) ve složce.

3. Postupujte následovně:

n Vymažte protokoly ze složky a odstraňte je z rozevíracího seznamu.
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n Zkopírujte protokoly do složky a přidejte je do rozevíracího seznamu.
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Karta Plate (Destička)
Poznámka: Jestliže protokol vybraný na kartě Protocol (Protokol) nezahrnuje krok čtení destičky pro
analýzu PCR v reálném čase, je karta Plate (Destička) skrytá. Abyste zobrazili kartu Plate (Destička),
přidejte do protokolu alespoň jedno čtení destičky.

Karta Plate (Destička) definuje nastavení destičky, kterou chcete načíst. Při PCR experimentu v reálném
čase obsahuje destička popis obsahu každé jamky včetně jejích fluoroforů, režimu skenování a typu
destičky. CFX Maestro Dx SE používá tyto popisy pro odečet a analýzu dat.

Ve výchozím nastavení software zobrazuje destičku definovanou v části File Selection for Run Setup
(Výběr souboru pro nastavení běhu) na kartě Files (Soubory) v dialogovém okně User > User
Preferences (Uživatel > Uživatelské předvolby). Výchozí destičku můžete v dialogovém okně User
Preferences (Uživatelské předvolby) změnit. Více informací naleznete v části Změna výchozího
nastavení souboru na straně 83.

Na kartě Plate (Destička) můžete:

n vytvořit novou destičku k načtení

n vybrat existující destičku k načtení nebo úpravám

Více informací o tvorbě a úpravě destiček uvádí Kapitola 8, Příprava destiček.
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Jak vytvořit novou destičku

1. Na kartě Plate (Destička) klikněte na možnost Create New (Vytvořit novou).

Objeví se Plate Editor (Editor destiček).

2. Pomocí nástroje Plate Editor (Editor destiček) vytvořte novou destičku.

3. Kliknutím na OK destičku uložíte a vrátíte se na kartu Plate (Destička) v nabídce Run Setup
(Nastavení běhu).

4. Zobrazte podrobnosti o destičce a postupujte následovně:

n Je-li popis v pořádku, kliknutím na položku Next (Další) přejdete na kartu Start Run (Spustit běh).

n Je-li potřeba popis upravit, kliknutím na položku Edit Selected (Upravit vybrané) se vrátíte do
nástroje Plate Editor (Editor destiček). Upravte soubor destičky, uložte změny a poté klikněte na
položku Next (Další) na kartě Plate (Destička). Přejdete tak na kartu Start Run (Spustit běh).

Jak vybrat existující soubor destičky

1. Na kartě Plate (Destička) postupujte následovně:

n Klikněte na položku Select Existing (Vybrat existující) a přejděte na existující soubor destičky.

n Klikněte na položku Express Load (Expresní načtení) a z rozevíracího seznamu vyberte soubor
destičky.

Tip: Z rozevíracího seznamu Express Load (Expresní načtení) můžete přidávat nebo
odstraňovat destičky. Více informací je uvedeno v následující části Přidání a odstranění
souborů destiček pro expresní načtení.

2. Zobrazte podrobnosti o destičce a postupujte následovně:

n Je-li popis v pořádku, kliknutím na položku Next (Další) přejdete na kartu Start Run (Spustit běh).

n Je-li potřeba popis upravit, kliknutím na položku Edit Selected (Upravit vybrané) otevřete okno
Plate Editor (Editor destiček). Upravte soubor destičky, uložte změny a poté klikněte na položku
Next (Další). Přejdete tak na kartu Start Run (Spustit běh).

Přidání a odstranění souborů destiček pro expresní načtení

Můžete měnit obsah rozevíracího seznamu Express Load (Expresní načtení), který se zobrazuje v editoru
Plate Editor (Editor destiček). Destičky, které se objeví v tomto seznamu, jsou uloženy v následující
složce:

c:\Users\Public\Documents\Bio-Rad\CFX_MDx\Users\<user_name>\ExpressLoad\
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Změna seznamu Express Load (Expresní načtení) souborů destiček

1. Přejděte do složky ExpressLoad (Expresní načtení) a otevřete ji.

2. Zkontrolujte soubory destiček (.pltd) ve složce.

3. Postupujte následovně:

n Vymažte soubory destičky ze složky, chcete-li je odstranit z rozevíracího seznamu.

n Zkopírujte soubory destiček do složky, chcete-li je přidat do rozevíracího seznamu.
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Karta Start Run (Spustit běh)
Na kartě Start Run (Spustit běh) se zobrazují informace o experimentu, který se má spustit. Zobrazuje
také připojený blok nebo bloky přístroje, na kterých můžete experiment spustit.

Na kartě Start Run (Spustit běh) můžete provést následující:

n Zobrazit podrobné informace o běhu, včetně vybraného protokolu, destičky a režimu skenování.

n Přidávat poznámky o běhu.

n Zobrazit podrobnosti o všech připojených přístrojích, včetně jejich provozního stavu (v chodu nebo
nečinný), objemu vzorku v µl, teploty víka, režimu emulace a ID nebo čárového kódu, pokud je
k dispozici.

Poznámka: Můžete upravovat sloupce, které se zobrazují v tabulce Start Run on Selected
Blocks (Spustit běh s vybranými bloky). Další informace naleznete v části Změna údajů v tabulce
Selected Blocks (Vybrané bloky) na straně 175.

n Vyberte jeden nebo více bloků, které chcete spustit.

n Otevřete nebo zavřete víko každého vybraného přístroje.

n Spusťte běh.
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Změna údajů v tabulce Selected Blocks (Vybrané bloky)

Sloupce v tabulce Start Run on Selected Block(s) (Spustit běh s vybranými bloky) můžete měnit. Rovněž
můžete měnit výchozí objem vzorku a teplotu víka v tabulce. Změny nastavení se použijí na běh, který má
být proveden.

Jak přidat sloupce do tabulky Start Run on Selected Blocks (Spustit běh s vybranými
bloky)

u Klikněte na tabulku pravým tlačítkemmyši a označte příslušnou možnost v otevřené nabídce.

Jak odstranit sloupce z tabulky Start Run on Selected Blocks (Spustit běh s vybranými
bloky)

u Klikněte na tabulku pravým tlačítkemmyši a odznačte příslušnou možnost v otevřené nabídce.

Jak upravit objem vzorku nebo teplotu víka pro blok

u Vyberte buňku s objemem vzorku nebo teplotou víka pro cílový blok a zadejte do ní novou hodnotu.

Jak přidat ID běhu nebo čárový kód pro blok

u Vyberte buňku ID/Bar Code (ID/čárový kód) pro cílový blok a zadejte ID nebo naskenujte blok pomocí
čtečky čárových kódů.

Zahájení experimentu
Důležité: Před zahájením experimentu se ujistěte, že antivirový software vašeho počítače nespustí
během běhu antivirovou kontrolu. Další informace najdete v části Instalace softwaru CFX Maestro Dx
SE na straně 33 a u vašeho správce systému.

Jak zahájit experiment

1. Na kartě Start Run (Spustit běh) ověřte podrobnosti o destičce a protokolu v části Run Information
(Informace o experimentu).

2. (Volitelné) V textovém rámečku Notes (Poznámky) můžete přidávat poznámky k běhu nebo
experimentu.

3. Označte zaškrtávací políčko jednoho nebo několika bloků, na kterých chcete běh spustit.

Tip: Abyste provedli experiment na všech blocích, vyberte možnost Select All Blocks (Vybrat
všechny bloky) pod tabulkou Selected Blocks (Vybrané bloky).

4. (Volitelné) Po kliknutí na možnost Flash Block Indicator (Indikátor Flash Block) začne blikat LED indikátor
na vybraných blocích přístroje.

5. Vložte připravené destičky do bloku:
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a. Klikněte na možnost Open Lid (Otevřít víko). Otevře se motorizované víko vybraného bloku.

b. Do vybraného bloku vložte destičku.

c. Klikněte na možnost Close Lid (Zavřít víko).

Tip: Vyberte Systém CFX Opus Dx, klepněte na Open Lid (Otevřít víko) nebo Close Lid (Zavřít
víko) na obrazovce Home (Domů).

6. Kliknutím na možnost Open Lid (Otevřít víko) nebo Close Lid (Zavřít víko) otevřete a zavřete
motorizované víko vybraného bloku přístroje.

7. Zobrazte informace o běhu a postupujte následovně:

n Jsou-li údaje v pořádku, klikněte na Start Run (Spustit běh).

n Nejsou-li údaje v pořádku:

o Opravte údaje v tabulce Selected Blocks (Vybrané bloky) a klikněte na Start Run (Spustit
běh).

o Vraťte se na správnou kartu a proveďte příslušné změny, uložte je a poté klikněte na
položku Next (Další) pro návrat na kartu Start Run (Spustit běh) a spusťte běh.

Jak zahájit nový běh z předchozího běhu

u Postupujte následovně:

n Vyberte možnost File > Repeat a Run (Soubor > Opakovat běh) v hlavní nabídce softwaru,
přejděte na datový soubor běhu, který chcete opakovat, a dvakrát na něj klikněte.

n Vyberte kartu Repeat Run (Opakovat běh) v nástroji Startup Wizard (Průvodce spuštěním)
a dvakrát klikněte na datový soubor běhu, který chcete opakovat.

Případně můžete na kartě Repeat Run (Opakovat běh) kliknout na možnost Browse
(Procházet), přejít na datový soubor běhu, který chcete opakovat, a dvakrát na něj kliknout.
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Dialogové okno Run Details (Podrobnosti o běhu)
Po kliknutí na tlačítko Start Run (Spustit běh) software CFX Maestro Dx SE vyzve k uložení datového
souboru (. pcrd ), spustí běh a otevře dialogové okno Run Details (Podrobnosti o běhu). Dialogové okno
Run Details (Podrobnosti o běhu) obsahuje tři karty stavu:

n Run Status (Stav běhu) – tato karta slouží k zobrazení aktuálního stavu protokolu, otevření nebo
zavření víka, pozastavení běhu, přidání opakování, přeskočení kroků nebo zastavení běhu.

n Real-time Status (Zobrazení v reálném čase) – tato záložka slouží k zobrazení dat fluorescence
PCR v reálném čase při jejich sběru.

n Time Status (Časový údaj) – tato karta slouží k zobrazení odpočítávací časomíry pro protokol na
celé obrazovce.

Tyto karty jsou podrobně vysvětleny v následujících kapitolách.

Karta Run Status (Stav běhu)
Karta Run Status (Stav běhu) ukazuje aktuální stav probíhajícího běhu. V tomto náhledu můžete rovněž
ovládat víko a měnit probíhající běh.
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1. Panel Run Status (Stav běhu) – ukazuje aktuální průběh protokolu.

2. Ovládací prvky Run Status (Stav běhu) – umožňují vám ovládat přístroj nebo
přerušit aktuální protokol.

3. Panel Run Information (Informace o experimentu) – ukazuje detaily běhu.

LEGENDA

Příkazy karty Run Status (Stav běhu)

Pomocí příkazů na kartě Run Status (Stav běhu) můžete buď ovládat přístroj ze softwaru, nebo změnit
probíhající běh.

Poznámka: Provádění změn protokolu v průběhu experimentu, například přidávání opakování,
nezmění soubor protokolu spojeného s během. Tyto akce jsou zaznamenány do protokolu Run Log
(Protokol běhu).

– otevře motorizované víko na vybraném přístroji.

Důležité: Otevření víka v průběhu experimentu pozastaví běh v aktuálním kroku a může změnit
data. Příkazy karty Run Status (Stav běhu) na straně 178.

– zavře motorizované víko na vybraném přístroji.

– Přidá další opakování k aktuálnímu kroku GOTO v protokolu. Tato volba je k dispozici, pouze
když je spuštěn krok GOTO.

Poznámka: V průběhu experimentu můžete v cyklu GOTO přidat další opakování. Nicméně,
CFX Maestro Dx SE rozpozná jen poslední změnu v počtu opakování. Pokud například v cyklu
GOTO přidáte dalších 10 opakování, software změní celkový počet na n + 10. Pokud poté
přidáte dalších pět (5) opakování ve stejném cyklu, CFX Maestro změní celkový počet
opakování na n + 5. První změna (10 opakování) tak bude ignorována. Abyste zajistili, že
software provede cílový počet opakování, zadejte vždy celkový počet (v tomto případě 15
opakování).

– přeskočí aktuální krok v protokolu.

Poznámka: Pokud během kroku GOTO zahájíte přeskočení, systém přeskočí na další cyklus ve
smyčce GOTO. Pokud v době přeskočení probíhal poslední cyklus kroku GOTO, systém
přeskočí na další krok.
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– rozsvítí indikátor LED na vybraném přístroji pro identifikaci vybraných bloků.

– pozastaví protokol.

Poznámka: Tato akce je zaznamenána v protokolu Run Log (Protokol běhu).

– obnoví pozastavený protokol.

– zastaví běh před ukončením experimentu.

Poznámka: Zastavení běhu před ukončením experimentu může změnit vaše data.

Otevření víka přístroje během cyklu PCR

Pokud je během cyklu PCR otevřeno víko libovolného přístroje, zobrazí CFX Maestro Dx SE následující
potvrzovací dialogové okno:

Když je dialogové okno zobrazení, přístroj pokračuje v běhu protokolu. Tlačítkem OK dojde k pozastavení cyklu
a víko přístroje se uvolní a otevře. Tlačítkem Cancel (Zrušit) dojde k zavření dialogového okna a pokračování
v cyklu.
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Karta Real-time Status (Zobrazení v reálném čase)
Karta Real-time Status (Zobrazení v reálném čase) zobrazuje data PCR odečtená v reálném čase
v průběhu experimentu po ukončení prvních dvou odečtů fluorescence.

1. Podokno Amplification trace (Amplifikační křivky) – zobrazuje amplifikační data
v reálném čase během experimentu.

2. Well group identifier (Identifikátor skupiny jamek) – pokud byly v nastavení destičky
identifikovány skupiny jamek, mohou uživatelé vybrat konkrétní skupinu jamek pro
zobrazení příslušných křivek, jamek a tabulkových informací.

Step number identifier (Identifikátor čísla kroku) – pokud protokol shromažďuje data
ve více než jednom kroku (například během amplifikace a křivky tání), mohou
uživatelé vybrat konkrétní krok a zobrazit křivky shromážděné v tomto kroku.

3. PodoknoWell selector (Nástroj pro výběr jamky) – zobrazí aktivní, neaktivní
a prázdné jamky na destičce.

4. Podokno Nastavení destičky – zobrazí nastavení destičky v tabulkovém formátu.

LEGENDA
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5. Podokno Run Details (Podrobnosti o běhu) – zobrazuje stav běhu v reálném čase
včetně těchto položek:

n Current step (Stávající krok),

n Current repeat (Stávající opakování),

n Current temperature (Stávající teplota),

n Time remaining (Zbývající čas),

n Sample temperature (Teplota vzorku),

n Lid temperature (Teplota víka).

6. Plate Setup (Nastavení destičky) – otevře dialogové okno Plate Setup (Nastavení
destičky), ve kterémmohou uživatelé upravovat aktuální nastavení destičky během
experimentu.

Na kartě Real-time Status (Zobrazení v reálném čase) můžete:

n Zobrazit nebo skrýt křivky v reálném čase jejich výběrem v podokně nástroje pro výběr jamky nebo
v tabulce nastavení destiček

n Zobrazit jednotlivé křivky nebo skupiny křivek tak, že je vyberete v rozevíracím seznamu skupin

n Upravit nebo nahradit soubor destičky

n Použít pro experiment PrimePCR formát.

Zobrazení nebo skrytí křivek v reálném čase

Standardně jsou všechny naplněné jamky aktivní a zobrazují se v tabulce nastavení destičky. Aktivní
jamky se objeví v podokně nástroje pro výběr jamek modře. V podokně nástroje pro výběr jamek se skryté
jamky zobrazují jako světle šedé a nepoužité jamky se zobrazují jako tmavě šedé.

V průběhu experimentu můžete skrýt křivky z aktivních jamek. CFX Maestro Dx SE nadále shromažďuje
údaje pro všechny jamky; pokud skryjete jamky, jejich data se neobjeví v tabulce nastavení destiček.

Skrytí křivek v reálném čase

u V podokně nástroje pro výběr jamek klikněte na aktivní (modré) jamky, které chcete skrýt.

Zobrazení křivek v reálném čase

u V podokně nástroje pro výběr jamek klikněte na skryté (světle šedé) jamky, které chcete zobrazit.

Další informace o nástroji pro výběr jamky naleznete v části Nástroj pro výběr jamky na straně 201.
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Úprava nastavení destičky

Úprava nastavení destičky

u Klikněte na možnost Plate Setup (Nastavení destičky) a potom vyberte položku View/Edit Plate
(Zobrazit/Upravit destičku).

Objeví se okno Plate Editor (Editor destiček), ve kterémmůžete upravovat destičku během
probíhajícího experimentu. Další informace o úpravách destiček uvádí Kapitola 8, Příprava destiček.

Poznámka: Způsob zobrazení křivek můžete také upravit v okně Plate Editor (Editor destiček).
Změny se objeví v záznamu amplifikačních křivek na kartě Real-time Status (Zobrazení
v reálném čase).

Nahrazení souboru destičky

Tip: Nahrazení souboru destičky je obzvláště užitečné, pokud spouštíte běh se souborem Quick
Plate (Rychlá destička) ve složce ExpressLoad (Expresní načtení).

Jak nahradit soubor destičky

u Klikněte na možnost Plate Setup (Nastavení destičky) a vyberte jednu z následujících možností:

n Replace Plate file (Nahradit soubor destičky) – vyberte nový soubor destičky ze seznamu v okně
prohlížeče

n Apply PrimePCR file (Použít soubor PrimePCR) – vyhledejte pomocí chytrého vyhledávání
soubor běhu, ze kterého bude získáno nastavení destičky, nebo klikněte na možnost Browse
(Procházet) , abyste našli soubor stažený z internetových stránek společnosti Bio-Rad, který se
nenachází ve složce PrimePCR

Poznámka: Software CFX Maestro Dx SE kontroluje režim skenování a velikost destičky
v každém experimentu. Nastavení musí být totožné jako nastavení běhu, se kterým byl
experiment zahájen.
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Dialogové okno Run Details (Podrobnosti o běhu)

Karta Time Status (Časový údaj)
Karta Time Status (Časový údaj) ukazuje zbývající čas do dokončení aktuálního běhu.
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Provádění experimentů PrimePCR
PrimePCR eseje jsou speciálně navrženy pro určité druhy experimentů, jsou BioRadem zoptimalizovány
a zvalidovány v laboratoři a jsou k dispozici v následujících formátech:

n Připravené panely – destičky obsahující testy, které jsou specifické pro určitou biologickou dráhu
nebo onemocnění; zahrnují kontroly a referenční geny PrimePCR.

n Vlastní konfigurované destičky – destičky, které lze nastavit v uživatelsky definovaném rozložení
s možností výběru testů pro požadované produkty, kontroly a reference

n Individuální testy – zkumavky, které obsahují jednotlivé sady primerů pro použití v PCR
experimentech v reálném čase.

Chcete-li zkrátit celkovou dobu běhu, můžete odstranit z protokolu krok křivky tání. Společnost Bio-Rad
důrazně doporučuje, abyste neprováděli žádné další úpravy protokolu běhu PrimePCR. Výchozí protokol
je protokol, který byl použit pro validaci testu. Jakékoliv odchylky od tohoto protokolu mohou mít vliv na
výsledky. Změny protokolu jsou zaznamenány na kartě Run Information (Informace o experimentu)
výsledného datového souboru a ve všech vytvořených sestavách.

Spuštění běhu PrimePCR

u Chcete-li spustit běh PrimePCR, postupujte následovně:

n V nástroji Startup Wizard (Průvodce spuštěním) vyberte PrimePCR na kartě Run Setup
(Nastavení běhu) a poté vyberte příslušnou chemii (SYBER® nebo sondu).

n Vyberte položku PrimePCR, která bude spuštěna ze seznamu Recent Runs (Aktuální běhy) na
kartě Repeat Run (Opakovat běh) v průvodci Startup Wizard (Průvodce spuštěním).

n Vyberte položky File > Open > PrimePCR Run (Soubor > Otevřít > Běh PrimePCR) v okně
Home (Domů).

n Přetáhněte soubor protokolu běhu PrimePCR do okna Home (Domů).

Po výběru běhu PrimePCR se otevře okno Run Setup (Nastavení běhu) na kartě Start Run (Spustit běh)
s výchozím nastavením destičky PrimePCR načteným na základě vybraného přístroje.

Chcete-li zkrátit celkovou dobu běhu, můžete z protokolu odstranit krok křivky tání.

u Na kartě Protocol (Protokol) zrušte zaškrtnutí políčka vedle Include Melt Step (Zahrnout krok tání).
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Import cílových informací pro destičky PrimePCR do nastavení destiček

1. Postupujte následovně:

n Na kartě Real-time Status (Zobrazení v reálném čase) v dialogovém okně Run Details
(Podrobnosti o běhu) vyberte položky Plate Setup > Apply PrimePCR File (Nastavení destičky >
Použít soubor PrimePCR).

n V okně Data Analysis (Analýza dat) vyberte položky Plate Setup > Apply PrimePCR File
(Nastavení destičky > Použít soubor PrimePCR) .

2. V dialogovém okně spuštění souboru PrimePCR klikněte na položku Browse (Procházet) a přejděte
na příslušný soubor PrimePCR (.csv).

3. Vyberte cílový soubor PrimePCR a klikněte na Open (Otevřít).

Systém CFX Opus Dx importuje cílové informace do rozvržení destičky
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Přenos Stand-Alone dat k analýze
Důležité: Při přenosu datových souborů ze Systém CFX Opus Dx na CFX Maestro Dx SE se
přenesou všechny soubory uložené v systému. Ujistěte se, že pro bezpečný přenos dat máte na
disku dostatečný prostor.

Jakmile je běh dokončen, CFX Maestro Dx SE provede analýzu fluorescenčních dat. Je-li běh proveden
v samostatném režimu stand-alone a uložen přímo do Systém CFX Opus Dx, je nutné data k analýze
přenést do počítače CFX Maestro Dx SE.

Systém CFX Opus Dx může uložit až 100 experimentů PCR v reálném čase. Po dokončení běhu můžete
stand-alone datové soubory přenést do počítače se softwarem CFX Maestro Dx SE přes e-mail, USB disk
nebo pomocí samotného softwaru.

Tato část popisuje, jak přenést stand-alone datové soubory do počítače se softwarem CFX Maestro Dx
SE.

Přenos dat prostřednictvím e-mailu
Odeslání datového souboru e-mailem na konci běhu

1. Nastavte e-mailová oznámení pro přístroj.

Viz Nastavení e-mailových oznámení na straně 79 nebo Návod k použití k přístroji PCR CFX Opus
Dx pro práci v reálném čase.

2. Při nastavování e-mailových oznámení zkontrolujte, zda je vybrána možnost Attach Data File
(Připojit datový soubor).

Data běhu se odesílají e-mailem jako soubor .pcrd.

Přenos dat z PCR CFX Opus Dx pro práci v reálném čase
Pomocí funkce File Browser (Prohlížeč souborů) na Systém CFX Opus Dx můžete přenášet datové
soubory na připojenou jednotku USB nebo do sdílené síťové složky. Můžete také převést soubory
protokolu CFX Maestro Dx SE z jednotky USB nebo sdílené síťové jednotky do složky nebo veřejné
složky na serveru Systém CFX Opus Dx a spustit je na přístroji Systém CFX Opus Dx .

Tip: Tato část vysvětluje, jak provádět přenos dat. Informace o nastavení připojení Ethernet
naleznete v návodu k použití pro PCR CFX Opus Dx pro práci v reálném čase v nabídce Help
(Nápověda) CFX Maestro Dx SE.
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1. Na obrazovce Home (Domů) Systém CFX Opus Dx klepnutím na Files (Soubory) zobrazíte
obrazovku File Browser (Prohlížeč souborů).

2. Na obrazovce File Browser (Prohlížeč souborů) přejděte na soubor, který chcete zkopírovat, a poté
klepnutím na tento soubor zobrazte podokno podrobností o souboru.

3. V podokně podrobností o daném souboru klepněte na Options (Možnosti) a potom na Copy
(Kopírovat).

Zobrazí se dialogové okno Select Location (Vybrat umístění).

4. V dialogovém okně Select Location (Vybrat umístění) proveďte jednu z následujících akcí:

n Přejděte do existující složky.

n Přejděte na dané umístění a vytvořte složku, do níž chcete soubor uložit, a potom klepněte na
Create Folder (Vytvořit složku)

( ) pro vytvoření nové složky v daném umístění.

5. Klepnutím na Select (Vybrat) zkopírujete soubor do zvoleného umístění nebo se klepnutím na
Cancel (Zrušit) vrátíte na obrazovku File Browser (Prohlížeč souborů).

Poznámka: Pokud ve vybraném umístění existuje soubor se stejným názvem, zobrazí se okno
se zprávou. Klepnutím na Yes (Ano) přepíšete existující soubor nebo klepnutím na No (Ne) se
vrátíte na obrazovku File Browser (Prohlížeč souborů).

Po úspěšném odstranění souboru zobrazí Systém CFX Opus Dx potvrzovací zprávu.
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Přenos dat prostřednictvím Software CFX Maestro Dx,
bezpečnostní edice
K přenosu dat prostřednictvím CFX Maestro Dx SE

1. Na panelu Detected Instruments (Detekované přístroje) v okně Home (Domů) klikněte pravým
tlačítkemmyši na cílový přístroj a vyberte možnost Retrieve Data Files (Načíst datové soubory).

Software CFX Maestro Dx SE otevře dialogové okno Browse For Folder (Najít složku).

2. V dialogovém okně Browse For Folder (Najít složku) přejděte na umístění, do kterého chcete datové
soubory uložit, a klikněte na OK.

Při procesu přenosu se ve vybraném umístění vytvoří složka s názvem Real-Time Data (Data
v reálném čase). Data procesu se uloží do složky Real-Time Data (Data v reálném čase) jako stand-
alone soubory .zpcr.

Přenos dat pomocí USB disku
Pokud zasunete USB disk do USB portu přístroje, datový soubor se po dokončení běhu automaticky uloží
do kořenového adresáře USB disku. Rovněž můžete vyhledat již uložené datové soubory a uložit je na
připojený USB disk.

Chcete-li přenést datové soubory na jednotku USB v Systém CFX Opus Dx

u V dialogovém okně Select Location (Vybrat umístění) klepněte na USB a přejděte do cílové složky,
do které chcete soubor zkopírovat, nebo klikněte na Cancel (Zrušit) pro návrat na obrazovku File
Browser (Prohlížeč souborů).

Poznámka: Pokud ve vybraném umístění existuje soubor se stejným názvem, zobrazí se
dialogové okno. Klepnutím na Yes (Ano) přepíšete existující soubor nebo klepnutím na No (Ne)
se vrátíte na obrazovku File Browser (Prohlížeč souborů).

Po úspěšném odstranění souboru zobrazí Systém CFX Opus Dx potvrzovací zprávu.
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Přenos dat prostřednictvím sdílené síťové jednotky pomocí PCR
CFX Opus Dx pro práci v reálném čase
Tip: Data můžete přenášet na a ze sdílené síťové jednotky pouze prostřednictvím Systém CFX Opus
Dx.

Systém CFX Opus Dx vám umožňuje připojit se ke sdílené síťové jednotce pomocí sítě Ethernet. Při
úspěšném připojení můžete přenášet datové soubory do a ze složky na sdílené síťové jednotce.

Přenos dat na sdílenou síťovou jednotku a z ní

u V dialogovém okně Select Location (Vybrat umístění) klepněte na Network (Síť) a přejděte do cílové
složky, do které chcete soubor zkopírovat, nebo na Cancel (Zrušit) pro návrat na obrazovku File
Browser (Prohlížeč souborů).

Poznámka: Pokud ve vybraném umístění existuje soubor se stejným názvem, zobrazí se
dialogové okno. Klepnutím na Yes (Ano) přepíšete existující soubor nebo klepnutím na No (Ne)
se vrátíte na obrazovku File Browser (Prohlížeč souborů).

Po úspěšném odstranění souboru zobrazí Systém CFX Opus Dx potvrzovací zprávu.

Vytvoření datového souboru
Chcete-li analyzovat data přenesená z přístroje do CFX Maestro Dx SE v počítači, musí se
komprimovaný datový soubor (soubor .zpcr) převést na datový soubor (soubor .pcrd). CFX Maestro Dx
SE převede soubor .zpcr na soubor .pcrd a poté vybere soubor destičky, který má stejný režim skenování
a velikost destičky, a použije jej na soubor .pcrd.

Vytvoření datového souboru ze Stand-Alone datového souboru

1. V softwaru CFX Maestro Dx SE postupujte následovně:

n Vyhledejte cílový soubor .zpcr a přetáhněte jej do okna CFX Maestro Dx SE Home (Domů).

n Vyberte File > Open > Stand-alone Run (Soubor > Otevřít > Stand-alone Run) a přejděte na
cílový soubor a vyberte jej.

CFX Maestro Dx SE otevře dialogové okno Save As (Uložit jako).

2. Přejděte do složky, do které chcete uložit soubor .pcrd, a klikněte na tlačítko Save (Uložit).

Po uložení souboru .pcrd otevře CFX Maestro Dx SE okno Data Analysis (Analýza dat) a zobrazí se
výsledná data.
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Kapitola 10 Analýza dat - přehled
Software CFX Maestro Dx, bezpečnostní edice automaticky zpracovává data PCR v reálném čase na
konci každého pracovního běhu a otevře okno Data Analysis (Analýza dat), kde tato data zobrazí (soubor
.pcrd).

n Přetáhnout datový soubor (koncovka .pcrd) do okna Home (Domů) a uvolnit jej.

n Vybrat File > Open > Data File (Soubor > Otevřít > Datový soubor) v okně Home (Domů) a přejít na
cílový soubor .pcrd.

n Vybrat File > Recent Data Files (Soubor > Nejnovější datové soubory) v okně Home (Domů), budete
tak mít výběr ze seznamu deseti nejnovějších otevřených datových souborů.

n Vybrat kartu Analyze (Analyzovat) v nástroji Startup Wizard (Průvodce spuštěním) a poté vybrat
z nabídky Recent Files (Nové soubory) nebo kliknout na Browse (Procházet) pro vyhledání datového
souboru.

Okno Data Analysis (Analýza dat)
Okno Data Analysis (Analýza dat) zobrazuje více záložek, přičemž každá záložka zobrazuje analyzovaná
data pro konkrétní metodu analýzy nebo informace specifické pro běh. Záložky se zobrazují pouze tehdy,
jsou-li pro tento typ analýzy k dispozici příslušná data.

Tip: Chcete-li vybrat karty, které chcete zobrazit, vyberte je v rozevírací nabídce View (Zobrazit)
v okně Data Analysis (Analýza dat). Chcete-li se vrátit k původnímu rozložení karet, vyberte položky
Settings > Restore Default Window Layout (Nastavení > Obnovit výchozí rozvržení okna).
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Panel nástrojů pro analýzu dat
Panel nástrojů v okně Data Analysis (Analýza dat) poskytuje rychlý přístup k důležitým funkcím analýzy
dat.

Tabulka 11 uvádí seznam funkcí tlačítek na panelu nástrojů.

Tlačítko Název Funkce

Plate Setup
(Nastavení
destičky)

View/Edit pane (Zobrazit/upravit destičku):
Otevře Plate Editor (Editor destiček) pro
zobrazení a úpravy obsahu jamek.

Replace Plate (Nahradit destičku) – Vybere
soubor destičky, který má nahradit nastavení
destičky.

Apply PrimePCR file (Použít soubor PrimePCR)
– Vybere soubor běhu, který má nahradit
nastavení destičky pro běh PrimePCR.

ManageWell
Groups (Spravovat
skupiny jamek)

Pro tvorbu, úpravu a odstranění skupin jamek
klikněte na oknoWell Groups Manager (Správce
skupiny jamek).

Well Group
(Skupina jamek)

Vybere existující název skupiny jamek
z rozevírací nabídky. Výchozí výběr je All Wells
(Všechny jamky). Toto tlačítko se zobrazí pouze
tehdy, když jsou vytvořeny skupiny.

Analysis Mode
(Režim analýzy)

Analyzuje data v režimu Fluorophore (Fluorofor)
nebo Target (Produkt).

Help (Nápověda) Otevírá softwarovou nápovědu, ve které najdete
online nápovědu a digitální kopii této příručky ve
formátu Acrobat PDF.

Tabulka 11. Panel nástrojů v okně Data Analysis (Analýza dat)
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Okno Data Analysis (Analýza dat)

Panel nabídek pro analýzu dat
Tabulka 12 obsahuje seznam položek nabídky v okně Data Analysis (Analýza dat).

Položka
nabídky Příkaz Funkce

File (Soubor) Save (Uložit) Uloží soubor.

Save As (Uložit jako) Uloží soubor s novým názvem.

File Passwords (Hesla souborů) Umožňuje uživatelům nastavit ukládání
souborů a otevírat hesla.

Sign (Podepsat) Umožňuje uživatelům podepsat datový
soubor.

Repeat Run (Opakovat běh) Extrahuje protokol a soubor destičky
z aktuálního běhu pro nové spuštění.

Close (Zavřít) Zavře okno Data Analysis (Analýza dat).

View (Zobrazit) Run Log (Protokol běhu) Otevře okno Run Log (Protokol běhu)
a zobrazí protokol běhu aktuálního datového
souboru.

Revizní záznam Otevře revizní záznam pro soubor.

Quantification (Kvantifikace), Melt
Curve (Křivka tání), Gene
Expression (Genová exprese),
EndPoint (End-point analýza),
Custom Data View (Vlastní
zobrazení dat), QC (Kontrola
kvality), Run Information
(Informace o experimentu)

Zobrazuje analyzovaná data na vybraných
kartách v okně Data Analysis (Analýza dat).
Musí být vybrána alespoň jedna karta.

Tabulka 12. Seznam položek v okně Data Analysis (Analýza dat)
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Položka
nabídky Příkaz Funkce

Settings
(Nastavení)

Cq Determination Mode (Režim
určení Cq)

Vyberte možnost Regression (Regrese) nebo
Single Threshold (Jednotný threshold),
a určete tak, jak se vypočítávají hodnoty Cq pro
každou křivku.

Baseline Setting (Poloha baseline) Umožňuje vybrat metodu odečítání polohy
baseline pro vybrané skupiny jamek.

Režim analýzy Umožňuje analyzovat data s použitím
možnosti Fluorophore (Fluorofor), nebo Target
(Produkt).

Počet cyklů zahrnutých do analýzy Umožňuje vybrat běhy, které se budou
analyzovat.

Baseline Threshold Otevřte okno Baseline Threshold a upravte
hodnotu baseline nebo threshold.

Trace Styles (Možnosti křivek) Otevře okno Trace Styles (Možnosti křivek).

Plate Setup (Nastavení destičky) Otevře Plate Editor (Editor destiček) pro
zobrazení a úpravu destičky; nahradí aktuální
destičku jedním z uživatelsky definovaných
souborů destiček nebo souborem PrimePCR.

Include All Excluded Wells
(Zahrnout všechny vyloučené
jamky)

Zahrne všechny vyloučené jamky v analýze.

Mouse Highlighting (Zvýraznění
myší)

Zapíná nebo vypíná současné zvýraznění dat
ukazatelem myši.

Tip: Pokud je Mouse Highlighting
(Zvýraznění myší) vypnuto, stiskněte
klávesu Control (Ctrl) pro dočasné
zapnutí zvýraznění.

Restore Default Window Layout
(Obnovit výchozí rozvržení okna)

Obnoví uspořádání oken na výchozí
nastavení.

Tabulka 12. Seznam položek v okně Data Analysis (Analýza dat), pokračování
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Okno Data Analysis (Analýza dat)

Položka
nabídky Příkaz Funkce

Export Export All Data Sheets (Exportovat
všechny tabulky)

Umožňuje vám vybrat, zda chcete exportovat
všechna zobrazení tabulky z každé karty do
formátu CSV nebo TXT. Soubor Excel nebo
XML.

Export RDML File (Exportovat
soubor RDML)

Umožňuje vybrat verzi 1.1 nebo 1.0 RDML, do
které chcete soubor exportovat.

Custom Export (Vlastní export) Otevře okno Custom Export (Vlastní export),
ve kterém je možné určit pole, která mají být
exportována, a formát souboru.

Export to LIMS (Export do složky
LIMS)

Otevře okno pro uložení dat do předem
určeného formátu do složky LIMS.

Ruční export Otevře okno pro identifikaci umístění
ukládaných dat ze všech zobrazení tabulky
v souborech aplikace Excel, speciálně
strukturovaných pro použití společností
Seegene, Inc., a Bio-Rad Laboratories.

Tip: Prohlížeč Seegene můžete také
automaticky spustit při exportu. Další
informace najdete v části Příkazy nabídky
Tools (Nástroje) na straně 65.

Tools (Nástroje) Reports (Reporty) Otevře report pro konkrétní datový soubor.

Well Group Reports (Report o
skupinách jamek)

Otevře oknoWell Group Report (Report pro
skupiny jamek) pro vytvoření reportu pro
určené skupiny jamek.

Import Fluorophore Calibration
(Import kalibrace fluoroforu)

Vyberte kalibrační soubor, který se použije pro
aktuální datový soubor.

qbase+ Spouští qbase+ v2.5 přímo z aktuálního
souboru .pcrd, pokud je nainstalován.

Generate LIMS PLRN file
(Generovat soubor LIMS PLRN)

Uloží datový soubor jako soubor PLRN ve
formátu LIMS.

Tabulka 12. Seznam položek v okně Data Analysis (Analýza dat), pokračování
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Karta Details (Podrobnosti)
Každá karta v okně Data Analysis (Analýza dat) obsahuje data z grafu a tabulek pro konkrétní metodu
analýzy a zahrnuje nástroj pro výběr jamek, s jehož pomocí lze vybírat data, která chcete zobrazit. Když
se otevře, zobrazí okno Data Analysis (Analýza dat) ve výchozím nastavení kartu Quantification
(Kvantifikace). Data z grafu Amplification (Amplifikace) na kartě Quantification (Kvantifikace) můžete
použít ke stanovení příslušného nastavení analýzy pro běh.

Poznámka: Software propojuje data v podoknech každé karty Data Analysis (Analýza dat).
Například při zvýraznění jamky tak, že na ni v nástroji pro výběr jamky umístíte kurzor, zvýrazní se i
data ve všech ostatních podoknech.

Nástroj pro výběr Step Number (Číslo kroku)
Systémy CFX Opus Dx mohou získávat fluorescenční data ve více krocích protokolu; software uchovává
data získaná v každém kroku samostatně. CFX Maestro Dx SE zobrazí nástroj pro výběr kroku pod
grafem Standardní křivka na kartě Kvantifikace. Pokud protokol obsahuje alespoň jeden krok sběru dat,
software CFX Maestro Dx SE zobrazí data z prvního kroku sběru.

Pokud protokol obsahuje více než jeden krok sběru, můžete z rozevíracího seznamu vybrat další krok.
Například:

Když vyberete krok, software použije tento výběr na všechna data, která se zobrazí v okně Data Analysis
(Analýza dat).
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Okno Data Analysis (Analýza dat)

Zobrazení skupin jamek v analýze dat
Pro účely nezávislé analýzy pomocí skupin jamek lze jamky na destičce sdružovat do dílčích sad. Když
vytvoříte skupiny jamek, objeví se názvy skupin v okně Data Analysis (Analýza dat), v rozevíracím
seznamuWell Groups (Skupiny jamek) na panelu nástrojů.

Jestliže jste vytvořili skupiny jamek, zobrazí software po otevření okna Data Analysis (Analýza dat)
výchozí skupinu jamek All Wells (Všechny jamky), která uvádí data pro všechny jamky obsažené
v grafech a tabulkách. V nástroji pro výběr jamek se objeví pouze jamky v načtené skupině s příslušným
obsahem a ve výpočtech pro analýzu dat budou zahrnuta pouze data pro tyto jamky.

Tip: Pro tvorbu, úpravu a odstranění skupin jamek klikněte na položku ManageWell Groups
(Spravovat skupiny jamek) na panelu nástrojů.

Poznámka: Pokud jste nevytvořili skupiny jamek, rozevírací seznamWell Groups (Skupiny jamek)
se na panelu nástrojů neobjeví.

Změna obsahu jamky po ukončení běhu
Pokud dojde během analýzy dat ke změnám ve způsobu zobrazení dat nebo popisu jednotlivých jamek,
Plate Editor (Editor destiček) nikdy nezmění fluorescenční data shromážděná z každé jamky v průběhu
experimentu. Naměřené hodnoty fluorescence není možné vymazat, ale lze je vyloučit ze zobrazení
a z analýzy.

Jak změnit obsah jamek po ukončení běhu

u V okně Data Analysis (Analýza dat) klikněte na Plate Setup (Nastavení destičky) a vyberte jednu
z následujících možností:

n Edit/View Plate (Editovat/upravit destičku) – otevře nástroj Plate Editor (Editor destiček), ve
kterémmůžete provádět manuální změny nastavení.

n Replace Plate File (Nahradit soubor destičky) – otevře prohlížeč Select Plate (Vybrat
destičku), ve kterémmůžete přejít na dříve uložený soubor destičky, jímž chcete nahradit
aktuální nastavení destičky.

n Apply PrimePCR file (Použít soubor PrimePCR) – otevře dialogové okno Select PrimePCR
file (Vybrat soubor PrimePCR), ve kterémmůžete přejít na spouštěcí soubor PrimePCR a použít
jej pro nastavení destičky.

Tip: Informace o obsahu jamky můžete přidávat nebo upravovat před během PCR, během něj nebo
po jeho ukončení. Před cyklem musíte přiřadit režim skenování a velikost destičky. Tyto parametry už
nelze po ukončení běhu změnit.
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Nastavení analýzy dat
Data v grafu Amplification (Amplifikace) na kartě Quantification (Kvantifikace) zobrazují relativní
fluorescenci (RFU) pro každou jamku v každém cyklu. Každá křivka v grafu představuje data pro jeden
fluorofor v jedné jamce. Tato data jsou použita pro stanovení hodnot Cq pro každou jamku na základě
jednoho fluoroforu. Software používá k určení hodnot Cq jeden ze dvou režimů:

n Regression (Regrese) – aplikuje vícerozměrný, nelineární regresní model pro jednotlivé křivky
a pak tento model používá k výpočtu optimálních hodnot Cq.

n Single Threshold (Jednotný threshold) – používá jedinou hodnotu threshold pro výpočet hodnot
Cq na základě hodnoty průniku jednotlivých fluorescenční křivek.

Vyberte položky Settings (Nastavení) > Cq Determination Mode (Režim určení) a vyberte režim určení
hodnot Cq.

Nastavení hodnoty Threshold
V režimu Single Threshold (Jednotný threshold) můžete upravit threshold pro fluorofor tak, že kliknete na
řádek s hodnotou threshold v grafu Amplification (Amplifikace) a svisle kurzor posunete. Případně můžete
stanovit přesný práh překročení pro vybraný fluorofor.

Nastavení baseline
Software automaticky nastaví hodnotu baseline individuálně pro každou jamku. Nastavení baseline
určuje metodu odečítání baseline pro všechny fluorescenční křivky. Software poskytuje tři možnosti
odečítání polohy baseline:

n No Baseline Subtraction (Bez odečtu baseline) – zobrazí data jako relativní fluorescenční křivky.
Některé analýzy v tomto režimu analýzy nejsou možné, a proto software nezobrazuje karty Gene
Expression (Genová exprese), EndPoint (End-point analýza) a Allelic Discrimination (Alelická
diskriminace).

n Baseline Subtracted (Baseline odečtena) – zobrazí data jako křivky po odečtení hodnoty baseline
pro každý fluorofor v jamce. Software musí od dat odečíst hodnoty baseline pro stanovení cyklů
kvantifikace, vytvoření standardních křivek a určení koncentrace neznámých vzorků. Aby se
generovala data s odečtením baseline hodnoty, software proloží optimální přímku procházející
zaznamenanou fluorescencí každé jamky během baseline cyklů a pak odečte ideálně proložená data
od pozadí odečtených dat v každém cyklu.

n Baseline Subtracted Curve Fit (Úprava odečtené linie baseline) – zobrazí data jako odečtené
hodnoty baseline a software vyhladí odečtenou základní linii pomocí středového filtru. Tento proces
se provádí tak, že všechny hodnoty Cq zůstávají beze změny.
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Nastavení analýzy dat

Kromě těchto možností můžete také vybrat možnost Apply Fluorescent Drift Correction (Použít korekci
posunu fluorescence). Pro jamky, které mají abnormálně driftující hodnoty RFU během počátečních několika
cyklů běhu, software odvodí odhadovanou baseline ze sousedních jamek, pro které byla úspěšně vytvořena
horizontální baseline.

Změna nastavení odčítání linie baseline

u Vyberte položky Settings > Baseline Setting (Nastavení > Poloha baseline).

Režim analýzy
Data mohou být seskupena a analyzována podle fluoroforu nebo podle názvu produktu. Při seskupení podle
fluoroforu se zobrazují datové stopy podle fluoroforu, jak je uvedeno v nastavení destičky pro daný běh.
Údaje o individuálních fluoroforech se objevují v grafu amplifikace a standardní křivky (je-li k dispozici),
pokud jsou vybrána příslušná zaškrtávací políčka nástroje pro výběr fluoroforu, nacházející se pod grafem
amplifikace.

Při seskupení podle produktu se zobrazují datové stopy podle názvu produktu zadaného v nastavení
destičky pro daný běh.

Výběr režimu analýzy dat

u Postupujte následovně:

n Vyberte Settings > Analysis Mode (Nastavení > Režim analýzy).

n Vyberte režim z rozbalovací nabídky Analysis Mode (Režim analýzy) na panelu nástrojů.
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Počet cyklů zahrnutých do analýzy
Počet cyklů pro analýzu můžete omezit. Můžete rovněž analyzovat data z konkrétních setů zahrnujících
omezený počet cyklů. Maximální počet cyklů, které lze analyzovat, je 50.

Poznámka: Odstranění cyklů na začátku pracovního běhu může mít významný dopad na nastavení
baseline.

Jak omezit analýzu dat na konkrétní rozsah cyklů

1. Vyberte položky Settings > Cycles to Analyze (Nastavení > Cykly pro analýzu).

Otevře se dialogové okno Cycles to Analyze (Cykly pro analýzu).

2. Zadejte počáteční a koncové hodnoty cyklu a klikněte na OK.

Klikněte na možnost Restore Defaults (Obnovit výchozí hodnoty) v dialogovém okně Cycles to Analyze
(Cykly pro analýzu) pro návrat k cyklům, které byly pro analýzu původně použity.
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Nástroj pro výběr jamky

Nástroj pro výběr jamky
Nástroj pro výběr jamky slouží k zobrazení nebo skrytí dat jamky v grafech nebo tabulkách v okně Data
Analysis (Analýza dat). V nástroji pro výběr jamky lze vybrat pouze jamky naplněné vzorkem. Software
používá barvy pro označení jamek v nástroji pro výběr jamky:

n Blue (Modrá) – označuje vybrané jamky. Data z vybraných jamek se zobrazí v okně Data Analysis
(Analýza dat).

n Light gray (Světle šedá) – označuje nevybrané jamky Data z nevybraných jamek se zobrazí v okně
Data Analysis (Analýza dat).

n Dark gray (Tmavě šedá) – označuje prázdné jamky.

Zobrazení nebo skrytí dat o jamce

u V nástroji pro výběr jamky postupujte následovně:

n Chcete-li skrýt jednu jamku, klikněte na konkrétní jamku. Chcete-li tuto jamku zobrazit, klikněte
na ni znovu.

n Chcete-li skrýt více jamek, přetáhněte kurzor přes jamky, které chcete vybrat. Chcete-li tyto
jamky zobrazit, znovu kurzor přetáhněte.

n Kliknutím na levý horní roh destičky skryjete všechny jamky. Pro výběr všech jamek klikněte
znovu na levý horní roh.

n Kliknutím na začátek sloupce nebo řádku skryjete příslušné jamky. Klepnutím na sloupec nebo
řádek znovu jamky zobrazíte.
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Položky nabídky po kliknutí pravým tlačítkem myši
Tabulka 13 obsahuje seznammožností dostupných v zobrazení nástroje pro výběr jamek po kliknutím
pravým tlačítkemmyši.

Položka Funkce

Well XX (Jamka XX) Zobrazí pouze tuto jamku, odstraní tuto jamku z náhledu, nastaví
barvu této jamky nebo vyjme tuto jamku z analýzy.

Selected Wells (Vybrané jamky)
(kliknout pravým tlačítkemmyši
a přetáhnout)

Zobrazí pouze tyto jamky, odstraní tyto jamky z náhledu, nastaví barvu
těchto jamek, nebo vyjme tyto jamky z analýzy.

Copy (Kopírovat) Zkopíruje obsah jamky do schránky, včetně typu vzorku a volitelného
čísla replikace.

Copy as Image (Kopírovat jako
obrázek)

Zkopíruje zobrazení nástroje pro výběr jamek jako obrázek.

Print (Tisk) Vytiskne zobrazení nástroje pro výběr jamek.

Print Selection (Vytisknout
výběr)

Vytiskne aktuální výběr.

Export to Excel (Export do
aplikace Excel)

Exportuje data do tabulky Excel.

Export to CSV (Export do
souboru CSV)

Exportuje data jako dokument .csv.

Export to Xml (Export do
souboru XML)

Exportuje data jako dokument ve formátu .xml.

Well Labels (Popis jamek) Změní popisy jamek na Sample Type (Typ vzorku), Target Name
(Název produktu), nebo Sample Name (Název vzorku).

Tabulka 13. Položky nabídky pro výběr jamek po kliknutí pravým tlačítkem myši
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Nástroj pro výběr jamky

Dočasné vyloučení jamek z analýzy
Jak dočasně vyloučit jamky z analýzy dat

1. Klikněte pravým tlačítkemmyši na nástroj pro výběr jamky, na křivku fluorescence nebo na bod
zanesený na standardní křivku. Pro vyloučení více jamek tyto jamky, křivky nebo body zvýrazněte
tak, že na ně kliknete pravým tlačítkemmyši a přetáhnete je.

2. Z nabídky po kliknutí pravým tlačítkemmyši vyberte příslušnou možnost:

n Well > Exclude Well (Jamka > Vyloučit jamku)

n Selected Wells > Exclude from Analysis (Vybrané jamky > Vyloučit z analýzy)

n Selected Traces > Exclude these wells from Analysis (Vybrané křivky > Vyloučit tyto jamky
z analýzy)

Případně pokud chcete trvale odejmout jamky z analýzy, vymažte obsah jamek v nástroji Plate Editor
(Editor destiček) tak, že kliknete na tlačítko Clear Wells (Vymazat jamky).

Důležité: Obsah každé vymazané jamky musíte znovu zadat.

Jak zahrnout vyloučenou jamku

u Klikněte pravým tlačítkemmyši na příslušnou jamku v nástroji pro výběr jamek a vyberte položky
Well > Include Well in Analysis (Jamka > Zahrnout jamku do analýzy).
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Grafy
Každý graf v okně Data Analysis (Analýza dat) zobrazuje data v různých diagramech a zahrnuje možnosti
pro úpravu a export dat nebo grafických prvků grafu.

Nástroje grafu
Tabulka 14 obsahuje seznammožností dostupných po kliknutím pravým tlačítkemmyši ve většině grafů.

Položka Funkce

Copy (Kopírovat) Zkopíruje graf do schránky.

Save Image As... (Uložit
obrázek jako...)

Uloží graf jako soubor obrázku. Nastavte rozlišení a rozměry obrázku
a potom vyberte typ souboru (PNG, GIF, JPG, TIF, nebo BMP).

Page Setup... (Nastavení
stránky...)

Vybere nastavení stránky pro tisk.

Print... (Tisk...) Vytiskne graf.

Set Scale to Default (Nastavit
měřítko na výchozí)

Zobrazí všechna data ve sloupcovém grafu. Posuvníky se objeví, když
je v grafu zobrazeno příliš mnoho datových bodů / vzorků.

Nastavení grafu Nastavení grafu (Copy to Clipboard) – otevře dialog Chart Settings
(Nastavení grafu), ve kterémmůžete upravit možnosti zobrazení grafu
včetně těchto položek:

n Názvy grafů a os

n Písmo a velikost grafu a osy

n Měřítko osy

n Pozice legendy

Tabulka 14. Položky nabídky po kliknutí pravým tlačítkem myši společné ve většině grafů

Nástroje grafu se zobrazí v každém grafu v okně Data Analysis (Analýza dat). U všech grafů jsou
následující nástroje:

Copy to Clipboard (Kopírovat do schránky) – zkopíruje obsah zobrazení grafu do schránky.

Chart Settings (Nastavení grafu) – otevře dialog Chart Settings (Nastavení grafu), ve kterémmůžete
upravit možnosti zobrazení grafu.

Export (Exportovat) – otevře dialog Export Options (Možnosti exportu), ze kterého můžete změnit
rozlišení a velikost grafu a uložit ho na určené místo jako jeden z následujících typů souborů:

n .bmp
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Grafy

n .jpg

n .png

Nástroje sloupcového grafu

Kromě výše uvedených funkcí zobrazují sloupcové grafy následující nástroje:

Sort (Řazení) – třídí produkty a vzorky abecedně nebo v obráceném pořadí.

Color Settings (Nastavení barvy) – otevře okno Color Settings (Nastavení barvy), kde můžete změnit
barvu produktů nebo vzorků.

Více informací naleznete v části Změna a anotace zobrazení grafu na straně 264.

Nástroje grafu amplifikace

Kromě výše uvedených funkcí zobrazují grafy amplifikace následující nástroje:

Trace Styles (Možnosti křivek) – otevře dialogové okno Trace Styles (Možnosti křivek), kde můžete
upravit vzhled křivek a grafu křivek amplifikace.

Baseline Threshold – otevře dialogové okno Baseline Threshold (Výchozí práh), kde můžete upravit
výchozí baseline pro vybrané jamky nebo změnit hodnotu threshold pro každou fluorescenční křivku
v grafu amplifikace.

Kopírování dat z grafů do schránky

Náhled grafu můžete kopírovat a vložit jej do jakékoliv aplikace, která umí pracovat s bitmapovými
obrazovými soubory.

Jak kopírovat data z grafů do schránky

1. Z nástrojů grafu vyberte ikonu Copy to Clipboard (Kopírovat do schránky).

2. Otevřete aplikaci, která umí pracovat s bitmapovými obrázky, například Microsoft Word.

3. Klikněte pravým tlačítkemmyši a vyberte možnost Paste (Vložit) pro vložení bitmapového obrázku ze
schránky do aplikace.

Změna nastavení zobrazení grafu

V dialogovém okně Chart Settings (Nastavení grafu) můžete měnit názvy, fonty a velikosti, měřítko os
a umístění legendy zobrazeného grafu. Provedené změny platí pouze pro zobrazený graf a společně
s grafem se uloží.
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Jak změnit nastavení zobrazení grafu

1. Z nástrojů grafu klikněte na Chart Settings (Nastavení grafu).

Otevře se dialogové okno Chart Settings (Nastavení grafu).

2. Vyberte kartu Chart And Axes (Graf a osy) pro:

n zadání názvu grafu;

n zadání nového názvu osy X a stanovení úhlu popisů;

n zadání nového názvu osy Y.

3. Vyberte kartu Fonts (Fonty) pro změnu fontu grafu a jeho velikosti.

Tip: Ve výchozím nastavení se při změně velikosti grafu automaticky mění i velikost fontu.
Vyberte Change Font Size (Změnit velikost fontu) pro nastavení statické velikosti fontu pro
každý typ popisku.

4. Vyberte kartu Axes Scale (Měřítko os) pro:

n zrušení automatické změny měřítka os X a Y a stanovení minimální a maximální hodnoty
měřítka;

n zobrazení mřížky nebo osových značek v grafu.

5. Vyberte kartu Legend (Legenda) pro:

n skrytí legendy grafu;

n změnu výchozí pozice legendy grafu.
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Poznámka: Pokud se legenda nachází nalevo nebo napravo od grafu, obsahuje pouze prvních
deset fluoroforů v grafu.

6. Kliknutím na Apply (Použít) můžete kdykoliv zobrazit změny nastavení grafu, aniž byste je uložili.

7. Pro uložení změn a návrat ke grafu klikněte na OK.

Export grafu

Toto dialogové okno slouží k úpravě šířky, výšky a rozlišení grafu pro jeho export v jednom
z následujících formátů souborů:

n .bmp

n .jpg

n .png

Exportovaný graf pak můžete použít k zobrazení výsledků v posterových relacích, prezentacích Microsoft
PowerPoint a odborných časopisech.

Poznámka: Při úpravě nastavení zvažte následující:

n Maximální a minimální limity šířky a výšky

o Při rozlišení 72 dpi: 0,25–210,82 cm

o Při 96 dpi: 0,25–157,48 cm

o Při 150 dpi: 0,25–101,6 cm

o Při 300 dpi: 0,25–50,8 cm

o Při 600 dpi: 0,25–25,4 cm

o Ve všech rozlišeních: 2–6 000 pixelů

n Poměr stran odpovídá šířce.

Export grafu

1. Z nástrojů grafu klikněte na Export.

Zobrazí se dialogové okno Export Preview (Náhled exportu).
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2. Podle potřeby upravte nastavení zobrazení.

3. Klikněte na položku Export (Exportovat).

4. V dialogovém okně Export postupujte následovně:

a. (Volitelné) Přejděte do složky, do které chcete uložit graf.

b. Zadejte název souboru a vyberte typ souboru z rozevíracího seznamu.

5. Klepnutím na tlačítko Save (Uložit) uložte graf.

Úprava nastavení Baseline Threshold

V režimu Single Threshold (Jednotný threshold) můžete upravit threshold pro fluorofor tak, že kliknete na
řádek s hodnotou threshold v grafu Amplification (Amplifikace) a svisle kurzor posunete. Případně můžete
stanovit přesnou hodnotu threshold pro vybraný fluorofor.

Tip: Na kartě Data Analysis (Analýza dat) v nabídce User > User Preferences (Uživatel > Uživatelské
předvolby) můžete určit rozsah cyklu, abyste stanovili baseline pro všechny datové soubory.

Jak nastavit rozsah hodnoty baseline pro každou jamku

1. Na kartě Quantification (Kvantifikace) vyberte jeden fluorofor pod grafem Amplification (Amplifikace).

2. Z nástrojů grafu vyberte Baseline Threshold.

Otevře se dialogové okno Baseline Threshold.

208 | Software CFX Maestro Dx SE



Grafy

3. V části Baseline Cycles (Běhy baseline) postupujte následovně:

n Pro výběr jedné jamky klikněte na číslo jejího řádku.

n Pro výběr několika sousedních jamek klikněte na číslo řádku první jamky a táhněte v sloupci
dolů až k poslední jamce.

n Pro výběr několika jamek, které se nenacházejí vedle sebe, stiskněte klávesu Control a klikněte
postupně na čísla řádků všech cílových jamek.

n Pro výběr všech jamek klikněte na levý horní roh tabulky.

4. Upravte rozsah hodnoty baseline pro všechny vybrané jamky, popř. změňte číslo počátečního
a koncového cyklu v dolní části tabulky.

Tip: Pro návrat nastavení na poslední uložené hodnoty klikněte na položku Reset All User
Defined Values (Resetovat všechny hodnoty definované uživatelem).

5. Pro uložení změn a návrat ke grafu klikněte na OK.

Jak stanovit rozsah cyklu pro všechny datové soubory

u V okně Home (Domů) nebo Plate Editor (Editor destiček) vyberte User > User Preferences (Uživatel
> Uživatelské předvolby) a zvolte kartu Data Analysis (Analýza dat).

Výběr cílových hodnot, dat vzorků a biologických skupin

Poznámka: Tato možnost je k dispozici pouze v grafu genové exprese.

Ve výchozím nastavení se seznamy Targets (Produkty), Samples (Vzorky) a Biological Groups
(Biologické skupiny) zobrazují v abecedním pořadí. Dialogové okno Sort (Řazení) slouží k řazení
zobrazení v obráceném abecedním pořadí nebo k ručnímu přesunutí výrazu na jinou pozici v seznamu.

Výběr cílových hodnot, dat vzorků a biologických skupin

1. Z nástrojů grafu klikněte na Export.

Zobrazí se dialogové okno Gene Expression Chart Sorting (Výběr dat grafu genové exprese).
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2. V dialogovém okně klikněte na položku Z-A a seřadíte seznam v obráceném abecedním pořadí.

3. Chcete-li termín ručně přesunout, vyberte jej a klikněte na příslušné tlačítko mezi grafy:

n Kliknutím na šipku nahoru nebo dolů přesunete vybraný termín o jednu pozici.

n Kliknutím na šipku nahoru nebo dolů přesunete vybraný výraz na začátek nebo na konec
seznamu.

4. Kliknutím na tlačítko OK uložte změny a vraťte se na kartu Gene Expression (Genová exprese).
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Změna nastavení barev produktu a vzorku

Poznámka: Tato možnost je k dispozici pouze v grafu genové exprese.

Pomocí dialogového okna Color Settings (Nastavení barev) můžete měnit barvu produktu nebo vzorku,
popř. odstranit položku z grafu.

Jak změnit nastavení barev

1. Z nástrojů grafu vyberte Color Settings (Nastavení barev).

Zobrazí se dialogové okno Color Settings (Nastavení barev).

2. Pro změnu barvy zobrazení produktu nebo vzorku klikněte na jeho barvu ve sloupci Color (Barva).

3. V zobrazeném dialogovém okně Color (Barva) vyberte novou barvu a klikněte na tlačítko OK.

4. Chcete-li odstranit položku z grafu genové exprese, odznačte příslušné zaškrtávací políčko v sloupci
Show Chart (Zobrazit graf).

Tip: Chcete-li odstranit všechny položky z grafu genové exprese, odznačte zaškrtávací políčko
Show Chart (Zobrazit graf) v hlavičce sloupce.

5. (Volitelné) Ve výchozím nastavení se barva sloupcového grafu zobrazí ve formě gradientu. Pro
zobrazení vyplněné barvy vyberte položku Use Solid Colors (Použít plné barvy).

6. Kliknutím na tlačítko OK uložte změny a vraťte se na kartu Gene Expression (Genová exprese).
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Zvětšení oblasti v grafu
Jak zvětšit oblast v grafu

u Klikněte a přetáhněte kurzor přes graf a následně klikněte na položku Zoom (Lupa). Software změní
velikost grafu a vystředí jej na vybranou oblast.

Poznámka: * V případě sloupcového grafu nemusíte na vyskakovací příkaz Zoom (Lupa) klikat.

Jak resetovat graf chart na plný náhled

u Klikněte pravým tlačítkemmyši na graf a vyberte položku Set Scale to Default (Nastavit měřítko na
výchozí).

Kopírování grafů do souboru Microsoft
Datové grafy můžete kopírovat do dokumentů pro Microsoft Word, Excel nebo PowerPoint. Rozlišení
obrázku odpovídá rozlišení obrazovky, ze které byl obrázek získán.

Jak kopírovat grafy do souboru Microsoft

1. V okně Analýza dat klikněte na Kopírovat do schránky v pravém horním rohu podokna grafu.

2. Otevřete prázdný soubor Microsoft a vložte obsah ze schránky.

Společné položky nabídky pro grafy po kliknutí pravým tlačítkem
myši
Tabulka 15 uvádí položky nabídky pravým tlačítkemmyši, které jsou k dispozici v grafech. Některé
položky jsou k dispozici pro všechny grafy, včetně položek ke změně zobrazení dat nebo k snadnému
exportu dat z grafu.

Položka Funkce

Copy (Kopírovat) Zkopíruje graf do schránky.

Save Image As
(Uložit obrázek
jako)

Uloží obrázek v zadané velikosti, rozlišení a typu souboru, včetně PNG (výchozí),
JPG a BMP.

Page Setup
(Nastavení
stránky)

Zobrazí možnosti nastavení tisku.

Tabulka 15. Položky nabídky pro grafy po kliknutí pravým tlačítkem myši
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Položka Funkce

Print (Tisk) Vytiskne graf.

Set Scale to
Default (Nastavit
měřítko na
výchozí)

Po zvětšení grafu vrátí graf do výchozího zobrazení.

Chart Options
(Možnosti grafu)

Otevře okno Chart Options (Možnosti grafu) pro změnu grafu, včetně názvu, výběru
limitů pro osy x a y a zobrazení rastrových čar a menších zaškrtnutí v osách.

Poznámka: Položky nabídky, které se vztahují na konkrétní grafy, jsou popsány v Kapitola 11,
Podrobnosti o analýze dat.
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Tabulky
Tabulky zobrazené v náhledu Data Analysis (Analýza dat) obsahují možnosti pro řazení a přenos dat.
Můžete sloupce řadit jedním z následujících způsobů:

n Klikněte a přetáhněte sloupec do nové pozice ve vybrané tabulce.

n Pro řazení dat ve vzestupném nebo sestupném pořadí klikněte na záhlaví sloupce.

Jak seřadit až tři sloupce dat v okně Sort (Řazení)

1. Klikněte pravým tlačítkemmyši do tabulky a vyberte položku Sort (Řazení).

2. V dialogovém okně Sort (Řazení) vyberte název prvního sloupce, který chcete seřadit. Seřaďte data
ve vzestupném nebo sestupném pořadí.

3. Vyberte druhý nebo třetí sloupec k řazení a zvolte možnost Ascending (Vzestupně) nebo Descending
(Sestupně).

4. Klikněte na OK pro řazení dat nebo na Cancel (Zrušit) pro ukončení řazení.

Tip: Zvýrazněte data v příslušných grafech a v nástroji pro výběr jamek tak, že podržíte kurzor nad
buňkou. Klikněte do buňky pro zkopírování a vložení jejího obsahu do jiného softwarového
programu.

Společné položky nabídky pro tabulky po kliknutí pravým
tlačítkem myši
Tabulka 16 zobrazuje položky nabídky po kliknutí pravým tlačítkemmyši dostupné v libovolném
zobrazení tabulky.

Položka Funkce

Copy (Kopírovat) Zkopíruje obsah vybraných jamek do schránky a vloží obsah do
tabulky, jako je Excel.

Copy as Image (Kopírovat jako
obrázek)

Zkopíruje zobrazení tabulky jako soubor obrázku a vloží jej do
souboru, který akceptuje soubor obrázku. Může jít například
o textové, obrázkové nebo tabulkové soubory.

Print (Tisk) Vytiskne aktuální zobrazení.

Tabulka 16. Položky nabídky pro tabulky po kliknutí pravým tlačítkem myši
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Položka Funkce

Print Selection (Vytisknout
výběr)

Vytiskne aktuální výběr.

Export to Excel (Export do
aplikace Excel)

Exportuje data do tabulky Excel.

Export to Text (Export do
textového souboru)

Exportuje data do textového souboru.

Export to CSV (Export do
souboru CSV)

Exportuje data do souboru .csv.

Export to Xml (Export do souboru
XML)

Exportuje data do souboru .xml.

Export to Html (Export do
souboru HTML)

Exportuje data do souboru .html.

Find (Najít) Vyhledá text.

Sort (Řazení) Seřadí data až do tří sloupců.

Select Columns (Vybrat sloupce) Vybere sloupce, které budou zobrazeny v tabulce.

Tabulka 16. Položky nabídky pro tabulky po kliknutí pravým tlačítkem myši, pokračování
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Export
CFX Maestro Dx SE obsahuje čtyři možnosti exportu z rozevírací nabídky Export:

n Export All Data Sheets (Exportovat všechny tabulky)

n Export RDML Files (Export souborů RDML)

n Custom Export (Vlastní export)

n Export to LIMS (Export do složky LIMS)

n Ruční export

Export všech tabulek
Všechny náhledy tabulek z každé karty softwaru CFX Maestro Dx SE můžete exportovat do jednotlivých
souborů.

Exportovat všechny tabulky

u Vyberte Export > Export All Data Sheets (Exportovat > Exportovat všechny tabulky) a poté vyberte
typ souboru, který chcete:

n CSV (*.csv)

n Text (*.txt)

n Sešit aplikace Excel (* .xlsx)

Exportované analýzy se ukládají do několika souborů sešitu aplikace Excel s jedním listem
s analytickými daty na každý soubor. Když analýza zahrnuje více fluoroforů, data z každého
fluoroforu se exportují na samostatný list.

n Sešit Excel - kombinovaný (* .xlsx)

Exportované analýzy se ukládají do jednoho souboru aplikace Excel, který obsahuje několik
listů, jeden pro každou sadu dat analýzy.

n Excel 97 - 2003 ( *.xls)

Důležité: Abyste mohli exportovat data do tabulky Microsoft Excel, musí být v počítači
nainstalován programMicrosoft Excel.

n Xml (*.xml)
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Export souborů RDML
RDML je strukturovaný a univerzální datový standard pro výměnu kvantitativních dat PCR (qPCR).
Datový standard je textový soubor ve formátu .xml (Extensible Markup Language). Další informace
o formátu výměny dat RDML naleznete na webových stránkách Mezinárodního konsorcia RDML
(www.rdml.org).

Důležité: Exportované soubory RDML obsahují data analýzy s nastavením základní linie, které
použijete v okně Data Analysis (Analýza dat). Další informace o nastavení základní linie naleznete
v části Nastavení baseline na straně 198.

Poznámka: Pokud používáte verzi softwaru qbase+ 2.3 nebo vyšší, uložte soubor RDML jako verzi
1.1.

Export souboru RDML

1. Vyberte položky Export > Export RDML Files (Export > Exportovat soubory RDML) a ze zobrazeného
seznamu vyberte RDML v1.1 nebo RDML v1.0.

Otevře se dialogové okno Save As (Uložit jako).

2. V dialogovém okně Save As (Uložit jako) uveďte název souboru a umístění, do kterého se soubor
RDML uloží.

3. Klepnutím na OK se exportovaný soubor uloží.
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Tvorba vlastního souboru pro export
Vytvoření vlastního souboru pro export

1. Vyberte položky Export > Custom Export (Exportovat > Vlastní export). Zobrazí se dialogové okno
Custom Export (Vlastní export).

2. Z rozevíracího seznamu, který se objeví, vyberte formát exportu.

3. Zaškrtněte políčka u položek, které chcete exportovat.

4. (Volitelné) Chcete-li změnit názvy sloupců, klikněte na tlačítko Customize Column Name (Upravit
názvy sloupců).

5. Klikněte na položku Export (Exportovat). Otevře se dialogové okno Save As (Uložit jako).
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6. V dialogovém okně Save As (Uložit jako) uveďte název souboru a umístění, do kterého se
exportovaný soubor uloží.

7. Klepnutím na OK se exportovaný soubor uloží.
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Export do složky LIMS
Můžete data exportovat do souborového formátu kompatibilního s LIMS. Více informací o vytvoření,
správě a používání souborů LIMS uvádí Příloha C, Integrace LIMS.

Jak exportovat data ve formátu LIMS

1. Vyberte položky Export > Export to LIMS Folder (Exportovat > Export do složky LIMS).

Otevře se dialogové okno Save As (Uložit jako).

2. V dialogovém okně Save As (Uložit jako) uveďte název souboru a umístění, do kterého se
exportovaný soubor uloží.

3. Klepnutím na OK se exportovaný soubor uloží.

Export dat ve formátu Seegene
Data ze všech náhledů tabulek můžete exportovat do souborů aplikace Excel, jejichž struktura je
upravena konkrétně pro použití společností Seegene, Inc.

Tip: Po dokončení exportu můžete také automaticky spustit prohlížeč Seegene. Další informace
najdete v části Příkazy nabídky Tools (Nástroje) na straně 65.

Jak exportovat data ve formátu Seegene

1. Vyberte možnost Export > Manual Export (Ruční export).

Zobrazí se dialogové okno Browse For Folder (Najít složku).

2. V dialogovém okně Browse For Folder (Najít složku) uveďte umístění složky, do které se
exportované soubory aplikace Excel (.xlsx) ve formátu Seegene uloží.

Analýzy se exportují do více souborů sešitu aplikace Excel s jedním listem s analytickými daty na
každý soubor.

3. Kliknutím na OK se exportované soubory uloží.
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Okno Data Analysis (Analýza dat) Software CFX Maestro Dx, bezpečnostní edice obsahuje více karet, ze
kterých lze zobrazit data. Tato kapitola podrobně vysvětluje tyto záložky.

Tip: V okně Data Analysis (Analýza dat) můžete pomocí nabídky View (Zobrazit) vybrat, které karty
se mají zobrazit. Vlastní rozložení se uloží s datovým souborem.
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Karta Quantification (Kvantifikace)
Pomocí dat na kartě Quantification (Kvantifikace) nastavíte podmínky analýzy dat, včetně nastavení
hodnoty baseline pro jednotlivé jamky a nastavení threshold. Karta Quantification (Kvantifikace)
zobrazuje data v těchto čtyřech náhledech:

n Graf Amplification (Amplifikace) – zobrazuje relativní jednotky fluorescence ( RFU ) pro každou
jamku při každém cyklu. Každá křivka v grafu představuje data pro jeden fluorofor v jedné jamce.

n Standard curve (Standardní křivka) – objeví se pouze v případě, že pracovní běh obsahuje jamky
označené jako standardní typ vzorku (Std (Standardní)). Standardní křivka zobrazuje hodnotu Cq
oproti log zobrazení počátečního množství. Legenda ukazuje účinnost reakce (E) pro každý fluorofor
v jamkách se standardním typem vzorku.

n Nástroj pro výběr jamky – vybere jamky s fluorescenčními daty, které chcete zobrazit.

n Tabulka – zobrazí tabulku dat shromážděných ve vybraných jamkách.

Možnosti pro fluorofor
Pro zobrazení dat o fluoroforu v grafech a tabulkách na kartě Quantification (Kvantifikace) vyberte cílové
fluorofory pod grafem Amplification (Amplifikace). Pro skrytí dat o fluoroforu v okně analýze dat odznačte
příslušné zaškrtávací políčko.
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Dialogové okno Trace Styles (Možnosti křivek)
Pomocí dialogového okna Trace Styles (Možnosti křivek) můžete upravit vzhled křivek při amplifikaci
a grafů křivek tání na kartách Quantification (Kvantifikace) a Melt Curve (Křivka tání). Následně můžete
zobrazit náhled změn v nástroji pro výběr jamek, který naleznete v dialogovém okně Trace Styles
(Možnosti křivek).

Jak upravit zobrazení křivky

1. Na grafu Amplification (Amplifikace) vyberte pouze jeden fluorofor.

2. Otevřete dialogové okno Trace Styles (Možnosti křivek) jedním z následujících způsobů:

n Klikněte na Trace Styles (Možnosti křivek) v grafu Amplification (Amplifikace).

n V panelu nabídek Data Analysis (Analýza dat) vyberte položky Settings > Trace Styles
(Nastavení > Možnosti křivek).

n Klikněte pravým tlačítkem na křivku a vyberte Trace Styles (Možnosti křivek).

Otevře se dialogové okno Trace Styles (Možnosti křivek).

3. V nástroji pro výběr jamek v dolním podokně dialogového okna Trace Styles (Možnosti křivek)
vyberte konkrétní sadu jamek. Případně vyberte jamky obsahující jeden typ vzorku v rozevíracím
nabídce ve sloupci Wells (Jamky).

4. Postupujte následovně:
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n Pro výběr barvy pro vybrané jamky klikněte na políčko ve sloupci Color (Barva).

n Pro přiřazení symbolu vybraným jamkám vyberte symbol z rozevíracího seznamu Symbol.

n Pro rychlé vybarvení jamek podle štítku tlačítka klikněte na příslušný rychlý výběr:

o Random byWell (Náhodně podle jamky),

o Random by Replicate (Náhodně podle replikátu),

o Use Fluor Colors (Použít barvy fluoroforu),

o Use Target Colors (Použít barvy produktů),

o Use Sample Colors (Použít barvy vzorků).

n Pro přiřazení popisů jamek vyberte možnost Sample Type (Typ vzorku), Target Name (Název
produktu), Sample Name (Název vzorku) nebo Symbol.

Možnost Log Scale (Logaritmické měřítko)
Vyberte Log Scale (Logaritmické měřítko) pod grafem Amplification (Amplifikace) pro zobrazení křivek
fluorescence v semilogaritmickémměřítku:

Tip: Pro zvětšení jakékoliv oblasti grafu přetáhněte kurzor přes cílovou oblast. Pro návrat na plný
náhled klikněte pravým tlačítkemmyši na graf a vyberte možnost Set Scale to Default (Nastavit
měřítko na výchozí).
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Standard Curve Chart (Graf standardních křivek)
Software vytvoří graf Standard Curve (Graf standardních křivek) na kartě Quantification (Kvantifikace),
jestliže data zahrnují typy vzorků definovaných jako Std alespoň pro jeden fluorofor v experimentu.

Graf Standard Curve (Graf standardních křivek) zobrazuje následující informace:

n Název každé křivky (fluorofor nebo produkt).

n Barvu každého fluoroforu nebo produktu.

n Účinnost reakce (E). Pomocí této statistiky můžete optimalizovat multiplexovou reakci a vyvážit data
pro standardní křivku.

Poznámka: Účinnost reakce popisuje, jaká část vašeho produktu vzniká při každém cyklu
protokolu. 100% účinnost znamená, že v každém cyklu dojde ke zdvojnásobení produktu..

n Koeficient stanovení, R2 (zapsaný jako R^2). Pomocí této statistiky můžete určit, jak přesně křivka
popisuje data (její přesnost).

n Slope (Sklon)

n Úsek y
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Možnosti nabídky grafu Amplification (Amplifikace)
Kromě společných možností nabídky grafů po kliknutí pravým tlačítkemmyši (viz Společné položky
nabídky pro grafy po kliknutí pravým tlačítkemmyši na straně 212) obsahuje Tabulka 17 seznam
možností nabídky dostupných pouze v grafu Amplification (Amplifikace).

Možnosti nabídky Funkce

Well XX, Fluor Target
(Jamka XX, produkt fluor)

Zobrazí pouze tuto jamku, odstraní tuto jamku z náhledu, nastaví barvu
této křivky nebo vyjme tuto jamku z analýzy.

Selected Traces (Vybrané
křivky)

Zobrazí pouze tyto jamky, odstraní tyto jamky z náhledu, nastaví barvu
těchto tras nebo vyjme tyto jamky z analýzy.

Show Threshold Values
(Zobrazit hodnoty
threshold)

Zobrazí hodnotu prahu pro každou křivku amplifikace v grafu.

Trace Styles (Možnosti
křivek)

Otevře okno Trace Styles (Možnosti křivek) pro změny zobrazení křivky
na kartách Quantification (Kvantifikace) a Melt Curve (Křivka tání).

Baseline Thresholds Otevře okno Baseline Thresholds po změnu polohy baseline nebo
threshold pro každý fluorofor (změny se zobrazí v grafu Amplification
(Amplifikace) na kartě Quantification (Kvantifikace)).

Tabulka 17. Položky nabídky grafu Amplification (Amplifikace) po kliknutí pravým a levým
tlačítkem myši

Tabulka na kartě Quantification (Kvantifikace)
Tabulka 18 definuje data zobrazená v tabulce na kartě Quantification (Kvantifikace).

Informace Popis

Well (Jamka) Pozice jamek na destičce

Fluor (Fluorofor) Detekovaný fluorofor

Target (Produkt) Název produktu pro jamky načtené v nástroji Plate Editor (Editor
destiček)

Content (Obsah) Kombinace typu vzorku (povinný) a čísla replikace (volitelné)
načtených v nástroji Plate Editor (Editor destiček)

Tabulka 18. Obsah tabulky na kartě Quantification (Kvantifikace)
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Informace Popis

Sample (Vzorek) Název vzorku v jamkách načtených v nástroji Plate Editor (Editor
destiček)

Cq Kvantifikační cyklus pro každou křivku

Změna produktu, obsahu nebo dat vzorků

Můžete měnit data ve sloupcích pro produkt, obsah a vzorek tak, že upravíte soubor destičky pomocí
nástroje Plate Editor (Editor destiček) i po provedení experimentu.

Jak změnit data ve sloupcích pro produkt, obsah a vzorek

u Pro otevření nástroje Plate Editor (Editor destiček) klikněte na Plate Setup (Nastavení destičky)
a vyberte View/Edit Plate (Zobrazit/upravit destičku).
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Karta Quantification Data (Kvantifikační data)
Na kartě Kvantifikační data jsou zobrazena kvantifikační data shromážděná v každé jamce. CFX Maestro
Dx SE zobrazí data ve čtyřech různých zobrazeních tabulky:

n Results (Výsledky) – zobrazí tabulku dat. Toto je výchozí zobrazení.

n Standard Curve Results (Výsledky standardních křivek) – zobrazí tabulku dat standardní křivky.

n Plate (Destička) – zobrazí data v každé jamce jako mapu destičky.

n RFU – zobrazuje množství RFU v každé jamce pro každý běh.

Vyberte každou tabulku z rozevíracího seznamu, který se zobrazí pod kartou Quantification Data
(Kvantifikační data).

Tabulka Results (Výsledky)
Tabulka Results (Výsledky) obsahuje data pro každou jamku na destičce.

Poznámka: Všechny výpočty Std. Dev (Směrodatná odchylka) platí pro skupiny replikátů přiřazené
jamkám v okně Plate Editor (Editor destiček). Výpočty zprůměrují hodnotu Cq pro každou jamku ve
skupině replikátů.

Tabulka 19 definuje data, která se objeví v tabulce Results (Výsledky).

Informace Popis

Well (Jamka) Pozice jamek na destičce

Fluor (Fluorofor) Detekovaný fluorofor

Tabulka 19. Obsah tabulky Results (Výsledky)
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Informace Popis

Target (Produkt) Název produktu amplifikace (genu)

Content (Obsah) Typ vzorku a číslo replikace

Sample (Vzorek) Popis vzorku

Biological Set Name (Název
biologického souboru)

Název biologického souboru

Cq Kvantifikační cyklus

CqMean (Průměr Cq) Průměr kvantifikačního cyklu pro skupinu replikátů

Cq Std. Dev (Směrodatná
odchylka Cq)

Směrodatná odchylka kvantifikačního cyklu pro skupinu replikátů

Starting Quantity (SQ)
(Počáteční množství (SQ))

Odhad počátečního množství produktu

Log Starting Quantity (Záznam
počátečního množství produktu)

Záznam počátečního množství produktu

SQMean (Průměr SQ) Průměr počátečního množství produktu

SQ Std. Dev (Směrodatná
odchylka Cq)

Směrodatná odchylka počátečního množství napříč replikáty

Tabulka 19. Obsah tabulky Results (Výsledky), pokračování
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Tabulka Standard Curve Results (Výsledky standardních křivek)
Tabulka Standard Curve Results (Výsledky standardních křivek) zobrazuje vypočítané parametry
standardní křivky.

Tabulka 20 definuje data, která se zobrazí v tabulce Standard Curve Results (Výsledky standardních
křivek).

Informace Popis

Fluor (or Target) (Fluorofor
(nebo produkt))

Byl detekován fluorofor (nebo produkt)

Efficiency % (Účinnost %) Účinnost reakce

Slope (Sklon) Sklon standardní křivky

Y-intercept (Úsek y) Bod, ve kterém křivka protíná osu y

R^2 Koeficient stanovení

Tabulka 20. Obsah tabulky Standard Curve Results (Výsledky standardních křivek)
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Tabulka Plate (Destička)
Tabulka Plate (Destička) obsahuje mapu destiček podle dat vždy pro jeden fluorofor.

Pro zobrazení dat pro konkrétní fluorofor

u Klikněte na příslušnou kartu ve spodní části tabulky.
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Tabulka RFU
Tabulka RFU obsahuje naměřené hodnoty relativních jednotek fluorescence (RFU) pro každou jamku
zjištěné při každém cyklu pracovního běhu. Nahoře se v každém sloupci objeví číslo jamky a vlevo od
každého řádku je uvedeno číslo cyklu.
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Karta Melt Curve (Křivka tání)
Pro barviva vázající DNA a neštěpitelné hybridizační sondy je změna intenzity fluorescence nejvýraznější
při separaci řetězců dvouvláknové DNA. Proto když teplota při tání stoupá (Tm), fluorescence klesá
konstantní rychlostí (konstantní sklon). Při Tm dochází k dramatickému snížení fluorescence se znatelnou
změnou sklonu. Rychlost této změny se stanoví vynesením negativní první regrese fluorescence oproti
teplotě (-d(RFU)/dT). Největší rychlost změny fluorescence má za následek viditelné píky a představuje
hodnotu Tm komplexů dvouvláknové DNA.

Software CFX Maestro Dx SE zobrazuje data RFU naměřená během křivky tání jako funkci teploty. Aby
bylo možné analyzovat data vrcholů tání, přiřazuje software každému vrcholu počáteční a koncovou
teplotu pohybem sloupce threshold. Základna plochy vrcholu je určena nastavením hodnoty threshold
tání. Vrchol musí mít minimální výšku vzhledem ke vzdálenosti mezi hodnotou threshold a výškou
nejvyššího vrcholu.

Karta Melt Curve (Křivka tání) zobrazuje hodnotu Tm (teplota tání) amplifikovaných produktů PCR ve
čtyřech zobrazeních:

n Melt Curve (Křivka tání) – zobrazuje data v reálném čase pro každý fluorofor jako hodnoty RFU vždy
pro teplotu každé jamky.

n Melt Peak (Vrchol tání) – zobrazuje negativní regresi dat RFU vždy pro teplotu každé jamky.

n Well selector (Nástroj pro výběr jamky) – zobrazí jamky pro zobrazení nebo skrytí dat.

n Peak spreadsheet (Tabulka vrcholů) – zobrazí data shromážděná ve vybrané jamce.

Poznámka: Tabulka zobrazuje až dva vrcholy pro každou křivku. Chcete-li zobrazit více
vrcholů, klikněte na tlačítko na kartě Melt Curve Data (Data křivky tání).

Tabulka 21 definuje data, která se objeví v tabulce Melt Curve (Křivka tání).

Uživatelská příručka | 233



Kapitola 11 Podrobnosti o analýze dat

Informace Popis

Well (Jamka) Pozice jamek na destičce

Fluor (Fluorofor) Detekovaný fluorofor

Content (Obsah) Kombinace typu vzorku a čísla replikátu

Sample (Vzorek) Název vzorku načtený v nástroji Plate Editor (Editor destiček)

Melt Temp
(Teplota tání)

Teplota vrcholu tání pro každou jamku

Poznámka: V tabulce se zobrazují pouze dva nejvyšší vrcholy.

Tabulka 21. Obsah tabulky křivky tání
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Úprava dat Melt Curve (Křivka tání)
Úprava dat Melt Curve (Křivka tání)

u Postupujte následovně:

n Klikněte a přetáhněte threshold v grafu Melt Peak (Peak tání) a zahrňte nebo vylučte vrcholy
v analýze dat.

n Vyberte Positive (Pozitivní) v rozevírací nabídce, aby se zobrazila data tabulky Peaks (Vrcholy)
nad řádkemMelt Threshold (Práh tání), nebo vyberte Negative (Negativní), chcete-li zobrazit
tabulková data peaků pod hranicí limitu tání.

n Otevřete okno Trace Styles (Možnosti křivek) a změňte barvu křivek v grafech Melt Curve
(Křivka tání) a Melt Peak (Vrchol tání).

n Vyberte číslo v nástroji pro výběr Step Number (Číslo kroku) a zobrazte data v křivce Melt Curve
(Křivka tání) v dalším kroku protokolu. Seznam obsahuje více než jeden krok, pokud protokol
obsahuje čtení destiček ve více než jednom kroku křivky tání.

n Vyberte jamky v selektoru jamek a zaměřte se na podmnožiny dat.

n Vyberte skupinu jamek pro zobrazení a analýzu podmnožiny jamek v destičce. V rozevírací
nabídce Well Group (Skupina destiček) v panelu nástrojů vyberte jednotlivé skupiny podle
názvu.
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Karta Melt Curve Data (Data křivky tání)
Karta Melt Curve Data (Data křivky tání) zobrazuje data z karty Melt Curve (Křivka tání) ve více tabulkách,
které obsahují všechny vrcholy tání pro každou křivku. CFX Maestro Dx SE nabízí čtyři možnosti tabulek,
ve kterých lze zobrazit data křivky tání:

n Melt Peaks (vrcholy křivky tání) – zobrazí všechna data, včetně všech vrcholů tání, pro každou
křivku. Toto je výchozí zobrazení.

n Plate (Destička) – zobrazí náhled dat a obsah každé jamky na destičce.

n RFU – zobrazí množství RFU při každé teplotě pro každou jamku.

n -d(RFU)/dT – zobrazí zápornou rychlost změny RFU během změn teploty (T). Toto je první regresní
graf pro každou jamku na destičce.

Vyberte každou tabulku z rozevíracího seznamu pod kartou Melt Curve Data (Data křivky tání).

Tabulka Melt Peaks (vrcholy křivky tání)
Tabulka Melt Peaks (vrcholy křivky tání) obsahuje všechna data o křivce tání.

Tabulka 22 na straně 237 definuje data, která se objevují v tabulce Melt Peaks (vrcholy křivky tání).
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Informace Popis

Well (Jamka) Pozice jamek na destičce

Fluor (Fluorofor) Detekovaný fluorofor

Content (Obsah) Typ vzorku uvedený v okně Plate Editor (Editor destiček)

Target (Produkt) Produkt amplifikace (gen)

Sample (Vzorek) Název vzorku uvedený v okně Plate Editor (Editor destiček)

Melt Temperature (Teplota tání) Teplota tání každého produktu, uvedená jako jeden peak (nejvyšší)
na řádek tabulky

Peak Height (Výška vrcholu) Výška peaku

Begin Temperature (Počáteční
teplota)

Teplota na začátku peaku

End Temperature (Koncová
teplota)

Teplota na konci peaku

Tabulka 22. Obsah tabulky Melt Peaks (vrcholy křivky tání)

Tabulka Plate (Destička)
Tabulka Plate (Destička) obsahuje data o křivce tání ve formátu destičky.

Poznámka: Pro úpravu vrchol vyvolaného softwarem upravte řádek s prahem v grafu Melt Peak
(Vrchol tání) na kartě Melt Curve (Křivka tání).

Tabulka 23 na straně 238 definuje data, která se objeví v tabulce Plate (Destička).
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Informace Popis

Content (Obsah) Kombinace typu vzorku (povinný) a čísla replikátu (volitelné)

Sample (Vzorek) Popis vzorku

Peak 1 (Vrchol 1) První vrchol tání (nejvyšší)

Peak 2 (Vrchol 2) Druhý vrchol tání (nižší)

Tabulka 23. Obsah tabulky Plate (Destička)

Tabulka RFU
Tabulka RFU obsahuje fluorescenci pro každou jamku v každém běhu získanou v rámci křivky tání.

Tabulka 24 definuje data, která se zobrazí v tabulce RFU.

Informace Popis

Well number (A1, A2, A3, A4, A5) (Číslo
jamky (A1, A2, A3, A4, A5))

Pozice jamek na destičce pro použité jamky

Temperature (Teplota) Teplota tání amplifikovaného produktu,
zaznamenaná jako jedna jamka na jeden řádek
a několik jamek pro několik produktů ve stejné
jamce

Tabulka 24. Obsah tabulky RFU
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Tabulka -d(RFU)/dT
Tabulka - d(RFU)/dT obsahuje zápornou rychlost změny RFU během změn teploty (T).

Tabulka 25 definuje data, která se objeví v tabulce -d(RFU)/dT.

Informace Popis

Well number (A1, A2, A3, A4, A5) (Číslo
jamky (A1, A2, A3, A4, A5))

Pozice jamek na destičce pro použité jamky

Temperature -d(RFU)/dT (Teplota -d
(RFU)/dT)

Záporná derivace změny RFU během změn teploty (T)

Tabulka 25. Obsah tabulky -d(RFU)/dT
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Karta EndPoint (End-point analýza)
Otevřete kartu EndPoint (End-point analýza) pro analýzu konečných relativních jednotek fluorescence
(RFU) pro jamky se vzorkem. Software porovnává úrovně RFU pro jamky s neznámými vzorky
s úrovněmi RFU pro jamky s negativními kontrolami a označí neznámý vzorek za pozitivní nebo
negativní. Pozitivní vzorky mají hodnotu RFU vyšší než průměrná hodnota RFU negativních kontrol plus
cut-off hodnota.

Pro analýzu dat end-point musí destička obsahovat negativní kontroly, jinak software nemůže provést
označení.

n Spusťte protokol Quantification (Kvantifikace) – nastavte standardní protokol. Po dokončení běhu
otevřete okno Data Analysis (Analýza dat), upravte nastavení analýzy dat na kartě Quantification
(Kvantifikace) a poté klikněte na kartu End Point (End-point analýza) pro výběr end-point reakce.

n Spusťte protokol End Point Only (End-Point) – načtěte protokol End Point Only (End-Point) na kartě
Plate (Destička) okna Run Setup (Nastavení běhu), vyberte nebo vytvořte destičku a spusťte běh

Karta EndPoint (End-point analýza) obsahuje průměrné hodnoty RFU, aby bylo možné stanovit, zda byl
produkt posledním (koncovým) během amplifikován. Pomocí těchto dat určete, zda se ve vzorku nachází
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konkrétní cílová sekvence (pozitivní). Pozitivní výsledky mají vyšší hodnoty RFU než vámi definovaná
cut-off hodnota.

Tip: Abyste vytvořili protokol analýzy end-point, otevřete kartu Protocol (Protokol) (okno Run Setup
(Nastavení běhu) ) a vyberte možnosti Run > End Point Only Run (Běh > End-Point reakce).

Po ukončení běhu se datový soubor otevře na kartě EndPoint (End-point analýza) je tvořena těmito
částmi:

n Settings (Nastavení) – upraví nastavení analýzy dat.

n Results (Výsledky) – zobrazí výsledky ihned po úpravě nastavení.

n Well Selector (Nástroj pro výběr jamky) – vybere jamky s daty end-point, které chcete zobrazit.

n RFU spreadsheet (Tabulka RFU) – zobrazí koncové RFU shromážděné ve vybraných jamkách.

Data výsledků
Část Results (Výsledky) zobrazuje následující data:

n Lowest RFU value (Nejnižší hodnota RFU) – nejnižší hodnota RFU v datech

n Highest RFU value (Nejvyšší hodnota RFU) – nejvyšší hodnota RFU v datech

n Negative Control Average (Průměr negativních kontrol) – průměrná RFU pro jamky, které obsahují
negativní kontroly

n Cut Off Value (Cut Off hodnota) – vypočítá se přidáním tolerance ( RFU nebo Percentage (Procenta)
rozsahu uvedeného v nastavení) a průměru negativních kontrol. Vzorky s hodnotou RFU větší než
mezní hodnota se budou nazývat „pozitivní“. Chcete-li upravit mezní hodnotu, změňte RFU nebo
procento rozsahu

Cut Off Value (Cut Off hodnota) se vypočte pomocí tohoto vzorce:

Cut Off hodnota = Průměr negativních kontrol + tolerance

Vyberte toleranci jednou z těchto metod:

n RFUs (výchozí) – vyberte tuto metodu pro použití absolutní hodnoty RFU pro toleranci. Minimální
hodnota tolerance RFU je 2. Maximální hodnota je absolutní hodnota nejvyšší hodnoty RFUmínus
absolutní hodnota nejnižší hodnoty RFU. Výchozí hodnota tolerance RFU je 10 % celkového rozsahu
RFU.

n Percent of Range (Procenta rozsahu) – vyberte tuto metodu pro použití procenta rozsahu RFU pro
toleranci. Minimální procento rozsahu je 1 %. Maximální procento rozsahu je 99 %. Výchozí hodnota
rozsahu je 10 %.
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Úprava analýzy dat end-point
Úprava analýzy dat na kartě EndPoint (End-point analýza)

u Postupujte následovně:

n Z rozevíracího seznamu vyberte fluorofor.

n Vyberte hodnotu End Cycle to Average (End-point pro průměr) , abyste nastavili počet cyklů,
pomocí kterých se vypočítá průměrnou hodnotu end-point RFU.

n Vyberte RFU pro zobrazení dat v jednotkách relativní fluorescence.

n Vyberte položku Percentage of Range (Procenta rozsahu) pro zobrazení dat jako procenta
rozsahu RFU.

n Vyberte jamky v selektoru jamek a zaměřte se na podmnožiny dat.

n Vyberte skupinu jamek pro zobrazení a analýzu podmnožiny jamek v destičce. V rozevírací
nabídce Well Group (Skupina destiček) v panelu nástrojů vyberte jednotlivé skupiny podle
názvu.

Tabulka RFU pro analýzu end-point
Tabulka 26 definuje data, která se objevují v tabulce RFU na kartě EndPoint (End-point analýza).

Informace Popis

Well (Jamka) Pozice jamek na destičce

Fluor (Fluorofor) Detekovaný fluorofor

Content (Obsah) Kombinace typu vzorku a čísla replikátu

End RFU (Koncové RFU) RFU v cyklu end-point

Call (Označení) Pozitivní nebo negativní, kdy pozitivní vzorky mají hodnotu RFU vyšší než
průměrná RFU negativních kontrol plus cut-off hodnota

Sample (Vzorek) Název vzorku načtený v nástroji Plate Editor (Editor destiček)

Tabulka 26. Obsah tabulky RFU EndPoint (End-point analýza)
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Karta Allelic Discrimination (Alelická diskriminace)
Karta Allelic Discrimination (Alelická diskriminace) přiřazuje genotypy jamkám s neznámými vzorky.
Použijte tato data k identifikaci vzorků s různými genotypy, včetně alely 1, alely 2, heterozygotu, bez
označení (žádná amplifikace) nebo neurčené.

Poznámka: Data pro alelickou diskriminaci musí pocházet z multiplexních cyklů s alespoň dvěma
fluorofory. Každý fluorofor identifikuje jednu alelu ve všech vzorcích.

Analýza alelické diskriminace vyžaduje následující minimální obsah jamek:

n Dva fluorofory v každé jamce

n Příklady NTC (no template control; kontrola bez templátu) pro optimalizaci analýzy dat

CFX Maestro Dx SE nabízí čtyři možnosti zobrazení dat alelické diskriminace:

n Graf Allelic Discrimination (Alelická diskriminace) – zobrazuje data v grafu RFU pro alelu 1 / alelu 2.
Každý bod grafu představuje data z obou fluoroforů v jedné jamce. Zaškrtnutím a zrušením
zaškrtnutí políčka Polar Coordinates (Polární souřadnice) můžete přepínat mezi kartézskými a
polárními souřadnicemi. Kartézské souřadnice představují RFU pro alelu 1 na ose x a RFU pro alelu
2 na ose y. Polární souřadnice představují úhel na ose x a vzdálenost mezi počátkem a RFU na ose y
(medián všech NTC).
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n Well spreadsheet (Tabulka jamky) – zobrazuje data pro alelickou diskriminaci shromážděná v každé
jamce destičky.

n Well selector (Nástroj pro výběr jamky) – vybere jamky s alelickými daty, která chcete zobrazit.

n Selected Fluorophores panel (Panel vybraných fluoroforů) – změní popisky os x a y v grafu Allelic
Discrimination (Alelická diskriminace), analyzovaný běh a možnost zobrazovat mapu signálů.

Úprava dat pro alelickou diskriminaci
Software automaticky přiřadí genotyp jamkám s neznámými vzorky na základě pozic NTC a úhlu
a vzdálenosti neznámých datových bodů z NTC.

Úprava dat alelické diskriminace

u Postupujte následovně:

n Chcete-li zobrazit polární souřadnice, zaškrtněte políčko v grafu Allelic Discrimination (Alelická
diskriminace).

n Chcete-li zobrazit další fluorofor, vyberte ho z rozevíracího seznamu na panelu Selected
Fluorophores (Vybrané fluorofory).

n Chcete-li změnit signál, přetáhněte ho přes datové body v grafu Allelic Discrimination (Alelická
diskriminace) a vyberte možnost v seznamu vybraných jamek:

o Allele 1 (Alela 1),

o Allele 2 (Alela 2),

o Heterozygote (Heterozygot),

o Undetermined (Neurčený),

o No Call (Bez označení),

o Auto Call (Automatický signál).

Tip: Chcete-li se vrátit k výchozímu signálu, vyberte možnost Auto Call (Automatický
signál).
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Možnosti nabídky grafu
Kromě obecných možností nabídky po kliknutí pravým tlačítkemmyši pro grafy (viz část Společné
položky nabídky pro grafy po kliknutí pravým tlačítkemmyši na straně 212) uvádí Tabulka 27 možnosti
nabídky dostupné v grafu Allelic Discrimination (Alelická diskriminace).

Možnosti nabídky Funkce

Zoom (Lupa) Zaměří zobrazení grafu na zvolenou oblast (kliknutím a přetažením
kurzoru do grafu).

Tip: Pokud chcete obnovit přiblížení na zobrazení všech
datových bodů, klikněte pravým tlačítkemmyši a vyberte
možnost Set Scale to Default (Nastavit měřítko na výchozí
nastavení).

Well (Jamka) Pro vybranou jamku jsou k dispozici následující možnosti: zobrazit
pouze tuto jamku, odstranit jamku ze zobrazení, nastavit barvu pro
tuto křivku nebo tuto jamku vyloučit z analýzy.

Selected Wells (Vybrané jamky) Pro vybrané jamky (vybrané kliknutím a přetažením kurzoru v grafu)
jsou k dispozici následující možnosti: zobrazit pouze tyto jamky,
odstranit jamky ze zobrazení, nastavit barvu pro tyto křivky nebo tyto
jamky vyloučit z analýzy.

Tabulka 27. Graf Allelic Discrimination (Alelická diskriminace) – možnosti nabídky po kliknutí
pravým nebo levým tlačítkem myši

Tabulka Allelic Discrimination (Alelická diskriminace)
Tabulka 28 definuje data, která se objevují v tabulce Allelic Discrimination (Alelická diskriminace).

Informace Popis

Well (Jamka) Pozice jamek na destičce

Sample (Vzorek) Popis názvu vzorku

Call (Signál) Určení alely, včetně automatické alely 1, alely 2, heterozygotů, bez
označení nebo neurčené

Tabulka 28. Obsah tabulky Allelic Discrimination (Alelická diskriminace)
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Informace Popis

Type (Typ) Auto (Automaticky) nebo manuálně, popisuje, jak byl signál získán.
Automaticky označuje případ, kdy signál vybral software. Manuálně
označuje případ, kdy signál vybral uživatel.

RFU1 RFU pro alelu 1

RFU2 RFU pro alelu 2

Tabulka 28. Obsah tabulky Allelic Discrimination (Alelická diskriminace), pokračování
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Karta Custom Data View (Vlastní zobrazení dat)
Karta Custom Data View (Vlastní zobrazení dat) zobrazuje souběžně několik podoken v přizpůsobitelném
formátu.

Rozevírací seznam Load a Preset View (Načíst přednastavené zobrazení) nabízí výběr šablon formátů
zobrazení. Výchozí zobrazení nezávisí na analyzovaném souboru. Například pokud jsou přítomna data
Melt Curve (Křivka tání), objeví se výchozí zobrazení Amp+Melt (Amplifikace+tání).
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Vytvoření vlastního zobrazení dat
Jak vytvořit vlastní zobrazení dat

u Postupujte následovně:

n Z rozevíracího seznamu vyberte alternativní přednastavené zobrazení.

n Vyberte z rozevíracího seznamu nahoře v každém podokně jiný náhled grafu.

n Změňte počet řádků a sloupců na kartě.

n Změňte rozměry jednotlivého podokna. Přetáhněte sloupce na okraj každého podokna.

Pro uložení upravených hodnot jako přednastavené šablony klikněte na položku Save as Preset (Uložit
jako předvolbu). Pro odstranění, přejmenování nebo obnovu existujících přednastavených náhledů
klikněte na položku Manage Presets (Spravovat předvolby).
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Karta QC (Kontrola kvality)
Karta QC (Kontrola kvality) vám umožňuje rychlý přístup ke kvalitě dat pracovního běhu na základě
pravidel definovaných v okně User Preferences (Uživatelské předvolby) na kartě QC (Kontrola kvality).

CFX Maestro Dx SE nabízí čtyři možnosti zobrazení dat QC (Kontrola kvality):

n Graf Amplification (Amplifikace) – zobrazí RFU pro každou jamku při každém běhu. Každá křivka
v grafu představuje data pro jeden fluorofor v jedné jamce.

n QC rules table (Tabulka pravidel kontroly kvality) – zobrazí dostupná pravidla QC (Kontrola
kvality) a nastavení definující každé pravidlo. Použitá pravidla QC (Kontrola kvality) jsou označena
zaškrtnutím.

n Well selector (Nástroj pro výběr jamky) – vybere jamky s fluorescenčními daty, které chcete
zobrazit.

n QC rule summary pane (Souhrnný panel pravidel QC) – zobrazí vybrané pravidlo QC (Kontrola
kvality) a zvýrazní jamky, které pravidlo nesplňují.
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Změna kritérií QC (Kontrola kvality)
Jak změnit kritéria QC (Kontrola kvality)

u Vyberte nebo odznačte zaškrtávací políčko Use (Použít) pro pravidlo, které chcete podle situace
zahrnout nebo odejmout z položky QC (Kontrola kvality).

Vyloučení jamek, které neprojdou QC (Kontrola kvality)
CFX Maestro Dx SE zobrazuje sloupce, které nesplňují kritéria QC (Kontrola kvality), ve sloupci Výsledky
v tabulce zásad QC (Kontrola kvality) a v souhrnném podokně.

Vyloučení jamek, které nesplňují kritéria QC (Kontrola kvality)

u Vyberte možnost Exclude Wells (Vyloučit jamky) pro každou jamku, kterou chcete vyloučit.
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Karta Run Information (Informace o experimentu)
Karta Run Information (Informace o experimentu) zobrazuje protokol a další informace o každém běhu.
Tato karta slouží k následujícím akcím:

n Zobrazení protokolu.

n Zadání nebo úprava poznámek o běhu.

n Zadání nebo úprava ID nebo čárového kódu běhu.

n Zobrazení událostí, ke kterým došlo během experimentu. Tyto zprávy mohou pomoci při řešení
problému.

Tip: Chcete-li kopírovat, exportovat nebo tisknout protokol, klikněte na něj pravým tlačítkemmyši.
Klepněte pravým tlačítkemmyši do podoken Notes (Poznámky), ID/Bar Code (ID/Čárový kód) nebo
Other (Jiné), chcete-li vrátit zpět, vyjmout, kopírovat, vložit, odstranit nebo vybrat text.
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Report z analýzy dat
Dialogové okno Report zobrazí informace o aktuálním datovém souboru v okně Data Analysis (Analýza
dat). Chcete-li otevřít report, zvolte Tools > Reports (Nástroje > Reporty) nebo klikněte v panelu nástrojů
na Reports (Reporty).

Okno Report obsahuje následující části:

n Nabídka a panel nástrojů – poskytuje možnosti formátování, ukládání a tisku reportu nebo šablony.

n Seznammožností (levá horní strana dialogového okna) – poskytuje možnosti zobrazení v reportu.

n Podokno možností (vlevo dole v dialogovém okně) – zobrazuje textová pole, do kterých můžete
zadat informace o vybrané možnosti.

n Podokno náhledu (pravá strana dialogového okna) – zobrazuje náhled aktuálního reportu.
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Analýza dat - kategorie reportu
Tabulka 29 obsahuje všechny dostupné možnosti pro report z analýzy dat podle typu dat v okně Data
Analysis (Analýza dat).

Kategorie Možnost Popis

Záhlaví

Titul, podtitul a logo pro report

Report Information (Informace o
reportu)

Datum běhu, uživatelské jméno, název
datového souboru, cesta k datovému
souboru a vybraná skupina jamek

Audit Information (Informace pro
audit)

Dodatečné informace požadované pro
audit, včetně podpisů

Notes (Poznámky) Poznámky k datovému reportu

Run Setup (Nastavení běhu)

Run Information (Informace o
experimentu)

Datum běhu, uživatelské jméno, název
datového souboru, cesta k datovému
souboru a vybraná skupina jamek

Protocol (Protokol) Textové zobrazení kroků a možností
protokolu

Plate Display (Zobrazení
destiček)

Zobrazení informací o destičkách pro
každou jamku destičky

Quantification (Kvantifikace)

Analysis Settings (Nastavení
analýzy)

Příslušný krok sběru dat, režim analýzy
a metoda odečtení baseline

Amplification Chart (Graf
amplifikace)

Graf amplifikace pro běhy zahrnující
kvantifikační data

Standard Curve Chart (Graf
standardních křivek)

Graf standardních křivek

Tabulka 29. Kategorie reportu z analýzy dat - nabídka možností
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Kategorie Možnost Popis

Data Tabulka se seznamem dat pro každou
jamku

Gene Expression – Bar Chart (Genová exprese – sloupcový graf)

Analysis Settings (Nastavení
analýzy)

Režim analýzy, data grafu, možnost
úpravy měřítka a chyba grafu

Chart (Graf) Kopie sloupcového grafu

Target Names (Názvy produktů) Graf názvů produktů

Sample Names (Názvy vzorků) Graf názvů vzorků

Data Tabulka se seznamem dat pro každou
jamku

Target Stability (Stabilita
produktu)

Graf hodnot stability produktu

Box-and-Whisker Chart (Box a
Whisker graf)

Box a Whisker graf

Dot Plot Chart (Bodový graf) Bodový graf

Exprese genů - clustergram a rozptylový graf

Analysis Settings (Nastavení
analýzy)

Nastavení pro každý typ grafu

Chart (Graf) Kopie grafu

Data Tabulka se seznamem dat pro každý
produkt

Gene Expression — ANOVA Data (Genová exprese – data pro ANOVA)

ANOVA Settings (Nastavení
ANOVA)

Práh hodnoty P použitý při analýze

ANOVA Results (Výsledky
ANOVA)

Tabulka výsledků z ANOVA a post-hoc
analýzy Tukey's HSD (Tukeyův HSD
test)

Tabulka 29. Kategorie reportu z analýzy dat - nabídka možností, pokračování
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Kategorie Možnost Popis

Melt Curve (Křivka tání)

Analysis Settings (Nastavení
analýzy)

Nastavení hodnot krok tání a threshold

Melt Curve Chart (Graf křivky
tání)

Graf křivky tání

Melt Peak Chart (Graf vrcholů
tání)

Graf vrcholů tání

Data Tabulka se seznamem dat pro každou
jamku

Allelic Discrimination (Alelická diskriminace)

Analysis Settings (Nastavení
analýzy)

Zobrazí fluorofory, běh a mapu jamek
podle genotypu

Allelic Discrimination Chart (Graf
alelické diskriminace)

Kopie grafu alelické diskriminace

Data Tabulka se seznamem dat pro každou
jamku

EndPoint (End-point analýza)

Analysis Settings (Nastavení
analýzy)

Fluorofor, průměrná hodnota
ukončených běhů, režim, nejnižší
hodnota RFU, nejvyšší hodnota RFU a
cut-off hodnota

Data Tabulka se seznamem dat pro každou
jamku

QC Parameters
(Parametry kontroly
kvality)

Data Tabulka se seznamem parametrů pro
každé pravidlo QC (Kontrola kvality)

Tabulka 29. Kategorie reportu z analýzy dat - nabídka možností, pokračování
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Vytvoření reportu z analýzy dat
Rozvržení sestavy můžete uložit jako šablonu, kterou můžete znovu použít pro podobné reporty.

Vytvoření reportu o analýze dat tání

1. Před vytvořením reportu proveďte konečné úpravy obsahu jamky, vybraných jamek, grafů a tabulek
v okně Data Analysis (Analýza dat).

2. Vyberte položky Tools > Reports (Nástroje > Reporty) na panelu nabídek Data Analysis (Analýza
dat) a otevřete dialogové okno Report.

3. Vyberte možnosti, které chcete do reportu zahrnout. Report se otevře s vybranými výchozími
možnostmi. Vyberte nebo odznačte zaškrtávací políčka pro změnu celých kategorií nebo
jednotlivých možností v kategorii.

Tabulka 29 na straně 253 uvádí dostupné možnosti zobrazení.

Poznámka: Data, která se objeví v reportu, závisí na aktuálních výběrech v záložkách Data
Analysis (Analýza dat). Například kvantifikační cyklus nemusí obsahovat standardní křivku, a
proto se tato data neobjeví v okně Data Analysis (Analýza dat) nebo v reportu dat.

4. Změňte pořadí kategorií a položek v reportu. Přetáhněte možnosti do relativní pozice. Položky lze
přenastavit pouze v rámci kategorií, do kterých patří.

5. (Volitelné) V podokně Report Options (Možnosti reportu) zadejte informace relevantní pro vybranou
možnost:

n Vyberte podmnožinu informací, které se mají zobrazit v reportu.

n Zvolte konkrétní nastavení pro vybranou možnost.

n Změňte text, který se má zobrazit pro vybranou možnost.

6. Klikněte na položku Update Report (Aktualizovat report) pro aktualizaci Report Preview (Náhled
reportu) se zohledněním všech změn.

7. Report vytiskněte nebo uložte:

a. Pro tisk aktuálního reportu klikněte na tlačítko Print Report (Tisk reportu) na panelu nástrojů.

b. Vyberte File > Save (Soubor > Uložit) a uložte zprávu ve formátu PDF (soubor Adobe Acrobat
Reader), MHT (dokument Microsoft) nebo MHTML (dokument Microsoft).

c. Vyberte místo, kam chcete soubor uložit.

d. Uložte report s novým názvem nebo do nového umístění zvolením položek File > Save As
(Soubor > Uložit jako).
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8. (Volitelné) Vytvořte šablonu zprávy s požadovanými informacemi. Pro uložení aktuálního nastavení
reportu v šabloně vyberte Template > Save (Šablona > Uložit) nebo Save As (Uložit jako). Pokud
chcete vytvořit nový report, načtěte šablonu reportu.
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Vytvoření reportu pro skupiny jamek
Jak vytvořit report o skupinách jamek

1. Vyberte Tools > Well Group Reports (Nástroje > Report pro skupiny jamek) v okně Data Analysis
(Analýza dat).

2. V dialogovém okněWell Groups Reports (Report pro skupiny jamek) vyberte skupiny jamek, kroky
amplifikace a kroky tání, které mají být v reportu uvedeny.

3. Zadejte cestu nebo přejděte do cílové složky, do které má být report uložen.

4. (Volitelné) Vyberte položku Choose a Report Template (Vybrat šablonu reportu) a přejděte do složky
se souborem šablony.

5. (Volitelné) Vyberte položku Open Destination Folder (Otevřít cílovou složku), otevře se složka
a zobrazí vygenerované reporty.

6. Klikněte na položku Create Reports (Vytvořit report).

258 | Software CFX Maestro Dx SE



Kapitola 12 Analýza genové exprese
Při použití přesně kvalifikovaných kontrol v každé reakci můžete pomocí Software CFX Maestro Dx,
bezpečnostní edice provádět experimenty genové exprese s cílem normalizovat relativní rozdíly cílové
koncentrace mezi vzorky. Obvykle se pro normalizaci exprese cílového genu používá jeden nebo několik
referenčních genů. Referenční geny kompenzují rozdíly v pipetování či jiné odchylky v každém vzorku a
jejich exprese by měla být ve studovaném biologickém systému stabilní.

Vyberte kartu Gene Expression (Genová exprese) v okně Data Analysis (Analýza dat) pro hodnocení
relativních rozdílů mezi reakcemi PCR ve dvou nebo více jamkách. Můžete například vyhodnotit relativní
počty virových genomů nebo relativní počty převáděných sekvencí v reakci PCR. Nejběžnějším využitím
pro studii genové exprese je srovnání koncentrace cDNA ve více reakcích pro odhad úrovní mediátorové
RNA ve stabilním stavu.

Software vypočítá úroveň relativní exprese produktu s jedním z těchto scénářů:

n Úroveň relativní exprese cílové sekvence (gen 1) vzhledem k jinému cíli (gen 2); například množství
jednoho genu vzhledem k jinému genu ve stejně zpracovaném vzorku.

n Relativní úroveň exprese jedné cílové sekvence ve vzorku ve srovnání se stejným vzorkem za
odlišných podmínek; například relativní množství jednoho genu za různých časových, geografických
nebo vývojových podmínek.

Nastavení destičky pro analýzu genové exprese
Pro provedení analýzy genové exprese musí obsah jamek zahrnovat následující:

n Dva nebo více produktů – dva produkty, které představují různé amplifikované geny nebo sekvence
ve vzorcích.

n Jeden nebo více referenčních genů – alespoň jeden produkt musí být referenčním genem pro
normalizovanou expresi. Přiřaďte všechny referenční geny v okně Experiment Settings (Nastavení
experimentu) pro analýzu dat v režimu normalizované exprese (ΔΔCq). Experimenty, které
neobsahují referenční hodnotu, musí být analyzovány pomocí režimu relativní exprese (ΔCq).

n Běžné vzorky – vaše reakce musí obsahovat běžné vzorky (minimálně dva požadované), aby bylo
možné zobrazit data zobrazená na kartě Gene Expression (Genová exprese). Tyto vzorky by měly
měly být připraveny odlišným způsobem pro každou z vašich cílových sekvencí. V okně Experiment
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Settings (Nastavení experimentu) přiřaďte kontrolní vzorek (volitelné). Pokud není vybrána žádná
kontrola, software použije jako kontrolu nejnižší hodnotu Cq.

Požadavky na nastavení genové exprese v nastavení Gene Expression (Genová exprese) v editoru Plate
Editor (Editor destiček) závisí na tom, zda jsou obsahy reakcí jednorázové PCR s jedním fluoroforem
v reakcích, nebo multiplexní PCR s více než jedním fluoroforem v reakcích.

Průvodce nastavením destičky
Jestliže nastavení destičky v datovém souboru neobsahuje informace nezbytné pro analýzu a je vybrána
karta Gene Expression (Genová exprese), bude prostor, ve kterém je obvykle umístěn sloupcový graf,
obsahovat pokyny pro zadávání těchto informací. Pro normalizovanou expresi genu proveďte následující
kroky:

1. Definujte názvy Target (Produkt) a Sample (Vzorek) jedním z následujících postupů:

n Plate Setup (Nastavení destičky) – otevře okno Plate Editor (Editor destiček).

n Replace Plate File (Nahradit soubor destičky) – otevře prohlížeč Select Plate (Vybrat destičku),
ve kterémmůžete přejít na dříve uložený soubor destičky, jímž chcete nahradit aktuální
nastavení destičky.

n Replace PrimePCR File (Nahradit soubor PrimePCR) – otevře dialogové okno Select PrimePCR
file (Vybrat soubor PrimePCR) , ve kterémmůžete přejít na spouštěcí soubor PrimePCR a
použít jej pro nastavení destičky.

2. Vyberte jeden nebo několik referenčních genů a kontrolní vzorek v dialogovém okně Experiment
Settings (Nastavení experimentu).

Pokud nastavení destičky již obsahuje informace o produktu a vzorku, je nutný pouze druhý krok,
jenž je zvýrazněn oranžově. Tento krok je nutné provést před analýzou normalizované genové
exprese.

Poznámka: Data pro rozptylový graf a graf „clustergram“ jsou zobrazena pouze tehdy, pokud
jsou splněny všechny požadavky na normalizovanou expresi genu uvedené v Plate Setup
(Nastavení destičky) pro analýzu genové exprese.
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Grafy genové exprese
Software CFX Maestro Dx SE zobrazí data genové exprese v několika zobrazeních. Tabulka 30 obsahuje
seznammožností grafu, které jsou v softwaru k dispozici.

Tlačítko Název Funkce

Graphing (Grafy) Zobrazí normalizovaná data genové exprese
v jednom z následujících zobrazení:

n Sloupcový graf (výchozí)

n Box aWhisker graf

n Bodový graf

Graf „clustergram“ Zobrazí data o normalizované expresi
v hierarchii podle úrovně podobnosti exprese
pro různé produkty a vzorky.

Rozptylový graf Zobrazí normalizovanou expresi produktů pro
kontrolu ve srovnání s experimentálním
vzorkem.

ANOVA Zobrazí výsledky jednofaktorové ANOVA dat
z genové exprese pomocí následujících R
balíčků pro provedení ANOVA a stanovení
výsledků podle Tukeyho:

n Průvodce použitou regresí (car)

n Metoda nejmenších čtverců (lsmeans)

Nástroj pro výběr referenčního
genu

(K dispozici na kartě Study Analysis (Analýza
studie) v okně Gene Study (Genová studie))
Identifikuje testované referenční geny
a kategorizuje je na základě stability jako
ideální, přípustné nebo nestabilní.

Analýza kontrol PrimePCR (K dispozici na kartě Study Analysis (Analýza
studie) v okně Gene Study (Genová studie))
Zobrazí výsledky testovaných vzorků.

Tabulka 30. Možnosti grafu genové exprese
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Graphing (Grafy)

Relativní exprese produktů je uvedena v těchto dvou zobrazeních:

n Graf genové exprese – zobrazí data PCR v reálném čase jako jednu z následujících možností:

o ΔΔCq – relativní normalizace exprese vypočtena pomocí kontrolních vzorků a referenčních produktů.

o ΔCq – relativní množství cílového genu ve vzorku vzhledem ke kontrolnímu vzorku.

Více informací o zobrazení dat naleznete v části Změna a anotace zobrazení grafu na straně 264.

n Tabulka – zobrazí tabulku dat genové exprese.

Tip: Klikněte pravým tlačítkemmyši na libovolný graf nebo tabulku možností. Vyberte možnost
View/Edit Plate (Zobrazit/Upravit destičku) z rozevírací nabídky Plate Setup (Nastavení
destičky) , aby se otevřel editor Plate Editor (Editor destiček), a změňte obsah jamky na
destičce.

Tip: Pravým tlačítkemmyši vyberte položku Sort (Třídit) , chcete-li uspořádat pořadí názvů
Target (Produkt) a Sample (Vzorek) v grafu.

Normalizace genové exprese

Pro normalizaci dat použijte jako normalizační faktor naměřenou úroveň exprese jednoho nebo několika
referenčních genů. Referenční geny jsou produkty, které nejsou ve studovaném biologickém systému
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regulovány, například aktin,GAPDH nebo tubulin.

Jak nastavit analýzu normalizace genové exprese (ΔΔCq)

1. Otevřete datový soubor (koncovka .pcrd).

2. Zkontrolujte data na kartě Quantification (Kvantifikace) okna Data Analysis (Analýza dat). Proveďte
úpravy dat, například změnu threshold nebo režimu analýzy.

3. Vyberte kartu Gene Expression (Genová exprese).

4. Na kartě Gene Expression (Genová exprese) klikněte na Experiment Settings (Nastavení
experimentu).

5. V dialogovém okně Experiment Settings (Nastavení experimentu) postupujte následovně:

a. Vyberte kartu Samples (Vzorky) a zvolte kontrolu. Když je kontrola přiřazena, normalizuje software
CFX Maestro Dx SE relativní množství pro všechny geny na množství kontroly, nastavené na 1.

b. Vyberte kartu Target (Produkt) a zvolte referenční geny. Analýza genové exprese vyžaduje
jeden referenční vzorek mezi vašimi vzorky.

6. Vyberte možnost Normalized Expression (ΔΔC q (Normalizovaná exprese (ΔΔCq) ), pokud již není
vybrána, a následně zobrazte úrovně exprese na kartě Gene Expression (Genová exprese).

Poznámka: Pro nastavení nastavení destičky pro analýzu normalizace genové exprese můžete
rovněž použít Setup Wizard (Průvodce nastavením).

Relativní množství

Už ze své povahy nejsou data o relativním množství (ΔCq) normalizována. Tato metoda se používá ke
kvantifikaci vzorků, jež nezahrnují žádné referenční geny (produkty). Při přípravě experimentu je třeba mít
na paměti jeden z následujících předpokladů:

n Každý vzorek obsahuje stejné množství RNA nebo cDNA v každé jamce.

n Jakékoliv odchylky v množství založeného biologického vzorku budou normalizovány po běhu nějakou
metodou analýzy dat mimo samotný software. Můžete se například rozhodnout, že hodnotu relativního
množství vydělíte normalizačním faktorem, případně hmotností nukleové kyseliny založené pro každý
vzorek nebo počtem buněk, ze kterých byla nukleová kyselina izolována.

Jak provést analýzu relativního množství (ΔCq)

u Na kartě Gene Expression (Genová exprese) vyberte z rozevíracího seznamu Mode (Režim)
v pravém podokně možnost Relative Quantity (ΔCq) (Relativní množství (ΔCq)).

Tip: Pro porovnání výsledků s daty z jiných cyklů genové exprese otevřete novou genovou studii
nebo přidejte datový soubor do existující genové studie.
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Změna a anotace zobrazení grafu
Pomocí příkazů z nabídky na panelu nástrojů grafu a nástrojů pro analýzu dat můžete změnit zobrazení
grafu, opatřit jednotlivé grafy poznámkami a změnit zobrazení grafu. Panel nástrojů grafů se zobrazí mezi
grafem a tabulkou analýzy dat v dolní části obrazovky.

Nástroje panelu nástrojů grafu

Tip: Informace o nástrojích grafu, které se zobrazují na pravé straně grafů analýzy dat, naleznete
v části Grafy na straně 204.

Panel nástrojů pod grafy poskytuje rychlý přístup k nástrojům pro přidávání popisků.

Tabulka 31 uvádí seznam funkcí tlačítek na panelu nástrojů grafů.

Tlačítko Název Funkce

Sloupcový graf Zobrazí relativní expresi produktů.

Box a Whisker graf Znázorňuje data jako rozsahy kvartilů (Informace
o výpočtu naleznete v části Grafy „Box“ a „Whiskers“ -
výpočet na straně 301).

Poznámka: Dostupné, pouze když je možnost Analyze
Using (Typ analýzy) nastavena na Biological Groups Only
(Pouze biologické skupiny).

Bodový graf Znázorňuje jednotlivé datové body vzorku pro každý
produkt.
Poznámka: Dostupné, pouze když je možnost Analyze
Using (Typ analýzy) nastavena na Biological Groups Only
(Pouze biologické skupiny).

Přidat šipku Nakreslí šipku na aktivní graf.

Přidat kroužek Nakreslí kroužek na aktivní graf.

Přidat text Do aktivního grafu vloží textové pole, ve kterém můžete
přidat text, který popisuje zajímavé položky v grafu.

Tabulka 31. Panel nástrojů grafu
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Tlačítko Název Funkce

Vrátit zpět Odstraní nebo vrátí poslední anotaci provedenou
v aktivním grafu.

Provést znovu Vrátí poslední akci zpět provedenou v aktivním grafu.

Vymazat vše Vymaže všechny anotace provedené v aktivním grafu.

Tabulka 31. Panel nástrojů grafu, pokračování

Výběr cílových hodnot, dat vzorků a biologických skupin

Poznámka: Tato možnost je k dispozici pouze v grafu genové exprese.

Ve výchozím nastavení se seznamy Targets (Produkty), Samples (Vzorky) a Biological Groups
(Biologické skupiny) zobrazují v abecedním pořadí. Dialogové okno Sort (Řazení) slouží k řazení
zobrazení v obráceném abecedním pořadí nebo k ručnímu přesunutí výrazu na jinou pozici v seznamu.

Výběr cílových hodnot, dat vzorků a biologických skupin

1. Z nástrojů grafu klikněte na Export.

Zobrazí se dialogové okno Gene Expression Chart Sorting (Výběr dat grafu genové exprese).

2. V dialogovém okně klikněte na položku Z-A a seřadíte seznam v obráceném abecedním pořadí.

3. Chcete-li termín ručně přesunout, vyberte jej a klikněte na příslušné tlačítko mezi grafy:

n Kliknutím na šipku nahoru nebo dolů přesunete vybraný termín o jednu pozici.

n Kliknutím na šipku nahoru nebo dolů přesunete vybraný výraz na začátek nebo na konec
seznamu.
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4. Kliknutím na tlačítko OK uložte změny a vraťte se na kartu Gene Expression (Genová exprese).
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Změna nastavení barvy produktu, vzorku a biologické skupiny

V dialogovém okně Color Settings (Nastavení barev) můžete změnit barvu produktu, vzorku nebo
biologické skupiny nebo odebrat položku z grafu.

Změna nastavení barvy produktu

1. V pravém podokně v dialogovém okně Gene Expression (Genová exprese) ověřte, zda se
v rozevíracím seznamu osy X zobrazí Sample (Vzorek).

2. V nástrojích grafu vyberte položku Color Settings (Nastavení barev).

Zobrazí se dialogové okno Color Settings (Nastavení barev).

3. Chcete-li změnit barvu zobrazení pro produkt, klikněte na jeho barvu ve sloupci Color (Barva).

4. V zobrazeném dialogovém okně Color (Barva) vyberte novou barvu a klikněte na tlačítko OK.

5. Chcete-li odstranit produkt z grafu genové exprese, odznačte příslušné zaškrtávací políčko ve
sloupci Show Chart (Zobrazit graf).

Tip: Chcete-li vymazat všechny produkty, vymažte položku Show Chart (Zobrazit graf) v záhlaví
sloupce.

6. (Volitelné) Ve výchozím nastavení se pruhy zobrazují v plných barvách. Odznačte zaškrtávací
políčko Use Solid Colors (Použít jednobarevné barvy) pro zobrazení pruhů v gradientních barvách.

7. Kliknutím na tlačítko OK uložte změny a vraťte se na kartu Gene Expression (Genová exprese).

Změna nastavení barvy vzorku nebo biologické skupiny

1. V pravém podokně v dialogovém okně Gene Expression (Genová exprese) ověřte, zda se
v rozevíracím seznamu osy X zobrazí Target (Produkt).

2. Proveďte kroky uvedené v části Změna nastavení barvy produktu na straně 267.

Změna zobrazení grafu

Změna existujícího zobrazení grafu

u Vyberte příkaz nabídky panelu nástrojů pro zobrazení produktu.

Poznámka: V záložce Gene Expression (Genová exprese) se vždy zobrazí data ve výchozím
zobrazení sloupcového grafu.
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Vyloučení odlehlých datových bodů

V bodovém grafu můžete snadno zobrazit odlehlé body a vyloučit je ze své analýzy.

Jak vyloučit odlehlé datové body

u V bodovém grafu klikněte pravým tlačítkemmyši na cílový odlehlý bod a vyberte možnost Exclude
Well from Analysis (Vyloučit jamku z analýzy).

Datový bod bude z bodového grafu odstraněn a jamka v nástroji pro výběr jamek na kartě Quantification
(Kvantifikace) zešedne.

Jak zahrnout vyloučený odlehlý datový bod

u Na kartě Quantification (Kvantifikace) klikněte v nástroji pro výběr jamek pravým tlačítkemmyši na
jamku a vyberte položky Well > Include in Analysis (Jamka > Zahrnout do analýzy).

Zobrazení podrobností o datových bodech

Jak zobrazit podrobnosti o datových bodech

u V grafu Box aWhisker a bodovém grafu zastavte kurzorem na jednom datovém bodu.

Objeví se okénko s názvem vzorku a jeho expresí (relativní množství nebo normalizace exprese,
v závislosti na vybraném režimu).

Anotace grafů

Pro jasnou komunikaci dat můžete v každém zobrazení sloupcového grafu přidávat šipky, kroužky a text.
Anotace se ukládají společně se sloupcovým grafem a jsou obsaženy v exportovaném a vytištěném
souboru. Anotace přidané do jednoho zobrazení grafu se ale nepřidají do jiných zobrazení tohoto grafu.

Jak nakreslit šipku nebo kroužek do grafu

1. Na panelu nástrojů sloupcového grafu klikněte na konkrétní nástroj.

2. Klikněte na sloupcový graf a podle potřeby přetáhněte kurzor přes graf.
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Jak přidat text do grafu

1. Na panelu nástrojů sloupcového grafu klikněte na Add Text (Přidat text).

2. Klikněte na sloupcový graf. V příslušnémmístě se objeví textový rámeček.

3. Do rámečku doplňte text.

4. Pro opuštění textového rámečku klikněte kamkoliv na graf.

Tip: Pro přidání několika řádků do textového rámečku stiskněte Enter.

Jak přesunout anotaci

1. Umístěte kurzor nad anotaci. Ikona se změní na ukazující prst a zvýrazní se okraj anotace.

2. Klikněte na anotaci a přesuňte ji jinam.

3. Po uvolnění zůstane anotace na novémmístě.

Jak anotaci vrátit zpět

u Klikněte na Undo (Vrátit zpět).

Poslední přidaná anotace bude odstraněna.

Tip: Můžete postupně zrušit deset nejnovějších anotací.

Jak obnovit anotaci

u Klikněte na Redo (Znovu).

Poslední odstraněná anotace bude obnovena.

Tip: Můžete postupně obnovit deset nejnovějších anotací.

Jak vymazat anotaci

u Klikněte na anotaci pravým tlačítkemmyši a vyberte Delete (Vymazat).
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Úprava dat genové exprese
Po výběru režimu analýzy – normalizovaná exprese (∆∆Cq) nebo relativní množství (∆Cq), upravte data,
která vidíte na kartě Gene Expression (Genová exprese) změnou možností nastavení na pravé straně
grafu.

Tip: Výchozí možnosti dat Gene Expression (Genová exprese) nastavíte v dialogovém okně User
Preferences (Uživatelské předvolby) (viz Nastavení výchozích parametrů datového souboru genové
exprese na straně 91 ).

Data grafu

Nastavte hodnotu osy y na lineární měřítko, abyste umožnili možnosti dat grafu. Možnosti dat grafu vám
umožňují prezentovat data v grafu jednou z těchto možností:

n (Relative to control) Relativní ke kontrole – graf dat s osou škálovanou od 0 do 1. Pokud přiřadíte
kontrolu do běhu, vyberte tuto možnost pro rychlou vizualizaci upregulace a downregulace produktu.

n Relative to zero (Relativní k nule) – graf dat s počátkem na nule.

Analyze Using (Typ analýzy)

V této rozevírací nabídce můžete vybrat způsob analýzy a zakreslení dat. Dostupné možnosti jsou:

n Samples Only (Pouze vzorky) – data se analyzují a zakreslují pro jednotlivé vzorky.

n Biological Groups Only (Pouze biologické skupiny) – data se analyzují a zakreslují pro biologické
skupiny. Exprese zobrazená pro biologickou skupinu představuje geometrický průměr vzorků v dané
skupině.

n Sample Biological Group (Vzorek, biologická skupina) – data se analyzují a zakreslují pro jednotlivé
vzorky, s doplněním biologické skupiny za názvem vzorku. Zobrazené hodnoty P se vypočítají na
základě biologické skupiny.

n Biological Group Sample (Biologická skupina, vzorek) – data se analyzují a zakreslují pro jednotlivé
vzorky, s doplněním biologické skupiny před název vzorku. Zobrazené hodnoty P se vypočítají na
základě biologické skupiny.

Pomocí rozevírací nabídky vyberte vzorek, který bude použit k normalizaci relativního množství:

Anotace hodnot P a prahu hodnoty P

Pokud je vybrána možnost Annotate P-Values (Anotace hodnot P), software zobrazí na sloupcovém grafu
nad produktem hvězdičku (*), pokud je jeho hodnota P pod vybranou hodnotou threshold. Software
automaticky vypočítá hodnotu P tak, že porovná úroveň exprese vzorku s úrovní exprese vybraného
kontrolního vzorku prostřednictvím standardního t-testu. Rozsah pro práh hodnoty P je 0,000–1,000.
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Možnosti osy X

Volba osy x umožňuje vybrat data osy x grafu Gene Expression (Genová exprese):

n Produkt – zobrazuje názvy produktů na ose x.

n Vzorek – zobrazuje názvy vzorků na ose x.

Možnosti osy Y

Možnosti osy Y vám umožňují zobrazit graf Gene Expression (Genová exprese) v jednom z těchto tří
měřítek:

n Linear (Lineární) – vyberte tuto možnost pro zobrazení lineárního měřítka.

Tip: Po nastavení osy Z na Linear (Lineární) je k dispozici rozevírací seznam Graph Data (Data
grafu), ze kterého lze vybrat sestavení grafu dat vzhledem ke kontrole nebo vzhledem k nule.

n Log 2 – vyberte tuto možnost pro vyhodnocení vzorků napříč velkým dynamickým rozsahem.

n Log 10 – vyberte tuto možnost pro vyhodnocení vzorků napříč velmi velkým dynamickým rozsahem.

Možnosti úpravy měřítka

Vyberte Normalized Gene Expression (Normalizovaná genová exprese)(ΔΔC q) a nastavte pro položku
možnost None (Žádná) , aby se povolila možnost škálování v grafu genové exprese. Vyberte jednu z
těchto možností škálování pro výpočet a prezentaci svých dat způsobem, který nejlépe vyhovuje vašemu
návrhu běhu:

n Unscaled (Bez měřítka) – představuje normalizaci genové exprese bez rozsahů.

n Highest (Nejvyšší) – zobrazuje normalizaci genové exprese pro každý produkt vydělením úrovně
exprese každého vzorku nejvyšší hodnotou úrovně exprese ve všech vzorcích.

Tato volba škálování používá vzorec rozsahu na nejvyšší hodnotu.

n Lowest (Nejnižší) – zobrazuje normalizaci genové exprese pro každý produkt vydělením úrovně
exprese každého vzorku nejnižší hodnotou úrovně exprese ve všech vzorcích.

Tato volba škálování používá vzorec rozsahu na nejnižší hodnotu.

n Average (Průměrná) – zobrazuje normalizaci genové exprese pro každý produkt vydělením úrovně
exprese každého vzorku geometrickým průměrem hladin exprese pro všechny vzorky.

Tato volba škálování používá vzorec rozsahu na průměrnou hodnotu.

V grafu Gene Expression (Genová exprese) vyberte možnost výpočtu typu chyby (chybové úsečky):
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Násobitel chybové úsečky v grafu

V grafu Gene Expression (Genová exprese) vyberte násobitel chybových úseček. Vyberte jedno z těchto
celých čísel:

n +/− 1 (default)

n 2

n 3

Typ násobitele se změní, když vyberete chybovou úsečku:

n SEMs (Hodnoty SEM) pro standardní chybu průměru

n Std Devs (Směrodatné odchylky) pro směrodatné odchylky

Nastavení experimentu
Tip: Toto dialogové okno je také dostupné v nástroji Plate Editor (Editor destiček). Více informací
naleznete v části Změna nastavení experimentu na straně 152.

V dialogovém okně Experiment Settings (Nastavení experimentu) můžete zobrazit nebo změnit seznam
produktů, vzorků nebo biologických skupin, vybrat referenční geny, vybrat kontroly nebo nastavit analýzu
Gene Expression Analysis (Analýza genové exprese) skupiny, kterou chcete analyzovat, pokud do jamek
byly přidány biologické skupiny.

Otevření dialogového okna Experiment Settings (Nastavení experimentu)

u Na kartě Graphing (Grafy) klikněte v dolní části pravého podokna na položku Experiment Settings
(Nastavení experimentu).

Zobrazí se dialogové okno Experiment Settings (Nastavení experimentu), které zobrazuje kartu
Targets (Produkty).

Úprava nastavení Targets (Produkty)

u Na kartě Targets (Produkty) postupujte následovně:

n Chcete-li vybrat produkt jako referenční gen pro analýzu dat genové exprese, vyberte jeho
název ve sloupci Reference.

n Chcete-li změnit barvu produktu, klikněte na jeho buňku ve sloupci Color (Barva) a změňte barvu
v zobrazeném dialogovém okně Color (Barva).

Změna barvy se objeví v grafech Gene Expression (Genová exprese).

n Chcete-li použít dříve určenou hodnotu účinnosti, zrušte zaškrtnutí políčka produktu ve sloupci
Auto Efficiency (Automatická účinnost) a zadejte číslo pro procento účinnosti produktu.
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Software vypočítá relativní účinnost pro produkt pomocí funkce Auto Efficiency (Automatická
účinnost), pokud data pro produkt obsahují standardní křivku.

Úprava nastavení položky Sample (Vzorek)

u Na kartě Samples (Vzorky) postupujte následovně:

n Chcete-li vybrat vzorek jako kontrolu analýzy dat genové exprese, vyberte jeho název ve sloupci
Control (Kontrola).

n Chcete-li změnit barvu vzorku skupiny, klikněte na její buňku ve sloupci Color (Barva) a změňte
barvu v zobrazeném dialogovém okně Color (Barva).

Změna barvy se objeví v grafech Gene Expression (Genová exprese).

n Chcete-li zobrazit vzorek v grafech Gene Expression (Genová exprese), vyberte příslušnou
položku ve sloupci Show Chart (Zobrazit graf).

n Chcete-li odstranit vzorek z grafů Gene Expression (Genová exprese), odstraňte příslušnou
položku ve sloupci Show Chart (Zobrazit graf).

Tip: Data vzorku skupiny zůstanou v tabulce Results (Výsledky).

Vyloučení typu vzorku z výpočtů analýzy

u Zaškrtněte políčko v dolní části dialogového okna Experiment Settings (Nastavení experimentu).

Poznámka: To vylučuje kontroly nebo standardy z analýzy genové exprese.

Možnosti nabídky po kliknutí pravým tlačítkem myši
Klikněte pravým tlačítkemmyši na graf genové exprese v Tabulka 32.

Položka Funkce

Copy (Kopírovat) Zkopíruje graf do schránky.

Save Image As (Uložit obrázek
jako)

Uloží graf jako soubor obrázku. Nastavte rozlišení a rozměry obrázku
a potom vyberte typ souboru (PNGnebo BMP).

Page Setup (Nastavení stránky) Vybere nastavení stránky pro tisk.

Print (Tisk) Vytiskne graf.

Tabulka 32. Položky nabídky genové exprese po kliknutí pravým tlačítkem myši
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Položka Funkce

Set Scale to Default (Nastavit
měřítko na výchozí)

Show All (Zobrazit vše) zobrazí všechna data v sloupcovém grafu.
Scroll Bar (Posuvník) zobrazí posuvník, pokud je v rámečku grafu
zobrazeno příliš mnoho vzorků a zároveň je zachována minimální
šířka pruhu.

Chart Settings (Nastavení grafu) Otevře okno Chart Settings (Nastavení grafu) pro úpravu grafu.

Sort (Řazení) Seřadí vzorky nebo produkty, které se objeví na ose x grafu.

Use Corrected Std Devs (Použít
korigovanou std. odch.)

Vypočítá chybové pruhy pomocí vzorce korigované standardní
odchylky.

Use Solid Bar Colors (Použít
barvou vyplněné pruhy)

Zobrazuje v grafu vyplněné pruhy.

X–Axis Labels (Popisky osy x) Zobrazí popisky na ose x vodorovně nebo šikmo.

Tabulka 32. Položky nabídky genové exprese po kliknutí pravým tlačítkem myši, pokračování

Tabulka dat
Tabulka 33 definuje data zobrazená v datové tabulce Gene Expression (Genová exprese).

Poznámka: Hodnoty v tabulce se počítají na základě typu grafu a předvoleb vybraných v panelu
napravo.

Informace Popis

Target (Produkt) Název produktu (amplifikovaného genu) vybraného v okně Experiment
Settings (Nastavení experimentu).

Biological Group (Biologická
skupina)

Sample Biological Group
(Biologická skupina vzorků)

Biological Group Sample
(Vzorek biologické skupiny)

Název vzorku nebo biologické skupiny v okně Experiment Settings
(Nastavení experimentu).

Tabulka 33. Popis informací v tabulce na kartě
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Informace Popis

Kontrola Název kontroly v okně Experiment Settings (Nastavení experimentu).
Pokud je možnost Analyze Using (Typ analýzy) nastavena na Samples
Only (Pouze vzorky), Control (Kontrola) označuje vzorek vybraný
v okně Experiment Settings (Nastavení experimentu). Pokud je
vybráno Biological Groups Only (Pouze biologické skupiny), Sample
Biological Group (Biologická skupina vzorků) nebo Biological Group
Sample (Vzorek biologické skupiny) , představuje kontrola biologickou
skupinu vybranou v okně Experiment Settings (Nastavení
experimentu).

Relativní množství nebo
exprese

Relativní množství (ΔCq) nebo normalizace genové exprese (ΔΔCq),
v závislosti na vybraném režimu.

SEM (nebo SD) relativního
množství nebo exprese

Standardní chyba průměru (SEM) nebo směrodatná odchylka (SD)
relativního množství nebo normalizace exprese v závislosti na zvolené
možnosti. Dostupné, pouze když je možnost Analyze Using (Typ
analýzy) nastavena na Samples Only (Pouze vzorky), Sample
Biological Group (Biologická skupina vzorků) nebo Biological Group
Sample (Vzorek biologické skupiny).

SEM (nebo SD) opraveného
relativního množství nebo
exprese

Výpočet opravené hodnoty SEM nebo SD relativního množství nebo
normalizace exprese v závislosti na zvolené možnosti. Dostupné,
pouze když je možnost Analyze Using (Typ analýzy) nastavena na
Samples Only (Pouze vzorky), Sample Biological Group (Biologická
skupina vzorků) nebo Biological Group Sample (Vzorek biologické
skupiny).

Průměr Cq Průměr kvantifikačního cyklu (nezobrazuje se, pokud je možnost
Analyze Using (Typ analýzy) nastavena na Biological Groups Only
Pouze biologické skupiny).

SEM (nebo SD) Cq SEM nebo SD kvantifikačního cyklu v závislosti na zvolené možnosti
(nezobrazuje se, pokud je možnost Analyze Using (Typ analýzy)
nastavena na Biological Groups Only (Pouze biologické skupiny)).
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Možnost Show Details (Zobrazit podrobnosti)
Tabulka 34 definuje data zobrazená při výběru možnosti Show Details (Zobrazit podrobnosti) z nabídky
pravého tlačítka tabulky sloupcového grafu.

Informace Popis

Datový soubor Údaje o fluorescenci jednoho fluoroforu v datovém souboru

Relativní množství Vypočtené relativní množství vzorků

SD relativního množství Výpočet směrodatné odchylky relativního množství

SD korigovaného relativního
množství

Výpočet směrodatné odchylky korigovaného relativního množství

SEM relativního množství Standardní chyba průměru výpočtu relativního množství

SEM korigovaného relativního
množství

Vypočtená standardní chyba průměru korigovaného relativního
množství

Relativní množství (lg) Log2 relativní veličiny, která se používá pro statistickou analýzu

SD RQ(lg) Směrodatná odchylka relativního množství (log2)

SEM exprese (lg) Standardní chyba průměru exprese (log2)

Exprese bez měřítka Vypočtená exprese bez měřítka

SD exprese bez měřítka Vypočtená směrodatná odchylka exprese bez měřítka

SD korigované exprese bez
měřítka

Výpočet směrodatné odchylky korigované exprese bez měřítka

SEM exprese bez měřítka Vypočtená standardní chyba průměru exprese bez měřítka

SEM korigované exprese bez
měřítka

Vypočtená standardní chyba průměru korigované exprese bez měřítka

Exprese bez měřítka (lg) Log2 exprese bez měřítka

SD exprese bez měřítka (lg) Směrodatná odchylka exprese bez měřítka (log2)

SEM exprese bez měřítka (lg) Standardní chyba průměru exprese bez měřítka (log2)

Tabulka 34. Informace v tabulce sloupcového grafu s vybranými údaji Show Details (Zobrazit
podrobnosti)
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Informace Popis

Exprese Normalizace genové exprese

SD korigované exprese Výpočet směrodatné odchylky korigované exprese

SEM exprese Standardní chyba průměru exprese

SEM korigované exprese Vypočtená standardní chyba průměru korigované exprese

Exprese (lg) Log2 exprese (normalizované exprese), která se používá pro
statistickou analýzu

SD exprese (lg) Směrodatná odchylka exprese (log2)

SEM exprese (lg) Standardní chyba průměru exprese (log2)

Průměr Cq Průměr kvantifikačního cyklu

Cq SD Směrodatná odchylka kvantifikačního cyklu

Cq SEM Standardní chyba průměru kvantifikačního cyklu

Tabulka 34. Informace v tabulce sloupcového grafu s vybranými údaji Show Details (Zobrazit
podrobnosti), pokračování
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Graf „clustergram“
Graf „clustergram“ zobrazuje data v hierarchii vycházející ze stupně podobnosti exprese pro různé
produkty a vzorky.

Poznámka: Chcete-li zobrazit jiný datový graf než relativní expresi pro sloupcový graf, musíte zvolit
referenční gen.

Obraz grafu „clustergram“ ukazuje relativní expresi vzorku nebo produktu takto:

n Upregulace (červeně) – vyšší exprese

n Downregulace (zeleně nebo modře) – nižší exprese

n Bez regulace (černě)

n Není vypočítána žádná hodnota (černě s bílým X)

Čím je barevný odstín světlejší, tím je rozdíl relativní exprese větší. Pokud nelze vypočítat žádnou
normalizovanou hodnotu Cq, bude čtverec černý s bílým X.

Na vnějších okrajích datového grafu je dendrogram, který znázorňuje shlukovou hierarchii. Produkty nebo
vzorky s podobnými vzory exprese budou mít napojené linky, zatímco odlišné vzory budou dále od sebe.

Settings (Nastavení)
Můžete nastavit následující možnosti:

n Cluster By (Shluk) – vyberte z Targets (Produkty), Samples (Vzorky), Both (Oba) nebo None
(Žádný).

n Size (Velikost) – upraví velikost obrazu a změní stupeň zvětšení grafu .

n Split Out Replicates (Rozdělit replikáty) – zobrazí hodnoty jednotlivých replikátů.

Tip: Můžete změnit barevné schéma z výchozí červené/zelené na červenou/modrou výběrem této
možnosti z nabídky pravým tlačítkemmyši v z těchto grafů.

Možnosti nabídky po kliknutí pravým tlačítkem myši
Možnosti nabídky po kliknutí pravým tlačítkemmyši pro graf „clustergram“ jsou stejné jako v případě
sloupcového grafu. Dostupné možnosti viz Tabulka 32 na straně 273. Kromě toho vyberte Color Scheme
(Barevné schéma), pokud chcete změnit expresi downregulace v grafu z výchozí červené/zelené na
červenou/modrou.

Tabulka dat
Tabulka zobrazuje hodnoty cílové, vzorové a normalizované exprese.
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Rozptylový graf
Rozptylový graf zobrazí normalizovanou expresi produktů pro kontrolu ve srovnání s experimentálním vzorkem.
Křivky grafu označují násobek změny hodnoty exprese. Datové body mezi křivkami ukazují, že rozdíl v expresi
pro daný produkt (gen) je mezi vzorky zanedbatelný. Datové body mimo křivky překračují násobek změny
hodnoty exprese a mohou být pro daný experiment nepodstatné.

Obrázek grafu ukazuje následující změny v expresi produktu na základě prahu násobku exprese:

n Upregulace (červený kroužek) – relativně vyšší exprese

n Downregulace (zelený nebo modrý kroužek) – relativně nižší exprese

n Bez změny (černý kroužek)

Klikněte a přetáhněte libovolnou křivku threshold pro úpravu hodnoty násobku exprese.

Nastavení
Můžete nastavit následující možnosti:

n Kontrolní vzorek

n Experimental Sample (Experimentální vzorek)

n Fold Change Threshold (Práh násobku exprese) Když budete zvyšovat nebo snižovat hodnotu
násobku exprese hodnotu regulace , budou se podle toho pohybovat křivky threshold v grafu.

Možnosti nabídky po kliknutí pravým tlačítkem myši
Možnosti nabídky po kliknutí pravým tlačítkemmyši pro rozptylový graf jsou stejné jako v případě
sloupcového grafu. Dostupné možnosti viz Tabulka 32 na straně 273. Vedle toho vyberte možnost
Symbol, pokud chcete změnit symbol používaný v grafu z výchozího kroužku na jeden z následujících:

n Trojúhelník

n Kříž

n Čtverec

n Kosočtverec

Tabulka dat
Tabulka zobrazuje hodnoty pro produkt a normalizovanou expresi pro kontrolní a experimentální vzorky.
Současně ukazuje, zda jsou produkty regulovány nahoru nebo dolů ve srovnání s regulací produktu
prahem regulace.
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Tabulka Results (Výsledky)
Tabulka Výsledky shrnuje data ze všech grafů. Tabulka 35 definuje data, která se zobrazí v tabulce
Results (Výsledky).

Informace Popis

Target (Produkt) Název produktu (amplifikovaného genu)

Sample (Vzorek) Název vzorku

Mean Cq (Průměr Cq) Průměr kvantifikačního cyklu

Mean Efficiency Corrected Cq
(Průměr korigované účinnosti
Cq)

Průměr kvantifikačního cyklu po úpravě účinnosti reakce

Normalizovaná exprese Exprese produktu normalizovaná na referenční produkt (ΔΔCq)

Relative Normalized Expression
(Relativní normalizovaná
exprese)

Normalizovaná exprese ve vztahu ke kontrolnímu vzorku; nazývá se
také Fold Change (Násobek exprese)

Regulation (Regulace) Změna exprese ve vztahu k kontrolnímu vzorku

Compared to Regulation
Threshold (Porovnání s prahem
regulace)

Up nebo downregulace experimentálního vzorku na základě nastavení
prahu

Tabulka 35. Informace na kartě Results (Výsledky)

Poznámka: Data pro replikáty se nacházejí pouze v tabulkách s kartami analýzy dat, ve kterých byly
vybrány rozdělené replikáty Split Out Replicates (Rozdělit replikáty) (tj. Clustergram (Graf
„clustergram“) a ). Může existovat nesoulad mezi daty genové exprese v tabulkách analýzy genové
exprese, pokud vyberete jako kontrolní vzorek v sloupcovém grafu „none (žádný)“.
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Genová studie
Vytvořte genovou studii pro porovnání dat genové exprese z jednoho nebo několika PCR experimentů
v reálném čase pomocí kalibrátoru mezi běhy s cílem provést normalizaci mezi experimenty. Genovou
studii vytvoříte tak, že do genové studie přidáte data z jednoho nebo několika datových souborů
(koncovka .pcrd). Software je sdruží do jednoho souboru (koncovka .mgxd).

Poznámka: Maximální počet vzorků, které můžete v genové studii analyzovat, je omezen velikostí
RAM paměti a virtuální paměti počítače.

Kalibrace mezi běhy
V každé genové studii se automaticky provádí kalibrace mezi běhy pro každý produkt, aby se
normalizovaly nesrovnalosti mezi produkty testovanými v oddělených bězích PCR v reálném čase (tj.
různé .pcrd soubory PCR generované různými destičkami).

Aby software rozpoznal vzorek jako kalibrátor mezi běhy, musí sdílet stejný název produktu, název vzorku
a, je-li použit, název biologického souboru napříč všemi porovnávanými destičkami.

Poznámka: V genové studii musí být přítomen alespoň jeden vzorek kalibrátoru mezi běhy pro
provedení kalibrace mezi běhy. Produkty bez vhodných vzorků kalibrátoru mezi běhy budou
zpracovány bez korekce v genové studii (nedoporučeno).

Kalibrátory mezi běhy lze aplikovat dvěma způsoby:

n Na každý produkt – různé PCR primery mohou mít různé účinnosti. Ve výchozím nastavení je
kalibrátor mezi běhy aplikován na všechny jamky na stejné destičce, které mají stejný název
produktu, například Cq vytvořený stejným testem.

n Celá studie – jeden kalibrátor mezi běhy je vybrán uživatelem a aplikován na celou genovou studii.
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Dialogové okno Gene Study (Genová studie)

Dialogové okno Gene Study (Genová studie) obsahuje dvě karty:

n Karta Study Setup (Nastavení studie) – spravuje běhy v genové studii.

Důležité: Přidáním nebo odstraněním datových souborů z genové studie se nemění data
v původním souboru.

n Karta Study Analysis (Analýza studie) – zobrazí data genové exprese pro kombinované běhy.

Karta Study Setup (Nastavení studie)
Tabulka 36 definuje data, která se objeví na kartě Study Setup (Nastavení studie).

Název sloupce Popis

File Name (Název souboru) Název spouštěcího datového souboru (koncovka .pcrd)

File Folder (Složka souboru) Adresář, ve kterém je uložen datový soubor pro každý běh genové
studie

Date Created (Datum
vytvoření)

Datum shromáždění dat běhu

Tabulka 36. Karta Study Setup (Nastavení studie) v dialogovém okně Gene Study (Genová
studie)
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Název sloupce Popis

Well Group Name (Název
skupiny jamek)

Název skupiny jamek vybraných při přidání souboru do genové studie

Tip: Pro analýzu jedné skupiny jamek v genové studii musíte
vybrat příslušnou skupinu jamek v okně Data Analysis (Analýza
dat) ještě před importem datového souboru do genové studie.

Step (Krok) Krok protokolu, jenž zahrnuje čtení destičky s cílem shromáždit data
PCR v reálném čase

Run Type (Typ běhu) Běh definovaný uživatelem nebo PrimePCR

Protocol Edited (Editovaný
protokol)

Je-li zvolena tato možnost, znamená to, že protokol použitý pro
PrimePCR byl upraven

View Plate (Zobrazit
destičku)

Otevře mapu destiček s destičkou s daty v každém běhu zařazeném
do genové studie

Tabulka 36. Karta Study Setup (Nastavení studie) v dialogovém okně Gene Study (Genová
studie), pokračování

Příprava genové studie
Jak připravit genovou studii

1. Před importem dat do genové studie postupujte v okně Data Analysis (Analýza dat) následovně:

n Ujistěte se, že vzorky se stejným obsahemmají stejný název. V genové studii software
předpokládá, že jamky se stejným názvem produktu nebo vzorku obsahují stejné vzorky.

n Upravte baseline a threshold (Cq) na kartě Quantification (Kvantifikace) pro optimalizaci dat
v každém běhu.

n Vyberte skupinu jamek, kterou chcete zařadit do genové studie.

Aby bylo možné v genové studii zobrazit data z jedné skupiny jamek, musí být tato skupina
vybrána před importem datového souboru.

Karta Study Setup (Nastavení studie) obsahuje seznam všech cyklů v genové studii.

2. V dialogovém okně Gene Study (Genová studie) vyberte kartu Study Setup (Nastavení studie).

3. Klikněte na položku Add Data Files (Přidat datové soubory) pro výběr souboru z okna prohlížeče.

Tip: Pro rychlé přidání cyklů do genové studie přetáhněte datové soubory (koncovka .pcrd) do
dialogového okna Study Setup (Nastavení studie).

4. CFX Maestro Dx SE automaticky provádí analýzu genové studie v průběhu přidávání datových
souborů. Vyberte kartu Study Analysis (Analýza studie) pro zobrazení výsledků.
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Jak odstranit běhy z genové studie

u Vyberte v seznamu jeden nebo více souborů a klikněte na položku Remove (Odstranit).

Jak přidat poznámky do genové studie

u Zadejte poznámky k souborům a analýze do textového rámečku Notes (Poznámky).

Karta Study Analysis (Analýza studie)
Karta Study Analysis (Analýza studie) obsahuje data ze všech cyklů genové studie. Možnosti analýzy dat
genové exprese jsou stejné jako možnosti pro jeden datový soubor, s následující výjimkou:

n V případě sloupcových grafů se po kliknutí na možnost Inter-run Calibration (Kalibrace mezi běhy)
objeví hodnoty kalibrace mezi běhy (jsou-li vypočítány).

Poznámka: Jako kalibrátor mezi běhy lze použít pouze následující typy vzorků:

o Unknown (Neznámý)

o Standard

o Positive Control (Pozitivní kontrola)

Jako kalibrátor mezi běhy nelze použít tyto typy vzorků: negativní kontrola, kontrola bez templátu
(NTC) a kontrola bez reverzní transkriptázy (NRT).

n Nástroj Reference Gene Selection (Výběr referenčního genu) identifikuje testované referenční geny
a kategorizuje je na základě stability jako ideální, přípustný či nestabilní:

o Ideální referenční geny jsou stabilní a představují minimální odchylky napříč testovanými vzorky.

o Přípustné referenční geny nejsou ideálně stabilní a představují středně velké odchylky napříč
testovanými vzorky. Pokud nejsou k dispozici ideální referenční geny, použijte v analýze tyto
referenční geny.

o Nestabilní referenční geny představují nadměrné odchylky napříč testovanými vzorky.
Doporučujeme tyto geny z analýz vyloučit.

n Nástroj pro kontroly PrimePCR zobrazí výsledky testovaných vzorků v tabulce:

o Karta Summary (Souhrn) obsahuje souhrn všech tetovaných vzorků. Vzorky, které prošly všemi
kontrolními analýzami, jsou označeny zeleně. Vzorky, které jednou nebo několika kontrolními
analýzami neprošly, jsou označeny žlutě.

o Karta PCR obsahuje výsledky analýzy pozitivní kontroly PCR. Tato analýza zjistí inhibici nebo
problémy při experimentu, které ovlivňují genovou expresi.
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o Karta RT obsahuje výsledky analýzy kontroly s reverzní transkripcí. Tato analýza kvalitativně
vyhodnotí výkonnost RT a identifikuje vzorky, u kterých je pravděpodobné, že výkonnost RT
naruší genovou expresi.

o Karta gDNA obsahuje výsledky analýzy kontroly s kontaminací DNA. Tato analýza určí, zda je
ve vzorku přítomna genomová DNA (gDNA) na úrovni, která by mohla narušit výsledky qPCR.

o Karta RQ obsahuje výsledky analýz kvality RNA (RQ1 a RQ2). Tyto analýzy kvalitativně
posoudí, zda by mohla integrita RNA nepříznivě ovlivnit genovou expresi.

Kategorie reportu o genové studii
Dialogové okno Gene Study Report (Report o genové studii) slouží k uspořádání údajů o genové studii do
sestavy. Tabulka 37 obsahuje všechny dostupné možnosti pro reporty z genové studie.

Kategorie Možnost Popis

Záhlaví

Titul, podtitul a logo pro report

Report Information
(Informace o reportu)

Datum, jméno uživatele, název datového
souboru, cesta k datovému souboru a vybraná
skupina jamek

Gene Study File List
(Seznam souborů genové
studie)

Seznam všech datových souborů v genové studii.

Notes (Poznámky) Poznámky k datovému reportu

Study Analysis (Analýza studie): Bar Chart (Sloupcový graf)

Analysis Settings
(Nastavení analýzy)

Seznam vybraných parametrů analýzy

Chart (Graf) Sloupcový graf genové exprese zobrazující data

Target Names (Názvy
produktů)

Seznam produktů v genové studii.

Sample Names (Názvy
vzorků)

Seznam vzorků v genové studii.

Tabulka 37. Kategorie reportu pro genovou studii
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Kategorie Možnost Popis

Data Tabulka, která zobrazuje data

Target Stability (Stabilita
produktu)

Data o stabilitě produktu

Inter-run Calibration
(Kalibrace mezi běhy)

Data z kalibrace mezi běhy

Box-and-Whisker Chart
(Box a Whisker graf)

Box a Whisker graf genové exprese

Show Chart (Bodový graf) Bodový graf genové exprese

Study Analysis (Analýza studie): Clustergram and Scatter Plot (Clustergram, rozptylový
graf, vulkánový graf a clustergram a rozptylový graf teplotní mapy)

Analysis Settings
(Nastavení analýzy)

Nastavení pro každý typ grafu

Chart (Graf) Graf genové exprese zobrazující data

Data Tabulka se seznamem dat pro každý produkt

Study Analysis (Analýza studie): ANOVA
Data

ANOVA Settings
(Nastavení ANOVA)

Práh hodnoty P použitý při analýze

ANOVA Results (Výsledky
ANOVA)

Tabulka výsledků z ANOVA a post-hoc analýzy
Tukey's HSD (Tukeyův HSD test)

Shapiro-Wilk Normality
Test (Shapirův-Wilkův test
normality)

Biologická skupina, počet, hodnota P a chyby,
které se vyskytnou pro každý produkt při analýze

ANOVA Errors (Chyby
ANOVA)

Chyby zjištěné během výpočtů ANOVA

Tabulka 37. Kategorie reportu pro genovou studii, pokračování
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Vytvoření reportu o genové studii
Jak vytvořit report o genové studii

1. Před tvorbou reportu upravte podle potřeby data a grafy reportu o genové studii.

2. Otevřete dialogové okno Report zvolením položek Tools > Reports (Nástroje > Reporty) v nabídce
Gene Study (Genová studie).

3. Vyberte možnosti, které chcete do reportu zahrnout. Report se otevře s vybranými výchozími
možnostmi. Vyberte nebo odznačte zaškrtávací políčka pro změnu celých kategorií nebo
jednotlivých možností v kategorii.

Kategorie reportu o genové studii na straně 285 obsahuje seznam dostupných možností zobrazení.

4. Změňte pořadí kategorií a položek v reportu. Přetáhněte možnosti do požadované pozice. Položky
lze přenastavit pouze v rámci kategorií, do kterých patří.

5. Klikněte na položku Update Report (Aktualizovat report) pro aktualizaci Report Preview (Náhled
reportu) se zohledněním všech změn.

6. Report vytiskněte nebo uložte. Pro tisk aktuálního reportu klikněte na tlačítko Print Report (Tisk
reportu) na panelu nástrojů. Vyberte položky File > Save (Soubor > Uložit) pro uložení reportu jako
PDF (Adobe Acrobat Reader file) (PDF (soubor Adobe Acrobat Reader)) a vyberte umístění, do
kterého se soubor uloží. Uložte report s novým názvem nebo do nového umístění zvolením položek
File > Save As (Soubor > Uložit jako).

7. (Volitelné) Vytvořte šablonu zprávy s požadovanými informacemi. Pro uložení aktuálního nastavení
reportu v šabloně vyberte Template > Save (Šablona > Uložit) nebo Save As (Uložit jako). Pokud
chcete vytvořit nový report, načtěte šablonu reportu.

Uživatelská příručka | 287



Kapitola 12 Analýza genové exprese

288 | Software CFX Maestro Dx SE



Příloha A Výpočty pro analýzu dat
Software Software CFX Maestro Dx, bezpečnostní edice automaticky vypočítá vzorce a zobrazí výsledky
na kartách Data Analysis (Analýza dat). Příloha podrobně vysvětluje, jak software CFX Maestro Dx SE
vzorce počítá.

Účinnost reakce
Použití přesného měřítka účinnosti pro každou sadu primeru a sondy vám dá při analýze dat genové
exprese přesnější výsledky. Výchozí hodnota účinnosti použitá ve výpočtech genové exprese je 100 %.
Pro hodnocení účinnosti reakce vygenerujte standardní křivku pomocí série ředění reprezentativního
vzorku napříč příslušným dynamickým rozsahem a poté zaznamenejte účinnost pro následnou analýzu
genové exprese. Jestliže váš běh zahrnuje standardní křivku, pak software automaticky vypočítá účinnost
a zobrazí ji pod možností Standard Curve (Standardní křivka) na kartě Quantification (Kvantifikace), když
je v okně Experiment Settings (Nastavení experimentu) na kartě Targets (Produkty) zaškrtnuta možnost
Auto Efficiency (Automatická účinnost).

Účinnost (E) ve vzorcích účinnosti odkazuje na „účinnost“ popsanou Pfafflem (2001) a Vandesompelem
a kol. (2002). V těchto publikacích odpovídá hodnota účinnosti 2 (dokonalé zdvojení při každém cyklu)
v tomto softwaru 100% účinnosti. Máte možnost převést své výpočty účinnosti na výpočty použité
softwarem, a to na základě následujících matematických vztahů:

n E = (% účinnosti * 0,01) + 1

n % účinnosti = (E – 1) * 100

Relativní množství
Vzorec pro relativní množství (ΔCq) pro každý vzorek (GOI) je:

Poznámka: Tento vzorec se používá pro výpočet relativního množství, pokud není definován žádný
kontrolní vzorek .

Kde:
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n E = účinnost sady primeru a sondy. Tato účinnost se počítá podle vzorce
(% Účinnost * 0,01) + 1, kde 100% účinnost = 2

n C q (min) = průměr Cq pro vzorek s nejnižší průměrnou hodnotou Cq pro GOI

n C q (vzorek) = průměr Cq pro vzorek

n GOI = zájmový gen (jeden produkt)

Relativní množství při výběru kontroly
Je-li přiřazen kontrolní vzorek nebo biologická skupina, vypočítá se relativní množství (RQ) pro libovolný
vzorek se zájmovým genem (GOI) tímto vzorcem:

Kde:

n E = účinnost sady primeru a sondy. Tato účinnost se počítá podle vzorce
(% Účinnost * 0,01) + 1, kde 100% účinnost = 2

n Cq (kontrola) = průměr Cq pro kontrolní vzorek

n Cq (vzorek) = průměr Cq pro všechny vzorky s GOI

n GOI = zájmový gen (jeden produkt)

Směrodatná odchylka relativního množství
Důležité: Výpočet se dá použít, pouze pokud je parametr Analyze Using (Typ analýzy) nastaven na
Samples Only (Pouze vzorky), Sample Biological Group (Biologická skupina vzorků) nebo Biological
Group Samples (Vzorky biologické skupiny).

Výpočet směrodatné odchylky relativního množství je

Kde:

n SD relativního množství = směrodatná odchylka relativního množství

n SD CqGOI vzorek = směrodatná odchylka Cq pro vzorek(GOI)

n Relativní množství = relativní množství vzorku
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Korigovaná účinnost Cq (CqE)

n E = účinnost sady primeru a sondy. Tato účinnost se počítá podle vzorce
(% Účinnost * 0,01) + 1, kde 100% účinnost = 2

n GOI = zájmový gen (jeden produkt)

Korigovaná účinnost Cq (CqE)
Vzorec pro korigovanou účinnost Cq je

Kde:

n E = účinnost

Průměrná korigovaná účinnost Cq (MCqE)
Vzorec pro průměrnou korigovanou účinnost Cq je

Kde:

n CqE = korigovaná účinnost Cq

n n = počet replikátů
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Normalizovaná exprese
Normalizovaná exprese (ΔΔCq) je relativní množství vašeho produktu (genu) normalizovaného na
množství referenčních produktů (genů nebo sekvencí) ve vašem biologickém systému. Chcete-li vybrat
referenční produkty, otevřete okno Experiment Settings (Nastavení experimentu) a klikněte na referenční
sloupec pro každý produkt, který slouží jako referenční gen.

Vzorec pro normalizovanou expresi, který používá výpočet relativního množství (RQ), je

Kde:

n RQ = relativní množství vzorku

n Ref = referenční gen v běhu, který obsahuje jeden nebo více referenčních genů v každém vzorku

n GOI = zájmový gen (jeden produkt)

Za předpokladu, že referenční geny v biologickém systému nemění hladinu exprese, bude výpočet
normalizované exprese zohledňovat rozdíly v zátěži nebo změny počtu buněk, které jsou reprezentovány
v každém vzorku.
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Normalizovaná exprese při výběru kontroly

Exprese a relativní množství pro biologické skupiny
Pokud je volba Analyze Using (Typ analýzy) nastavena na Biological Groups Only (Pouze biologické
skupiny), software zobrazí průměrnou expresi (normalizovaná exprese nebo relativní množství,
v závislosti na výběru režimu) vzorků v rámci biologické skupiny. Protože exprese je normálně
distribuována logaritmicky, průměr je tvořen geometrickým průměrem:

Kde:

n Exp1, Exp2, Expn = relativní množství nebo normalizovaná exprese vzorků v biologické skupině

n n = počet vzorků v biologické skupině

Normalizovaná exprese při výběru kontroly
Když vyberete kontrolní vzorek v okně Experiment Settings (Nastavení experimentu), software nastaví
úroveň exprese kontrolního vzorku na 1. V tomto případě software normalizuje relativní množství veškeré
exprese produktu (genu) podle množství kontroly (hodnota 1). Pokud je zvolena kontrola, odpovídá tato
normalizovaná exprese analýze normalizované exprese bez úpravy měřítka.

Poznámka: Tomu se také říká relativní normalizovaná exprese (RNE) nebo násobek exprese.
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Směrodatná odchylka pro normalizovanou expresi
Úprava rozsahu hodnoty normalizované exprese se provádí tak, že se směrodatná odchylka
normalizované exprese vydělí hodnotou normalizované exprese pro nejvyšší nebo nejnižší úroveň
exprese podle toho, kterou možnost úpravy rozsahu si zvolíte. Vzorec pro směrodatnou odchylku (SD)
normalizačního faktoru je

Kde:

n RQ = relativní množství vzorku

n SD = směrodatná odchylka

n NF = faktor normalizace

n Ref = referenční gen

n n = počet referenčních genů

Pokud je přiřazen kontrolní vzorek, nemusíte tuto funkci úpravy rozsahu směrodatné odchylky provádět,
jak je znázorněno v následujícím vzorci:

Kde:

n NE = normalizovaná exprese

n RQ = relativní množství vzorku

n SD = směrodatná odchylka

n GOI = zájmový gen (jeden produkt)
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Normalizovaná exprese upravená podle nejvyšší úroveň exprese

Normalizovaná exprese upravená podle nejvyšší úroveň
exprese

Pokud běh nezahrnuje kontroly, stanovte rozsah normalizované exprese (NE) pro každý produkt (gen)
tak, že vydělíte úroveň exprese každého vzorku nejvyšší úrovní exprese ve všech vzorcích. Software
stanoví nejvyšší úroveň exprese na hodnotu 1 a upraví rozsah všech úrovní exprese vzorku. Vzorec pro
nejvyšší rozsah je

Kde:

n GOI = zájmový gen (produkt)

Normalizovaná exprese upravená podle nejnižší úrovně
exprese

Pokud běh nezahrnuje kontroly, stanovte rozsah normalizované exprese (NE) pro každý produkt (gen)
tak, že vydělíte úroveň exprese každého vzorku nejnižší úrovní exprese ve všech vzorcích. Software
stanoví nejnižší úroveň exprese na hodnotu 1 a upraví rozsah všech úrovní exprese vzorku. Vzorec pro
nejnižší rozsah je

Kde:

n GOI = zájmový gen (produkt)

Normalizovaná exprese upravená podle průměrné úrovně
exprese

Pokud běh nezahrnuje kontroly, stanovte rozsah normalizované exprese (NE) pro každý cíl (gen) tak, že
vydělíte úroveň exprese každého vzorku geometrickým průměrem úrovní exprese ve všech vzorcích.
Software stanoví průměrnou úroveň exprese na hodnotu 1 a upraví rozsah všech úrovní exprese vzorku.
Vzorec pro průměrný rozsah je

Kde:
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n GOI = zájmový gen (produkt)

n GM = geometrický průměr normalizované exprese všech vzorků
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Směrodatná odchylka pro normalizovanou expresi
s upraveným rozsahem

Opětovná úprava měřítka hodnoty normalizované exprese (NE), jejíž měřítko již bylo upraveno, se
provádí tak, že se směrodatná odchylka (SD) normalizované exprese vydělí hodnotou normalizované
exprese pro nejvyšší (MAX) nebo nejnižší (MIN) úroveň exprese, podle toho, kterou možnost úpravy
měřítka si zvolíte.

Poznámka: Pokud je přiřazen kontrolní vzorek, nemusíte tuto funkci opětovné úpravy měřítka podle
směrodatné odchylky provádět.

Výpočet podle tohoto vzorce je

Kde:

n NE = normalizovaná exprese

n SD = směrodatná odchylka

n GOI = zájmový gen (produkt)

n MAX = nejvyšší úroveň exprese

n MIN = nejnižší úroveň exprese
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Chybové úsečky pro směrodatnou odchylku (lg) a standardní
chybu průměru (lg)

Kromě použití intervalů spolehlivosti mohou být zobrazeny chybové sloupce pro biologické skupiny na
základě směrodatné odchylky nebo standardní chyby průměru log2 exprese. Chybové úsečky se
vypočítají takto:

Dolní chybová úsečka RQ = 2RQ(lg)-SD RQ(lg) nebo 2RQ(lg)-SEM RQ(lg)

Horní chybová úsečka RQ = 2RQ(lg)+SD RQ(lg) nebo 2RQ(lg)+SEM RQ(lg)

Kde:

n RQ(lg) = log2 relativního množství pro biologickou skupinu

n SD RQ(lg) = směrodatná odchylka relativního množství (log2)

n SEM RQ(lg) = standardní chyba průměru relativního množství (log2)

Exp. dolní chybová úsečka = 2Exp.(lg)-SD Exp.(lg) nebo 2Exp.(lg)-SEM Exp.(lg)

Dolní chybová úsečka horní chybová úsečka = 2Exp.(lg)+SD Exp.(lg) nebo 2Exp.(lg)+SEM Exp.(lg)

Kde:

n Exp.(lg) = log2 exprese (normalizovaná exprese) pro biologickou skupinu

n SD RQ(lg) = směrodatná odchylka exprese (log2)

n SEM RQ(lg) = standardní chyba průměru exprese (log2)
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Násobek exprese
Násobek exprese je měřítkem zvýšení nebo snížení exprese produktu pro experimentální vs. kontrolní
vzorek nebo biologickou skupinu a stanoví se následovně:

Pokud platí, že exprese (experimentální) > exprese (kontrolní):

Pokud platí, že exprese (experimentální) < exprese (kontrolní):

Poznámka: Pro Graphing (Grafy) exprese vychází buď z relativního množství, nebo
z normalizované exprese v závislosti na vybraném režimu (viz Graphing (Grafy) na straně 262). Pro
rozptylový graf, a graf „clustergram“ se násobek exprese vždy vypočítá z normalizované exprese.
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Vzorce pro korigované hodnoty
Důležité: Tyto výpočty se dají použít, pouze pokud je Analyze Using (Typ analýzy) nastaveno na
Samples Only (Pouze vzorky), Sample Biological Group (Biologická skupina vzorků) nebo Biological
Group Samples (Vzorky biologické skupiny).

Rozdíl mezi korigovanými a nekorigovanými hodnotami je vidět pouze tehdy, pokud je v rámci běhu PCR
v reálném čase vytvořena standardní křivka. Software používá k určení šíření chyb tři rovnice:

n Standardní chyba

n Standardní chyba normalizované exprese

n Standardní chyba pro normalizovaný sledovaný gen (produkt)

Vzorec pro standardní chybu je

Kde:

n n = počet referenčních produktů (genů)

n SD = směrodatná odchylka

Standardní chyba pro faktor normalizace ve vzorci normalizované exprese je

Kde:

n n = počet referenčních genů

n SE = standardní chyba

n NF = faktor normalizace

n RQ = relativní množství

Standardní chyba pro vzorec normalizovaného sledovaného genu (GOI) je

Kde:

n SE = standardní chyba

n GOI = zájmový gen (jeden produkt)
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Výpočet intervalu spolehlivosti pro analýzu biologických skupin

n NF = faktor normalizace

n n = počet referenčních genů

Výpočet intervalu spolehlivosti pro analýzu biologických
skupin

Při provádění analýzy biologických skupin (parametr Analyze Using (Typ analýzy) je nastaven na
Biological Groups Only (Pouze biologické skupiny)) jsou intervaly spolehlivosti vypočteny pro relativní
množství a relativní normalizovanou expresi.

Intervaly spolehlivosti jsou vypočteny v logaritmickémměřítku na základě t-rozdělení pomocí
následujícího vzorce:

Kde:

n = střední exprese logaritmických hladin exprese vzorků v biologické skupině

n SD = standardní odchylka logaritmických hladin exprese vzorků v biologické skupině

n n = počet vzorků v biologické skupině

n t = získané z t-rozdělení na základě stupňů volnosti a úrovně alfa

Poznámka: Úroveň alfa lze nastavit pomocí pole hodnoty threshold P na kartě Graphing
(Grafy).

Po výpočtu intervalů spolehlivosti se převedou na lineární měřítko a zobrazí se v tabulce Data genové
exprese a v sloupcovém grafu na kartě Graphing (Grafy).

Grafy „Box“ a „Whiskers“ - výpočet
Box aWhisker graf zobrazuje distribuci hodnot exprese v rámci biologické skupiny vynesením dat jako
kvartilů. První (1.) a třetí (3.) kvartil jsou reprezentovány dolní, resp. horní hranicí pole. Medián je
zobrazen jako plná čára přes pole. „Vousy“ (Whisker) představují minimální a maximální hodnoty, které
nejsou v datové sadě. Odlehlé hodnoty jsou hodnoty, které překračují 1. a 3. kvartil o 1,5násobek
interkvartilového rozsahu.

Poznámka: Pokud je v biologické skupině pouze jeden vzorek, je zobrazen jako jeden kruh,
označující jediný datový bod.

Následující Box a Whisker graf ukazuje, jak jsou tyto údaje znázorněny.
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1. Odlehlý bod. Tato hodnota odlehlého bodu je > Q3 + (1,5 x [Q3 - Q1]).

Poznámka: Umístěte ukazatel myši na kruh a zobrazte nápovědu, která obsahuje název
vzorku a relativní množství nebo informace normalizované exprese v závislosti na
zvoleném režimu.

2. Maximální vymezení bez odlehlých bodů

3. Horní/3. kvartil (Q3). 75 % hodnot exprese je menší než Q3.

4. Medián nebo střední hodnota, hodnoty exprese seřazené podle pořadí

5. Dolní/1. kvartil (Q1). 25 % hodnot exprese je menší než Q1.

6. Minimální vymezení bez odlehlých bodů

7. Odlehlý bod. Tato hodnota odlehlého bodu je < Q1 - (1,5 x [Q3 - Q1]).

LEGENDA
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Příloha B Revizní záznamy
Software CFX Maestro Dx, bezpečnostní edice vytváří revizní záznamy pro datové soubory a soubory
genových studií (soubory .prcd a .mgxd). Veškeré změny nebo akce provedené na zabezpečených
datových souborech a souborech genových studií jsou při uložení souboru zachyceny v revizním
záznamu souboru.CFX Maestro Dx SE vytvoří pro každý soubor samostatný revizní záznam.

Můžete vybrat položku File > Save as (Soubor > Uložit jako) a uložit zabezpečené podepsané nebo
nepodepsané datové soubory a soubory genových studií do jiné složky nebo pod jiným názvem. Vzniklý
nový soubor zdědí revizní záznam od původního souboru. Revizní záznam pro takový nový soubor
rovněž zachycuje akce Uložit jako. Změny nebo akce provedené v novém souboru jsou zachyceny v jeho
vlastním revizním záznamu. Původní soubor si uchová svůj revizní záznam, ve kterém jsou zachyceny
další akce.

Auditovatelné události na straně 305 uvádí auditovatelné události, které software zachytil.

Prohlížení revizních záznamů
Každý revizní záznam zobrazuje následující informace:

n Podrobnosti záhlaví auditu

o File version (Verze souboru) – uložená verze souboru

o Date (Datum) – datum aktuální auditovatelné události

o User (Uživatel) – doménaWindows a uživatelské jméno přihlášeného uživatele

o Comment (Komentář) – poslední uložený komentář

o Signature (Podpis) – elektronický podpis poslední osoby, která soubor podepsala

o Signature reason (Důvod podpisu) – důvod podpisu

o Application (Aplikace) – CFX Maestro Dx SE

o Application version (Verze aplikace) – aktuální verze CFX Maestro Dx SE

o Full name (Celé jméno) – celé jméno přihlášeného uživatele

o Machine (Stroj) – počítač, na kterém je nainstalován CFX Maestro Dx SE

n Podrobnosti o změně auditu
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o Object (Předmět) – položka, která byla změněna (kontrolovaná položka)

o Old value (Stará hodnota) – předchozí hodnota

o New value (Nová hodnota) – nová hodnota

o Description (Popis) – popis změny

Zobrazení revizního záznamu

u V souboru otevřených dat nebo genové studie vyberte možnost View > Audit Trail (Zobrazit > Revizní
záznam). Zobrazí se revizní záznam souboru.

Ve výchozím nastavení jsou data tříděna podle data a času a všechny události se zobrazují
v rozbaleném zobrazení. Můžete filtrovat zobrazení podle uživatelského jména a předmětu a sbalit
rozbalené zobrazení, abyste je mohli snadno seřadit podle libovolného pole záhlaví. Revizní záznam
můžete také zobrazit jako zprávu ve formátu html.

Seřadit podle uživatelského jména

u Vyberte cílového uživatele z rozevíracího seznamu User Name (Uživatelské jméno).

Seřadit podle předmětu

u Vyberte produkt z rozevíracího seznamu Object (Předmět).

Skrytí úplného popisu událostí

u Klikněte na Collapse All (Sbalit vše).
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Řazení dat v tabulce podrobností o změně

u Kliknutím na symbol kosočtverce v záhlaví sloupce dat provedete vzestupné řazení (od A do Z, od
nejmenšího čísla po největší nebo od nejstaršího po nejnovější).

Chcete-li vytisknout revizní záznam

1. Kliknutím na HTML Report (Zpráva v HTML) zobrazíte revizní záznam ve webovém prohlížeči.

2. V okně prohlížeče proveďte jednu z následujících akcí:

n Vyberte File > Print (Soubor > Tisk).

n Klepněte pravým tlačítkem na zprávu a vyberte položku Print (Tisk).

Auditovatelné události
CFX Maestro Dx SE zachycuje následující auditovatelné události v datových souborech a souborech
genových studií.

Auditovatelné události při běhu

n Run Start Time (Čas spuštění běhu)

n Úpravy Run Time Plate (Doba běhu destičky)

n Úpravy Run Time Protocol (Protokol doby běhu)

n Run End Time (Čas konce běhu)

Auditovatelné události při vytvoření datového souboru

n Vytvoření datového souboru

n Interpolované odečty destiček přidané systémem

Auditovatelné události při uložení datového souboru

n Všeobecné

o Name (Název)

o Signing (Podepisování)

o Plate Setup (Nastavení destičky)

o Display Wells (Zobrazit jamky)

o Analyzed fluorophores (Analyzované fluorofory)

o Úpravy Plate (Destička)
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o Režim Analysis (Analýza)

o PCR Active Well Group (Skupina aktivních jamek PCR)

n Karta Quantification (Kvantifikace)

o Active step (Aktivní krok)

o Settings— Cq Determination mode (Nastavení - C q Režim stanovení)

o Settings— Baseline Setting (Nastavení – Poloha baseline)

o Drift correction applied (Byla použita korekce posunu)

o Settings – Cycles to Analyze (Nastavení – Cykly pro analýzu)

o Settings – Analysis Mode (Nastavení – Režim analýzy)

o Settings— Baseline Threshold (Nastavení – Baseline threshold)

n Karta Melt Curve (Křivka tání)

o Active step (Aktivní krok)

o Peak type displayed (Zobrazený typ vrcholu)

o Peak analysis threshold (Práh pro analýzu vrcholu)

n Karta EndPoint (End-point analýza)

o Active fluorophore/target (Aktivní fluorofor/terč)

o End cycles to average (Počet ukončených cyklů pro výpočet průměru)

o Tolerance calculation method (Metoda výpočtu tolerance)

o Percentage of range (Procento rozsahu)

n Karta Allelic Discrimination (Alelická diskriminace)

o X- and Y-axis fluorophore (Fluorofor v ose X a Y)

o Select cycle number (Číslo vybraného běhu)

o View call map (Zobrazení mapy určení)

n Karta Expression tab— All plots (Genová exprese – Všechny grafy)

o Experiment Settings— Target reference (Nastavení experimentu – referenční produkt)

o Experiment Settings— Sample control (Nastavení experimentu – Kontrola vzorku)

o Experiment Settings— Auto efficiency (Nastavení experimentu – Automatická účinnost)
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o Experiment Settings— Efficiency (Nastavení experimentu – Účinnost)

n Karta Gene Expression—Graphing (Exprese genů – Grafy)

o Režim Analysis (Analýza)

o Graph Data (Data grafu)

o X-axis (Osa X)

o Y-axis (Osa Y)

o Scaling option (Možnosti úpravy měřítka)

o Error bar (Chybová úsečka)

o Error bar multiplier (Násobitel chybové úsečky)

o P-value threshold (Práh hodnoty P)

n Záložka Gene Expression— Clustergram (Exprese genů – graf „clustergram“)

o Cluster By (Seskupit podle)

o Split Out Replicates (Rozdělit replikáty)

n Záložka Gene Expression— Scatter Plot (Exprese genů – Rozptylový graf)

o Control biological group (Biologická skupina kontroly)

o Experimental biological group (Experimentální biologická skupina)

o Fold change threshold (Práh násobku exprese)

n Záložka Gene Expression— ANOVA (Exprese genů— ANOVA)

o P-value threshold (Práh hodnoty P)

n Plate Setup— View/Edit Plate (Nastavení destičky – Zobrazit/upravit destičku)

o Settings— PlateType (Nastavení – Typ destičky)

o Settings— Units (Nastavení – Jednotky)

o Editing Tools — Flip Plate (Nástroje pro úpravy – Obrátit destičku)

o Well groups (Skupiny jamek)

o Plate fluorophores (Destičkové fluorofory)

n Plate Setup— Replace Plate and Apply PrimePCR File (Nastavení destičky – Vyměnit destičku
a použít soubor PrimePCR)

o Plate Setup Import (Import nastavení destičky)
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Změny auditu pro soubory genových studií

Všeobecné

n Name (Název)

n Karta Study Setup (Nastavení studie)

o Add/Remove data files (Přidat/odebrat datové soubory)

n Karta Study Analysis (Analýza studie)
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Software CFX Maestro Dx, bezpečnostní edice můžete nakonfigurovat pro použití se systémem správy
laboratorních informací (LIMS). Pro integraci LIMS vyžaduje software CFX Maestro Dx SE informace
o nastavení destičky generované platformou LIMS (soubor LIMS *.plrn ), soubor protokolu vytvořený
pomocí CFX Maestro Dx SE (*.prcl), definované umístění exportu dat a definovaný formát exportu.

Po dokončení běhu vygeneruje CFX Maestro Dx SE datový soubor (.pcrd) a uloží jej do definovaného
umístění složky pro export dat.CFX Maestro Dx SE může také vytvořit datový soubor kompatibilní s LIMS
ve formátu .csv a uložit jej na stejné místo.

Vytvoření datových souborů kompatibilních s LIMS
Tato příloha vysvětluje, jak nastavit software CFX Maestro Dx SE pro vytvoření, uložení a export
datových souborů kompatibilních s LIMS.

Nastavení možností složky LIMS a exportu dat
Ve výchozím stavu ukládá CFX Maestro Dx SE protokoly, soubory a soubory exportu dat LIMS do této
složky:
C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Můžete CFX Maestro Dx SE nakonfigurovat tak, že uloží soubory do jiné složky, a současně můžete
měnit možnosti exportu pro data LIMS.

Jak nastavit možnosti složky LIMS a exportu dat

1. V okně Home (Domů) vyberte položky Tools > Options (Nástroje > Možnosti).

2. V dialogovém okně Options (Možnosti) vyberte položku Data Export Settings (Nastavení exportu
dat).
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3. (Volitelné) Vyberte možnost Automatically export LIMS data at end of run (Automaticky exportovat
data LIMS na konci běhu).

Software automaticky provede export dat LIMS po každém běhu a uloží je do stanoveného umístění.

4. Chcete-li změnit výchozí možnosti exportu dat LIMS, klikněte na položku LIMS Data Export Settings
(Nastavení exportu dat LIMS).

Důležité: Zpět do softwaru CFX Maestro Dx SE lze importovat pouze data LIMS exportovaná
jako soubor .csv.

5. V dialogovém okně LIMS Data Export Format Settings (Nastavení formátu pro export dat LIMS)
vyberte požadované možnosti exportu a klikněte na OK.

6. V dialogovém okně Options (Možnosti) najděte a vyberte výchozí složku, do které chcete uložit
datové soubory LIMS. Pro každý typ souboru můžete vybrat jiné umístění:

n Protokol

n Soubor LIMS

n Export dat

7. Kliknutím na OK uložíte změny a zavřete dialogové okno Options (Možnosti).
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Vytvoření protokolu LIMS
Chcete-li spustit běh LIMS , vytvořte soubor protokolu CFX Maestro Dx SE (*. prcl) a uložte jej do
určeného umístění složky protokolu LIMS.

Další informace uvádí Kapitola 7, Vytvoření protokolů.

Vytvoření souboru LIMS
Soubor LIMS (*.plrn) obsahuje podrobnosti o nastavení destičky a název souboru protokolu. Tento
soubor je generován vaším interním LIMS.CFX Maestro Dx SE používá soubor LIMS k vytvoření souboru
destičky pro použití se souborem protokolu.

Software CFX Maestro Dx SE obsahuje soubory šablony pro import destiček, které můžete upravovat,
abyste vytvořili vlastní soubory destiček LIMS.

Tip: Tento úkol by měl vykonávat specialista na LIMS.

Jak vytvořit soubor LIMS

1. V okně Home (Domů) vyberte položky View > Show > LIMS File Folder (Náhled > Zobrazit > Složka
souboru LIMS).

2. Otevřete složku LIMS Templates (Šablony LIMS) a vyberte soubor .csv pro import do vašeho
interního LIMS.

3. Pomocí LIMS upravte šablonu tak, že vyplníte požadovaná pole, viz Tabulka 38.

4. Postupujte následovně:

n Chcete-li uložit změny pro budoucí použití, uložte soubor jako soubor CSV.

n Chcete-li uložit změny a soubor okamžitě použít, uložte soubor s příponou .plrn.

n Uložte šablonu se souborovou koncovkou .plrn do složky pro soubory LIMS.

Důležité: Software CFX Maestro Dx SE otevírá pouze soubory .plrn. Abyste mohli uložit běh
LIMS, musíte soubor .csv uložit jako .plrn.

Sloupec Řádek Popis Obsah Účel

A 1 Záhlaví destičky Neupravovat Předdefinováno

A,B,C 2 Pole/data/pokyn Neupravovat Předdefinováno

Tabulka 38. Definice obsahu LIMS souboru .csv
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Sloupec Řádek Popis Obsah Účel

B 3 Verze Neupravovat Předdefinováno

B 4 Velikost destičky Neupravovat Předdefinováno

B 5 Typ destičky Zadejte „BRWhite“ („BR
bílá“), „BR Clear“ („BR
čirá“) nebo jiný
kalibrovaný typ destičky

Vyžadováno

B 6 Režim skenování Zadejte „SYBR/FAM
Only:“ („Pouze
SYBR/FAM“), „All
Channels“ („Všechny
kanály“) nebo „FRET“

Vyžadováno

Tabulka 38. Definice obsahu LIMS souboru .csv, pokračování
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Sloupec Řádek Popis Obsah Účel

B 7 Jednotky Zadejte jedno z
následujících: „copy
number“ („číslo kopie“),
„fold dilution“ („ředění
násobku“), „micromoles“ 
(„mikromoly“),
„nanomoles“ 
(„nanomoly“),
„picomoles“ 
(„pikomoly“),
„femtomoles“ 
(„femtomoly“),
„attomoles“ („attomoly“),
„milligrams“ 
(„miligramy“),
„micrograms“ 
(„mikrogramy“),
„nanograms“ 
(„nanogramy“),
„picograms“ 
(„pikogramy“),
„femtograms“ 
(„femtogramy“),
„attograms“ 
(„attogramy“) nebo
„percent“ („procenta“)

Vyžadováno

B 8 ID běhu Zadejte krátký popis
nebo čárový kód
s identifikací tohoto
cyklu (maximálně 30
znaků, čárky nejsou
povoleny)

Volitelné

B 9 Poznámky k běhu Zadejte popis běhu Volitelné

B 10 Protokol běhu Zadejte přesný název
souboru protokolu.

Vyžadováno

Tabulka 38. Definice obsahu LIMS souboru .csv, pokračování
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Sloupec Řádek Popis Obsah Účel

A 11 Datový soubor Zadejte název datového
souboru

Volitelné

A 12–15 TBD/prázdné Neupravovat Předdefinováno

A 16 Data destičky Neupravovat Předdefinováno

A 17–113 Pozice jamky Neupravovat Předdefinováno

B–G Barv. kanál1, barv.
kanál2, barv.
kanál3, barv.
kanál4, barv.
kanál5, FRET

Pro každý použitý kanál
zadejte název jednoho
kalibrovaného barviva
(například „FAM“)

Vyžadováno

H Typ vzorku Zadejte jeden z
následujících typů
vzorku: „Unknown“ 
(„Neznámý“), „Standard“ 
(„Standardní“), „Positive
Control“ („Pozitivní
kontrola“), „Negative
Control“ („Negativní
kontrola“), „NTC“ nebo
„NRT“

Vyžadováno

I Název vzorku Zadejte název vzorku Volitelné

J–O Produkt kanál1,
produkt kanál2,
produkt kanál3,
produkt kanál4,
produkt kanál5,
produkt FRET

Zadejte název produktu
pro každý použitý kanál

Volitelné

P Název sbírky Zadejte název
biologického souboru

Volitelné

Tabulka 38. Definice obsahu LIMS souboru .csv, pokračování
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Vytvoření datových souborů kompatibilních s LIMS

Sloupec Řádek Popis Obsah Účel

Q Replikace Zadejte kladné celé číslo
pro každý soubor
replikace. Hodnota
nesmí být nulová.

Volitelné

R–W Množství kanál1,
množství kanál2,
množství kanál3,
množství kanál4,
množství kanál5,
množství FRET

Zadejte hodnoty
množství pro každý
standard. Zadejte
koncentraci v decimální
podobě.

Vyžadováno pro
všechny standardy

Tabulka 38. Definice obsahu LIMS souboru .csv, pokračování

Uživatelská příručka | 315



Příloha C Integrace LIMS

Sloupec Řádek Popis Obsah Účel

X Poznámka k jamce Zadejte poznámku k
jamce (maximálně 20
znaků)

Poznámka: Ačkoli
CFX Maestro Dx
SE má při zadávání
poznámek doWell
Note (Poznámky
k jamce) pomocí
softwaru limit 20
znaků, pole Well
Note může
obsahovat až 500
znaků, pokud je
součástí
importovaného
souboru .plrn.
Nicméně,
CFX Maestro Dx
SE zobrazí pouze
prvních 20 znaků.
Exportovaný
soubor .pcrd bude
obsahovat všechny
znaky v poli Well
Note (Poznámka
k jamce), neztratí
se žádná data.

Volitelné

Y–AD Barva jamky kanál1,
barva jamky kanál2,
barva jamky kanál3,
barva jamky kanál4,
barva jamky kanál5,
barva jamky FRET

Zadejte uživatelem
definovanou barvu
zobrazení křivek v
decimálním formátu
32bitového celého čísla
(argb)

Volitelné

Tabulka 38. Definice obsahu LIMS souboru .csv, pokračování
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Spuštění běhu LIMS
Jak spustit běh LIMS

1. Chcete-li otevřít soubor LIMS .plrn, postupujte následovně:

n V okně Home (Domů) vyberte položky View > Show > LIMS File Folder (Náhled > Zobrazit >
Složka souboru LIMS) a otevřete cílový soubor . plrn.

n V okně Home (Domů) vyberte položky File > Open > LIMS File (Soubor > Otevřít > Soubor
LIMS) a otevřete cílový soubor .plrn.

Soubor se otevře na kartě Start Run (Spustit běh) v průvodci Run Setup (Nastavení běhu). Na kartě
Start Run (Spustit běh) se zobrazují informace o experimentu, který se má spustit. Zobrazuje také
připojený blok nebo bloky přístroje, které jsou k dispozici.

2. Na kartě Start Run (Spustit běh) vyberte přístroj a klepněte na položku Start Run (Spustit běh).

Export dat do LIMS
Po ukončení běhu software CFX Maestro Dx SE vygeneruje datový soubor (.pcrd) a uloží jej do
definované složky pro export dat.
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Jak exportovat datový soubor do LIMS

u Otevřete soubor .pcrd a vyberte Export > Export to LIMS Folder (Exportovat > Export do složky
LIMS).

Tip: Pokud v okně LIMS Options (Možnosti LIMS) vyberete možnost Automatically Export Data after
Run (Automaticky exportovat data po běhu), vytvoří software CFX Maestro Dx SE datový soubor
kompatibilní s LIMS ve formátu .csv a uloží jej do stejné složky.
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Příloha D Software CFX Maestro Dx, bezpečnostní
edice – poradce při potížích

Software CFX Maestro Dx, bezpečnostní edice, se může při upgradu nebo spuštění setkat s problémy.
Tato příloha obsahuje návrhy jejich řešení.

Seznam povolených souborů a složek Software CFX Maestro
Dx, bezpečnostní edice

Je možné, že za účelem ochrany před viry a malwarem vaše oddělení IT implementovalo velmi přísná
softwarová bezpečnostní opatření. Tato opatření mohou mít vliv na dobu potřebnou k upgrade nebo ke
spuštění CFX Maestro Dx SE.

Chcete-li zlepšit výkonCFX Maestro Dx SE, doporučuje Bio-Rad, aby vaše IT oddělení přidalo na seznam
povolených prvků následující soubory a složky v nastavení brány firewall ve vašem antivirovém softwaru
nainstalovaném na serveruCFX Maestro Dx SE:

Složky

n C:\Program Files (x86)\Bio-Rad\CFX_MDx

n C:\ProgramData\Bio-Rad\CFX_MDx

n C:\Users\Public\Documents\Bio-Rad\CFX_MDx

Soubory

n Všechny soubory .exe umístěné ve složce C:\Program Files (x86)\Bio-Rad\CFX_MDx

n R.exe a Rscript.exe (umístěné ve složce C:\Program Files (x86)\Bio-Rad\CFX_MDx\ R\
R-3.3.1\bin)
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Protokol aplikací
Před spuštěním nového běhu spustí systém CFX Opus Dx autodiagnostický test, který ověří, zda běží
v rámci specifikací. Software zaznamenává výsledky tohoto testu do souboru Run Log (Protokol běhu) a
Application Log (Protokol aplikací). Pokud zaznamenáte problém pro jeden nebo více experimentů,
otevřete protokoly běhu a aplikací, abyste zjistili, kdy problém začal.

Software Dx CFX Maestro Dx SE sleduje informace o stavu přístroje během běhu v protokolu aplikací.
Tyto protokoly použijte ke sledování událostí, které se vyskytují na přístrojích a v softwaru a při řešení
problémů.

Otevření protokolu aplikací

u V okně Home (Domů) vyberte View > Application Log (Zobrazit > Protokol aplikací).

Chcete-li zobrazit protokol aplikace jako soubor HTML, klikněte na tlačítko HTML Report (Zpráva
v HTML).
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Načtení souborů protokolů aplikace a firmwaru
Protokoly aplikace a firmwaru obsahují informace o činnostech provedených během používání softwaru
a provádění cyklů. Tyto protokoly také zaznamenávají všechny chyby softwaru nebo firmwaru, které se
vyskytnou během provozu softwaru nebo přístroje.

Přístup k souborům protokolů aplikace a firmwaru:

1. V podokně Detected Instruments (Detekované nástroje) klikněte pravým tlačítkemmyši na přístroj.

2. Vyberte možnost Retrieve Log Files (Načíst soubory protokolů).

3. V dialogovém okně Browse For Folder (Najít složku) vyberte cílovou složku v síti nebo místním disku,
do kterého chcete soubory protokolu uložit.

Poznámka: Složka má název „Logs“.

4. Klepnutím na tlačítko OK soubory uložíte.

Důležité: Uložení souboru protokolu se stejným názvem jako existující soubor protokolu přepíše
existující soubor protokolu.

Poradce při potížích
Problémy s komunikací softwaru a přístrojů lze obvykle vyřešit restartováním počítače a systému. Před
restartováním nezapomeňte uložit všechny probíhající operace.

Poznámka: Ověřte, zda má počítač dostatek paměti RAM a volné místo na disku. Minimální velikost
paměti RAM je 4 GB a minimální místo na pevném disku je 128 GB.

Výpadek napájení
Při výpadku napájení se přístroj a počítač vypnou. Pokud je výpadek napájení krátký, přístroj obnoví
provoz protokolu, ale protokol aplikací zaznamená výpadek napájení. V závislosti na nastavení počítače
a době, kdy je napájení přerušeno, se přístroj a software pokusí pokračovat v provozu v závislosti na
kroku protokolu:

n Pokud je protokol v kroku bez čtení destičky, protokol bude pokračovat, jakmile se znovu obnoví
napájení přístroje.

n Pokud je protokol v kroku s načtením destičky, přístroj čeká, až se software restartuje a obnoví
komunikaci, aby shromáždil data. V této situaci protokol pokračuje pouze v případě, že počítač není
vypnut. Při opětovném spuštění počítače a softwaru protokol pokračuje.
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Přenos souborů do počítače CFX Maestro Dx SE
Můžete přenášet data a soubory protokolu umístěné v přístroji na pevný disk připojeného počítače se
softwarem CFX Maestro Dx SE.

Tip: Všechny soubory ve složce s daty shromážděnými v reálném čase v základně přístroje se
načtou do počítače.

Poznámka: Z přístrojů CFX Opus Dx můžete přenášet pouze soubory protokolu. Všechny soubory
protokolu v přístroji se přenesou do počítače.

Jak načíst soubory z přístroje

1. V podokně Detected Instruments (Detekované přístroje) v okně Home (Domů) klikněte pravým
tlačítkemmyši na cílový přístroj a vyberte Retrieve Log Files (Načíst soubory protokolů).

2. Vyberte umístění složky pro uložení načtených souborů.

3. Klikněte na OK.

Software CFX Maestro Dx, bezpečnostní edice – ruční instalace
Jak manuálně nainstalovat software CFX Maestro Dx SE

1. V případě potřeby odpojte od počítače všechny připojené přístroje.

Najděte a odpojte USB kabel přístroje z počítače se softwarem CFX Maestro Dx SE. Konec zapojený
do přístroje můžete ponechat na místě.

2. Přihlaste se k počítači se softwarem CFX Maestro Dx SE s oprávněním správce.

3. Zasuňte USB disk se softwarem CFX Maestro Dx SE do USB portu počítače.

4. V Průzkumníkovi Windows přejděte na USB jednotku se softwarem CFX Maestro Dx SE a otevřete ji.

5. Otevřete složku CFX a poklepejte na soubor CFXMaestro Dx Setup.exe, čímž spustíte instalaci
CFX Maestro Dx SE .

6. Při instalaci softwaru postupujte podle pokynů na obrazovce.

Po dokončení se na obrazovce počítače otevře úvodní obrazovka Bio-Rad Software CFX Maestro
Dx, bezpečnostní edice a na pracovní ploše se objeví ikona Bio-Rad Software CFX Maestro Dx,
bezpečnostní edice.

7. Bezpečně vyjměte USB disk se softwarem a spusťte CFX Maestro Dx SE.
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Přeinstalování ovladačů
Přeinstalování ovladačů přístroje

u Pro přeinstalování ovladačů vyberte v položky Tools > Reinstall Instrument Drivers (Nástroje > Znovu
instalovat ovladače přístroje).

Poznámka: Pokud máte po přeinstalování ovladačů a kontrole připojení USB problémy se
softwarem komunikujícím se systémem v reálném čase, obraťte se na technickou podporu
společnosti Bio-Rad.
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Příloha E Bio-Rad Free and Open-Source Notices
for PCR Products

This document includes licensing information relating to free, open-source, and public-source software
and data (together, the “MATERIALS”) included with or used to develop Bio-Rad products and services.
The terms of the applicable free, open-source, and public-source licenses (each an “OPEN LICENSE”)
govern Bio-Rad’s distribution and your use of the MATERIALS. Bio-Rad and the third-party authors,
licensors, and distributors of the MATERIALS disclaim all warranties and liability arising from all use and
distribution of the MATERIALS. To the extent the OSS is provided under an agreement with Bio-Rad that
differs from the applicable OSS LICENSE, those terms are offered by Bio-Rad alone.

Bio-Rad has reproduced below copyright and other licensing notices appearing within the MATERIALS.
While Bio-Rad seeks to provide complete and accurate copyright and licensing information for all
MATERIALS, Bio-Rad does not represent or warrant that the following information is complete, correct, or
error-free. MATERIALS recipients are encouraged to (a) investigate the identified MATERIALS to confirm
the accuracy of the licensing information provided and (b) notify Bio-Rad of any inaccuracies or errors
found in this document so that Bio-Rad may update this document accordingly.

Certain OPEN LICENSES (such as the Affero General Public Licenses, Common Development and
Distribution Licenses, Common Public License, Creative Commons Share-Alike License, Eclipse Public
License, Mozilla Public Licenses, GNU General Public Licenses, GNU Library/Lesser General Public
Licenses, and Open Data Commons Open Database License) require that the source materials be made
available to recipients or other requestors under the terms of the same OPEN LICENSE.

The corresponding open source software is available for download from the links in the section that
follows.
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Software Notices

ZedGraph
Project homepage/download site:

https://sourceforge.net/projects/zedgraph/

Bio-Rad source code site:

https://github.com/bio-rad-lsg-open-source/ZedGraph-5.0.1

External source code site:

https://github.com/ZedGraph/ZedGraph

Project licensing notices:

/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

/sources/ZedGraph/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

Standard Open License Text

LGPL-2.1
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple
Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to
copy and distribute verbatim copies of this license document, but
changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]
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Standard Open License Text

Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the
explanations below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and
charge for this service if you wish); that you receive source code or
can get it if you want it; that you can change the software and use
pieces of it in new free programs; and that you are informed that you
can do these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or
if you modify it.

For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we
gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must
provide complete object files to the recipients, so that they can
relink them with the library after making changes to the library and
recompiling it. And you must show them these terms so they know their
rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified
by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's
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reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.

When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
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operating system, as well as its variant, the GNU/Linux operating
system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter
must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or
translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term
"modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output
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from such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool
for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library. You may charge a fee for the physical act of transferring a
copy, and you may at your option offer warranty protection in
exchange for a fee.

2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge
to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the
facility still operates, and performs whatever part of its purpose
remains meaningful. (For example, a function in a library to compute
square roots has a purpose that is entirely well-defined independent
of the application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must be
optional: if the application does not supply it, the squareroot
function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
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distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the
Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version
2, instead of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other
change in these notices. Once this change is made in a given copy, it
is irreversible for that copy, so the ordinary GNU General Public
License applies to all subsequent copies and derivative works made
from that copy. This option is useful when you wish to copy part of
the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine- readable source code,
which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange. If
distribution of object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled
or linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
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therefore falls outside the scope of this License. However, linking a
"work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of
the Library), rather than a "work that uses the library". The
executable is therefore covered by this License. Section 6 states
terms for distribution of such executables. When a "work that uses
the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the
Library even though the source code is not. Whether this is true is
especially significant if the work can be linked without the Library,
or if the work is itself a library. The threshold for this to be true
is not precisely defined by law. If such an object file uses only
numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it
is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications. You must give prominent
notice with each copy of the work that the Library is used in it and
that the Library and its use are covered by this License. You must
supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the
Library among them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-
readable source code for the Library including whatever changes were
used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library,
with the complete machine-readable "work that uses the Library", as
object code and/or source code, so that the user can modify the
Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the

332 | Software CFX Maestro Dx SE



Standard Open License Text

contents of definitions files in the Library will not necessarily be
able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a copy
of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will
operate properly with a modified version of the library, if the user
installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three
years, to give the same user the materials specified in Subsection
6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.

e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a
combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
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a) Accompany the combined library with a copy of the same work based
on the Library, uncombined with any other library facilities. This
must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that
part of it is a work based on the Library, and explaining where to
find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated
so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are

prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance by
third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under
this License and any other pertinent obligations, then as a
consequence you may not distribute the Library at all. For example,
if a patent license would not permit royalty-free redistribution of
the Library by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this
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License would be to refrain entirely from distribution of the
Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended
to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice. This section is intended to make
thoroughly clear what is believed to be a consequence of the rest of
this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published
by the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
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copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free
status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER MATERIALS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest
possible use to the public, we recommend making it free software that
everyone can redistribute and change. You can do so by permitting
redistribution under these terms (or, alternatively, under the terms
of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It
is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should
have at least the "copyright" line and a pointer to where the full
notice is found.
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<one line to give the library's name and a brief idea of what it
does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is
distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public
License for more details.

You should have received a copy of the GNU Lesser General Public
License along with this library; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307
USA

Also add information on how to contact you by electronic and paper
mail. You should also get your employer (if you work as a programmer)
or your school, if any, to sign a "copyright disclaimer" for the
library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the
library `Frob' (a library for tweaking knobs) written by James Random
Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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Informace o autorských právech Minpack (1999), University of Chicago. Všechna práva

vyhrazena.

Další distribuce a použití ve zdrojové a binární podobě, s úpravami nebo bez úprav, jsou povoleny za
předpokladu, že jsou splněny následující podmínky:

1. Součástí dále distribuovaného zdrojového kódu musí být výše uvedené informace o autorských
právech, tento seznam podmínek a následující upozornění.

2. Součástí dále distribuované binární formy musí být výše uvedené informace o autorských právech,
tento seznam podmínek a následující upozornění v dokumentaci a/nebo jiných materiálech
poskytovaných současně s distribucí.

3. Dokumentace pro koncového uživatele, která součástí případné distribuce, musí obsahovat
následující informaci:

„Tento produkt obsahuje software vyvinutý na University of Chicago v partnerství s laboratoří Argonne
National Laboratory.”
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